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1 Introduction 
Welcome to The Edge! 
 
The Edge is a powerful software application developed specifically to fulfill the needs of the 
independent retail jeweler in a straight forward and intuitive manner.  This includes recording day-to-day 
business transactions and managing inventory, but goes well beyond that by incorporating advanced 
tools to aid you in efficiently marketing to your customers, analyzing sales performance, and interpreting 
inventory performance, among other features.   
 
Based on the latest Microsoft programming platform, The Edge is both cutting-edge and stable.  To 
ensure continued operation in an ever-evolving computing world, the program is updated regularly 
through our community website (www.edgeuser.com). 
 
It is our hope that you take advantage of everything our software package offers you.  To this end, this 
manual exists as a starting point for any questions on the operation of the software.  In the event you 
require more assistance with a topic, do not hesitate to contact our Support Team. 
 
Also, our Training Department offers several ways to receive additional training.  This includes an 
introductory class that we strongly recommend all new users attend.  The class is available in two 
formats:   a live class that you attend at our facilities in Connecticut or a web-based class that can be 
attended from anywhere.  Specific classes covering more advanced topics are also available.   
 
Beyond The Edge software, Abbott Jewelry Systems, Inc. offers other services including various degrees 
of training, a retail management consulting group, and trade show seminars.  Contact our Sales 
Department for more information.  
 
For your convenience, here is a quick listing of contact information.  More comprehensive information is 
available (see Abbott Jewelry Systems Contact Information). 
 
Support Team 877-844-0002 Support@ajsllc.com 
Sales Department 866-580-3343 Sales@ajsllc.com 
Training Department 866-580-3343 x 1905 Training@ajsllc.com 
 
 
 
 
 
 

http://www.edgeuser.com/
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 About This Guide 
This guide describes how to make the best use of the features and functions of The Edge.  It is assumed 
you are familiar with the use of computers and general Windows® features.  Throughout this guide, all 
references made to Windows imply any of Microsoft 7, Windows 8, Windows 10, and the general 
Windows-type graphical user interface. 
 
For ease of reading, the following conventions are used throughout this guide: 
 
• A bold font is used to highlight features of the user interface, such as buttons, field names, and 

menu items. 
• A monospaced font is used to indicate file names and information that you must type. 
• Use of ► indicates that a series of options are to be selected. 
 
Throughout this guide, you will see extra information designed to provide guidance and assistance for 
getting the most from The Edge: 
 

 

Offers a best practice or other type of extra information to help you get the best results from 
The Edge. 

 

Provides information to help you get the most from a procedure or function. 

 

Provides information that, without it, could cause the function to behave unexpectedly or 
results to be inaccurate. 

 Additional Reference Materials 
Tip sheets and video tutorials can be found at www.edgeuser.com.   
 
 
 
 
 
 
 
 
 
 
 
  

http://www.edgeuser.com/
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 Abbott Jewelry Systems Contact Information 
Abbott Jewelry Systems Offices 
Main Line: 866-580-3343 (866-580-EDGE)  
www.theedgeforjewelers.com  
3 Corporate Drive, #215 
Shelton, CT 06484  USA 
 
Please do not ship us anything without first contacting us. Packages without a valid RMA number will 
be refused.  If sending something in for a specific person or department, be sure to indicate that. 
 
International Numbers 
Phone:  +1-203-567-1900 
Fax:  +1-203-416-6577  
 
The Edge Support 
Phone: 877-844-0002 
Fax: 877-683-4888  
Email:  support@ajsllc.com 
www.edgeuser.com    
For best results, see the tip sheet entitled Getting the Most from Edge Support. 
 
The Edge Sales/Supplies 
Phone: 866-580-3343, option 5  
Fax: 203-413-2943 
Email:  sales@ajsllc.com  
 
The Edge Training 
Phone:  866-580-3343, option 8  
Fax:  203-413-6259  
Email:  training@ajsllc.com  
 
The Edge Conversion 
Phone:  877-844-0002 
Fax:  203-816-8555 
Email:  convert@ajsllc.com   
 
Video Tutorials  
www.screencast.com/users/www.AJSLLC.com/folders/EDGE%20Tutorials  
Password: edge user 
 

http://www.theedgeforjewelers.com/
http://www.edgeuser.com/
http://docs.edgeuser.com/TIP-2015-068_Getting_the_Most_from_Support_QR.pdf
mailto:sales@ajsllc.com
mailto:training@ajsllc.com
mailto:convert@ajsllc.com
http://www.screencast.com/users/www.AJSLLC.com/folders/EDGE%20Tutorials
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The Edge Retail Academy 
Phone:  877-569-8657 
Email:  becka@edgeretailacademy.com 
 
Integrated Postcards 
Drive Retail, LLC 
Email:  postcards@ajsllc.com  
Phone:  770-937-0735 
www.driveretail.com  
 
Paper/Forms/Plastic Cards 
Hershel Barg & Associates 
Phone:  800-675-2675  
www.hershelbargassociates.com  
 
Geller Blue Book (Repair SKU Table) 
Jeweler Profit:  888-255-9848 
www.jewelerprofit.com 
 
Integrated Credit Card Payment Processing 
For a list of our certified partners, contact The Edge Sales at 866-580-3343, option 5. 
 
Website Partners 
• GemFind:  949-752-7710 http://www.gemfind.com 
• Punchmark:  704-910-4774 www.punchmark.com 
 
Training 
Contact our Training Department to obtain information regarding our training options.  
 
      Phone           Fax            Email 
866-580-3343x1905       203-413-6259  Training@ajsllc.com 
 
Available training options include classes held at our offices in Connecticut, on-site training at your 
store, online classes (webinars) that can be attended from anywhere, and occasional training seminars 
held throughout the country in concert with jewelry shows/seminars.  The Edge Newsfeed contains more 
information. 
 
The Edge Community 
To stay up to date with The Edge, visit our community website:   www.EdgeUser.com.  This website 
includes: 
 
• Links to download the latest version of The Edge 

mailto:becka@edgeretailacademy.com
mailto:postcards@ajsllc.com
http://www.driveretail.com/
http://www.hershelbargassociates.com/
http://www.jewelerprofit.com/
http://www.gemfind.com/
http://www.punchmark.com/
mailto:Training@ajsllc.com
http://www.edgeuser.com/
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• Online discussion forum for Edge users 
• Additional reference and how-to documentation 
• Online training videos 
• The latest Edge and Abbott Jewelry Systems, Inc. news. 
 

 

You must register to access The Edge Community site.  To register, contact 
support@ajsllc.com.   

 
 
 
 
 

mailto:support@ajsllc.com


The Edge User Guide v. 20.0.0.114 

6 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

2 The Edge Navigation Basics 
Understanding the fundamentals of The Edge is a critical first step in learning the software.  This section 
details the common interface components found throughout the software and gives a brief overview of 
each.  It is not a comprehensive explanation, but rather a starting place to help get you oriented. 

2.1.1 Main Edge Screen 
When you open The Edge, the application will appear as follows: 
 

 
 

A  Title Bar Contains the title of the active window.   
B  Window Control Boxes Allows you to minimize, maximize, or close windows. 
C  The Edge Menu Bar Contains standard Windows functions and The Edge Administrative 

functions, which will probably not be needed for day-to-day use.  
These options are detailed in the sections entitled The Edge Menu 
Bar and Administrative Menu. 

D  Main Navigation Bar Provides access to The Edge’s main functional areas.  These 
functions are detailed throughout this manual. 
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E  Function-Specific menu This contextual menu varies according to the function selected from 
the Main Navigation Bar.  Notice that the color of the menu tabs 
match that of the associated function tab.  These options are detailed 
in the applicable function description. 

F  Frame Window Contains contents of an active window.   
G  Password Time-Out The time left while logged in, but inactive, as a particular user 

before the system will log you off automatically.  If time-out has 
passed, and no one is logged in, this field will not appear. 

H  Version The version of The Edge that is running. 
I  Child Window List Contains buttons for minimized windows so you can maximize 

them. 
 

 

The Edge has a number of keyboard shortcuts.  To see them, press the Alt key.  The 
underlined letter indicates the key to press along with the Alt key to quickly go to that 
function or task.  For example, from Point of Sale, press Alt+T to activate the Tender 
area.  From there, press Alt+C to select Cash. 

 
Once a task window is open, a button for it will reside on the Windows taskbar at the bottom of the 
screen.   
 

 
 
More than one window can be open at a time.  To reactivate a window, select the desired button from the 
taskbar.  To close a function or window, select Close or select the close window button in the upper right 
corner of the screen.   
 

  
 

 

The ESC key on your keyboard can also be used to close the active window. 

2.1.2 Navigation Bars 
List Navigation Bar 
 
When in the list view, the navigation bar at the bottom of the window will allow you to select and work 
with lists.   
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Options in the list navigation bar vary according to the nature of the list and can include: 
 

Presets Allows you to save or load settings for future lists.  See the section entitled 
Presets for more information. 

Edit Allows you to open the selected record. 
Add Allows you to create a new record of the type listed. 
Delete Deletes the selected record(s). 
Group/Mailing List Creates a mailing list from the selected record(s). 
Supervisor Offers the Supervisor menu appropriate for the list. 
Switch to Spouse In customer records, allows you to quickly load information for a customer’s 

spouse/partner, if there is one. 
Print List Allows you to print the list.  We recommend printing to the report printer. 
Cancel Closes the list. 

 
Record Navigation Bar 
 
For windows that are for specific records, such as the Customer window or the Item window, and other 
functions that involve data entry will offer the Record Navigation Bar at the bottom of the window.   
 

 
  A  B    C      D E 
 
Options in the record navigation bar allow you to navigate between records and save records in several 
ways.  These apply to all the sections of The Edge. 
 

A Returns the first record in the set. 
B Returns the previous record in the set. 
C Indicates what record of the results is presented.   
D Returns the next record in the set. 
E Returns the last record in the set. 
Save & New Saves the record with which you are currently working and opens a new 

record for additional entry.  For example, selecting this option while entering 
inventory will save the piece you are currently entering and open a new Add 
Item window so that you can add your next piece. 

Save & Duplicate  Saves the record you are working on and creates a new record using the same 
information.  This is useful in inventory for quickly copying an item or when 
entering items that vary only slightly, such as in stone composition. 

Supervisor Presents advanced options depending on the section in which you are 
working.  
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Save & Print Saves the record and offers a detailed record detail in print format.  We 
recommend printing to the report printer. 

Revert Reverts to the information entered in the record since the last save.   
Save & Stay Saves the information entered thus far, but keeps the record open. 
OK/Save & Close Saves the record and closes it. 
Cancel Cancels the action. 

2.1.3 Printing 
Many windows have options to print output and report results.  That output follows instructions set as 
described in the section entitled Printer Setup.  If no printer setup has been defined, Windows will 
attempt to use the Windows default printer.   

2.1.4 Presets  
The Presets button appears throughout The Edge in the lower left corner of any of the Find or report 
filters as well as list windows.  This function allows you to customize the default parameters of a 
particular filter or list as well as save current settings under a specific presets name.  
 
For filters, presets include things like values entered, options selected, and groupings. For list views, 
presets include things like column selection, column order, column width, and sort order.  The apply to 
only the filter or view that is open unless you select Set as Default, in which case they will apply to all 
filters or views. 
 

 
 
Depending on the filter or window with which you are working, options in the Presets commands 
include: 
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Load Settings Offers a list of previously saved parameters so that you need not type the same 
entries over and over.  Select the name of the set and select OK. 

 

 
 

The Show Similar option returns additional records in the Load Settings 
window.  It offers presets that have been saved in similar searches in other 
areas of The Edge.  For example, if you are doing a Find Customer in Point of 
Sale and select Show Similar, presets saved in other Find Customers 
activities, such as those in Customer Mailings, might appear. 
 

Save Settings Allows you to save the parameters you just entered as a set for use later with 
Load Settings.  If the form for which you are saving settings includes a list 
view, then the list view mode (images vs. list), column order and column sizes 
(including hidden columns) are also saved.  Enter a name and select OK.   

 

 
 

Set as Default Saves these settings as the default for each time you run this query or view 
these results. 

Set Starting Field Allows you to specify the default location for new data entry in that filter. 
Load Defaults Deletes the setting changes made, if any, and loads the last Set as Default 

settings. 
Load Program 
Defaults 

Deletes the setting changes made, if any, and enters the initial Edge values 
regardless of any local defaults you have loaded.  

Memorize this 
Report 

If in the Reports area, saves the filter options selected as a memorized report.  
See the section entitled Memorizing Reports for more information.   

Most Recent 
Settings 

Allows you to reload the most recent set of parameters and make changes from 
there. 

Cancel Cancels the Presets function and returns to the previous window.   
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2.1.5 Capitalization 
In the case of some text fields, The Edge allows you to quickly standardize the capitalization styles for 
your entries.  Some description fields contain a capitalization selector: 
 

 
 

ABC Converts all text in the field to uppercase. 

abc Converts all text in the field to lowercase. 

Abc Converts all text in the field to title case. 

2.1.6 Spellcheck 
Also in the case of some text fields, you can spellcheck or use basic editing tools.  Right-click to see the 
text editing menu.  
 

 

2.1.7 Calculations 
The Edge contains an automatic calculator function in many numeric fields.  For example, if you click in 
a field in Re-price, you can use the numeric keys on your keyboard to enter the desire equation, and The 
Edge will make the calculation behind the scenes. 
 

 

2.1.8 Querying Data 
Data stored in The Edge is searchable through query forms that work in the same consistent manner 
throughout the program.  These query forms (e.g., Customer Find filter) allow you to specify a variety 
of criteria to return the specific records you seek.  Understanding how to use these queries is an essential 
building block to using advanced Edge features. 
 
Whether in The Edge database or on-line store, it might be helpful to narrow results.  Suggestions for 
refining your search to get a more direct result of what you are looking for include narrowing by 
suggested retail price, by stone, but metal, by type.  Here are some examples: 
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A. Looking for a bracelet between $500 – $1,000 suggested retail? 
a. Select Bracelet from the Generic Desc drop-down menu. 
b. In the Price Range fields, type 500 in Min and 1000 in Max. 
 

B. Looking for Amethyst earrings? 
a. Select Earrings from the Generic Desc drop-down menu. 
b. Select the Stones tab, select Amethyst from the Type menu. 

 

• Filter parameters are cumulative.  That is, the more parameters you enter, the fewer 
items will be returned.  For example, if you enter a category and a keyword, only 
items with matches in BOTH fields will be returned.  This applies to parameters on all 
the tabs. 

• Because this information is specific, if you search by ID, no other search criteria will 
be used. 

 

 

• Leaving a filter field blank instructs The Edge to include all criteria.  For example, if 
you left all fields blank on a Find filter, it would return a list of all the records. 

• Wild cards can be used in filters.  For example, entering 1** will return all 
categories in the 100s. 

 

2.1.9 Filtering by Date 
Throughout The Edge, options to narrow results will include filtering by date.   
 

 
 
In the date picker, there are many ways to select the date range you require.   
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Min/Max Specific beginning and ending dates for the range. 
Relative Dates Today, Yesterday, This Week, Next 30 Days, etc., all allow you to select 

time periods relative to today.  Last year, Last Quarter, etc., are the last 
full year, the last full quarter.   

 

 

Bear in mind that in The Edge, a week is always considered S  
to Saturday. 

 

Rolling Dates Rolling Days, Rolling Weeks, Rolling Months, Rolling Quarters, 
Rolling Years all refer to a way of setting repeating functions such that 
you do not have to reprogram the function every day or week.  The Rolling 
Dates feature allows you to set a minimum and maximum number of days, 
weeks, months, quarters, or years from the date of the job.  This is 
particularly useful when making use of presets in find filters.  For example, 
if you are setting up an automatic mailing function, and you wish to always 
send cards 3 weeks in advance of an event, you would specify rolling 
weeks to Min 3/Max 3.  In this case, the minimum sets the beginning of 
the third week out and the maximum sets the end of the third week out.  
This way, the job will look ahead and find any event 3 weeks ahead.  It will 
include associated targets that match within that week relative to the 
current date.  The rolling numbers can be used forward or backward (using 
a negative number).     
 

 
 

A Date was Entered This filters by any record in which a date was entered. 
No Date was Entered This filters by any record in which no date was entered. 

2.1.10 Setting ETAs and Expiration Dates 
When setting an ETA, usually to estimate when a service job or special order will be complete, or 
expiration dates, The Edge offers three ways to specify the date.  You can select from a drop-down 
calendar, enter a specific date, or enter a number of days from the current date.    
 
If you enter a number, The Edge will calculate the date for you.  For example, if you wish to set the date 
for one week from today, if you enter 7 in the ETA or expiration date field, The Edge will populate the 
field with a date one week from today.  In another example, when using this feature for default 



The Edge User Guide v. 20.0.0.114 

14 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

expiration settings, and you enter 365, and the default expiration date for such cards will always be one 
year from the date you activate the card. 
 
In many instances, you can further specify time.  At the bottom of the calendar are fields to enter hour 
and minute and select A.M. or P.M.  For example, if you want to tell a customer that a repair will be 
done at 1:00 p.m., you can specify that. 
 

 

2.1.11 List Output 
The List data view is the output you will see anytime you use a Find filter.  This is true whether doing a 
Customer Find, Inventory Find, Repair Find, etc.  Lists can be printed, but are primarily designed for 
viewing and interacting with data on your screen and as such are not ideally formatted for printing.  That 
is the purpose of reports, described in the section entitled Navigating Reports. 
 
When a list view appears, it will take the form of a spreadsheet or data grid, with data separated into 
pertinent columns.  The columns displayed will vary depending on the type of Find you initiated (e.g., a 
Customer Find will result in a list displaying important customer details, i.e., name and address). 
 
In almost all cases, The Edge allows you to rearrange data in the results of queries.  Column sizes can be 
changed by dragging the column divider to the left or right.  Rows can be similarly moved up or down.  
To sort a table by data in a particular column, click the header of that column.  The data will be sorted in 
ascending order.  If you click on it again, the data will be re-sorted in descending order. 
 
You can sort multiple columns by clicking on one column header followed by another in reverse order of 
the desired end result.  For example, if you want to sort by last name and then first name, you would 
click the First Name column header first, and then click the Last Name column header. 
 
Whenever a query or other screen presents a list of records from which to select, you can select the 
record and select OK, select the record and press Enter, or double-click on the record to select it and 
proceed. 
 
Lists are also equipped with context menus offering appropriate data options.  For example, if you right-
click on a record from the Find Customer results list, the following menu will appear: 
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This context menu will change to reflect the checkbox-related options.  The checkbox column allows 
you to check records on which to take actions.  Options that might appear include: 
 
View Allows you to change the appearance of the list, i.e., to show photos, etc. 
Print Offers a print preview so you can print selected items. 
Export Returns a Save dialog with options to output the entire list as a csv or text 

file.  Again, this will apply to the entire list, not just the selected record. 
Export Raw Allows you to export the raw data to a .csv file. 
Show Checkboxes Displays checkboxes next to each record on the list allowing you to pick 

those to print/export. 
 

 
Fit [column name] 
column 

Automatically sizes the right-clicked column to fit the data. 

Fit all visible columns Automatically sizes all columns to the data. 
Hide [column name] 
column 

Hide the right-clicked column. 

 
Sort Columns You can re-sort the list by clicking any of the column headers. 

Click the column header once to sort the records in ascending order. 
Click it again to sort the records in descending order. 

Resize Columns You can resize the width of any column. 
 Click the bar at either end of the column header and drag it left or right to 

increase or decrease the width. 
 Double click the right side of the column header to expand the column to 

automatically fit the widest record. 
Reposition 
Columns 

Change the order of the columns to build a better print layout. Click and drag the 
column header to the desired location. 
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By selecting desired records, either one by one or using the Check All option above, the subsequent 
context menus will allow you to act on only the selected records.  For example, printing or exporting at 
this point will result in including only those records that are checked. 
 

 
 
Alternatively, you can print data from a list by selecting Print List.  To change the page setup for 
printing lists, select File ► Printer Setup ► List Printer Setup.  For example, to better fit the data on 
a page, it may be useful to set your printer to print such lists in landscape format.  

2.1.12 Navigating Reports 
The Report data view is the output you get when you run any of the functions under the Reports tab.  
Reports are generated similarly to lists; the difference is that reports are, by design, specifically 
formatted for printing. 
 

 

Most reports are tailored for landscape printing. 

 
Depending on which report you run, you will notice query fields similar, if not identical, to the filter 
fields found when you generate lists.  Regardless of whether you are generating a list or report, the 
queries behave in the same manner. 
 
Unlike lists, which allow you to manipulate the resulting data on-the-fly, reports generate static 
documents.  All of the report view customizations must be done through the Options tab on the report 
query.  For additional information on running and customizing the various reports, see the section 
entitled Reports. 

2.1.13 Security and User Permissions 
The Edge is set up to ensure that only authorized personnel can conduct transactions.  For example, all 
users are permitted to make a sale.  However, a supervisor’s password might be required to access 
reports, tax settings, or even inventory areas.  For further security, logon credentials timeout after 5 
minutes.   
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The Edge will terminate if the system clock differs from Internet time by more than 
10 minutes.  This is to prevent data integrity issues.  If this happens repeatedly, have 
your IT technician check your Internet connections and conduct some ping tests. 

 
Identify Yourself 
 
When a password-protected function is accessed, the Identify Yourself security dialog will appear.   
 

 
 
Enter your ID and Password and select OK.  If your ID and password are accepted, the desired window 
will appear and allow you to proceed.  If your ID and password are not accepted, you will receive an ID 
Failure message.  If you feel you received this message in error, contact your supervisor or system 
administrator.  Each user’s permissions can be customized as needed.  See the section entitled Security 
for more information.   
 

 

When using the Edge for the first time with no conversion, you must enter an 
associate.  When you do this, there are no permissions in yet, so there is no way to 
get to Associates ► Add.  When you go there, and permission window comes up, 
select Cancel.  The Edge will allow you to go to the Add window enter an associate, 
but that's all until someone with permissions is entered. 

 

 

If you forget your password, contact The Edge Support Team for assistance in 
resetting it. 

 
Need Override  
 
Separate from Identify Yourself is the Need Override window; this is to capture the permission of a 
supervisor or user who can allow another user to perform a specific task.  It also records who, when, and 
why an action is taken.  System Options can require that the Notes field be completed. 
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Add Permission 
 
A third type of permission window pops up when permission is not actually specified for the associate, 
but the associate is an administrator.  In that case, the user will be prompted to update his or her own 
record to allow the activity.  This will be saved in the associate's security settings. 
 

 

2.1.14 Search Functionality 
From many areas, there is a search option in the upper right corner of the window.  Use this to find text 
strings on the window. 
 

 

2.1.15 Adding and Managing Photos 

The camera icon ( ) returns the photo menu to capture an image of the item.  More than one image 
can be associated with the record. Depending on the record type, options can include: 
 
Acquire Obtain a photograph using your twain device. 
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Retake Image Allows you replaces the image currently displayed.  It is only 
available when an image already exists. 

Copy File Allows you to browse for a photo file and copy it into The Edge 
photo folder.  It also associates the file with the record. 

Use File Associate an existing file with this record.  It can be an image, but it 
can also be anything you want to associate with a customer or item 
record: for example, a pdf of an invoice or an appraisal document, or 
even a fax.  Use the Windows file window and change the file type 
filter to All Files to see all your options. 
 
If the target is outside the photo folder, you will be prompted to copy 
the file to the photo folder.  If you opt not to copy the image, it will 
not be shown. 

View Image Opens the image in the Windows photo gallery. 
Edit Image Opens the image editor as described in the section entitled Image 

Editor. 
Print Image Prints the image to your report printer. 
Image Properties Opens the Windows File Properties window. 
Copy Image to Clipboard Puts the image in the clipboard to paste elsewhere. 
Copy File Name to 
Clipboard 

Puts the file name in the clipboard to paste elsewhere. 

Make Default Image Makes this the default image. 
Remove Image Removes this image from this record. 
Remove All Images Removes all images from this record. 
Select Source Choose the twain device or camera to obtain a photo. 
Cancel Cancel the photo menu. 

2.1.15.1 Image Editor 
All images in The Edge, including item images and customer photos, have a context menu of available 
actions.  This includes places where there is only an image placeholder.  Note that more than one image 
can be associated with the record.   
 
Item Image 
 

    
 

Image Placeholder  
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The camera icon ( ) contains the photo menu to capture an image of the item.  Depending on the 
record type, options can include: 
 
Acquire Obtain a photograph using your TWAIN device. 
Retake Image Allows you replaces the image currently displayed.  It is only 

available when an image already exists using your TWAIN device. 
Copy File Allows you to browse for a photo file and copy it into The Edge 

photo folder.  It also associates the file with the record. 
Use File Associate an existing file with this record.  It can be an image, but it 

can also be anything you want to associate with a customer or item 
record: for example, a pdf of an invoice or an appraisal document, or 
even a fax.  Use the Windows file window and change the file type 
filter to All Files to see all your options. 
 
If the target is outside the photo folder, you will be prompted to copy 
the file to the photo folder.  If you opt not to copy the image, it will 
not be shown. 

View Image Opens the image in the Windows photo gallery. 
Edit Image Allows you to work with the image in an image editor.  See the 

section below about editing images. 
Print Image Prints the image to your report printer. 
Image Properties Opens the Windows File Properties window. 
Copy Image to Clipboard Puts the image in the clipboard to paste elsewhere. 
Copy File Name to 
Clipboard 

Puts the file name in the clipboard to paste elsewhere. 

Make Default Image Makes this the default image. 
Remove Image Removes this image from this record. 
Remove All Images Removes all images from this record. 
Select Source Choose the twain device or camera to obtain a photo. 
Cancel Cancel the photo menu. 
 
To work with an image using the Image Editor: 
 
1. Select the desired image within the desired record. 
2. Select Edit Image from the image control context menu.  The EditImage window will open. 
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Functions available in the Image Editor: 
 

Transform  
Resize Resizes the image in pixels or in percentage of the current size.   

 

 
Canvas Resize Resizes the canvas.  The canvas is the space in which the editor works. 

In the example above, the canvas is the same size as the image. If you 
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make the canvas larger, you will see a background.  If you make it 
smaller, the image will cover the canvas or even be cropped to fit on it.  
You can change where on the canvas the image falls and the color of 
the canvas.   
 

 
Rotate 90 Rotates the image 90 degrees clockwise.   
Rotate 180 Rotates the image 180 degrees clockwise; this is in addition to previous 

rotations. 
Rotate 270 Rotates the image 270 degrees clockwise; this is in addition to previous 

rotations. 
Round Corners Rounds the images corners.  Use Radius to set how much rounding to 

use. Use border to add a border to the image.  Notice that rounding 
won’t show on a white background unless you add a border. 
 

  
Flip Horizontal Reverses the image left to right. 
Flip Vertical Reverse the image top to bottom. 
Crop Creates a window to frame out and crop the image.  
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Draw Text Allows you to add and place text on the image.  You can change the 

size, color, location, and rotation of the text over the image. 
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Draw Allows you to draw illustrations on the image. 
 

  
 

Adjust  
Hue Shift Allows you to change the hues/colors of the image by shifting through 

the color wheel. 
Saturation Allows you to reduce or increase the depth of existing colors. 
Contrast Allows you to reduce or increase the contrast between existing colors. 
Invert Colors Reverses the image like a negative.  Dark colors become light and light 

colors become dark. 
Effects  

Sharpen Allows you to sharpen the lines in the image. 
Blur Allows you to soften the lines in the image. 

 
3. Use the image commands to make changes to the image. 
4. Select a Save option.   

• Save As New creates a new file from the edited image.   
• Save and Close saves the open image with the changes. 
• Reset, where available, removes any changes made since the last time you saved. 
• Commit Changes will exit any editing functions and save the results.  If you hit Enter from 

any of the control boxes, your changes will be committed.   
• Zoom lets you view the image larger or smaller.  It does not change the image size, just the 

view. 

2.1.16 Numbering Conventions 
In The Edge, all items and transactions have unique identifiers, which are assigned automatically by The 
Edge.  So you can easily access records, these are cross-referenced across associated customers, sales, 
items, services, and parts.     

2.1.16.1 Numbering on Receipts 
As a demonstration of receipt numbering, suppose a customer has purchased an item and left an item for 
repair.  The following table breaks down what the transaction IDs are. 
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Numbering 
Scheme 

Example Breakdown 

Sale ID 001-126396 001 is store 
126396 is sale number 

Customer ID 001-000652 001 is the store where the customer first made a purchase 
000652 is the customer number 

Item ID [001-]100-05199 [001 is store where the item is located] (if you only have one 
store, that store number does not appear, as is the case here) 
100 is category number 
05199 is the item number 

Repair/custom 
job service 
request and 
associated tasks 
ID 

[001-]126396-002-
001 

[001 is store where the transaction originated] (not shown 
here, but on the envelope) 
126396 is sale number 
002 is job number; it corresponds with the line number in the 
original in-take transaction 
001 is the repair task number (shown on the repair envelope, 
not on the receipt 

 
Although all records contain a store number, if you are a single-store operation, it is unnecessary to use 
the store number prefix.  The store number is 001 by default and is only used behind the scenes.  
 
For multi-store users, the store number is the location of the transaction by default.  If you are searching 
for a record within your store, the store number is automatically assigned.  However, if you are searching 
for an item or transaction outside your store, you must include the store ID.   
 
There is never a reason to type leading zeroes when searching for a record.  For example, if you’re 
searching for item number 002-100-00001, you need only enter 2-100-1.  The Edge fills in the leading 
zeroes. 
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2.1.16.2 Numbering on Repair Envelopes 
When working with repair envelopes, similar conventions are used.  While this example uses a repair, 
the conventions apply to custom jobs, appraisals, and special orders. 
 

Numbering 
Scheme 

Example Breakdown 

Customer 
ID 

001-000652 001 is the store where the customer first made a purchase 
000652 is the customer number 

Repair ID 001-126396-002 001 is store 
126396 is sale number 
002 is the job number 

Task ID 001 001 is the task number for the repair 
 

 
 

 

A single sale can have an infinite number of lines or jobs.  A job can have an infinite 
number of tasks.  An envelope can have up to four repair jobs, based on System 
Options. 

Customer ID 
Repair ID 

Task ID 
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2.1.16.3 Barcode/Tender/Rewards/Referral Card Numbering 
The Edge required numbering specification is Interleaved 2 of 5, which starts with a unique four-digit 
assigned prefix based on the store account and card type and ends with a check digit, which is a 
calculated number to ensure validity. 
 
Each card has a printed number and a barcode number, which also has a numerical representation.  
Either number can be used for entering or scanning the card. 

2.1.16.3.1 Tender/Rewards/Referral Card Numbers 

The printed numbers on tender, rewards, and referral cards will always be 12 digits long. 
Example: 8514000000010  
Broken down, the number consists of 3 parts: [8514][00000001][0] 

• 8514 represents the custom-assigned prefix for the store account and card type 
• 00000001 represents the sequential card number 
• 0 is the check digit. 

2.1.16.3.2 Tender/Rewards/Referral Barcode Numbers 

The barcode numbers associated with tender, rewards, and referrals cards will always be 14 digits long. 
Example: 598514000000010  
Broken down the number consists of 4 parts:  [59][8514][00000001][0] 

• 59 represents the prefix that provides instruction to The Edge concerning the type of barcode 
scanned 

• 8514 represents the custom-assigned prefix for the store account and card type 
• 00000001 represents sequential card number 
• 0 is the check digit. 
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3 Inventory 
Good inventory management will lead to better overall performance and profitability.  The Edge 
software will measure and clearly report inventory performance.  By setting up categories, items, and 
vendors before launching The Edge, you will maximize these management features. 
 
A category is a collection of items having like characteristics (e.g., colored stone rings set in precious 
metals, strands of pearls, diamond bracelets, and diamond engagement rings).  However, some 
categories may consist of odds and ends and have little in common (e.g., all men’s miscellaneous 
jewelry).  It is by the categories you setup that sales performance will be measured.   
 
Categorizing inventory is the first and most important step in setting up The Edge software.  With that in 
mind, take ample time to consider the categories that will provide you with the most benefit.  Up to 999 
categories can be created, but you should avoid numbers 1–99.  The Edge software will provide detailed 
reporting by subcategories such as stone or metal type from the information provided when entering 
items.  It is not necessary to define a category of ladies’ ruby rings or ladies’ sapphire rings to be able to 
measure the performance of these product types.  A colored stone ring category will provide the 
management information needed to make better buying decisions.  You can run a report showing what 
percentage of business was done by stone type when needed.   
 

 

The Edge comes with a default list of categories that we strongly urge you to consider 
as the core of your inventory categorization.  Slight modifications are expected.  If 
you are considering a major overhaul, contact The Edge Support Team for direction. 

 
As a matter of category structure, we recommend the following strategy: 
 
1. Start with default categories provided with The Edge. 
2. Delete those that you don’t need.  You can always add them back if you add that product.  Keep in 

mind, however, that you cannot delete a category that has items. 
3. Add any categories that are required but that weren’t included with The Edge. 
4. Modify each category, both new and existing, to meet your needs.   
 
Details for accomplishing these steps are described in the section entitled Categories. 
 
  



The Edge User Guide v. 20.0.0.114 

30 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 Categories 
Before you can start entering inventory, you must have set up a category for the items you wish to enter 
and you must have defined the vendor that provided you with the items to The Edge software.  A 
category is a collection of related items (i.e., chains, charms, diamond bracelets, colored stone rings, 
giftware, etc.) that the software will use as a foundation in producing management reports.  Dividing 
items into categories will assist you in discovering which categories are producing the most revenue and 
which price points are most productive within the categories.   
 
The Edge comes with default, recommended categories.  Though there may be reasons to vary a bit, we 
strongly encourage that you use a category structure very similar to that provided with The Edge.  It will 
provide best use of analytical tools and better organization of items.  For help ensuring your categories 
are well designed, see the tip sheet entitled Category Cleanup at www.edgeuser.com.   

3.1.1 Listing Categories 
To see a list of existing categories: 
 
1. Select Categories ► List from the Inventory menu.  A list of all the categories entered into The 

Edge, including their ID numbers, names, and types, will appear.   
 

   
 
Fields in the Category List include: 
 

http://docs.edgeuser.com/TIP-2015-066_Category_Cleanup.pdf
http://www.edgeuser.com/
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ID The unique identifier for the category. 

Name The name of the category; it describes the items that fit in the category. 
Type The high-level type of item that fits in the category. 
Department The department to which this category is assigned. 

 
2. From this window, you may select a category to edit, add a new one, or delete categories by using 

the buttons across the bottom of the window. 
3. To print the list as a whole, select Print.   

 

 

• Access to the categories is often set as a supervisory function and might not be 
available to all associates using The Edge. 

• If you attempt to delete a category, it will only be marked Inactive.  For a category 
to be marked Inactive, it may not have any items in stock, on layaway, on memo 
out, or work-in-progress. 

3.1.2 Adding a Category 
To add a new category to the system: 
 
1. Select Categories ► Add from the Inventory menu.  A blank category window will appear with 

the General tab selected.   
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Fields and options in the General tab include: 
 
Inactive Indicates that the category should be considered inactive.  It will no 

longer appear on any list views. 
ID, Name The ID number and name of the category.  The ID must be numeric. 

Department The department to which you want this category to be assigned.   

Type The type of items to go into this category. 
Gender The gender for which the items are intended. 
Generic Description A brief description of the items that will be in this category.  This 

will be included as part of the suggested description that is offered 
when entering an item. 

Commission 
Adjustment 

Any adjustment to commission that might be applied to sales of 
items in this category.  The default setting of 100% specifies that an 
associate would receive their full commission percentage as dictated 
by the commission options on the associate’s record. 

Default Pricing Method 
for Items in this 
Category 

Defines the default pricing method to be applied to items added to 
this category.  Options include: 
• Fine Jewelry, Individual Item Pricing 
• General Merchandise, UPC/SKU Pricing 
• Buy and Sell Item by Unit of Measure 
• Buy and Sell Item by Measure Only 
• Mixed Retail Pricing (PRE) 
 
For fine jewelry pricing, The Edge will assign unique item numbers 
to each item.  Other pricing methods apply to bulk inventory.  For 
information regarding bulk setup and use, see the section entitled 
Bulk Inventory. 

Category Lead Time 
for Jobs 

If an item from this category is a build or assemble job, the default 
number of days estimated for completion. 

Exclude Category from 
Care Plan 

If you are offering care plans to your customers, checking this box 
will exclude items in this category from that offering. 

 
2. Complete the General tab fields as appropriate, and select the Pricing tab.   
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In the Pricing tab, you can indicate that certain categories are automatically marked up or down.  
Fields and options in the Pricing tab include: 
 

Automatic 
Markup  

This section defines the markup to be applied to items in this category if 
automatic pricing is enabled.  See the section entitled Inventory Options for 
additional information on enabling/disabling automatic pricing.  Also, note 
that markup can also be specified at the vendor level if necessary.  This will 
override the category markup.  See the section entitled Adding a Vendor for 
additional information. 

Min Cost For items of the indicated minimum cost, treat as in the following fields.  
Note that these fields together, read vertically, constitute ranges for 
which the markup applies.  To use a single markup for the entire 
category, it is only necessary to fill in the first row.  However, this is not 
advisable as price points on performance reports are derived from this 
markup table. 

Markup The factor by which to set the retail price.  Entering 3 would multiply 
the cost by a factor of 3.  For example, if you enter 3, a $50 item would 
have a retail price set at $150.  For any particular item, this can be 
overridden at the time of entry. 

Min Markup Defines the minimum price at which this item can be sold.  If you 
attempt to sell the item for less than this price, you will be prompted for 
a manager override.  So if 2 is entered here, a $50 item that should sell 
for $150 can sell for no less than $100 without approval. 
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Automatic 
Mark Down    

This section defines an automatic markdown to be applied to inventory 
based on age for the purposes of reducing old inventory. The markdown is 
only applied to inventory if you initiate an inventory repricing.  See the 
section entitled Reprice Items for more information. 

Min Days The minimum number of days for which the markdown applies.  Note 
that these fields together, read vertically, constitute ranges for which 
the markdown applies.  At 540 days, or roughly a year and a half, we 
suggest that a spiff be applied.  See below. 

Mark Down % The percentage by which the items should be marked down.  At 600 
days, we suggest a markdown of 30% be applied.  This means the $50 
item retailing for $150 will now show a retail of $105. 

Spiff Any spiff, or percentage of profit, to be applied for the sale of an item 
in the category.  We recommend that at Min Days of 540, spiff of 50 
be entered.  This provides the employee a bonus of half of the profit 
that was generated by the sale.  On the $50 item that was selling for 
$150, a spiff of 50 would award the associate $50 as that is 50% of the 
$100 profit generated.   
 

 

If you pay commissions, the greater of the values will be 
paid, but not both. 

 
Using the spiff field here will cause the item to appear on Bonus 
Posters for associate reference.  See the section entitled Bonus Poster 
for more information. 

In-Case 
Signage 

The sign to be displayed along with the items marked down.  These 
signs are printed as described in the section entitled Printing Signage 
and designed as described in the section entitled Sign Formats.   

 

Signs must be set up before this feature will work. 

 

3. Complete the Pricing tab fields as appropriate, and select the Details tab. 
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The Details tab allows you to provide the category with descriptors that apply only to it, such as the 
kind of strap on a watch, serial number, metal type, etc.  These details will appear as fields when 
entering items into this category.  Additionally, any detail created here can be printed on the tag.  
There are two groups of details, Group 1 and Group 2 to accommodate items that may have two 
parts, such as a pendant and chain.  In each group, fields include: 
 

Group Name Optional.  Allows you to label the detail columns in the Item window. 
Detail Name The label of the detail field in the Item window. 
Detail Type This defines whether the descriptor includes predefined choices derived from 

a list or if it will provide a blank field in which to type in the desired data 
when entering the item. 
 
To use a predefined list, select it.  For information on creating these lists, see 
the section entitled Lists. 

To use a blank field to create a custom detail, in the Detail Name field, enter 
the name of the field.   Select either NUM or TEXT from the Detail Type 
drop-down menu.  NUM will only allow you to enter numbers while TEXT 
will accept any characters.  This field will now be an option in the Tags tab, 
Data drop-down menu. 
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Advanced 
Options/More 
 

Returns the Details:  Advanced Options dialog.  
 

 
 
This dialog defines data characteristics.  Its contents may vary based on the 
type of data defined above. 
 
If you are editing/replacing existing default details, you must change the 
Storage on that detail to one of the numbered itDetail choices.  If you are 
creating new details, you need not change the Storage setting. 
 
Check the Storage drop-down menu for data types that exist in the database.  
Values might include:   
• itStyle 
• itMetalFinish 
• itMetalColor 
• itMetalType 
• itMetalWeight 
• itSize 
• itLength 
• itMfg 
• itOldBarcode 
• itOldKey 
• itCostReplacement 
• itSerialNumber 
• itMillimeter 
• itDetail_1 
• itDetail_2 
 

You can use the Copy From… option for any particular tab to import that tab information from 
another category.  You can also use the Defaults option to load default category information. 
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The suggested item description generated for the receipt is from category, type, 
gender, stones, and system-generated detail fields.  Custom detail fields will not 
affect the description.   You can manually update the description when adding 
inventory. 

 
4. Complete the Details tab fields as appropriate, and select the Tags tab. 

 

 
 
Fields and options in the Tags tab include: 
 
Media The type of tag to print.  The Edge comes with default layouts for each 

available type.  
Outlines Shows outlines on the screen while the tag is being composed.  Outlines 

are never printed and should be enabled while manipulating the tag layout. 
Print Select to print sample tags.  Also useful for testing the functionality and 

alignment of a tag printer. 
Details of  Selected 
Tag Field 

Shows the details of the selected tag field.  The fields are described below. 

Previous Goes to the previous field on the tag. 
Next Goes to the next field on the tag. 
Remove Removes the field from the tag. 
Add Adds a new field on the tag. 
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You can use the Copy From… option on any tab to import information from that tab of another 
category.  You can also use the Defaults option to load default category information. 
 
Editing Tag Fields 
 
In the Tags tab, there is a preview of the tag and each field on it.   
 

 
 
Each field has its own set of details. Select a tag field and you’ll see those details.  In the example 
below, we’ve selected the field containing the Retail price of the item.   
 

 
 
Use the Details of Selected Tag Field fields to change the data in each field.  You can remove or 
add fields by using Remove or Add and work in the details fields to populate them.  
 
Fields in the Details of Selected Tag Field Include: 
 
Left The margin for the left side of the tag field. 
Top The margin for the top of the tag field. 
Width The width of the tag field. 
Height The height of the tag field. 
Font The font to be used. 
Align The alignment (i.e., centered, left, or justified). 
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Prefix Any text that should appear at the beginning of the field. 
Only if Data 
Present 

Indicates that the prefix should only appear if data is present.  Otherwise, 
that part of the tag will be blank. 

Data Select the data to display in this field on the tag.  Please note that in 
addition to our default choices, any details added on the Detail tab will 
appear as valid data choices.  These can be found at the end of the list.  
Values for jewelry plan costs and cost plus retail can be selected.  That 
serves as a starting point from which to explain care plan pricing to 
customers.  

Sample For the purposes of a preview on this screen, how data of that type might 
appear. 

Format For any particular data type, the format in which it should appear.  For 
details on using letter codes or cost codes see the tip sheet entitled Tag 
Formats and Letter Codes at www.EdgeUser.com.  

Parameter Any additional information required in formatting the field, for example, 
the letters to be used in a cost code. 

Postfix Any text that should appear after the data. 
Only if Data 
Present 

Indicates that the postfix should only appear if data is present. 

 
In addition to changing data, you can modify the positioning of fields on the tag with your mouse by 
clicking and dragging to its desired position or by using the arrow keys on your keyboard.  Also, you can 
resize the fields on the tag.  Move your mouse to the right side or bottom of the tag field.  When your 
mouse cursor turns into a double arrow, click and drag to resize the field in the specified direction.  This 
can be done with the keyboard by holding the shift key and using the arrow keys.  See The Edge video 
tutorial library for demonstrations of this functionality:    
 
• Inventory, Tag Layout, Basic:  http://www.screencast.com/t/B1Errif1XOL  
• Inventory, Tag Layout, Advanced:  http://www.screencast.com/t/SFuqt3qfB.  

 

 

If you are changing tag systems, you change tag layouts en masse.  Contact The 
Edge Support Team for assistance. 

 
5. Complete the Tags tab fields as appropriate, and select the Taxes tab. 

 

http://docs.edgeuser.com/TIP-2014-040_Tag_Formats_and_Letter_Codes.pdf
http://docs.edgeuser.com/TIP-2014-040_Tag_Formats_and_Letter_Codes.pdf
http://www.edgeuser.com/
http://www.screencast.com/t/B1Errif1XOL
http://www.screencast.com/t/SFuqt3qfB
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6. This tab is used in the event a category has taxes that are different from those of other items, such as 
one that is classified as a luxury item.  These taxes can be selected from those shown here, which 
are defined in the Administrative menu.  Setup of taxes is discussed in the section entitled Sales 
Tax. 

7. Select applicable taxes from the Taxes tab if appropriate.   
8. When you have completed tax information, you can select the Description Template tab.  Note that 

basic data fields in the other tabs are required before you can continue with the Description 
Template tab.  
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Fields and options in the Description Template tab include: 
 
Merge Fields A list of data fields that can be used as variables in the description text.  

These will change according to the category.  Click the top level to 
expand the field merge lists. 

Insert Use this to insert the selected merge field into the description text. 

Clear All Clears the entire description text.  This cannot be undone. 

Add Stone Adds a stone to the merge fields with the same available variables as the 
primary stone so you can add descriptions for as many stones as you like. 

Remove Stone Removes the selected stone. 

Copy From Copies a category template from another template. 
 

9. Use the Description Template tab to create a template to be used for items in this category when 
you enter them and select Suggest [description]. 
a. Some data will always be pulled from the category record, such as the description.  In this case, 

it is Lady’s Engagement Ring. 
b. Use the merge fields on the left, which expand, to enter variable data that The Edge will 

populate based on specific item data. Click on a merge field, and it will appear in the Input and 
Output preview fields.  In the Input field, enter text, punctuation, and carriage returns as 
desired around the merge fields.   

c. Continue adding fields and text until the description appears as desired in the Output field. 
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d. You can add stones using the Add Stone option or remove them using the Remove Stone 

option.  For each stone you add, the stone variables will be available for that as well. 
 

10. When all information has been entered in all the tabs, select the desired save option from the 
Record Navigation Bar.   

3.1.3 Departments 
As an additional, optional way of grouping items and services, especially for reporting purposes, The 
Edge offers a department feature.  Departments can include not only inventory (by category), but also 
repairs, appraisals, custom jobs, and miscellaneous sale lines.  When enabled and used, the departments 
feature will enable department filter options in searches and reports.   
Setting up departments does not work retroactively.  Only those repairs, sales, appraisals, etc. completed 
after department setup will show up on the report.   

3.1.3.1 Department Setup 
Before you can populate departments, they must be set up as list items for use in various drop-down 
menus.  To do so: 
 
1. Select Administrative ► Lists.  This will open the List of Lists window. 
2. Open the Department list.  The departments in the list will appear.  These are departments that are 

available. 
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To edit a department record, double-click the department record.  The List Item window will 
appear. 
 

 
 
Fields in the List Item window include: 
Short Value An abbreviation or code for this department (e.g., 001, DIA, 1001). 
Original ID The same as Short Value. 
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Long Value A description for this department. 
3. Make changes in the List Item window as needed and select OK/Save & Close.   

 
For instructions on putting items in departments, see the section entitled Populating Departments.   
 

 

If you have no departments defined, where possible, recent versions of The Edge will 
automatically create departments based on your category setup.   Your System 
Options will be modified to ensure default departments are created. 

3.1.3.2 Populating Departments 
By Category 
 
Inventory can be assigned to a department by category.  Specifying a department in a category will 
override the default department system option assignment (if any).  To assign a category to a 
department: 
 
1. Select Inventory ► Categories ► List.  A list of categories will appear. 
2. Double click or edit the category you want to assign. 
3. From the Department drop-down menu on the General tab, select the department to which you 

want this category assigned.  All items in the category will be assigned. 
 

 
 
4. Select OK/Save & Close to save your changes. 
 
By Repair SKU 
 
Services such as repair tasks can be assigned to a department, but they must be predefined repair SKUs.  
Specifying a department on a service will override the default department system option assignment (if 
any).  To assign a service to a department: 
 
1. Select Administrative ► Repair ► Repair SKUs. 
2. Double click or edit the repair SKU you want to assign.   
3. From the Department drop-down menu on the General tab, select the department to which you 

want this service assigned. 
4. Select OK/Save & Close. 
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By Miscellaneous Sale Line 
 
Miscellaneous sale lines can be assigned to a department.  Specifying a department in a miscellaneous 
sale line will override the default department system option assignment (if any). 
 
To assign a miscellaneous sale line to a department: 
 
1. Select Administrative ► Misc Sale Lines. 
2. Double click or edit the miscellaneous sale line you want to assign. 
3. From the Department drop-down menu on the General tab, select the department to which you 

want this miscellaneous sale line assigned. 
4. Select OK/Save & Close. 

3.1.3.3 Department Defaults 
Though not required, default departments can be setup for appraisals, custom jobs, inventory 
(categories), miscellaneous sale lines, and repairs.  The default department will be used if one is not 
otherwise specified on the category, repair SKU, etc.   
 
To setup default departments: 
 
1. As described in the section entitled Department Setup, set up departments to act as the defaults for 

appraisals, customer jobs, inventory, miscellaneous items, and repairs. 
2. Select Administrative ► System Options. 
3. Scroll down to the Department Defaults section. 
 

 
 
4. Use the drop-down menus for each area to select a default department. 
5. Select OK to save your changes. 
 
 



The Edge User Guide v. 20.0.0.114 

46 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 Vendors 
Before an item can be accepted into the inventory database, certain data elements must be present. That 
includes a vendor record for the item.  

3.2.1 Adding a Vendor 
To add a new vendor to the system: 
 
1. Select the Vendors ► Add from the Inventory menu.  The Vendor window with the Contact tab 

selected will appear.   
 

 
 
Fields and options in the Contact tab include: 
 

General  
ID Enter an ID number for the vendor.  It may be up to three 

characters and can contain letters and numbers. 
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Inactive Indicates that the vendor is inactive.  If it is, the vendor will not 
appear in list views. 

My Brand Indicates that the vendor is a store or company brand; you might 
use this most for items that you build or assemble in-house. 

Name The company name of the vendor. 
Address The address for the vendor. 
Address 2 Additional address line for the vendor address. 
Postal Code The ZIP code for the vendor. 
City The city of the vendor. 
State/Province The state of the vendor. 
Country The country of the vendor. 
Phone The vendor’s phone number 
Fax The vendor’s fax number. 
Website The vendor’s website. 
Email The vendor’s email address. 

Credit Manager  
Name The name of the credit manager for the vendor. 
Phone The direct phone number of the special order contact. 
Email The direct email of the special order contact. 

Orders  
Our Account # Your account number with that vendor. 
Salesperson The name of your salesperson or other contact person with that 

vendor. 
Phone The direct phone number of your salesperson. 
Email The direct email of your salesperson. 
Special Orders The person to contact for special orders. 
Phone The direct phone number of the special order contact. 
Email The direct email of the special order contact. 

Returns  
Name The name of the vendor contact for returns. 
Address The street address of the vendor contact for returns. 
Address 2 The second line of the street address of the vendor contact for 

returns. 
Postal Code The postal code of the vendor contact for returns. 
City The city of the vendor contact for returns. 
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ST/Province The state or province of the vendor contact for returns. 
Country The country of the vendor contact for returns. 

 
2. Enter contact information for the vendor, including ID, name, address, telephone and fax numbers, 

website, email, account number, and contact information for your salesperson, special orders, and 
the credit manager.  Select My Brand to indicate that the vendor record is one of your own; this is 
necessary for build and assemble items. 

 

 

Only Vendor ID and Vendor Name are required.  The remaining fields are 
optional. 

 
3. Select the Pricing tab.  The pricing tab will appear with a button that reads See Pricing.  
4. Select See Pricing to enter pricing information.   

 

 

Vendor pricing is not necessary for every vendor.  This is only for vendors who 
have specific pricing rules that are different from those of the appropriate 
category.  This option is offered as an alternative to creating a category for 
vendors who do have separate pricing rules. 

 

 
 
Fields and options in the Pricing tab include: 
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Automatic Markup Enables you to associate a predefined markup with this vendor that 
will override the markup assigned in the category. 

Commission 
Adjustment 

Represents an adjustment paid to an associate for selling an item from 
this vendor.  If you enter 75 percent, the commission will be reduced 
by 25 percent. 

Overrides Category 
Adjustment 

Whether this commission adjustment overrides the adjustment listed 
in the category record. 

Compounds Category 
Adjustment 

Whether this commission adjustment is figured on top of the 
adjustment in the category record. 

 
5. Select the Notes tab to enter miscellaneous information about the vendor. 
6. When all information has been entered, select a save option from the Record Navigation Bar. 

3.2.2 Finding and Editing a Vendor 
To find a vendor in The Edge: 
 
1. Select Vendors ► Find from the Inventory menu.  The Find Vendors window will appear.   

 

 
 

2. Search for a particular vendor by entering a Vendor ID, Vendor Name, Contact Name, or 
Category ID.  The Search Mode field allows you to search for companies based on partial 
responses.  For example, selecting Starts With in the Search Mode field and entering only the 
letter “a” in the Vendor Name field will find both Agem Manufacturing Co. and Avirom.   

3. Select Find.  The Vendor List window will appear. 
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4. To edit a vendor record, open it and edit fields as described in the section entitled Adding a Vendor.   

3.2.2.1 Change Vendor ID 
When in the Vendor Edit window, the Supervisor menu contains a Change ID option. 
 
The Change ID option allows a supervisor to change the vendor’s ID.  This change may take a few 
minutes to finish as it requires changes to all affected items.  To change a vendor’s ID: 
 
1. Perform a vendor find and select the vendor for which you want to change the ID. 
2. Select Enable Change Id from the Supervisor menu.  This will unlock the ID field on the vendor 

record. 
3. Make the desired change to the vendor’s ID. 
4. Select one of the save options from the Navigation bar to finalize the change. 

3.2.2.2 Vendor Merge 
The Vendor Edit window contains a Supervisor button, which contains a Merge option.  The Merge 
option allows a supervisor to combine two vendor records into one.  The vendor record to be consumed 
will have all of its related data transferred to the vendor designated to remain.  The consumed vendor 
record will then be marked inactive.  Depending on the number of related records, a vendor merge could 
take a few minutes to complete as The Edge must make the appropriate changes to inventory and sales 
records.  To merge vendor records: 
 
1. Perform a vendor find and select the vendor record you wish to keep. 
2. Select Merge Vendors from the Supervisor menu.  The Merge A Vendor window will appear. 
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3. Use the Vendor record to be consumed filter to locate the vendor to merge into this one.  
4. The default remaining vendor record is that which was selected.   
5. Use the Take checkboxes to designate any data to be retained from the consumed vendor record. 

 

 

Vendor merge cannot be undone.  Verify that you have selected the appropriate 
vendors before proceeding. 

 
6. Select OK. 
7. Select a save option to finalize the vendor merge. 

3.2.3 Return Memo 
The Return Memo function allows you to mark memo items as returned to vendor.  This can also be 
done through the Supervisor menu on a specific item record.   
 
1. Select Return Memo from the Vendors submenu.   
2. Use the Find Item filter to find the items to return.  The Edge will return a list of matching items.   
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3. Select the items to be returned.   
4. Select OK.  They will be taken out of inventory and a confirmation window will appear. 

 

 

In QuickBooks, an item with stock type memo that has a payable date is accounted for 
as owned stock merchandise.  These items have been sold and posted to the Memo 
Payments due account.  For more information, see the section entitled QuickBooks 
Inventory Tab. 

3.2.4 Importing Vendor Catalog Files 
The Edge supports the importation of vendor catalog files.  When imported, the catalog file does not 
create new in-stock items, but rather provides data about a particular vendor style for quick entry when 
the real items are ordered or entered.  For a list of catalog files along with download links, please visit 
our user website (www.edgeuser.com) and click on Downloads ► Catalog Downloads.  It may be 
necessary to add a vendor record for the vendor whose catalog you are importing. 
 
To import a vendor catalog: 
 
1. Make sure The Edge is idle and no POS transactions or inventory entries are in progress. 
2. From the server device, download the appropriate catalog file from our website 

(www.edgeuser.com). 
3. Make a note of where you save the file. 
4. Select Inventory ► Vendor ► Load Catalog. 

 

http://www.edgeuser.com/
http://www.edgeuser.com/
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5. From the Import Catalog File drop-down menu, choose the catalog file you downloaded from our 
site. 

6. If this is your first time loading a catalog from this vendor, you must assign categories so the system 
knows where to import.  Once assigned, the system will automatically populate these fields when 
you do your next import for this vendor. 

7. If this is the first time loading a catalog for this vendor, you will need to choose which of your 
vendors to match it to with the Vendor ID dropdown.  This will fill in automatically if you have 
imported previously. 

8. Check Update Prices if you want the catalog import to update pricing on existing items from this 
vendor.  This will only work if your vendor style numbers exactly match those used by the vendor. 

9. Select OK to begin the import.  The Import Catalog window will appear with groups of items from 
the vendor list. 
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10. For each group, assign an Edge category. 
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11. Select OK.  The items will be entered for easy reference when ordering. 
 

 
 

12. Do this process on the server for each store. 
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 Items 
The Edge is built around a simple concept.  Enter all items into inventory as they arrive at the store, and 
use the system’s functions to sell them, alter them, return them for credit, scrap them, etc.  The Edge will 
know who bought the item, who sold it, when it was sold, and for how much it sold.  In the process, it 
will build a customer database, calculate commissions when applicable, recommend items for reorder, 
and more.   
 
When entering an item for the first time, it is essential to tell The Edge what category the item belongs to 
during the entry process.  If an item has been previously entered into the system, entering the vendor ID 
and style number or scanning the vendor’s barcode will automatically return details from a previously 
entered item.  Some fields are mandatory and must be present before The Edge will accept an item into 
the system.  The Items menu allows you to quickly and easily add and locate specific items in your 
store.  
 
When adding an item, the first thing to consider is category, which allows you to categorize items by 
type and style, but not vendor or brand, so you can see what kinds of items perform well.   For more 
about categories, go to the section in The Edge Online Help entitled Categories 
(http://docs.edgeuser.com/NetHelp/Documents/categories.htm).  For more about how The Edge’s 
inventory management features can help you maximize profits, see the video at 
https://www.screencast.com/t/LjGscxKzaR.   
 
The second is pricing method, which is what we will discuss in detail in this section. 
 
Based on the discussion above, you can see that when you receive an item, the first thing you should do 
is consider two things: 
 
1. To what category does it belong?    
2. What pricing method should it have? 
 
Selecting the Category 
 
A category is a collection of related items (i.e., chains, charms, diamond bracelets, colored stone rings, 
giftware, etc.) that The Edge will use as a foundation in producing management reports.  Assigning 
items to categories will assist you in discovering which categories are producing the most revenue and 
which price points are most productive within the categories.   
 
The Edge comes with default, recommended categories.  Though there may be reasons to vary a bit, we 
strongly encourage that you use the category structure provided with The Edge.  It will provide best use 
of analytical tools and better organization of items. For a video tutorial about working with inventory 
filters, go to http://www.screencast.com/t/ICQVlzwB.  
 
Selecting the Pricing Method 
 
The Edge provides five ways to price items: 
 

http://docs.edgeuser.com/NetHelp/Documents/categories.htm
https://www.screencast.com/t/LjGscxKzaR
http://www.screencast.com/t/ICQVlzwB
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• Fine-item pricing, which allows you to track individual pieces from purchase to sale to a retail 
customer.  

• Bulk item pricing, of which there are four types, whereby we are tracking quantities of the same 
style of item until retail sale to a customer and an individual sold instance of that item is created. 

 
In The Edge, all items are assigned a pricing method.  The most common pricing method in The Edge is 
fine jewelry, individual item pricing.  This method assigns each item its own unique inventory SKU even 
if the style has previously been in inventory.  By individually tracking items, The Edge is able to report 
very precisely.   
 
Single-item pricing is not appropriate for all types of inventory, particularly those merchandise lines that 
are low cost and carried in great quantity.  Always use a bulk category when the merchandise cannot be 
physically tagged. These types of items should be entered as bulk inventory.  Bulk inventory allows you 
to create a single inventory SKU and have it carry a quantity that can be replenished.  Like single items, 
bulk items can also fulfill special orders, be placed on a purchase order, managed as fast sellers, etc.   
 
In The Edge, bulk item pricing is the exception rather than the rule.  But the good news is that The Edge 
manages all these types of records for you, ensuring accurate transaction records. 
 
Types of Bulk Inventory 
 
There are four types of bulk inventory pricing methods: 
 
General Merchandise,  
UPC/SKU 

Appropriate when an item is carried in quantity and carries the same 
cost and price each, e.g., charms, batteries, and bead lines. 

Buy and Sell Item by Unit 
of Measure, IUOM  

Appropriate when an item is carried in quantity that includes a physical 
count and a measure and sold per measure, e.g., melee diamond parcels, 
especially larger stones (.05 ct. and larger) that would be sold 
individually. 

Buy and Sell by Measure 
Only, UOM 

Appropriate when an item is carried in measure and sold per measure, 
e.g., gold stock or smaller diamond melee that is sold as several stones. 

Mixed Retail Pricing,  
PRE 

Appropriate when an item represents a group of like-items of differing 
costs and prices but consistent markup, e.g., watchbands. 

 
Here is a decision tree to help you decide how to price an item in The Edge. 
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New Inventory

Can you 
individually tag 

the item?

No

Probably 
Individual, Fine-

Item Pricing

End

Yes
Enter Item as 
Described in 

Adding an Item 
(Standard)

No

Is it sold by 
piece and 

weight (ct)?  
(Usually 
Diamond 

Melee)

Is it a bead or 
other item too 
small for a tag 

or sold in 
quantity?

Is it provided 
pre-priced by a 

vendor?

Is it sold by 
weight (kt) or 
length? (Ex:  

Gold Chains)

No

No

Probably 
Still UPC.

No

Probably Bulk 
Individual Unit of 
Measure (IUOM)

Probably Bulk Unit 
of Measure (UOM)

Probably Bulk 
Prepriced (PRE)

Probably UPC

Yes

Yes

Yes

Yes

Enter as Described 
in Adding an Item 
(Standard) Using 

the Quantities Tab
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3.3.1 Bulk Records:  Behind the Scenes 
The Edge can manage bulk inventory records with the same precision as individual records and yet still 
allow you to avoid creating item records for each piece.  How does this work? 
 
Bulk records are structured in three levels:   
 
Bulk Master  Bulk master records are typically based on the vendor style number and provide 

management of that item regardless of status and quantity. 
Bulk Quantity  Bulk quantity records are a subset of bulk master records, but are based on 

shipments.  For example, if you receive 10 of a particular bulk item, a bulk 
quantity record is created. 

Instance Bulk instance records are created when a bulk item is sold or otherwise used 
individually.  Creation of an instance record depletes the quantity record for that 
item.  Instance records are very much like non-bulk, fine-item records. 

 
To add a new bulk item, you’re really creating a new master record.  After that, to replenish, we 
recommend using Add by Invoice and typing the style number of the existing bulk master and updating 
the quantities in the Quantities tab.  Then, as you work with each piece, The Edge will create an 
instance record for that transaction. 

3.3.2 Adding an Item (Standard) 
The Edge can record a tremendous amount of information about an individual piece.  You need not use 
all these fields, but they can be helpful in tracking and reporting on transactions. 
 

 

Adding an item can also be done in the Receive Invoice process.  See the section 
entitled Add Item from Invoice. 

 
To add a new item to your inventory from scratch: 
 
1. Select Inventory ► Item ►Add.  The New Item window will appear with the General tab open.   
 

Primary to an item record are four data fields: 
• Category 
• Vendor 
• Pricing method 
• Price. 
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An important feature of the New Item window is that once you select a category, the details defined 
by the Details tab of that category will appear.  See the section entitled Categories. 
 

2. Complete the tabs as described in the sections that follow. 
3. If the item has been in your inventory before, when you enter the vendor and vender style number, 

you will be prompted to copy the details from the previous record. 
4. Do so or enter the data manually. 
5. If the item is in response to a purchase order, associated with a special order, it is a bulk item, or if 

you have a multistore environment, the Allocate window will appear.  Allocate the items as 
described in the section entitled Allocating Items. 

6. Select OK/Save & Close. 
 

 

For bulk items, verify that the correct pricing method shows on the item record. 
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3.3.2.1 Item General Tab 
The General tab is the tab to which an item record will open from Inventory ► Items ► Find as 
described in the section entitled Finding and Editing an Item. 
 

 
 
Fields and options in the General tab include: 
 
Category The inventory category to which the item belongs.  Entering a numeric 

category ID or spelling part of the category name will reduce lookup time.  
Categories must be defined prior to entering inventory items.  For more 
information, see the section entitled Adding a Category. 

Vendor Info  
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 Vendor ID The vendor ID is a character string up to three positions in length used to 
identify each supplier of inventory items in the system.  Vendor IDs must be 
predefined before an item can be entered.  A drop-down list of all vendors is 
part of this entry function.   
 

 

The vendor record can be brought up immediately by 
selecting Vendor from the Vendor Info area. 

 

 PO# The purchase order number, if any, on which this item was received. 
 Invoice # Optional.  The invoice number corresponds to the number on the invoice 

from the vendor.  This field is not required, but we strongly recommend its 
use.  For convenience, The Edge will retain the first invoice number you enter 
under the assumption that subsequent added items are on that same invoice.  
This will continue until you change the invoice number again or stop entering 
inventory.   

 Quantity Optional.  Quantity allows you to create many inventory items with one 
entry.  For example, if there are five herringbone chains exactly alike, you 
would only have to enter the 5 into the Quantity field to create five unique 
inventory records.  The Edge will default to 1 if the field is skipped. 

 Ven Style # This is the vendor’s unique style number.  Enter it exactly as it appears on the 
invoice.  This field has the same use as the barcode field with regard to 
subsequent entries for this item.  As soon as the system detects that the same 
style number was entered previously, it will offer to complete the values 
accordingly.  Changes may be made or the item can be accepted just as it was 
recalled from its previous entry.   

 Style Note Text added to the style number that will help identify the item.  For example, 
it might be stone type, size, etc. 

 Barcode Optional.  If the item being entered into inventory has a barcode tag on it, 
scanning it while the cursor is in this field will result in the barcode being 
stored with this record.  The manufacturer’s barcode can then be used in the 
system for identifying the item in the same way as the system-generated 
barcode can.  It can be used to scan the subsequent entries of this item into 
inventory, saving time and minimizing mistakes.   
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 Stock Type This indicates how the item was acquired.  Values include: 
 
S  Stock 
M  Memo 
C  Consignment 
O  Special Order  
T  Trade-in 
V  Catalog Entry 
F  Faux model 
L  Live model  
A  Assembled 
P  Takeoff (i.e. disassembled part). 

Inventory   
 Store # Multi-store only.  The ID of the store where the item is located.   
 Allocate When entering new inventory, especially in a quantity greater than one, this 

option allows you to split that quantity among stores and/or allocate inventory 
to outstanding special orders.  Under certain circumstances, this option 
activates automatically. 

 Location Optional.  This represents a location in the store.  It may be a case, a window 
display, or the safe.  It is helpful for quickly detecting missing items by 
monitoring the item counts per case.   Security permissions are required. 
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 Status Indicates the current status of the item.  For a new item, it will always be I 
for in stock. Values include: 
 
I  In stock 
L  On Layaway 
S  Sold 
A   Memo Out 
V   Returned to Vendor 
M  Missing 
D  Disassembled 
U  Consumed here (i.e. as a part) 
    Consumed gone (no status letter, determined by sold or in stock) 
X  Scrapped 
G  Giveaway 
N  Donation 
W  Work in Progress 
C  Cancelled. 
 
Purchase Order Statuses: 
Q  Queued 
E  Entered 
B  Backordered 
O  On Order 
C  Cancelled. 

 Customer If the item is sold, this returns the customer record of the purchaser. 
 Sale If the item is sold, this returns the sale record. 
 As Of When the status indicated above was recorded. 
 Entered Date when the item first became an item.  This defaults to the current day if 

left blank. 
 Entered By Associate who entered the item. 
 Price 

Method 
Determined by the type of item.  The default is Fine Jewelry, 
Individual Item Pricing.  Other pricing methods apply to bulk 
inventory.  For more about bulk inventory, see the section entitled Bulk 
Inventory. 

 Exclude 
from 
Rewards 

Indicates that sale of the item should not count toward rewards. 

Pricing These fields detail pricing at both cost and margin. 
 Cost This field is the cost of a purchased item.  Enter cost with two decimal places. 
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 Re-cost The Re-Cost Item feature allows you to track and change the replacement 
cost of an inventory item, for reference and planning purposes, without 
affecting the actual cost paid.   This way, a retailer can consider what the cost 
of an inventory item would be if they purchased it again.   

 Re-Cost DT The date the re-costing was performed. 
 Retail  This field will be primed with the calculated retail price as determined by the 

values in the category record or an overriding vendor record.  The margin 
field immediately to the right of the retail price shows the amount of profit 
full price would result in. 

 Lowest This field will be automatically generated when required values are present in 
the category record.  The system will not allow items to be sold for less than 
this price without authorization.  The margin field to the right of this field 
shows the percentage of profit realized if the item is sold at this price. 

 Current The currently listed price of the item.  This may vary from retail for a few 
reasons, including the item being on sale or taking part in an automatic 
markdown. 

 Sold The price at which the item sold. 
 Spiff Spiff is an incentive applied to an item to encourage the sales staff to sell this 

item.  The spiff is represented as a percentage of profit generated on the sale 
of the item.  It is a good technique for getting rid of unwanted items.  Spiffs 
can be applied one by one (on the item record) or the system can 
automatically spiff items that meet a certain criteria on the Pricing tab as 
described in the section entitled Adding a Category.   
 

 

If you pay commissions, the greater of the values will be paid, 
but not both. 

 

 Levels Allows you to manage the minimum and maximum quantity of the item.  For 
more information, see the section entitled Inventory Levels.   Later, when 
editing the item record, if there are levels set, this button will be green. 

 Auto Indicates this item is subject to automatic repricing.  By default, all new items 
have this flag checked.  This is to assist you in managing aged inventory. 

On 
Sale 

 The fields that follow deal with sale pricing. 

 Price If the item is on sale, the sale price. 
 Margin If the item is on sale, the margin based on the sale price. 
 Starts When the sale price takes effect. 
 Ends When the sale price is no longer valid. 
 Sign Indicates the in-case sign used to advertise the sale. 
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Camera icon ( ) Returns photo menu to capture an image of the item as described in the 
section entitled Adding and Managing Photos.   

Description Allows you to enter a description of the item.  The Suggest option will 
construct a description based on the category data, the Stones tab, the 
category’s description template,  and the options selected for the item to date.  
It can be edited from there.   

 

Fields that appear in the General tab vary according to the item type. 

3.3.2.2 Item Stones Tab 
The Stones tab contains a record of stone details for each stone in a piece.   
 

 
 
To add a stone record to an item: 
 
1. Select Add.  The Add Stone window will appear.   
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Notice that once you’ve selected a type of stone, pertinent data fields will appear.  Fields vary based 
on the stone type.  Values available in each drop-down menu are managed in system lists. For more 
information, see the section entitled Lists.   
 

2. Complete the stone fields as needed. 
 
To change the stone data for an item, double-click on the stone record in the item record. 
 
The Edge software is sensitive to the value and importance of maintaining detailed stone information 
when necessary.  Detailed gemological information can be maintained by the software, but it is not 
always essential.  You may enter the information needed to satisfy your purposes.   
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The Edge will prepare an appraisal using the data supplied in the inventory record as 
an option.  It is in your best interest to provide as much information as possible for 
items that you anticipate will require an appraisal after selling them. 

 
The Edge will also produce reports by gemstone type.  It is important that the Stone tab be used for 
describing the gems in most pieces to a minimal degree anyway.  The order of the stones is significant to 
the software.  Stones are normally entered in the order of significance in the piece.  The first stone 
entered would be the center stone, the second stone entered would be the side stone, and so on.  The 
Stones tab has function buttons that will enable the user to readily reorder stones if necessary.   
 
The following dataset is provided as a default.  However, this information can be customized via the lists 
built into The Edge.  See the section entitled Lists for information on managing these lists. 

3.3.2.2.1 Diamond 

The Edge will provide you with all the data elements required to describe all known gemstones.  You 
may choose to use as many or few of these data elements as you deem necessary for describing the 
product being entered. 
 

Stone Type  
 Count A count of the stones to which all characteristics apply. 
 Type The type of stone (e.g., diamond when entering a diamond). 
 Shape The shape of the stone (e.g., round, marquis, pear, etc.). 
Dimensions  
 Varied If stone weights are varied, the system will prompt you to enter 

minimum and maximum weights. 
 TWT Total weight of all the stones. 
 Weight The weight of a single stone or the total weight of all stones in a 

group.   
 Length Measurement of the stone’s length in MM. 
 Width  Measurement of the stone’s width in MM. 
 Depth Measurement of the stone’s depth in MM. 
Cut  
 Table mm A measurement of the table size in MM. 
 Table % Table size as a percentage of diameter. 
 Crown % Degrees in the crown angle. 
 Girdle Smallest girdle measurement. 
 Girdle Max Largest girdle measurement. 
 Pavilion Percentage of diameter represented by the depth of the pavilion. 
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 Culet Size of culet. 
 Major Sym Symmetry rating. 
 Minor Sym Symmetry rating. 
Coloration  
 Clarity Standard industry codes (i.e., FL, VS2, SI1, etc.). 
 Color Standard industry codes (i.e., D to Z) that describe body color. 
 Fluor The degree of florescence, if any, in the stone. 
Finish  
 Polish Type of polish. 
 Finish Type of finish. 
Quality  
 Cut How the stone is cut. 
 Cost/Ct. The stone’s quality expressed as cost per carat. 
 Lab The ID of the lab that certified the stone. 
 Report # The certificate number associated with the stone. 
 Inscription If the stone has an inscription, what that reads. 
Supplier Info   
 Supplier The name of the supplier. 
 Invoice The invoice number. 
 Date 

Received 
The date the stone was received. 

Retail/Cost   
 Retail The current retail price of the stone. 
Enhancements   
 Identification If the stone has an enhancement, the type of the enhancement:   

• Natural 
• Laboratory-grown 
• Synthetic 
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 Enhancement If the stone has an enhancement, the nature of the enhancement: 
• Bleached 
• Surface coating 
• Dyed 
• Heat treated 
• High pressure, high temperature (HPHT) 
• Impregnated 
• Irradiated 
• Laser drilled 
• Lattice diffused 

3.3.2.2.2 Colored Stones 

The stone type would be other than diamond, opal, jade, or pearl and have its unique requirements 
displayed on the window. 

3.3.2.2.3 Pearl 

Pearls have a different set of characteristics than do other gems.  The Edge has a set of data elements to 
accommodate the descriptive values of pearls.   

3.3.2.2.4 Opal 

Opals have a different set of criteria needed to describe them.  The Edge recognizes that need and 
presents the user with those data elements needed to clearly define opals. 

3.3.2.2.5 Jade 

Jade has a different set of criteria needed to describe it.  The Edge recognizes that need and presents the 
user with the data elements needed to clearly define jade and the ability to add your own.   

3.3.2.2.6 Others 

System lists can be manipulated to include your own stone types.  See the section entitled Lists for more 
information and instructions on how to do this. 
 

 

In the item list view, two asterisks next to the item number indicates that there is a 
stone type of “other” associated with the item.  

3.3.2.3 Item Tag Tab 
Tags can be printed in batches from Print Tags as described in the section entitled Printing Item Tags.  
However, you may wish to print a tag for items as you add them to inventory.  To print a tag: 
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1. Select the Tag tab from the Add Item window.  A preview of the tag as defined by the category will 
appear.  Note that The Edge knows whether the tag is yet to be printed.  If so, Print Later as part of 
a batch print is selected automatically.   
 

 
 

2. To print a tag now, select Print Now.  The tag will print.  
 

 

Tag layout is set up at the category level.  To edit a tag layout for an item, visit the 
corresponding category’s Tag tab. 

3.3.2.4 Item Quantities Tab  
There are six pricing methods included in The Edge.  The default method, Fine Jewelry, Individual 
Item Pricing, applies to the majority of inventory and specifies that each item will receive its own 
unique item number for tracking purposes.  For this method, the Quantities tab has no use. 
 
The remaining four pricing methods represent different ways of handling what we refer to as bulk 
inventory (see the section entitled Bulk Inventory).  Bulk inventory means that a single item number 
represents a quantity of an item.  All four of these methods make use of the Quantities tab.  
 
Buy and Sell 
Item by Unit 
of Measure 
(IUOM) 

Recommended for melee diamond parcels.  Requires you to specify unit of measure, 
the number of pieces, total measure, cost (per measure), and price (per measure).  
This method allows you to keep track of a physical count and measure. 
For example, if you stocked a three-carat parcel of melee the total measure would be 
300 points while the total number of pieces would equal the number of physical 
stones on the parcel. 
 

 

To ensure accurate counts, this option requires that items are sold 
one per sale line during which time the weight of the single item is 
specified.  Selling multiple of this item requires adding additional 
sale lines. 

 

Buy and Sell 
by Measure 
Only (UOM) 

Recommended for gold, bar stock, etc.  Requires you to specify unit of measure, 
total measure, cost (per measure), and price (per measure).  This method allows you 
to sell directly by weight. 

Mixed Retail 
(Pre) 

Recommended for pre-priced watchbands where the individual cost may not be 
known.  Requires you to specify number of pieces, total cost of shipment, total price 
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of shipment, and the standard markup used.  This method will require that you enter 
the retail price of the item you are selling at point of sale.  Then, based on the total 
price/cost and markup, it will calculate the cost of that item and reduce the 
appropriate amounts from the item record. 
 

 

To ensure accurate counts, PRE requires that items be sold one per 
sale line.  Selling multiple of this item requires additional sale lines. 

 

General 
Merchandise 
(UPC/SKU) 

Appropriate when an item is carried in quantity and carries the same cost 
and price each, e.g., charms, batteries, and bead lines. 

Spot Metal 
Pricing 
(SPOT) 

Allows you to carry a quantity and sell metals by penny weight or grams; 
metal prices can be quickly updated so that you are selling based on the 
current spot price. 

 
Although you will probably add inventory from invoice as described in the section entitled Add Item 
from Invoice, you can do so here.  To manage quantities from the Quantities tab:  
 
1. Find the item with which you wish to work and open the Quantities tab. 
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The appearance of this information will vary depending on the pricing method.  It is used primarily 
for bulk items rather than fine items. 
 

2. To add bulk items, select Add from the Quantities tab.  The Item Quantities window will appear. 
 

 
 
Fields and options in the Item Quantities window include (but vary according to the item's bulk 
pricing method): 
 
Invoice # The incoming invoice number on which the items appear. 
Store The store to which the items should be assigned. 
Received On Date on which the items were received. 
Received Fields in this column apply to the items newly received. 
In Stock Fields in this column apply to the items already in stock. 
# Pieces If fine item pricing, the number of pieces being recorded. 
Cost Each If fine item pricing, the cost of each item to the store. 
Price Each If fine item pricing, the price of each item to the customer. 
Total Measure If a bulk item is sold as a unit of measure, such as ounces, inches, etc., the 

unit for this item is entered here.  This is the total measure of items 
received. 

Cost per Measure If bulk, the cost of a given quantity to the store. 
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Price per Measure If bulk, the price of a given quantity to the customer. 
Total Cost The total cost is calculated. 
Total Price The total price is calculated. 
Markup Markup is calculated. 

 
3. Select OK/Save & Close.  The Allocate window will appear. 
 

 
 
4. Complete the Item Quantities tab fields as described in the section entitled Allocating Items and 

select the Notes tab, if desired.   
 

 

Required fields in the Add Quantity window vary depending on the selected pricing 
method. 

 
For more information, see the section entitled Bulk Inventory. 

3.3.2.5 Item Notes Tab 
The Notes tab allows you to enter miscellaneous information about the item.  Notes will be available at 
point of sale when the item is inserted into a sale line.  This is indicated when the More button on the 
Point of Sale window is green. 
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Fields and options in the Notes tab include: 
 
Insert Insert new note. 
Format Edit font, color, size, etc. 
Revert Revert notes to last save. 
Unlock Unlock previously entered notes. 

3.3.2.6 Item Pop-Ups 
Items can have pop-up reminders associated with them for point of sale purposes.  For example, if an 
item had an interesting story, and you want the make sure the associate shares that information with the 
customer, it can appear in a pop-up.  Or, suppose there is some point of disclosure that should be 
mentioned, this would be a good forum for that.  Pop-ups can be edited on a specific item or you can use 
the Item Pop-Up wizard to apply a pop-up to multiple items. 
 
To create a single item pop-up: 
 
1. From the Item window, select the Pop-Ups tab.  
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Fields and options in the Pop-Ups tab include: 
 
Add Insert a new pop-up. 
Edit Edit an existing pop-up. 
Delete Delete a pop-up. 
Show Inactive Allows you to see pop-ups that have been marked inactive. 

 
2. Select Add.  The New Pop-Up window will appear. 
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Fields and options in the New Pop-Up window include: 
 
Inactive Indicates that this pop-up is inactive. 
Title A descriptive name for the pop-up. 
Extra Emphasis System Options control whether you want item pop-ups in general.  

Enabling this field will cause this specific item pop-up to pop-up.  This 
feature includes additional emphasis options for the More button.  Here is 
a summary: 
 

 

System Options:  If 
Inventory Item 

Pop-Up at POS is 
set to True 

System Options:  If 
Inventory Item 

Pop-Up at POS is 
set to False 

Extra Emphasis 
option checked 

More button turns 
red and item pop-up 

appears 

More button turns 
red 

Extra Emphasis 
option not checked 

More button turns 
green 

More button turns 
green 

   
Pop-Up Starts When the pop-up should start popping up.  If this is left blank, the pop-up 

will start immediately. 
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Pop-Up Ends When the pop-up should stop popping up.  If this is left blank, the pop-up 
will continue indefinitely.  

Marked as Done The date when the pop-up was resolved at point of sale by checking the 
Do Not Show This Pop-Up Again option at point of sale.   

Notes The content of the pop-up. 
Entered The date the pop-up was created. 
Last Modified The date, if any, the pop-up was last edited. 

 
3. Complete fields as desired and select a save option. 

3.3.2.7 Item Pop-Up Wizard 
The Item Pop-Ups wizard allows you to apply a pop-up to multiple items at once.  For more 
information on item pop-ups see Item Pop-Ups. 
 
To use the item pop-up wizard: 
 
1. Click Inventory ► Items ► Add ► Item Pop-Ups.  The wizard will appear.   

2. Click Next and it will bring you to the item selection screen. 
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3. Use the Item Filter drop-down to specify criteria, then click the Search button.  A list of matching 
items will populate in the lower portion of the window. 

 
4. Check the items you wish to include and click Next. 

 
5. Enter the Title, date range to display pop-up, and the Notes, then click Create Pop-Ups.  The pop-

up will now be added to all the selected items. 
 

3.3.2.8 Assembled Tab 
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When an item is assembled, this tab details the items and tasks that were used to create an assembled 
item.  If the parts were stock items, this provides shortcuts to the original item (consumed) records.  For 
more about assembled items, see the section entitled Assembling an Item.   

3.3.2.9 Disassembled Tab 
When an item is disassembled, this tab details the resulting parts (take-offs) and provides a shortcut to 
these new item records. For more about disassembling, see the section entitled Item Disassembly. 

3.3.2.10 Item Pre-Appraise Tab 
The Pre-Appraise tab allows you to include additional information that will help to generate an 
appraisal at point of sale.  This type of appraisal is not treated as a special service, such as that described 
in the section entitled Appraisal.  This is information entered along with the item when it is entered into 
inventory.  If such an appraisal is conducted, and it is ready to print, the More… button next to the sale 
line item in the Point of Sale window will be green.   
 
There is a system option to set a title for pre-appraisal.  By default, the option reads “Evaluation 
Certificate.”  
 
Once the item is sold, you can print this appraisal directly from the Pre-Appraise tab of the sold item.   
 

 

If you do an appraisal intake for an inventory item at point of sale, this information 
entered here will be used to populate the appraisal intake fields. 
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Fields and options in the Pre-Appraise tab include: 
 

Appraised By The employee ID or appraiser’s name from the drop-down list. 
Appraised Value The value as indicated by the appraiser. 
Short Description The short description of the item as included in the item record. 
Full Description The full description of the item as included in the item record. 
Suggest Provided with most description fields, allows The Edge to generate a 

description based on the previously completed data fields. 
Save & Print Appr Allows you to save the appraisal and print it immediately. 

 
To create a pre-appraisal: 
 
1. From the Pre-Appraise tab, select an associate from the Appraised By drop-down menu. 
2. Enter a value in the Appraised Value field. 
3. Enter a short description in the Short Description field. 
4. Enter a full description in the Full Description field.  The Suggest option will offer text based on 

vendor style information. 
5. Select a save option. 
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3.3.2.11 History Tab 
Any activity concerning the item will be recorded here.  This will be empty with a newly added item. 
Activities might include: 
 
• Inventory addition 
• Sale 
• Donation or giveaway 
• Return to vendor  
• The item location for any activity. 

3.3.2.12 Website Tab 
If you are using Third-Party Website, the Website tab is where item upload settings are recorded.  For 
more about third-party website, see the section entitled Third-Party Website.   
 

 
 
Fields and options in the Web tab include: 
 

Never Upload This Item Indicates that the item should never be included in TPW uploads. 
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Always Upload This Item Indicates that the item should always be included in TPW uploads.  
Use this option with caution; when it is enabled, the item will 
remain on the website until you remove the check.  Always Upload 
This Item is typically used on fast selling items that you always 
want displayed on the website regardless of whether the item is in 
stock. 
 
A full upload is required anytime the Always Upload or Never 
Upload boxes are selected or deselected.  Also, you should contact 
the web company to inform them that those settings were used. 
They will not automatically populate anywhere on the website until 
it is configured on the web provider’s end. 

Web Category The category from the website into which the item should be put.  
This may not be the same as The Edge category. 

Web Title The title of the item as it will appear on the website. 

Web Description The description of the item as it will appear on the website.  By 
default, this will be the description that appears in the item record, 
but you can make changes as needed. 

Meta Title The item title as it should appear in the page's HTML meta tags. 

Meta Description The item description as it should appear in the page's HTML meta 
tags. 

Meta Keywords Search terms with which to associate this record.  Enter as many as 
you like, but separate them with a comma. 

3.3.2.13 Allocating Items 
If the item is in response to a purchase order, associated with a special order, it is a bulk item, or if you 
have a multistore environment, the Allocate window will appear.  This tells The Edge what to do with 
the item:  assign to a particular store, increase bulk quantities, assign it to a special order, etc.  To 
allocate an item, when prompted: 
 
1. Add or receive the item as needed.  When appropriate, the Allocate window will appear. 
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Fields and information in the Allocate window include: 
 
Cost  For fine jewelry, enter the TOTAL cost of all items. 

For bulk pricing methods, enter the cost of EACH item. 
Invoice # The invoice number associated with the item order. 
Description Description of the item. 
Style Note Text added to the style number that will help identify the item.  For example, 

it might be stone type, size, etc. 
Allocate Quantity of this item to allocate to this store or special order. 
Price Each Price of the item to the customer. 
Ordered Quantity on order from purchase order for this store or special order. 
Customer/Store The special order customer or store for this allocation line. 
Entered Date the item was entered for special order at POS. 
Ready By Date the order is to be available. 
Promised ETA date is firm, not an estimate. 
 

2. Enter the number of that item to be allocated to each store.   
3. Select OK.  You will be returned to the add item process you were in. 

3.3.2.14 Allocating Special Orders 
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If the item is the result of a special order, when you enter vendor and style number, you will be prompted 
to select from an existing item.  The item you ordered will be highlighted in purple. 
 

 
 

 

For special orders, there is a separate entry for each special order customer.  You can 
only copy details for one special order at a time. 

3.3.3 Add Item from Invoice 
The Receive Invoice feature allows you to enter a number of items into inventory at once based on the 
invoice that accompanies the shipment.  Though it is designed to function with purchase orders, it can be 
used by itself.   For working with receipt of special orders, matching the incoming item with the order is 
automatic. To receive items from invoice: 
 
1. Select Inventory ► Items ► Add ► From Invoice (or P/O ► Rcv Invoice).   The Select a 

Vendor window will appear.   
 

 
 
Fields and options in the Select a Vendor window include:  
Vendor drop-down menu Used to select the vendor from whom the shipment came. 
Show vendors with items 
on order only 

If this is enabled, The Edge populates the Vendor drop-down list 
with vendors who have items on order. 
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Show vendors with Special 
Orders not on a PO 

If this is enabled, The Edge populates the Vendor drop-down list 
with vendors who have special orders not created in a purchase 
order. 

 
2. Enter the vendor ID or select it from the drop-down menu and select OK.  The Items Ordered 

window will appear. 
 

 
 
The Ordered Items window contains a list of items ordered from this vendor.  They may or may 
not be included in the shipment you are receiving.  Information shown on the Items Ordered 
window include: 
Source The initial source of the ordered item: 

Q: Queued from the item record or Rapid Reorder 
SO:  Generated by a special order at POS (highlighted in purple). 

Vendor Style The vendor style number for verification. 
Style Note Text added to the style number that will help identify the item.  For 

example, it might be stone type, size, etc. 
# Ordered The quantity ordered. 
PO #/Customer The purchase order number associated with the ordered item.  If it is a 

special order, the customer name will appear. 
Description A description of the item. 
Check/Uncheck All Allows you to quickly check or uncheck all the items in the list. 
Show Images Allows you to enable the image column.   
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For the purposes of the Retrieve Queued window and the Purchase Order window, line items will 
be color-coded as follows:  
 

Yellow Queued items 
Purple Special order items 
Dark Red Marked to be cancelled 
Light Yellow Other 
Blue Selected 
Light blue Hovering 

 
3. Check the items that are included in this shipment.  This should only be done for one invoice at a 

time. 
4. Select OK.  The Receive Invoice window will appear populated with the selected items. 

 

 
 
Fields and options in the Receive Invoice window include: 
 
Show Images Used to show item images if available. This will help you identify the 

piece. 



The Edge User Guide v. 20.0.0.114 

88 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

Invoice # The number of the vendor's invoice that contains the item.  This is 
required. 

Date Received The date you are entering the items.  By default, The Edge populates this 
field with the current date.  It will go into the item record as the Date 
Entered value. 

Allocate Items to 
Store x 

Allows you to quickly allocate items to store the current store; if you use 
this, the Allocate window will not open for this item when you save the 
Receive Invoice window. 

Save All as Memo Allows you to quickly mark these items as memo items.  For more 
information about memo items, see the section entitled Consignment and 
Memo Items. This will not work for bulk or special order items. 

Recall Costs Obtains costs for the ordered item lines for all items.  If you have the 
system option set to use the most recent cost, it will load the most recent 
cost for that style code from the database.   

Items on Order Returns the Items Ordered window so you can select additional items. 
Add Line Allows you to manually add an item line to the invoice, from the style 

number records, or completely new.  If the item is associated with a 
special order, it will be highlighted in purple.  

Delete Line If the item has been ordered, this deletes a line from the Receive Invoice 
list and the item is not received.  It does not affect the purchase order, 
only the receive list.  Next time you are receiving from the vendor, it will 
still appear.  The item will be unchecked in the Items Ordered list. 

View Item Details Opens the item record for the selected item.  Changes made will be 
reflected here.   

Receive All Automatically receives all items in the Receive Invoice list.  It fills in the 
ordered quantities and dates them the current day.  

Allocate Allows you to allocate items for the currently selected line.  If it is a 
special order, be sure to allocate to the correct customer. 

 
5. In the Invoice # field, enter the invoice number to be applied to all items received on this shipment. 
6. To add new or existing styles to be received on this shipment that didn't appear in the Items 

Ordered window, select Add Line.  This is useful for shipments that did not have purchase orders 
associated with them.  Alternatively, for items with a vendor barcode that has been in stock before, 
you can scan the tag and a line item will be populated for you.  When you enter the style number, 
for items used before, The Edge will prompt you to copy the details for the existing record.   Note 
that for special orders, items are highlighted.  You must select the correct record to copy from for 
each customer.   

7. For each line item, verify and correct the data: 
 

a. Source:  What initiated the order:  Q is for Queue, SO is for Special Order. 
b. Qty Received to Date:  The quantity of this item so far on this purchase order.   
c. Qty Received Today:  The quantity of this item received in this shipment. 
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d. Vendor Style/Note:  The vendor style number or note. 
e. Category:  The Edge category for the item. 
f. Description:  The Edge description of the item. 
g. Cost:  The cost of the item. 
h. Retail:  The retail price of the item. 
i. Lowest:  The lowest the item can be sold at; this is kept in the item record. 
j. Current:  The current price of the item; this is kept in the item record. 
 

8. Edit or add item lines as needed.  If you wish to undo changes to cost, use the Recall Cost button.  
9. Specify quantity received for each style in the Rec’d Today field.  
10. Press Enter.  The Allocate window will appear.   
 

 
 
11. Allocate items as described in the section entitled Allocating Items.    Notice that special order items 

will indicate the customer for whom the items was ordered and use that line to allocate the item to 
him or her. 

12. Select OK.  The line item in the Receive Invoice window will indicate that item has been allocated. 
 

 
 

13. Select OK/Save & Close to receive this shipment and add these items to inventory.  You will have 
an opportunity to edit item details. 
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14. Repeat the entire process for each invoice.  If a purchase order is associated with the order, its 
record will be updated to indicate that items were received. 

3.3.4 Finding and Editing an Item 
To locate a particular item within your inventory: 
 
1. Select Items ►Find from the Inventory menu.   
2. Scan the barcode, enter the item number, or provide other details in the Find Item window tabs as 

described below to search for an item.  As always, the Presets feature allows you to save search 
parameters for future use.  See the section entitled Presets for more information. 

 
 
Fields and options in the General tab include: 
 
Category Returns items in the specified category, whether by ID number or selected 

from the drop-down list.    
Generic Desc Returns items with a matching description. 
Type Returns items of the item type entered. 
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Vendor Returns items from the vendor ID indicated, whether by ID number or 
selected from the drop-down list. 

Style# Returns items matching the style number entered. 
Invoice# Returns items appearing on a particular invoice. 
Store Returns items located in a particular store. 
Location Returns items in a particular location of any store. 
Price Range: 
Min 

Returns items priced at greater than or equal to the indicated amount. 

Price Range: 
Max 

Returns items priced at less than or equal to the indicated amount. 

Keywords Returns items containing the specified phrase in the description. 
By ID Use this section to query by item ID number. 

Item# Returns items with a matching current item ID.  Using this search field will 
cause The Edge to ignore all other search filters. 

Old Item# Returns items with a matching pre-conversion ID number. To ensure that 
The Edge looks for only legacy item numbers, put a period (.) in front of 
the number, especially if the legacy number has any dashes. 

Old Barcode Returns items with a matching pre-conversion barcode number.   
Honor Other 
Criteria 

Allows you to include these criteria without nullifying other filters; 
otherwise, searching by Item # will cause The Edge to ignore all other 
search filters. 

View Contains a drop-down menu with options for images to appear in results. 
Show 
Checkboxes 

Returns a checkbox with each record in the results.  The checkbox can be 
used to indicate which records to perform various actions on:  Edit, Add, 
Delete, etc. 

RFID  Contains a drop-down menu with options for filtering based on whether 
items have an RFID tag. 

Collections Returns items included in selected collections.  For more about collections, 
see the section entitled Collections. 

 

 

• Filter parameters are cumulative.  That is, the more parameters you enter, 
the fewer items will be returned.  For example, if you enter a category and a 
keyword, only items with matches in BOTH fields will be returned.  This 
applies to parameters on all the tabs. 

• Because this information is specific, if you search by ID, no other search 
criteria will be used. 

 
3. Complete the General tab fields, if any, as needed to retrieve the appropriate data. 
4. If needed, select the Type & Status tab.    
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Fields and options in the Type & Status tab can vary based on item status.  Fields may include: 
   
Pricing Methods Returns items priced in one or more of the following pricing 

methods: 
 
• Item Pricing 
• UPC/SKU 
• Item by UOM 
• UOM Only 
• Pre-Marked. 
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Inventory Type Returns items in one or more of the following inventory groups: 
  
A:  Assembled 
P:  Take-Off 
U:  Custom 
S:  Stock 
M:  Memo 
C:  Consignment 
O:  Special Order 
T:  Trade-In 
B:  Built 
E:  Template 
V:  Virtual Model 
I:  Internet Model approved 
J:  Internet Model Browse not yet approved 
F:  Faux Model 
L:  Live Model. 
 

Item Status Returns items with one or more of the following statuses: 
 
I  In stock 
L  On Layaway 
S  Sold 
A   Memo Out 
V   Returned to Vendor 
M  Missing 
D  Disassembled 
U  Consumed here (i.e. as a part) 
     Consumed gone (no status letter, determined by sold or in stock) 
X  Scrapped 
G  Giveaway 
N  Donation 
W  Work in Progress. 

PO Status Returns items with one of more of the following purchase order 
statuses. 
 
Q  Queued 
E  Entered 
B  Backordered 
• On Order 
C  Cancelled. 

Show each invoice For bulk items, results show one item row for each invoice. 
Hide out-of-stock bulk Excludes items that are out-of-stock bulk. 
Date Entered Returns items entered into inventory in the provided date range. 
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Date Created Returns items entered into inventory in the provided range.  Unlike 
Date Entered, Date Created cannot be changed and will always be the 
true date the item was entered. 

Status Date Returns items by the date range during which their current status was 
indicated. 

Sold Date If a Status of Sold is included, this will return items sold during the 
specified date range. 

In Stock On Returns items that were in stock inventory on the specified date.  This 
option works in combination with all the other criteria.  Most users 
find it best to also check all the Item Status options. 

Sold By If a Status of Sold is included, this will return items that were sold 
by a specified associate(s). 

Sold To If a Status of Sold is included, this will return items that were sold 
to a specified customer. 

 
5. Complete the Type & Status tab fields as needed, if any, to retrieve the appropriate data. 
6. Select the Item Details tab, if needed.  
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Fields in the Item Details tab include: 
 

Metal Type Returns items of a particular metal type. 
Metal Color Returns items of a particular metal color. 
Metal Finish Returns items of a particular metal finish. 
Sign Format Returns items based upon their designated sign format.  Sign formats are 

assigned on the category setup window. 
Item Style Returns items of a particular style. 
Item Location Returns items based on specified location(s). 
Category ID Returns items of selected categories only. 
Vendor ID Returns items of selected vendors only.  
Always 
Upload 

Returns items that are marked Always Upload for TPW. 
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Never Upload Returns items that are marked Never Upload for TPW. 

7. Select the Stones tab, if needed.   
 

 
 
Fields and options in the Stones tab, which vary according to the stone type, can include: 
 

Type Returns items with stones of a particular type. 
Shape Returns items with stones of a particular shape. 
Lab Returns items with a report associated with a specified lab. 
Weight Returns items with stones of a particular weight range. 
Length Returns items with stones of a particular length range. 
Width Returns items with stones of a particular width range. 
Depth Returns items with stones of a particular depth range. 
Coloration  
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 Clarity, Lowest Returns items with stones of a minimum clarity. 
 Clarity, Highest Returns items with stones of a maximum clarity. 
 Color, Lowest Returns items with stones of minimum color designation. 
 Color, Highest Returns items with stones of maximum color designation. 
Match stones by 
position 

Returns items with stones in a particular position on the piece. 

 Primary Stone 
Only 

Returns items with the specified stone in position one. 

 Primary or 
Secondary Stone 

Returns items where stone one or stone two matches the specified 
criteria. 

 Any Stone Returns items where any stone matches the criteria. 
Organize resulting 
list 

Indicates how results should be presented. 

 One item per 
row 

Lists only one item per row in the results. 

 One stone per 
row 

Lists results by stone.  A single item might be listed more than once for 
each matching stone.  This will change the layout of the results, but also 
focuses the results on the stones rather than the item. 

 

 
 

 
 

8. Complete the Stones tab fields, if any, as needed to retrieve the appropriate data. 
9. Select the Scan Data tab, if needed.   
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Fields and options in the Scan Data tab include: 
 
Scanned Since Returns items that have been scanned during physical inventory of any kind 

since the specified date and time.  If you use this filter, also enter a time from 
the bottom of the date picker. 

Not Scanned 
Since 

Returns items that have not been scanned during physical inventory of any kind 
since the specified date and time.  If you use this filter, also enter a time from 
the bottom of the date picker. 

 
10. If desired, enter date and time to narrow by the last inventory scan.  
11. Select the Options tab, if needed.   The Options tab contains data determined by the context of the 

operation.  For example, it might allow the Find function to include the cost of an item. 
 

 

Parameters are cumulative.  That is, the more parameters you enter, the fewer items 
will be returned.  This applies to parameters on all the tabs. 
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12. Select OK.  A list of the matching items will appear.   
 

 
 

 

• An item number with one asterisk next to it represents a bulk item quantity 
added at another store. 

• Two asterisks next to the item number indicates that there is a stone type of 
“other” associated with the item.  

 
13. For more detail about a piece, double-click on it or select it and select Edit.  Alternatively, select the 

item and select Details or press Enter.   
14. Work with the item as needed.  Fields and options in the Item Record are described in the section 

entitled Adding an Item (Standard).   
15. For options in working with the Supervisor menu, see the section entitled Working with Item 

Records. 

3.3.5 Working with Item Records 
This section details the information found in each item record.  From the item record, you can make 
changes to item records, order items, or change the category. 

3.3.5.1 Order Items 
Found on the Item List view Supervisor menu, Order Items allows you to quickly select items and 
start purchase orders based on the existing records.  To do so:   
 
1. From the Item List view, select the item or items you wish to order. 
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2. From the Item List view Supervisor menu, select Order Items.  The Queue Items for Order 
window will appear. 

 

 
 
3. In the Qty field, enter the number of the item to order. 
4. Check the other fields to ensure accuracy. 
5. To create a new line using one of the existing ones, select the line to copy and select Copy Selected 

Line. 
6. Select OK.  The order will be queued. 
7. Create a purchase order and submit it as described in the section entitled Purchase Orders. 

3.3.5.2 Working with Item History 
To work with existing item history:  
 
1. From the Item details window, select the History tab.  If there are entries in the item’s history, there 

will be a green dot on the tab.  Because we are creating a new item, there will be an empty History 
tab. 
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2. To see event detail, select it and select See Service, See Sale, or See Customer as needed.  These 
options will return the detailed transaction or customer record, if applicable. 

3. Select a save option.  Changes made in all tabs will be saved. 

3.3.5.3 Move Items to New Category 

 

Changing categories cannot be undone. 

Before changing categories, you must protect the integrity of your database by doing the following: 
• Shut down The Edge in all workstations but the one from which you will do this. 
• Backup your database. 
• Tags will be queued for reprint; we recommend you do this immediately after the recategorization. 
 
To change the category in which an item falls:     
 
1. From the Item List view, use the checkbox option to select the item or items you wish to 

recategorize. 
2. From the Item List view Supervisor menu, select Move Items to New Category.  You will be 

prompted to select a new category. 
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3. Enter a category ID or select a category from the drop-down menu. 
4. Select OK.  A confirmation will appear. 

3.3.5.4 Return to Vendor 
Found in Supervisor at the bottom of the Item List view or Item window, the Return to Vendor 
option allows you to return an item to the vendor.  It will take the item out of inventory.  To do so: 
 
1. From the Items list, right click to turn on the checkboxes next to the items. 
2. Select the items to be returned. 
3. From the Supervisor menu, select Return to Vendor.  
4. After confirmation that the item has been taken out of inventory.   

3.3.5.5 Back from Vendor 
1. From the Item List view, select the item or items you wish to get back from the vendor. 
2. From the Item List view Supervisor menu, select Back From Vendor.  The item status will 

change accordingly. 

3.3.5.6 See Cost, See Re-Cost, See Lowest 
Found in Supervisor at the bottom of the Item window, the See Cost, See Re-Cost, and See Lowest 
options causes these fields to become visible in the Item window.   They can be turned off using the 
analogous Hide Cost, Hide Re-Cost, and Hide Lowest.  
 

See Cost Allows the supervisor to view the initial cost of the item. 
See Re-Cost Allows the superivsor to view the re-defined cost of the item. 
See Lowest Allows the supervisor to view lowest price at which the item may sell. 

3.3.5.7 Change Pricing/Protect Pricing 
Found in Supervisor at the bottom of the Item window, the Change Pricing/Protect Pricing option 
allows the supervisor to change the cost, re-cost, and lowest figures in the Item window, Pricing area.  
For more about item pricing, see the section entitled Reprice Items.        

3.3.5.8 Missing/Scrap/RTV 
To mark an item as missing, scrap, or return to vendor:  
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1. From the Item Detail window Supervisor menu, select Missing, Scrap, or RTV as desired.  You 

will be prompted to confirm the action. 
2. Select Yes. The item status will change.  
 
You can return to vendor en masse from the list view: 
 
1. From the list view, check the items for which their status must be changed. 
2. From the Supervisor menu, select the appropriate option.   
 
In some cases, especially if dealing with bulk or missing items, the entire list might need to be of the 
same status, so use the item find filter with that in mind.  Bulk found gets recorded against missing items 
before The Edge creates new records. 

3.3.5.9 Fixup Status 
The Fixup Status option allows you to correct an item’s status, e.g., sold vs. in-stock, etc.  This is 
typically used to correct an item record after an error or crash occurred.  The Edge looks at item records 
and compares with sales records to reconcile differences.  To do so: 
 
From the Item Detail window Supervisor menu, select Fixup Status.  The status change process will 
run.  If the sale record indicates that an item should be a different status than what is on file, you will be 
prompted to perform the suggested corrective action. 

3.3.5.10 Editing Existing Bulk Quantities 

 

The Edit Bulk Quantities option is used only to correct entry errors.  In the case of a 
return to vendor, scrapped item, or missing item, it is best to use options in the 
Supervisor Menu.  Otherwise, use of this option could result in bookkeeping errors. 

 
To make changes to bulk quantities after they have been committed to inventory, i.e., to correct an error: 
 
1. Select Inventory ► Items ► Find. 
2. Enter the vendor ID and vendor style number. 
3. Select the Type & Status tab. 
4. Choose the appropriate bulk Pricing Method (or all bulk pricing methods). 
5. Select OK.  
6. Select and edit the bulk item record. 
7. Select the Quantities tab. 
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This window shows all quantities received for this bulk item.  Fields and options in the Quantities 
tab include: 
 
Unit of Measure Specify how measure being stored (UOM, IUOM only). 
Add Use this button to create a new quantity row. 
Adjust Select an existing quantity row and use this button to edit its details.  

You can also double-click on the line item to edit.   
Remove Select an existing quantity row and use this button to delete it. 

 
8. Select the row to edit and select adjust or double-click it.  The Item Quantities window will appear. 
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Fields and options in the Item Quantities window include: 
 
Invoice The invoice number of the shipment being altered. 
Store # The store number in which the quantity resides. 
Memo Notes concerning the reason for the edit. 
Received On The date the items were received. 
# Pieces Received The number of pieces received on the specified invoice.   
# Pieces In Stock The number of pieces from that order that are still in stock. 
Cost Each The cost of each piece. 
Price Each The price of each piece. 
Total Measure Received The amount, for bulk sold in UOM, received. 
Total Measure In Stock The amount, for bulk sold in UOM, in stock after the order came. 
Cost Per Measure The cost, for bulk sold in units of measure, for each unit of measure. 
Price Per Measure The price, for bulk sold in units of measure, for each unit of measure. 
Total Cost The total cost for the amount entered from this invoice. 
Total Price The total price for the amount entered from this invoice. 
Markup The percentage markup. 
See Cost Returns the cost history of the items. 
 

9. Edit the fields as needed and select OK/Save & Close. 

 

• An individual item number is assigned to each bulk item as it is sold.  For example, 
at point of sale, if you sell item 900-00001.  The receipt will show 900-1000001, 
which serializes this item, specific to this customer, so the item can be returned 
appropriately.  On return, the individual item is deleted and the original bulk 
SKU is increased by the quantity of the return. 

• When conducting a physical inventory of bulk items, the physical quantity counted 
is automatically adjusted against the previous in-stock count.   

• Use Inventory ► Items ► Levels to manage bulk inventory by vendor. 

3.3.5.11 Bulk Item Supervisor Menu 
The Supervisor menu in a bulk inventory item looks much like the fine item pricing Supervisor menu 
and includes tasks such as: 
 
See Cost Enables the cost fields to appear in the General and Quantities tabs. 
See Re-Cost Enables the replacement cost fields to appear in the General tab. 
See Lowest Enables the lost pricing field to appear in the General tab. 
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Change Pricing Allows you to set a spiff on the bulk master record.  Bulk pricing is modified 
through the Quantities tab. 

Return to Vendor Allows you to return a specified quantity of an item to the vendor. 
Missing Allows you to mark a specified quantity of an item missing. 
Scrap Allows you to mark a specified quantity of an item as scrap. 
Fixup Status Reconciles the status against transaction records. 
Fixup Bulk 
Quantities 

Reconciles bulk quantities against transaction records. 

Merge Bulk Allows you to merge bulk item records.  For more information, see the section 
entitled Bulk Inventory Merge.   

Cancel Cancels out of this menu. 

3.3.5.12 Bulk Inventory Merge 
Found on the Supervisor menu at the bottom of the Item window of a bulk item, Merge Bulk allows 
you to merge duplicate bulk masters.  To merge bulk inventory: 
 
1. Starting from the record that you want to merge into, from the Item Supervisor menu, select Merge 

Bulk.  The Find Bulk Masters window will appear.  It operates much like the Find Item filter. 
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2. Complete the filter as desired to find items you want to merge in to this master and select OK.  

Matching results will appear. 
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3. Select the record you want to merge in and select OK.   
4. Save the record for the merge to finalize. 

3.3.6 Find Stones 
Items can be looked up by stone.  To do so: 
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1. Select Stones ► Find.  The Stones Find window will appear. 

 
2. The Type drop-down allows you to specify a stone; leave blank to include all stones. 
3. The Weight, Length, Width, and Depth fields allow you to narrow your search by stone 

dimensions; leave blank to include all stones. 
4. If you specify a Type, additional fields may appear to let you further filter by stone shape, color, 

etc.  This will vary based on the type of stone and available characteristics. 
5. Use the Match Stones by Position option to specify whether to search only primary stones, only 

primary and secondary, or all stones on an item. 
6. Specify desired criteria and click OK.  A list of matching items will be displayed with one row for 

each stone on the item. 
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3.3.7 Find Item by RFID Tag 
If you use RFID for inventory, you can use the RFID tag number to locate the item record.  To do so: 
 
1. Select Inventory ►Items ►Find By RFID.  The Scanning for Tag window will appear. 

 

2. Scan the tag.  The Edge will search the database for the item number and return results a list with 
that item in it. 

3.3.8 Consignment and Memo Items 
Consignment and memo items are identified in The Edge as such via the Stock Type field in the item 
record.  By properly selecting memo type or consignment type, The Edge can greatly improve the 
management of payables and accounting.  Once the items are properly identified as consignment or 
memo, they will continue to be treated as such for the remainder of the accounting cycle.  For example, 
if you’re integrated with QuickBooks, consignment and memo items can be mapped to special income 
and cost-of-good-sold accounts so that you may manage them differently from regular stock items.  
Consignment items and memo items are similar to each other in that both are liabilities while in your 
possession. Also, they will both generate a payment due after being sold, which is expressed by setting a 
payable date on the item record.   
 
They differ in that memo items are owned by a vendor and consignment items are owned by a customer.  
Therefore, how you pay for these items will have a different process.  For consignment items, there is a 
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system option to automatically generate a credit memo to the owner when the item is sold.  Memo items 
are paid for, albeit after the sale, like any other inventory bill when they become payable and is handled 
outside The Edge. 
 
For the purposes of reporting, consignment and memo items are not considered part of stock until the 
item is sold and a payable is attached to the record. 
 
Consignment and memo sales follow this general process: 
 
1. Item intake, where you indicate the type of item you have 
2. Sell the item to a customer 
3. Pay the owner or vendor. 

3.3.8.1 Adding Consignment or Memo Items 
When you receive a consignment or memo item, use the same process as described in the section entitled 
Working with Item Records, except from the General tab, select Consignment or Memo from the 
Stock Type drop-down list.   
 
Consignment 
 

 
 
For a consignment item, you will be asked to identify the owner using the Customer Find filter.  This 
indicates who should be paid when the item sells.  Without that information, The Edge will not allow 
you to save the record.  Like any other item, for the integrity of management reporting, consignment 
items require a vendor entry.  We recommend that you create a single vendor called Consignment. 
 
 
 
 
Memo 
 

 
 
A memo item has an option to indicate an expiration date, which is the date it is due back to the vendor 
if unsold.  The item’s Vendor Return Memo feature allows you to send all memo items based on the 
Memo Expires value. 

3.3.8.2 Finding and Reporting on Consignment and Memo Items 



The Edge User Guide v. 20.0.0.114 

112 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

To work with consignment and memo items, for example, to determine what payments are due, use the 
Item Find feature.  In the Type & Status tab, under Inventory Type, deselect Inventory and select 
Memo or Consignment.  You can also specify the dates or a specific owner or vendor.   

3.3.8.3 Working with QuickBooks and Consignment and Memo Items 
To ensure the proper mapping of consignment and memo inventory as liabilities and to facilitate 
payments, be sure to map The Edge consignment and memo items to the proper QuickBooks accounts.  
By selecting the appropriate stock type, your item will adhere to the appropriate accounting activities as 
set up in your accounting system. 
 

 
 
See the section entitled Mapping The Edge with QuickBooks Accounts for more information. 

3.3.8.4 Consignment and Memo Items Returned to Stock 
If the item is returned, the user must determine whether the item has been paid for and is now owned 
merchandise or whether it is still under memo or consignment liability.  The Edge treats a returned 
consignment or memo item as owned merchandise because a payable date was set and is accounted for.  
To remove a payable date, go to the item record Supervisor menu and select Remove Payable.  

3.3.8.5 Consignment and Memo Items Returned to Vendor 
To return a memo item to the vendor, use the process described in the section entitled Return to Vendor.   
 
To return a consignment item to the customer, remove the item from inventory as with any other item by 
marking it Return to Vendor.  The difference is that you refer to the Owner field to determine to whom 
it should be returned. 
 

3.3.9 Assembling an Item 
The Edge allows you to assemble new items from existing inventory while retaining full details of the 
individual parts involved.  It also allows you to disassemble items into their component parts while 
keeping a record of the original piece.  Part records are automatically cross-referenced in the software so 
that if you look up an item that has been consumed as a part towards an assembled piece, that part item 
will have a link to the final piece and vice-versa.  Check your System Options to ensure these features 
are turned on.  
 
There are three ways to assemble items: 
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Assemble Allows you to create a built or assembled item from scratch. 
Template Allows you to create a built or assembled item from a template using the Add Template 

option.  Templates are created from the Supervisor menu of the original item by 
selecting Create Template.  It is useful to create a template for a specific set of tasks 
that might later be used as part of a larger effort, e.g., welding or mounting. You can 
make changes after you’ve pulled in the template.  

Previous Allows you to duplicate a previously built or assembled item.  You can make changes 
after you’ve pulled in the previously assembled item. 

3.3.9.1 Creating an Assembled Item from Scratch 
To create a new item assembly:  
 
1. Select Inventory ► Items ► Assemble.  The New Item window will appear with the Parts tab 

open. 
 

 
 
Options in the Parts tab include: 

 
Add A Part Allows you to add a part that is required for the assembly. 
Remove Part Allows you to remove a part from the list. 
Part Details Allows you to view the part details entered when the part was added. 
Set Primary Part Allows you to indicate that a part is primary to the piece.   

 

If this option is selected, then the resulting item details 
fields will be populated according to this part; this also 
means that the resulting item category will match this 
part category. 

 
2. To add a part, from the New Item ► Part tab, select Add a Part. The New Part window will 

appear.  
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Fields and options in the New Part window include: 

 
Task Labor or other task associated with working with this part. Each part must 

be associated with the task that first attaches the part to the finished item. 
Item # If an inventory item, the item ID for the part. 
Status Whether the part is in inventory. 
Quantity The quantity of the part required for the assembly.  The second quantity 

field is only used when measure is involved. When using melee diamonds, 
you would specify both the number of stones (quantity) and the total 
weight (measure). 

Units The unit of measure of for the quantity; this will apply to bulk item parts. 
Price Each Pricing information for this part.  They will automatically populate for 

inventory parts and will need to be filled in for non-inventory parts.  You 
will be prompted to confirm this. The exception to this is when adding 
bulk parts as quantity will be required.   
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Cost Each The cost of the part.  This is populated automatically based on the entries 
you made.  To specify cost for non-inventory items, select Supervisor ► 
See Cost. 

Vendor The vendor from whom the part is to be obtained. 
Vendor Style # The vendor’s style number.  Optional. 
Barcode The barcode of the part.  Optional. 
Metal Type If made of metal, the metal type.  Optional. 
Metal Color If made of metal, the metal color.  Optional. 
Metal Finish If made of metal, the metal finish.  Optional. 
Metal Weight If made of metal, the metal weight.  Optional. 
Item Style The item style (motif) of the part.  Optional. 
Size  The size of the part.  Optional. 
Length The length of the part.  Optional. 
In Stock and 
Ready to Use 

Used to indicate that this item is in inventory and ready to be part of the 
assembly job.  This box gets automatically checked when adding 
inventory parts.  Optional. 

Ordered Whether the part was ordered.  Optional. 
Received Whether the part has been received.  Optional. 
Canceled Whether the order was canceled.  Optional. 

Camera icon ( ) Displays photo menu to capture one or more images of the item.   

Description A description of the part beyond the fields described above. 
 

When adding a part from inventory, many fields will automatically be populated with the details 
from the item record you specify.  You cannot change them.  When adding a non-inventory part, 
these fields will remain blank.  You can fill out as many or as few as you like.  The only required 
field is Description. 
 

3. Use the Task drop-down menu to choose which labor task first attaches the part to the finished item.  
 

 

By default, when you create a new assembly item, there is one labor task created 
called Assemble.  Use this drop-down to add additional tasks. 

 
4. If an inventory item is to be used as a part, select that item from the Item Number field.  You can 

enter the item number directly or select from the Item Number drop-down menu.  For non-
inventory parts, skip this field.  

5. Complete remaining fields as appropriate. 
6. Once all part information has been entered, select one of the Save options to finish adding that part.   
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When adding multiple parts, use the Save & New button to save the current part 
and immediately open a New Part window to add the next part. 

  
7. Added parts will appear in the Parts tab.  Inventory items will appear with their SKU number while 

non-inventory items will just appear with their description. 
 

 
 

8. To access the Part Details window, select a part and select Part Details.  This window is identical 
to the New Part window.  Use this to make changes to existing parts. 

9. Use Set Primary Part  to specify a part to be the Primary Part of this assembled piece.  The Edge 
will automatically copy key details from the primary part (such as vendor and style).  This is 
optional. 

 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 117 
© 2020 Abbott Jewelry Systems, Inc. 

 

With IUOM and PRE inventory used as parts, it is important to treat consumption 
for service jobs to account for both the amount (ct, grams, etc.) and the quantity (1 
diamond, 1 piece, etc.)  For service, it means creating a part line for each part and 
enter the unit of measure.  For example, if you use three .10-ct diamonds for a job, 
you must specify this by adding three separate parts, each being .10 carats.  Do not 
add one part of .30 carats as this would not properly reduce the physical quantity 
available in stock and your resulting inventory would be off. 

 
10. The Edge allows you to detail and account for the labor required to assemble an item.  To add labor 

associated with a task, select the Labor tab from the New Item window.  It will appear with an 
automatically generated labor task named “Assemble.”   

 

 
 

The Assemble task automatically includes a price for the parts (items) being assembled 
together.  You may also specify labor or other pricing associated with this task.  The Parts, Labor, 
and Other prices for all tasks will be summed and suggested as a new price for the assembled item 
when the item is saved.  You can add additional tasks to the assembly by selecting Add Task.   
 
Options in the Labor tab include: 
 
Move Task Up To ensure chronological order of tasks, use this to move a task up in the 

list. 
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Move Task Down To ensure chronological order of tasks, use this to move a task down in 
the list. 

Add Task Add an additional labor task. 
Add Template Adds a template to this job.  It will add one or more tasks and one or 

more parts to this job as created from a previous assembly using the 
Supervisor menu. 

Done/Undone Task Mark the task Done or Undone. 

Cancel/Uncancel 
Task 

Remove the task from the list.   

Task Details Opens the Task Details window so you can make changes or add parts 
for the specific task. 

Done All Tasks Marks all tasks in the list Done and moves it into stock. 

ETA The estimated date the work should be complete. 
 
11. If there is a labor charge associated with this assembly, you can enter the amount into the Labor 

field. 
12. To add specific steps to the labor, select Add Task.  A new task line will appear. 
13. Enter appropriate notes for the task. 
14. To enter additional details, select Task Details.  The Task Details window will appear. 
 

 
 

15. Make the desired changes, including adding task-specific part information in the parts tab, and 
select OK.  You’ll be returned to the New Item window. 
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In Assemble Item, the Add button on the Stone tab is disabled.  You cannot 
directly add stones to this assembled piece.  Instead, any stones must be added 
under the Assembled tab as a part.  We do not recommend using non-inventory 
items to represent stone parts because they lack the supporting inventory record 
and therefore the stone information will not appear on the Stones tab of the final 
assembled item.  Instead, you should add the stone to inventory so they can be 
added as inventory parts.  Stones will be moved to the Stones tab after the item is 
complete. 

 
16. After entering part and labor details, you must complete the assembled item entry on the General 

tab.  This is described in more detail in the section entitled Adding an Item.  You may complete 
other tabs described there as well. 

17. Select OK/Save & Close. 
18. To save the item as a template, from the Item window Supervisor menu, after the item has been 

saved, select Create as a Template and select Save & Close. 
19. You will be prompted to print an envelope.  Select Yes to print an envelope if needed. 
 
On saving this newly assembled piece, all of its parts that came from inventory will have their status 
changed from In Stock (I) to Consumed (U).  Additionally, there will be a new button visible on the 
consumed part’s item record that links to the assembled piece. 

3.3.9.2 Creating an Assembly Template 
Templates are useful for frequently assembled items or items with similar assemblage.  All the tasks and 
parts are imported to the new item, along with the description.  To create a template: 
 
1. Open the assembly that you want to make the template (it can be the resulting item record when you 

completed an assembly). 
2. From the Supervisor menu, select Create as a Template. 
3. Select Save & Close.  The template will be named after the vendor style number.  Certain options in 

the Item window will no longer be available, but the template will be available for future 
assemblies. 

  

 

The parts identified in a template are placeholders. You must specify actual parts 
so they will match actual inventory. 

3.3.9.3 Creating an Assembled Item from a Template 
To create a record for an item assembled from a template: 
 
1. From the Inventory menu, select Item ► Assemble. The New Item window will open. 
2. From the Labor tab, select Add Template.   
3. Use the item filter to locate the template.  Note that only templates that were marked as such in the 

Item ► Supervisor menu will be found.   
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4. Repeat steps 2 and 3 as needed. 
5. Add additional parts and tasks as needed and as described in the section entitled Creating an 

Assembled Item from Scratch.   
6. Save the item. You will be prompted to print an envelope.  
7. Select Yes if desired. 

3.3.9.4 Creating an Assembled Item from a Previous Item 
To create a record for an item assembled from a previous item: 
 
1. From the Inventory menu, select Item ► Find.   
2. Find and open the item from which you wish to create the new item.  
3. Select Save and Duplicate. 
4. Make changes as needed and save the record. 

3.3.9.5 Assembled and Built Item Supervisor Menu 
Two functions available in the Assemble and Build Supervisor menu in addition to other item functions. 
 
Change to Work in Progress Allows you to indicate that the item is not done and should not be 

put into stock.    
Change to In-Stock Allows you to indicate that the item should be considered done and 

put into stock.  This will automatically mark all the tasks associated 
with the job as "done."    

3.3.10 Building Items 
Building items differs from assembling them in that it is designed to build items of your own design, for 
your own product line or brand, with separate accounting and controls, whereas assembly is better suited 
for simple pairing of parts such as a semi mount and a center stone.  
 
While an item is under construction, it is labeled as Work in Progress (W) in the item database.  It will 
be changed to in-stock after the item is complete. 
 

 

Built items must use a store-created vendor, such as My Brand, which you should create 
in Inventory ► Vendors. 

 
While an item is under construction, it is labeled as Work in Progress (W) in the item database.  It will 
be changed to in-stock after the item is complete. 
 
For a video tutorial about working with building items, go to 
http://www.screencast.com/t/w796zMHTQRxk. 

3.3.10.1 Creating a Built Item from Scratch 

http://www.screencast.com/t/w796zMHTQRxk
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To create a record for a build item: 
 
1. From the Inventory menu, select Items ► Build ► From Scratch.  The New Item window will 

appear with the General tab open. Notice that the Vendor field is populated by default with a list of 
“My Brand” vendors. 
 

 
 

2. Complete the fields as needed for the item record.   
3. Select the Parts and Labor tabs and add parts and labor as described in the section entitled Creating 

an Assembled Item from Scratch. 
4. If you wish to save this item as a template, select Supervisor ► Create as a Template.  The 

template will be named according to the vendor style number. 
5. You will be prompted to print an envelope.  Select Yes to print an envelope if needed. 

3.3.10.2 Creating a Built Item from Template 
Templates are useful for frequently build items or items with similar construction.   
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To create a template, from the Item window Supervisor menu, after the item has been saved, select 
Create as a Template and select Save & Close.  The template will be named after the vendor style 
number.  Certain options in the Item window will no longer be available, but the template will be 
available for future work. 
 
To create a record for an item build from a template: 
 
1. From the Inventory menu, select Build ► From Template.  The Build Item Template Find filter 

will appear. It works like the Item Find filter.  Note that only templates that were marked as such in 
the Item ► Supervisor menu will be found. 

2. Enter filter parameters as desired and select OK.  A list of templates will appear. 
3. Select the template with which you wish to work and select Select.  The New Item window will 

open. 
4. Create the build item in the Parts and Labor tabs as described in the section entitled Creating an 

Assembled Item from Scratch.  
5. To incorporate another template, from the Labor tab, select Add Template. 
6. Save the item.  You will be prompted to print an envelope.   
7. Select Yes to print an envelope if needed. 

3.3.10.3 Creating a Built Item from Previous 
To create a record for an item build from a previous item: 
 
1. From the Inventory menu, select Build ► From Previous.  The Item Find for Previous Built 

Items filter will appear.  It works like the Item Find filter.  Results will include templates but you 
do not have to use a template.  Also, by default, Built will be selected in the filter, but it can be any 
item type.  Built or assembled items will bring up tasks; other item types will have no tasks. 

2. Enter filter parameters as desired and select OK.  A list of previously built items will appear.   
3. Select the item you wish to replicate and select Select.  The New Item window will open. 
4. Proceed with creating the item in the Parts and Labor tabs as described in the section entitled 

Creating an Assembled Item from Scratch.     
5. You will be prompted to print an envelope.  Select Yes. 

3.3.11 Finding Built or Assembled Items and Parts 
Because they result in items, assembled and built items and their parts can both be searched for with the 
standard inventory Find filter by going to Inventory ► Items ► Find.  For the convenience of your 
shop staff, these jobs can also be found under Services ► Find ► Job. 
 
To search for assembled or built items in inventory, check the Assembled or Built boxes on the Type & 
Status tab of the Find filter.  As always, the Presets feature allows you to save search parameters for 
future use.  See the section entitled Presets for more information. 
 
To search for items that have been associated with a job but are still be in the store and might possibly be 
taken away from the job for some other purpose, check the Consumed Here box on the Type & Status 
tab of the Find filter.  In contrast, the Consumed Gone status will show parts that have been consumed 
but are not available for repurposing.  
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3.3.12 Editing Built or Assembled Items 
You can review and edit assembled and built items in inventory.  To do so, first find the item in 
inventory and edit it.  Assembled items will have slightly different tabs.  To review the assembly details 
of assembled items, select the Parts and Labor tabs as described in Creating an Assembled Item from 
Scratch.   
 
To edit or review the details of a part, select it and select Part Details on the bottom of the assembled 
tab.  To review the labor details, click the Labor tab from the assembled tab. 
 
It may be necessary to cancel a work in progress before it is complete, but after the record is created.  
When you do this, if there are parts attached to the built item, you will be prompted to indicate what to 
do with the parts that have been allocated to it.  This window allows you to put the items back in stock or 
scrap them.   
 
If you create a build item and have not allocated any parts or completed any tasks, when you cancel it, 
the item becomes deleted.  You will not be asked to re-allocate parts because none were specified.  If 
tasks are completed or a part is allocated from inventory, you will only be able to cancel the job; the item 
will still exists as cancelled. 

3.3.13 Item Disassembly 

3.3.13.1 Disassembling a Stock Item 
The take-off, or disassembly, process consists of finding and editing an in-stock item you want to 
disassemble.  To disassemble a stock item: 
 
1. Use Item ► Find, described in the section entitled Finding and Editing an Item, and open the 

record of the desired item. 
2. Go to the Disassembled tab. 

 

 
 

3. From the bottom left corner, select Create a Take-Off.  The New Item window will appear. 
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A take-off is a new component that you are taking away from the original item.  You should create a 
new take-off for each part that the item is getting broken down into.  For example, if you were 
disassembling a ring with a single diamond mounted, you would create two take-offs: one for the 
diamond and one for the ring mount.  You can create as many take-offs as necessary to completely 
account for the disassembly of an item.  The full details of the original piece you are disassembling 
will be automatically copied into this New Item window.   
 

4. Modify these details so that this new item represents one part of the original item.   
5. When finished modifying, select OK or Save & Close to add this as a Take-Off. 
6. Repeat this process to create each of your component parts. 
7. To view take-off details, select Take-Off Details. 
8. To remove a take-off from a disassembly, select Undo A Take-Off. 

3.3.13.2 Disassembling an Assembled Item 
Disassembling an item you had previously assembled in the store is a different process from 
disassembling a stock item.  You do not make use of the Disassembled tab or create Take-Offs. 
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To disassemble an assembled item, start by finding and editing it in inventory.  Then, go to its Parts tab.  
Here you will be presented with a list of the individual parts that were used to make up this item. 
 

 
 
Use the Remove Part button to individually remove each part from this item.  For stock parts, they will 
be restored to in stock status in inventory under their original stock number.  Miscellaneous parts will be 
removed without affecting any inventory since they never existed in inventory in the first place.  You 
can add them as new items (with a backdated entry date) if you wish. 

 

 

Even after removing all parts, the inventory record will remain.  You should delete it 
to avoid any confusion. 

3.3.14 Collections 
The Edge Collections feature allows you to group items as part of a collection.  An item can belong to 
more than one collection.  Once the item has been designated as part of a collection, that information can 
be used for marketing, reporting, and suggestive selling.  For example, a collection item sold at point of 
sale can be set to prompt the salesperson to offer additional pieces in the collection.  Another use for the 
Collections feature is to help identify items that were presented together as part of a sale flier or catalog.   
 
There is not a specific report for collections, but because Collections is now a filter item in the Item 
Find filter, which is also used for inventory reports.  These allow you to obtain data concerning the 
success of a particular collection, whether it be a product line or items featured in a particular promotion.  
Coupling the Collections option in the filter and the Collections group-by option, you can obtain a 
variety of information concerning collections.   
 
Collections can be enabled or disabled through System Options. 
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3.3.14.1 Creating Collections 
To create a new collection: 
 
1. From the Inventory menu, select Items ► Collections ► Add.  The New Collection window will 

appear.  
 

 
 

Fields and options in the New Collection window include:  
 

Collection Name The name for the collection.   
Collection Sub Name The name for a sub-collection, if desired.   
Start Date The date the items in the collection will begin to pop-up at point of sale.  

If this is left blank, the collection will start immediately.  
End Date The date the items in the collection will cease to pop-up at point of sale.  

If this is left blank, the collection will continue indefinitely.  
Add to Collection Used to add an item to the collection. 
Remove Removes the item from the collection.  It does not change the inventory 

status. 
 
2. Enter a name for the collection. 
3. Enter a name for the sub-collection, if desired. 
4. Use the date pickers to select a start and end date for the collection if desired.  If the end date needs 

to be extended, or is you wish to reactivate the collection, change these dates as needed. 
5. At least one item must be added; select Add To Collection.  A collection line item will appear.   
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6. Locate the desired vendor using the Vendor drop-down menu. 
7. Locate the desired style number using the Style drop-down menu.  Alternatively, use the Find Item 

option to locate an item using the Item Find feature. 
 

 

To quickly enter items into the collection, scan them in. 

 
8. Repeat as needed to add all the items to the collection. 
9. Select OK/Save & Close.  The items can now be found when searching by collection using the Item 

Find feature.  Also, the collection items will now appear as suggestions at point of sale, provided 
System Options are set accordingly. 

3.3.14.2 Finding and Editing Collections 
To change the content or dates of a collection: 
 
1. From the Inventory menu, select Items ► Collections ► Find.  The Find Collections filter will 

appear.  As always, the Presets feature allows you to save search parameters for future use.  See the 
section entitled Presets for more information. 

 

 
 

Fields and options in the Find Collections filter include: 
 

Start Date Returns collections with a matching start date range. 
End Date Returns collections with a matching end date range. 
Vendor Returns collections that contain items from this vendor. 
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Style Returns collections that contain this style number. 
Collection Returns collections with matching key words in the name of the collection. 

 
2. Select parameters as desired.   
3. Select OK.  A list of matching collection records will appear.  From there you can edit a collection 

or add another collection. 
 
To edit or add items to a collection: 
 
1. From the results provided by the Collection Find function, select a collection record and double 

click it.  The Collection window will open; it will contain the same fields as described in the section 
entitled Creating Collections. 

 

 
 

2. Make changes as required. 
3. Select OK/Save & Close. 

3.3.15 Inventory Levels 
The Levels function allows you to view your inventory on a vendor and style basis.  This works in 
concert with the Rapid Reorder form, and in turn, the Purchase Order feature, to help you maintain 
optimum inventory levels.  It is also a useful tool for monitoring stock quantities and also offers a fast 
way to gauge a particular style’s performance by displaying some of the more pertinent statistics.  
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Additionally, it allows you to set minimum and maximum stock levels per style to ensure they are never 
out of stock.  Levels are best when initially set in the General tab item record. 
 
The Levels feature operates much like the Find Items function, though it is most useful when used in a 
broad sense, such as to view the performance of an entire category or specific vendor.   
 
To work with levels as a group:   
 
1. Use Items ► Levels, using a filter similar to that described in the section entitled Finding and 

Editing an Item, to find a list of items matching your criteria.  The Levels interactive grid will 
appear. 

 

 
 

Buttons and fields include: 
 

Store Drop-
Down 

Multi-store only; filters styles by store.  Only styles with levels set per store (not 
company) will display. 

Edit Levels Unlocks levels fields allowing you to set Min and Max quantities.  For multi-
store, use the accompanying Set Individually/Store button to toggle between 
setting levels by company (all stores combined) or per store. 

Transfer Multi-store only; use this button to select items to transfer to other stores.  Note 
this button is only available on style lines where there is quantity in stock. 

Vendor The vendor of this particular style. 
Style # The vendor’s style number. 
Store Multi-store only; displays break down by store for each style.  The first row of 

each style will show Totals if managing per store or All if managing by 
company. 

Min User-defined minimum stock quantity for that style. 
Max User-defined maximum stock quantity for that style. 
# In Stock Quantity of this style currently in stock. 
On Order Quantity currently on a PO that has not been received or canceled. 
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Avg Days On 
Hand 

The average of the number of days the in-stock items of this style have been in 
stock. 

MR Recv The date of the last time a piece matching this style was entered into inventory. 
# Sold Total number of this style sold. 
Avg Days to 
Sale 

The average of the number of days the sold items of this style remained in stock 
before being sold. 

MR Sold The date of the last time a piece matching this style was sold. 
# SPO Of # Sold, this quantity were sold on special orders. 
Retail The retail price for this style. 
Cost The cost for this style. 
# Other  The number of this style in inventory under statuses other than In Stock and 

Sold including consumed, items on layaway, assembled, disassembled, built, 
etc. 

Do Not 
Reorder 

Mark this style to never be reordered. 

Discontinued Mark this style discontinued. 
Description The description of this style of item. 

 
2. To see the underlying item records for a style, select the line and click See Items in the bottom left. 
3. To change the minimum and maximum level fields, use the Set Levels button in the top right. 
4. After setting levels, be sure to click the Save Levels button in the top right. 
5. To indicate the item should not be reordered, select Do Not Reorder.  The item will not appear in 

the Rapid Reorder form or report.  Styles marked with this value will not show up on the Rapid 
Reorder form or Rapid Reorder report.  However, they will still show up in the Vendor Style 
drop-down menus for item add and purchase orders. 

6. To indicate that the style is no longer available from the vendor, select Style is Discontinued.  The 
item will not appear in the Rapid Reorder form or report.  Styles marked with this value will not 
show up on the Rapid Reorder form or Rapid Reorder report, nor will they show up in the 
Vendor Style drop-down menus for item add or purchase orders.   

3.3.15.1 Managing a Style 
To adjust the minimum and maximum stock levels of a particular vendor’s style: 
 
1. Perform an Item Find. 
2. Select a particular style from the resulting list and select Edit.  Alternatively, double-click on a 

style. 
3. Use the Supervisor menu to Unlock level fields.  
4. Enter desired quantities into the Minimum level and Maximum level fields.  To set an item as 

“never out,” set the minimum to at least 1. 
5. Select a save option to retain these settings. 
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Additional options on this window include: 
 

See Items Returns a list of inventory matching this vendor and style. 
See Cost Located on the Supervisor menu, displays cost. 

3.3.16 Move Item 
The move item feature requires set up of locations.  For more information, see the section entitled 
Locations.  Once locations are established, The Edge can allow you to relocate inventory within the store 
from one location to another.  To do so:     
 
1. Select Inventory ► Items► Move.  The Move Items window will appear. 

 

 
 
The Move Items window is divided into three sections: 

• The top part is for setting inventory input type, entering item numbers, and managing other 
settings. 

• The first window provides a list view of inventory as it is scanned or entered. 
• The second window provides a picture view of items scanned and added to the results.   

Specific fields and options in the Move Items window include: 
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Scanning Indicates input methods: 

Item Number By input to the keyboard in the form of the item number that appears 
on the tag.   

Item Barcode By barcode scan. 
Old Item Number By keyboard entry; a stock number produced by another system.  
Old Barcode By scan of a barcode from a previous system. 

Item The value scanned or to allow for manual entry. 
Location Allows you to select a specific location within the store to which items 

should be moved.    For more about working with locations, see the section 
entitled Locations. 

Clear Clears the window.  This does not clear the move activity, it just refreshes 
the window. 

Close Items are saved as you scan.  This closes the Move Item window. 
Print List Prints a hard copy list of the inventory.  You will be prompted to indicate 

which portion of the window to print. 
 
2. Select the method of scanning, i.e., the field to be captured with the barcode scan, to be used from 

the options described above. 
3. From the Location drop-down menu, select the location of the item in the store, such as CASE1 or 

WALL1.  Depending on settings in System Options, this may be required. 
4. If you have opted to manually enter item numbers by keyboard, you should type them into the Item 

field.  If you are scanning items, note that the barcode will appear in the Item field.   
5. Enter the item to be moved. 
6. The item listing will appear in the middle portion of the Move Items window and an image, if 

available, will appear in the lower portion. 
7. When moving is complete, select Close.  The item record will reflect that location. 
 

 

To recategorize items, use Supervisor ► Move to new category. 

3.3.16.1 Best Practices 
Consider adding Move Locations as a standard practice in your store when displaying your cases.  For 
example, if you begin your day by deciding what will be displayed in the window case, make it 
procedure to record this movement of items when you make the move. 

3.3.17 Photographing an Item 
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The Edge allows you to store a photograph of an item for verification purposes.  This can be very helpful 
to confirm inventory records against transactions, but also for security when dealing with repairs and 
estimates.  To include a photo of an item in the record: 
 

1. From the Add Item window, select the camera icon ( ).  A context menu will appear in which 
the image options.  For details about the options in this menu, see the section entitled Adding and 
Managing Photos.   

2. Select Acquire to activate the camera. 
3. Turn the focus ring on the camera to obtain optimum picture (Watchport V/2 only). 
4. Adjust shelf height if necessary to get optimum depth of picture.   
5. Select Save from the Acquire window to take the picture.  The image should now appear on the 

item window.  This option may vary according to camera manufacturer. 

3.3.18 Cloud Images 
The Cloud Images feature allows you to link The Edge to a cloud storage drive.  This facilitates the 
seamless use of smartphone cameras to acquire photos. 
 
For information on setting up and using, see this website: 
http://download.edgeuser.com/EdgeUpdates/CloudImages/CloudImages.html 

3.3.19 Re-Costing Items 
Re-costing frequently happens when you are adding inventory or editing inventory records.  To do so: 
 
1. Locate the item using Item ► Find. 
2. From the desired item record, select Supervisor. 
3. From the context menu: 

a. To see the cost, select See Cost. 
b. To see the re-cost, select See Re-Cost. 
c. To change the re-cost value, select Change Pricing, which allows you to edit the Re-Cost 

field. 
 

 
 

http://download.edgeuser.com/EdgeUpdates/CloudImages/CloudImages.html
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4. Change the value to the desired amount. 
5. You will be prompted to record the re-cost date. 
6. Select OK/Save & Close. 
 

 

• When new items are received, the cost that is entered is what is considered the 
current re-cost. 

• To re-cost multiple items, use the Re-Cost feature in the Reprice function as 
described in the section entitled Reprice Items. 

 

To allow an associate to re-cost items, go to Administrative ► Associates ► Security. 

3.3.20 Spot Metal Pricing 
The Spot Metal pricing method allows you to sell inventory by metal type & weight.  The Edge contains 
a Metal Prices function that allows you to set current metal prices.  This must be manually updated, but 
can be done so quickly and will automatically apply the new metal price to all in stock inventory.  There 
is also a system option that can be set to prompt the associate for the current metal price when they 
attempt to sell the item at POS.  

3.3.20.1 Setup 
Before you can begin using spot metal pricing there is initial setup you must complete.  Please see the 
following sections: 

3.3.20.1.1 System Options 

There are two system options related to spot metal pricing located under Inventory Options. 
 

Prompt for Spot Metal 
Price when Selling 

When a spot-priced metal is sold, this indicates whether you want The 
Edge to automatically prompt you for the current metal price at POS. 
 

Prompt for Spot Metal 
Time Out 

Only applicable if Prompt for Spot Metal Price When Selling set to 
True, this defines a timeout period in minutes.  If the spot price has not 
been updated in this timeframe it will prompt.  Set to 0 to prompt 
every time an item sold. 

Spot Metal Pricing 
Website 

The website used to obtain metal pricing.  This does not automatically 
update anything in the software; instead, this website will appear as a 
link in the metal pricing window. 

3.3.20.1.2 Metal Types 

The Edge will load with a list of default metal types.  To add, view, or edit additional metals: 

1. Click Administrative ► Lists.  This will display the List of Lists window. 
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2. Check Show System Lists at the bottom. 

3. Select SpotMetals from the list and Edit it.  A list of current spot metals will appear. 

 
4. From here, you can use Delete Item to delete an unwanted metal, Edit Item to edit an existing 

one, or Add Item to create a new one.  When adding, you will need to specify both a short 
value (abbreviation) and long value (spelled out). 

 
Each metal needs to be mapped to a Metal Type and assigned a Metal Value.  For example, 10k karat 
gold has a purity of approximately 41 percent gold.  The Edge will load default values for you.  To add 
or change mapping: 

1. Click Administrative ► Metals Setup.  The Metal Mapping Setup window will appear.  

 
 

Store Metal Value The name of the metal in your store as defined in the SpotMetals list. 
 

Metal Type The type of metal to map to; these are hardcoded and cannot be 
changed.  Options include Gold, Silver, Platinum, and Palladium. 
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Metal Value The purity value of the metal. 

 

2. Each Store Metal must be mapped to a Metal Type and assigned a purity.  You can edit existing 
mappings, add new with the + Metal Mapping button, or remove mappings with the Red X 
button. 

 

3.3.20.2 Metal Prices 
After spot metals have been setup and mapped to metal types, you can use the Metal Prices feature to 
enter spot prices based on current market values.  This must be done manually, but can be done quickly 
and will update all relevant item pricing instantly.  There is also a system option that can be enabled to 
prompt the associate to check and update metal pricing right from POS if a spot metal priced item is 
being sold. 
 
To set metal prices: 

1. Click Inventory ► Metal Prices.  The Metal Pricing window will appear. 

 
2. Each metal will be listed with the last entered price.  To update a price, simply enter it next to 

the type of metal and click OK. 
 

 

The calculator provided here allows you to calculate prices for reference purposes only.  
This information is not stored anywhere. 

3.3.20.3 Creating a Spot Metal Pricing Category 
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Unlike other pricing methods, spot metal priced items require their own category.  This category can 
only contain items of this pricing method, and likewise, categories set to any other pricing method will 
not allow the entry of spot metal priced items. 
 
To create a category for spot metal pricing: 

1. Click Inventory ► Categories ► Add. 

2. On the General tab, use the Pricing Method drop-down to select Spot Metal Pricing and use 
the Unit of Measure drop-down to select DWTs or Grams.  Fill out other fields on this tab as 
described in section Adding a Category. 

 
3. Click on the Pricing tab and enter a markup.  Unlike other categories, you can only specify a 

single markup.  This is multiplied by the metal cost to calculate retail price. 
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4. Click on the Details tab.  The first detail will default to Metal and will be linked to your list of 
spot metals.  This detail is hardcoded and cannot be changed.  Add other details as described in 
section Adding a Category. 

 
5. Complete other tabs as desired, then save the category. 

3.3.20.4 Adding a Spot Metal Pricing Item 
Before you can add items of this pricing method you must first create a category for them.  Spot metal 
priced items can only be entered into categories setup specifically for this pricing method.  See Creating 
a Spot Metal Pricing Category for information on how to setup a category. 
 
To add a spot metal priced item: 

1. Click Inventory ► Item ►Add ► Item.  The New Item window will appear. 

2. Select a category that you have setup with the spot metal pricing method. 

3. Specify a vendor and vendor style.  After you enter a vendor style # the Allocation window will 
appear. 
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4. Specify Cost Per Measure, Invoice #, Description, and Total Measure being received, then 
click OK. 

5. This will bring you to the quantities tab of the item and a window will appear allowing you to 
select the type of metal for this item.   

 
6. This metal type appears on, and can also be changed from, the General tab.  Choose the correct 

metal from the drop-down and click OK.  The quantities tab now displays your entry. 

 
7. Click on the General tab.  There are two fields here unique to spot metal pricing:  Labor and 

Labor Cost.  Labor is for the retail price of labor; this gets added to the price when this item is 
sold.  Labor Cost is the cost for this. 

 
8. Complete remaining tabs as described in the section Adding an Item (Standard) and save your 

new item. 
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3.3.20.5 Selling a Spot Metal Pricing Item 
To sell a spot-priced item: 

1. Go to POS.  Specify the associate and customer. 

2. Click Sell Item and enter the item’s number.  Alternatively, you can scan its barcode.   

 
3. Enter the quantity being sold. 

4. If you have the system option enabled a window will appear asking you to input the current 
metal price.  Otherwise, it will calculate retail based on the last entered price for the metal. 

 
5. The retail price will be calculated.  If you entered an amount in the Labor field on this item 

record then this will be added to the retail price. 

6. Proceed with the rest of the sale as you normally would. 
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 Purchase Orders 
The Purchase Order feature is part of a larger inventory management system offered by The Edge that 
consists of a number of features that work together:  item records, Inventory Buying Tools, the Levels 
feature, the Rapid Reorder feature, special orders, purchase orders, and item intake.  This section 
covers purchase orders and describes how to order items queued from special orders, item records, or the 
Rapid Reorder feature (see the section entitled Ordering Reports) and receive them into inventory.   

3.4.1 Adding a Purchase Order 
To create a new purchase order:  
1. Select Inventory ► PO ► Add.  The Purchase Order Add window will appear. 
 

 
 
Fields and options in the Purchase Order Add window include: 
 
Vendor The vendor to whom this purchase order will be submitted.  
Show vendors with 
queued orders only 

Enabled by default, populates the Vendor drop-down list with vendors 
who have open purchase orders. 

Edit Vendor Returns the vendor record so you can review details or make changes.  
The changes will be reflected immediately. 

Show Images Enables the image column on the window.  It does not affect images on 
the purchase order when printed or emailed. 
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PO # The Edge-generated purchase order number; it will be created when the 
purchase order is saved. 

Ship Via The shipping method or carrier.  Shipping methods can be managed from 
Administrative ► Lists.  The list name is Shipping Methods. 

ETA The estimated date of arrival based on typical vendor delivery time.  It 
cannot be earlier than the current date and cannot be changed after the 
purchase order is submitted. 

Date Ordered Shows the date the order was submitted.  This will not appear until the 
purchase order has been submitted. 

Note Allows you to enter notes about the order. 
PO Store Multi-store only; assign this PO to a store.  Leaving this blank will mark 

this PO as ‘Unassigned.’  It is not necessary to assign a PO to a store. 
Ship To Store Multi-store only; which store to ship the items to.  This can differ from 

the PO Store. 
Add Line Allows you to add a line item to the purchase order.  It is disabled after 

the purchase order is submitted. 
Delete Line Allows you to delete a line item from the purchase order.  If the item 

came from the queued item list, it will be returned there. 
 
2. Select the vendor for this order.  The Retrieve Queued Items and Special Orders window will 

appear.  Note that if you choose a vendor for whom a purchase order exists, you will be prompted to 
open that purchase order and add items to it. 
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For the purposes of the Retrieve Queued window and the Purchase Order window, line items will 
be color-coded as follows:  
 

Yellow Queued items 
Purple Special order items 
Dark Red Marked to be cancelled 
Red Cancelled 
Light Yellow Other 
Blue Selected 
Light blue Hovering 

 
3. Select the items to be added to the purchase order.  From here you can only change quantity and 

cost. 
4. Select OK.  The Purchase Order Add window will be populated with the items. 

 

 
 
5. If needed, use Retrieve Queued to go back to the Retrieve Queued window and select more items.  
6. Select a shipping method from the Ship via drop-down menu. 
7. Enter notes in the Notes field to place a note on the order (optional). 
8. Enter an estimated time of arrival in the ETA field.  This can be set for the entire purchase order or 

for each item line. 
9. To add more items, select Add Line.  If this order is for a style that has been in stock before, select 

the vendor style from the drop-down menu.  If this order is for a new style, type in its vendor style 
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number and basic details.  As a shortcut, you can scan item tags and special order envelopes to 
quickly create line items. 

10. Multi-store only; each PO line has a Store drop-down allowing you to select a style for this line.  It 
is possible to have different store numbers on each line if desired.  When received, the inventory 
will allocate to the appropriate store. 

11. Verify and correct data in each item line: 
a. Image 
b. Source 
c. Quantity (must be greater than 0) 
d. Style Code (required).  You may be prompted to copy details from a previous item. 
e. Status 
f. ETA (must be later than the current date) 
g. Description (required) 
h. Category (required) 
i. Cost per item (required). 

12. Choose a save option: 
a. Print Preview:  Allows you to print a purchase order.  This does not submit the purchase order.  

To do so, use Submit & Print. 
b. Submit & Email:  Saves the purchase order in The Edge as ordered and sends the purchase 

order by email to the vendor. 
c. Submit & Print:  Saves the purchase order in The Edge as ordered and sends the purchase 

order to the printer so you can fax or mail it to the vendor. 
d. OK/Save & Close:  Saves the purchase order to be worked on later.  This does not submit the 

purchase order to the vendor or record it as such in The Edge. 

3.4.2 Purchase Order Settings 
Found in both new and existing purchase order records, the Purchase Order Settings option allows you 
to choose information that should appear when printing a purchase order.  To work with purchase order 
settings: 
 
1. From the purchase order record, select PO Settings.  The Purchase Order Settings window will 

appear with the Shipping Info tab open. 
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The Shipping Info tab allows you to change the store to which the order should be sent.  Fields are 
self-explanatory and are populated from your Edge license file. 
 

2. Make changes as needed and select the Email tab. 

 
 
Fields in the Email tab are treated as follows: 
 
Store Email 
Address 

Obtained from your Edge license file.  This cannot be changed. 

To Email Address Obtained from the purchase order vendor email field.  If it is not on the 
purchase order, it will be pulled from the vendor record.  This is needed to 
submit by email. 
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From Email 
Address 

This is the store email address unless otherwise specified in the System 
Option Purchase Order Email Address. 

CC Email Address Allows you to add a carbon copy email to a third party.  To use more than 
one, separate them with a semi-colon (;).  Default addresses can be set in 
System Options. 

BCC Email 
Address 

Loaded from the System Option Purchase Order BCC Email Address.  
To use more than one, separate them with a semi-colon (;).  It can be 
changed here.  Default addresses can be set in System Options. 

Delivery Receipt If the recipient's email system supports it, this will generate a receipt of 
delivery.  This is saved to the Most Recent Settings. 

Read Receipt If the recipient's email system supports it, this will generate a read receipt.  
This is saved to the Most Recent Settings. 

 
3. Make changes as needed in the Email tab and select the Printing Options tab. 

 
 
The Printing Options tab allows you to decide what should appear on the actual purchase order in 
either email or print format.  These options are saved for future use.  Items you can include are:  

• Print Images 
• Print Vendor Account Number 
• Print Vendor Phone Number 
• Print Vendor Fax Number 
• Print Vendor Email address 
• Print Retailer Phone Number. 
 

4. Complete these options and select Done. 
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3.4.3 Finding and Editing a Purchase Order 
To avoid confusion with your vendors, care should be taken in editing a submitted purchase order.  We 
do not recommend resubmitting purchase orders except to ensure The Edge is not expecting an item to 
be entered into inventory. To find, view, or edit an existing purchase order: 
 
1. Select Inventory ► P/O ► Find Orders.  The Purchase Order Find window will appear. 

 

 
 
Fields and option in the Purchase Order Find window include: 
 
PO Number Returns POs numbered in this range. 
Vendor Returns POs for the specified vendor. 
Date Ordered Returns POs with a submission date in the specified date range. 
ETA Returns POs with the specified ETA date range. 
Purchase Order Status Returns POs with statuses as selected below. 

Entered P/O created but not ordered. 
Ordered P/O ordered but none of ordered quantity received. 
Partially Filled P/O ordered and some ordered quantity received. 
Filled P/O ordered and all ordered quantity received. 
Deleted P/O deleted before order was placed. 
Cancelled Order on the P/O was placed, but then cancelled. 

 
2. Enter criteria to find a specific purchase order and select OK.  The Purchase Order list will appear. 
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3. Select the purchase order and select Edit.  The Purchase Order Edit window will appear. 

 

 
 
Fields and options in the Purchase Order Edit window include: 
 
Vendor  Allows you to select a vendor. 
Edit Vendor Returns the vendor record so you can view details or make changes.  

These changes will be applied to the purchase order. 
PO Submitted As If submitted, the method by which the purchase order was submitted. 
PO # The Edge-assigned purchase order number. 
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Ship Via The shipping method or carrier. 
ETA The estimated time of the order's arrival. 
Date Ordered If submitted, the date the order was submitted. 
Note For notes about the purchase order in general. 
Show Images Allows you to see item images.  This is only on the window; it doesn’t not 

affect the actual purchase order when printed or emailed. 
Add Line If not submitted, you can add items to the order. 
Cancel Line Cancels the item from the purchase order and marks the line item 

cancelled.  This option has some contingencies: 
 
• If a selected line has not been saved, it will delete the selected line 

from the purchase order.  If the line came from the Retrieve Queued 
window, it will return it to the queue for fulfillment later. 

• If a selected line has been saved, Cancel Line will cancel the selected 
line on the order.  It will only appear if you have Show Cancelled 
checked.  The line will turn dark red and will be cancelled when the 
purchase order is saved. 

• If a selected line represents ordered items that are partially received, 
the button will cancel the portion of the order that has not been 
received. 

• You cannot cancel fulfilled lines that have been fully received. 
Include Cancelled 
Items 

Allows you to show items that have been cancelled from this purchase 
order.  This option is only visible if there are line items on the purchase 
order. 

Include Received 
Items 

Allows you to show items that have already been received and added. 

Estimated Total Contains a total of the cost of all items in the purchase order.  It is the 
quantity times the cost. 

PO Settings Opens the Purchase Order settings window described in the section 
entitled Purchase Order Settings. 

Submit Email Allows you to submit this purchase order by email.  Appears only if the 
order has not been submitted previously. 

Re-Submit Email Allows you to re-submit this purchase order by email.  Appears only if the 
order has been submitted previously. 

Submit & Print Allows you to submit this purchase order by mail.   Appears only if the 
order has not been submitted previously. 

Re-Submit & Print Allows you to re-submit this purchase order by mail.  Appears only if the 
order has been submitted previously. 
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4. As long as the purchase order has not been submitted, you can make changes to fields, except style 
code.   You can change quantity, category and cost.  After it is ordered, everything but cost is fixed. 

3.4.4 Receiving Ordered Styles 
Styles that are placed on purchase orders and marked ordered will be automatically available to be 
received using the Receive Invoice feature.  Those who manage purchase orders regularly may find it 
more convenient to work from this area.  For more information, see the section entitled Add Item from 
Invoice. 
 
Ordered styles that are subsequently added to inventory will automatically fulfill outstanding purchase 
orders on a FIFO basis (first-in, first-out).  If a style order appears on multiple purchase orders and is 
then received to inventory, the oldest purchase order for that style will get fulfilled.  If you do not use 
purchase orders, it might be best to use add an item, even special orders, directly as described in the 
section entitled Adding an Item (Standard). 

 

 

There is no way to manually specify the purchase order number on a received item.  
The Edge automatically fulfills and links received ordered items against outstanding 
purchase orders. 

3.4.5 Finding Orders 
The Finding Orders function allows you to find orders by item rather than by invoice or purchase order.  
To find an order: 
 
1. Go to Inventory ► P/O ► Ordered Items.  The Find Items on Order window will appear. 
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Fields and options in the Find Items on Order window include: 
 
PO # Returns orders contained on purchase orders numbered in the specified 

range. 
Vendors Returns orders with the specified vendors. 
Categories Returns orders in the specified categories. 
Styles Returned orders with the specified styles.   
Status  

Queued Items Returns orders that have the status of Queued. 
Entered Items Returns orders that have the status of Entered. 
On Order Returns orders that have the status of On Order. 
Canceled Returns orders that have the status of Cancelled. 

Item Type  
Special Orders Returned orders that are a result of a special order. 
Stock Returned orders contain stock items. 

 
2. Complete the search parameters and select OK.  The results will appear in the Items on Order 

window. 
3. To work with an item record, select the item and select Edit.  
4. To cancel the item from an order, select the item and select Cancel Item. 
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 Printing Item Tags 
Every item entered into inventory will have a tag created for it in the tag file. It is recommended that 
entered items be printed in manageable quantities of 30 to 50 items.  Also, when an item is returned, a 
new tag will be created here.   Alternatively, tags can be printed from the Add Item or Edit Item 
window on an individual basis.  The information on the tags will be controlled by choices made when 
setting up the category record.  See the section entitled Adding a Category for more information 
regarding setting up the tag layout on a category.     
 
To print a batch of tags: 
 
1. Select Print Tags from the Inventory menu.  The Tags to be Printed window will appear.   

 

 
 
This window contains the status of the queue of tags to be printed.  Before you begin, make sure 
your printer is loaded with a sufficient number of the correct format tags. 
 

2. Select the method(s) you would like to use to determine tag organization:  
 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 153 
© 2020 Abbott Jewelry Systems, Inc. 

By Station Separates the tags based upon the computer used for inventory entry.  This is 
useful when multiple associates are entering inventory from multiple 
locations.   

By Category Separates the tags by category.  This is useful if you were repricing existing 
inventory by category.   

By Vendor Separate the tags by vendor.  This is useful when used in conjunction with 
the By Invoice option. 

By Invoice Separates the tags by invoice. 
By Store Separates the tags by store.  This is useful in a multi-store environment. 
By Location Separates the tags by case location.   
By Date Entered   Separates the tags based upon the date the items were entered into inventory. 

 
3. Highlight the row of tags you wish to print. 
4. Optionally, enter the number of records you would like to print at one time in the First N Records 

field. 
5. To specify the order in which tags are printed, select Sort tags by drop-down list.  This offers 

Date Status Changed, Item Number, Old Item Number, Date Entered, or Date 
Created. 

 

 

By selecting Include ALL items in stock, not just those to be printed and/or 
Exclude Special Order Items, you can print all tags within the system sorted per 
your specifications. 

 
6. Select Print.  Alternatively, double-clicking on a row of tags will also cause them to start printing. 
7. At the conclusion of printing a row of tags, a window will be displayed showing all the tags that 

should have printed.  This is used to clear the tags from the queue.  If you need to reprint a tag, clear 
its checkbox before selecting OK. 

8. To clear tags that you do not wish to print, highlight the row and select Clear.  Place a check next to 
the tags you wish to delete before selecting OK.   

 

 

Clear can also be used to preview tags that are waiting in queue.  To do so, select a 
row, select Clear, and then, rather than selecting tags for deletion, cancel out. 
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 Printing Signage 
In addition to printing tags, The Edge offers the feature of generating and printing signage.  These are 
signs designed to be on display along with items as opposed to poster-size signs.  Such signs are 
generated from selections made in the Start a Sale function (see the section entitled Start a Sale) or 
Automatic Markdown in the Categories function (see the section entitled Categories).  We recommend 
pre-perforated and colored paper stock on which to print such signs.   
 
Sign templates can be assigned in a few ways: 
 
• Use Administrative ► Start a Sale function to put items on sale.  If you choose a sign when 

creating the sale, signs will be generated for all items involved in the sale. 
• Setup automatic markdown tables for use with Inventory Buying Tools.  Each markdown tier can 

be assigned a sign (if appropriate) and these signs will be automatically generated when AIMS 
Autopilot is run. 

 
To generate signs: 
 
1. Select Print Signage from the Inventory menu.  The Signage to be Printed window will appear.   

 

 
 

2. Select the record containing the type of signage you would like to generate.  You have a few options 
as to the order and number of signs you would like to print.   
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Organize by Location Organizes the signs by the location of the included items within the store. 
Organize by Start 
Date 

Organizes the signs by the starting date of the event.   

Organize by Vendor Organizes the signs by the vendor providing the items. 
First N Records Allows you to indicate the number of signs to print at one time. 
Sort Signage By Sorts by location, item number, or old item number. 

 
3. To generate a preview of the signs before printing, select Print from the lower right corner of the 

window or double-click on the desired record.  The Print Preview window will appear as follows: 
 

 
 

4. If the layout and information are acceptable, select the Print icon on the left side of the toolbar 
across the top of the window.  If you want to further edit the page, select the Close button.  Use the 
arrows in the top left corner to view additional pages.  

  

 

Signs must be created as described in the section entitled Sign Formats before they can 
be printed. 
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 Physical Inventory 
Conducting a Physical Inventory consists of 3 steps: 

1 - Start the Inventory 
 Choose what is being inventoried 

2 - Conduct the Inventory 
 Scan or enter items 

3 - Reconcile & Finish 
 Review and account for discrepancies 
 Finish (close) the inventory 

3.7.1 Step 1 - Start the Inventory 
The Physical Inventory Wizard allows you to select what is being inventoried.  You can do a full 
inventory of the entire store or a filtered inventory for selected criteria (locations, vendors, collections, 
categories, etc.)   

Only one full inventory can be open at a time.  There is no limit to the number of open filtered 
inventories.  See FAQ section for more information on running multiple inventories at once. 

To start an inventory: 

1. Click Inventory > Physical Inventory > Start New Inv.  The Physical Inventory Wizard 
will appear.  Click Next to begin. 

 
 

2. Choose whether doing a Full Inventory or Filtered Inventory, then click Next.  Only one full 
inventory can be open at a time.  If this option is greyed out, you must finish or cancel the 
existing inventory.  There is no limit to the number of Filtered Inventories you can have open 
at once. 
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3. If doing a Filtered Inventory, use the Selection Criteria drop-downs to set one or more 
parameters for items to be included in this inventory.  Leaving a drop-down blank will 
automatically include all values.  Choose criteria and click Next.  If doing a Full Inventory, 
this step is skipped automatically. 

 
4. Enter a Physical Inventory Name, choose whether Layaways should be included, then click 

Next. 
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5. Click Finish.  The inventory is now created and the Scanning window will appear.  See Step 2 
- Conduct the Inventory for the next step in the inventory process. 
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3.7.2 Step 2 – Conduct the Inventory 
Upon creating a new inventory, The Edge will automatically open the Scanning window.  This is used 
to inventory your items.  You can manually get to this screen using Inventory > Physical Inv > 
Continue Inv. 

To inventory your items: 

1. In the top left, choose how you will be inputting items for inventory (e.g. barcode, item #). 
2. If using locations, choose the location you are working with, then input all items.  Repeat for 

each location.   
3. Notice as you input items the activity log (second pane) updates.  Any warnings or errors will 

display here.  The bottom two panes also update to show items inventoried and outstanding. 
4. You can close and continue this process later at any time.  Use Inventory > Physical Inv > 

Continue Inv to resume an in progress inventory. 
5. Once all items inventoried, see Step 3 – Reconcile & Finish for the final steps. 

3.7.2.1 Scanning Window Overview 
The Scanning window is divided into four sections: 

 
The top section lets you specify input options. 
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Scanning… Choose how to input items: 

Item Number Manually key item # into Item field 

Item Barcode Scan barcode into this screen 

Old Item 
Number 

Manually key item # from previous software 

Old Barcode Scan barcode from previous software 

Old Item 
Number with 

Duplicates 

Manually key item # from previous software where multiple 
items can have same number 

Old Barcode 
with Duplicates 

Scan barcode from previous software where multiple items 
can have same barcode 

Vendor Barcode 
with Duplicates 

Scan barcode from vendor where multiple items can have 
same barcode 

 

Item Use this field to manually key in item # or old item #s 

Location Use this drop-down to select a location.  Inventorying an item will move it to this 
location.   

Warn about 
Layaways 

If checked, layaways will generate a warning when inventoried. 

Warn About 
Location 
Changes 

If checked, inputting an item to a location different than the one currently on file will 
result in a pop-up window asking you to confirm moving it to the new location. 

Clear Use this button to clear the form.  It does NOT undo any inventory activity. 

Close Use this button to close the window.  It does NOT undo any inventory activity nor 
does it finish or close the inventory. 

Print List Use this button to print either the middle or bottom lists. 
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The next section keeps a running log as you input items.  Errors and warnings will also appear here. 

 
The bottom two sections show items that were inventoried as well as those items that are still 
outstanding.  By default, the outstanding items for the selected location will be shown.  To see all items, 
check the Show All Inventory box.  This may negatively affect performance based on the number of 
items in the inventory. 

 

 

NOTE:  You can view an item’s record by double clicking on it in the window.  In 
addition to seeing its details, this can be useful if you accidentally inventory an item as 
you can use Supervisor > Remove Last Inventory Date to un-inventory it. 
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3.7.3 Step 3 – Reconcile & Finish 
The last step in the inventory process is reconciliation.  This is where you review discrepancies, make 
any final adjustments, and then finish (close) the inventory. 
To begin reconciliation: 

1. Click Inventory > Physical Inv > Finish Inv, then Select the inventory you are working with.  
The Inventory Reconciliation window will appear. 

 
2. This window will display all item discrepancies.  A discrepancy indicates that the quantity 

inventoried does not match the quantity on file.  The Qty Diff and UOM Diff (Bulk only) 
columns indicate the difference in number or, for UOM bulk, difference in measure (weight). 

3. Review each discrepancy.  Then, take the following action: 
a. If the discrepancy is correct (e.g. item missing), check the line and click Accept 

Count.  This will mark the Qty Diff and UOM Diff (bulk only) as missing. 
b. If the discrepancy is incorrect, check the line and click Recount.  For fine jewelry, this 

will mark the individual piece inventoried.  For bulk, you will be prompted for new 
quantity (you can enter a New Total or Add to the existing inventoried quantity). 

c. For bulk only, if after Recount there is still a Qty Diff and/or UOM Diff, you must 
check the item and Accept Count to finalize and accept the change in quantity. 

4. Notice each discrepancy line highlights in green as you work through the list.  Once you have 
addressed each discrepancy all lines should be highlighted green. 

5. Click the Refresh Count button at the bottom.  If all discrepancies were successfully 
addressed, the screen should now be empty. 

6. Click Finish Inventory to complete and close this inventory. 

 

NOTE:  To pause reconciliation, use the Continue Later button to close this screen.  You 
can resume at any time via Inventory > Physical Inventory > Finish Inv. 

 

 

NOTE:  Though not typically recommended, you are not required to address all 
discrepancies and will still be able to close the inventory via the Finish Inventory button.  



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 163 
© 2020 Abbott Jewelry Systems, Inc. 

You may find this useful if dealing with layaway or special order discrepancies that 
cannot be resolved here.   

 

3.7.3.1 Bulk Conflicts 
The Conflicted column on the Inventory Reconciliation screen will indicate Yes when a bulk item has 
had its quantity changed outside of the inventory process. Examples might include an item being sold, 
added, etc. 

 
The purpose of Conflicted is to draw your attention to this change to ensure your count is accurate.  To 
see what caused the changed, check the item row and click the Show Bulk Changes button at the 
bottom. 
 
It is not necessary to do anything with these conflicts.  This is simply provided as a tool to help identify 
potential causes of discrepancies. 

3.7.3.2 Layaway & Special Orders 
Items on layaway and/or special order can be included in the inventory process.  However, if there is a 
discrepancy in quantity, it cannot be addressed from the Inventory Reconciliation screen because it is 
tied to an ongoing transaction. 
To account for missing layaway or special order items: 

1. Process a return for the layaway or special order transaction at POS. 
2. Manually mark the item missing via Inventory > Item > Find, Edit the item, then click 

Supervisor > Missing. 

3.7.3.3 Canceling an Inventory without Finishing 
To cancel an open inventory without finishing: 

1. Click Inventory > Physical Inv > Continue Inv or Finish Inv. 
2. Click on the inventory, then click the Cancel Inventory button in the bottom left. 

3.7.4 Reports 
There are four physical inventory reports available all found under Inventory > Physical Inv > 
Reports: 

Not Scanned All items part of this inventory that were not scanned 
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Scanned All items part of this inventory that were scanned 
Missing All items marked missing during this particular inventory 
Errors Log of all inventory errors 

 
The Not Scanned, Scanned, and Missing reports are all inventory specific and run the same way.  To 
run: 

1. Click Inventory > Physical Inv > Reports and select the report you wish to view. 
2. By default, the drop-down will only show open inventories.  Use the Show Closed Inventories 

checkbox if you want to run the report against a closed inventory. 
3. Choose the inventory for which you want to run this report. 
4. Optionally, visit the Options tab to change the report details and layout. 
5. Click OK to generate the report. 

The Errors report functions differently and is date driven.  To run: 

1. Click Inventory > Physical Inv > Reports > Errors.   
2. Use the Error Dates drop-down to select the dates for which you wish to view errors.  It is 

recommended you only set the Min date as the start and leave Max at the default. 
3. Use the Error Descriptions drop-down to select the types of errors you wish to view. 
4. Visit the Options tab to change report details and layout.  If you have run multiple inventories, 

group by Inventory Cycle to separate the errors by physical inventory. 
5. Click OK to generate the report. 

3.7.5 Frequently Asked Questions (FAQ) 
How do I “un-scan” or “un-inventory” an item that I’ve entered by mistake? 

To remove an item’s last inventory date: 

1. Edit the item.  Note that you can do this from the Scanning screen by double clicking. 
2. Click Supervisor > Remove Last Inventory Date. 
3. Save your changes. 

The Edge records the last 2 dates an item was inventoried.  Using this option will remove the most recent 
date and retain the prior one.  If you use this option twice it will remove all dates. 

How do I cancel an inventory? 

To cancel an open inventory: 

1. Click Inventory > Physical Inv > Continue or Finish Inv. 
2. Highlight the inventory you wish to cancel. 
3. Click the Cancel Inventory button in the bottom left. 
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What happens if I run multiple physical inventories at the same time? 

All physical inventories are date driven.  When you create a new inventory, the software records the start 
date.  As you scan items, the item record is updated with the scanned date.  When determining if an item 
was inventoried, The Edge compares the item’s scanned date to the inventory start date. If the scanned 
date is AFTER the start date, the item is counted as scanned for that inventory. 
 
For example, let’s say you start a full inventory on 12/26/2018 and scan item 100-00001.  Then, you 
start a filtered inventory for category 100 on 12/28/2018.  Running the scanned report for your full 
inventory would yield the one item; running the scanned report for your partial inventory would yield no 
item because the item was scanned on 12/26, but the filtered inventory was started on 12/27. 
 
If as part of your filtered category 100 inventory, you now scanned item 100-00002 that item would 
count as scanned against both your full inventory and the filtered inventory.  Running the scanned report 
for the full inventory would show both items while running the scanned report for the partial inventory 
would only show 100-00002. 
 
On the Finish Inv screen, what is the purpose of Recount and Accept Count? 
 
These buttons are used to address inventory discrepancies.   
For fine jewelry pieces:  

• Recount will mark the item as inventoried. 
• Accept Count will mark the item as missing. 

For bulk pieces:  

• Recount will open a window allowing you to adjust the quantity.  You can either enter a new 
quantity or add to the existing.   

• Accept Count will accept the discrepancy and adjust inventory with either the missing or found 
items.  

 
 

3.7.6 Configuring RFID for The Edge 
RFID will usually be set up and configured by your RFID vendor.  This information is provided for 
informational purposes.  To configure the RFID server and hardware: 
 
1. From Administrative ► Configuration, scroll down to RFID.   
2. Set options as follows: 

RFID Config File 
Path 

The location of the RFID configuration file.  Use the standard Windows 
Open File window to find the file.  The RFID vendor should provide this 
file and the path to it. 
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RFID Maintains 
Connection 

Whether the RFID device maintains a connection while scanning. 

RFID Server Type The type of server for the RFID device.  For TJS, it is Insite.  For 
TracTech, it is Impinj. 

3. Select OK. 

3.7.7 Tagging RFID Items 

 

• No two in-stock items can have the same RFID tag.   
• You cannot save a tag that is saved to an item already without removing it from 

the old item first. 
• Bulk items cannot have RFID tags assigned to them. 
 

To associate tags provided by your RFID hardware vendor with the item records in The Edge: 
 
1. From the Inventory menu, select Tag RFID Items.  The Scanning for Tag window will appear. 
 

 
 
Fields and options in the Scanning for Tag window include: 
 
Device Indicates the scanning device. 
Barcode The barcode of the item to be tagged. 
Tag ID The RFID tag number. 
Description A description of the item. 
Start Scan Allows you to scan the tag number. 
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2. From the Device drop-down menu, select which device you are using to scan the tag.   
3. Using a barcode reader, read or type in the barcode for the item to come up. 
4. For some systems, place the item with the tag in the scanning box. 
5. Select Start Scan button and scan the individual tag you want to assign to the item.  The green bar 

will start moving across the form indicating that the tag reader is scanning.  After the tag is 
registered, it will be assigned to the item and indicate the tag ID in the Tag Id field.   

6. The form will pause for two seconds and then reset itself so you can repeat for additional items. 
7. Close out of the form. 
 

 

If a tag is already assigned to another in-stock item, you will be prompted to assign 
this tag to the current item and remove it from the other item. 

Alternatively, you can assign RFID tags to an item in two other ways: 
 
1. Use Inventory ► Items ► Find to locate the item.  From the search results, select Supervisor ► 

Assign RFID Tag. 
2. From the item record select Supervisor ► Assign RFID Tag. 
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 Inventory Buying Tools 
Inventory management is the single biggest factor in the success of a retail business.  Your goal is to sell 
as much product at the highest price from the smallest investment possible.  To do so, you must 
vigilantly monitor, measure, and adjust your activities to make the most of your inventory with educated 
decisions.  The Edge features a series of buying tools and reports to help you move older inventory and 
replenish more popular items.  These tools work together to take a proactive approach to managing aging 
inventory.  Popular inventory can be set to be automatically reordered and potentially profitable 
categories can be identified using your sales data through a series of reports.  Aging inventory is 
managed through a tiered system of assigning spiff and price markdowns to items dynamically as they 
age.   
 
In general, here's how it works:  Items come in and you sell them.  Based on sales history and trends, 
The Edge's Levels and Rapid Reorder features work together to queue good sellers for replacement. 
Then the Purchase Order feature makes it easy to retrieve queued items, order them, and receive them 
into stock.  All the while, the Edge tracks sales data and through the use of the Inventory Buying Tools, 
which will help make strategic decisions about what you should obtain more of what sells and what you 
should do to move old inventory. 

 

 
 

There are two steps to using the Inventory Buying Tools: 
The Weekly Buying Plan 

a. Rapid Reorder Report with Form option 
b. Replenish Base Stock report 
c. Recovered Cost of Aged Items report. 
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The Monthly Aged Inventory Management System (AIMS) 

a. Repricing 
b. Bonus Poster generation 
c. Signage Location report. 

 
This section details how to use these features.  If you use the inventory management and reporting 
features discussed here along with the reporting features, The Edge will help maximize your profits.   

3.8.1 Setting Up Automatic Mark Downs and Repricing for Inventory Buying 
Tools 

At the heart of automatic buying tools is the Automatic Mark Down table found on the Pricing tab of 
each category.  The Mark Down table is used to define mark down amounts based on aging and should 
be setup for each participating category.  Repricing goes through and applies the mark downs to selected 
items.   
 
To setup the Automatic Mark Down table: 
 
1. Select Inventory ► Categories ► List. 
2. Select the category and edit it. 
3. Select the Pricing tab and look at the Automatic Mark Down table on the right. 

 

 
 
Fields in this table include: 
 
Min Days Number of days an item must be in inventory before assigned the 

prescribed action. 
Mark Down % Percentage to discount from item’s retail price. 
Spiff % Percentage of profit to award an associate as commission for the sale of 

this item.  Spiff supersedes commission. 
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In-Case Signage Specify a sign template to use to generate a sign when this action taken 
(e.g., generate in-case sale signs to accompany items placed on sale). 

 
4. Setup the table as desired for each participating category.  Use the Copy From button in the top 

right to copy the pricing tables from another category to the category currently being edited. 
 
The example mark down table provided here shows our default setup.   
 

 
 
Using this example, an item is considered old when it becomes 540 days old.  At this point, a spiff of 50 
percent is assigned.  This means that if an associate sells this item they are assigned a commission of 50 
percent of the profit generated.   
 
When the item reaches 600 days old, the spiff is removed and a mark down of 30 percent is applied 
against the retail price.  Also, a sign is queued for print using the “AIMS30” sign template.   
 
When the item reaches 630 days old, the mark down changes from 30 percent to 40 percent and a new 
sign is generated using the “AIMS40” sign template.  Finally, when the item reaches 660 days old, the 
mark down changes from 40 percent to 50 percent and a new sign is generated using the “AIMS50” sign 
template. 

 

 

The spiff and mark downs do not happen without user intervention.  Repricing must 
be initiated with the Buying Tools options enabled.   

Repricing must be run with either from the Reprice area from the Administrative menu or run as part of 
the larger monthly AIMS process. While this can be done at any time, it is recommended this be done 
once per month in a consistent cycle (e.g., first Monday of every month).  
 
To initiate a standalone AIMS repricing: 
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1. Select Administrative ► Reprice Items. 
2. Select the Item Filter to specify inventory to include/exclude based on category, vendor, inventory 

type, etc.  Alternatively, leave this blank to include all qualifying items. 
3. Select the default settings for each Change pricing section (i.e., Change Cost, Change Retail, 

Change Lowest Price, and Change Current Price).  The defaults are as follows.  
 

Change Cost No change. 
Change Retail No change. 
Change Lowest Price No change. 
Change Current Price Retail x Age Markdown 

Check do Signage and spiff 
Check Auto-price items only 

4. Select OK.  A preview list of items eligible for automatic mark down will be presented.  The list 
will show each qualifying item along with pertinent details including the old and new pricing 
information.   

5. Select the items to reprice and select OK to finalize the repricing. 
 

 

• In-case signage will be queued for print any time a sign template is assigned to a 
markdown.  Select Inventory ► Print Signage to view and print these signs.  

• See the section entitled Sign Formats for more information on working with sign 
templates. 

 

For repricing, there is no undo.  Consider printing and retaining the repricing 
preview list. 

3.8.2 Using Inventory Buying Tools 
The Inventory Buying Tools feature consists of six steps and is designed to fulfill two roles: 
 
• Weekly inventory orders and reorders 
• Monthly AIMS repricing. 
 
These two roles are not dependent on one another and it is entirely possible to use either exclusively.  
However, the system works best when both are employed side-by-side.   

3.8.2.1 Weekly Buying Plan 
To run Inventory Buying Tools: 
 
1. Select Inventory ► Buying Tools.   
2. Select Weekly Buying Plan.  The Weekly Buying Plan includes: 

a. Reorder Fast Sellers, which yields the Rapid Reorder Report and Form. This step is used to 
setup the rapid reorder report and form.  From the Settings options, the sale date range should 
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always be Last Week (it will default to this; this step is designed to be run weekly).  See the 
section entitled Rapid Reorder for more information on setting fast seller and reorder criteria.   

b. Replenish Base Stock report.   This step will setup a report to aid in replenishing current sold 
inventory.  From the Settings options, “current” refers to items that did not sell fast enough to 
be considered fast sellers, but did not sell slow enough to become aged inventory.  The sale date 
range should always be Last Week (it will default to this; this step is designed to be run 
weekly).   

c. Recovered Funds Redeployment Guide. This step will setup a report to aid in the 
reinvestment of funds recovered through the sale of old inventory.  From Settings, on the Type 
& Status tab, Date Sold should always be 365 days (it will default to this).  

 

 
 

Reorder Fast Sellers 
 
There are two outputs for this step:  the Rapid Reorder form and the Rapid Reorder report.  Both the 
report and the form show the same data, albeit in slightly different formats.  The report is designed to be 
viewed and printed for analysis.  The form, on the other hand, is designed to be acted upon.  It allows 
styles to be queued for order.  See the section entitled Rapid Reorder for more information. 
 
Replenish Base Stock 
 
Base stock refers to inventory that did not sell fast enough to qualify as a fast seller, but did not take long 
enough to sell to be considered old inventory.  It is inventory considered worthy of keeping in stock 
regularly.  In The Edge, an item is considered old once it reaches the second tier of the automatic mark 
down table.  By default, this happens at 540 days. 
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In this report, sold items are shown based on items sold the past 365 days grouped by category.  It is 
further broken down by price groupings.  For each grouping, based on GMROI and the length of time it 
was held in inventory, The Edge makes a recommendation as to whether you should buy more or hold at 
the level you have.   
 

 
 
Data fields shown in the Replenish Base Stock report include: 
 
Category & Cost The category and cost range being presented. 
# / Cost The cost range within the category being presented. 
Recommendation The Edge’s recommendation as to whether to acquire more items in this 

category and cost range. 
• If Category and Cost GMROI is over 20 percent greater than Total 

GMROI for that category, then Buy+ (+ indicates that you should buy 
several). 

• If Category and Cost GMROI is up to 20 percent greater than Total 
GMROI for that category, then Buy. 

• If Category and Cost GMROI is less than Total GMROI for that 
category, but by less than 10 percent, then Buy- (- indicates that you 
should buy a small number). 

• If Category and Cost GMROI is less than Total GMROI for that 
category by 10 percent or more, then Hold. 

GMROI The gross margin return on investment.  The formula used to calculate this is 
profit divided by the cost of inventory. 
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Sold Last 12 The quantity of items in the category and cost range sold within the last 12 
months.  The quantity is broken down by turnover time:  fast seller, interim 
seller, and those that took over 540 days to sell. 

In Stock The quantity of items in the category in stock.  This broken down into the 
quantity that has been on hand for less than 540 days and more than 540 days. 

 
In the example above, in category 190, Loose Diamonds in the cost range of $0-$250, the 
recommendation is buy more because of 19 sold, 17 were fast sellers.  We would recommend that you 
invest more in that area.  In category 140, Diamond Semi-Mount Rings in the cost range of $250-$500, 
of 5 pieces sold, 0 were fast sellers and 2 were interim sellers.  We would recommend you hold with the 
current inventory for the time being. 
 
Selecting values in the following columns will bring up the list containing the items that make up the 
quantity value for that column: 
 
• # / Cost 
• Fast (Sold Last 12) 
• Interim (Sold Last 12) 
• Over 540 (Sold Last 12) 
• Under 540 (In Stock) 
• 540+ (In Stock). 
 
Ultimately, this report helps to keep a pulse on where inventory is moving and where money should be 
invested.  The focus is not on exact style replacement, but rather on identifying areas of inventory that 
perform reliably to suggest where inventory should be maintained.  Different styles in that category 
might give you more variety for your repeat customers who like these types of items. 

 
 
This report is a more streamlined version of the Replenish Current Inventory report, which was moved 
to Reports; for more about that report, see the section entitled Replenish Current Inventory Report. 
 
Recovered Funds Redeployment Guide 
 
The output for this step is the Recovered Funds Redeployment Guide.  This report suggests categories 
that, because they performed well based on ROI, would make good areas where money recovered 
through the sale of old inventory could be reinvested.   
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Data fields in the Recovered Funds Redeployment Guide include: 
 
Category The category being presented. 
Cost The cost range within the category being presented. 
GMROI The gross margin return on investment.  The formula used to calculate this is 

profit divided by the cost of inventory. 
Sold Last 12 The quantity of items in the category and cost range sold within the last 12 

months.  The quantity is broken down by turnover time:  fast seller, interim 
seller, and those that took over 540 days to sell. 

In Stock Now The quantity of items in the category in stock.  This broken down into the 
quantity that has been on hand for 30/90/180 days plus what is considered 
Interim and more than 540 days. 

 
In the example shown above, category 650, Silver Jewelry Misc in the cost range of $25-$50 had 145 
items that were fast sellers.  More of this type of seller would be a good investment.  Selecting values in 
the Sold Last 12 columns will bring up the list containing the items that make up the quantity value for 
that column. 
 
Of course, the report is a suggestion and investment of recovered money is entirely up to you.  There are, 
obviously, investment opportunities outside of the scope of The Edge software. 
 
This is a streamlined version of the Recovered Cost of Aged Items Report, which is found in the 
Report menu. For more about that report, see the section entitled Recovered Cost of Aged Items Report. 
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3.8.2.2 Monthly Aged Inventory Management 
To run Monthly Aged Inventory Management: 
 
1. Select Inventory ► Buying Tools.   
2. Select Monthly Aged Inventory Management.  Monthly Aged Inventory Management includes: 

a. Repricing.  This step performs automated repricing based on markdown settings in category 
records.   

b. Bonus Poster generation.  This step is used to generate a bonus poster showing all items that 
have a spiff assigned.  See the section entitled Bonus Poster for more information. 

c. Signage Location report.  This is a simple report that will list current in-case signs by case 
location.  For more about working with signs, see the section entitled Sign Formats and the 
section entitled Printing Signage.   
 

 
 

3. Select OK.  Each buying tool step run will generate output in separate windows that are accessible 
from the tabs across the bottom of the window.  Work with results as follows. 

 

 

To save this setup permanently, click Presets ► Set as Default. 
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Repricing 
 

 

Before you run AIMS Repricing Tools, understand that it will reprice items based on 
the Automatic Mark Down settings in each category record.  There is no undo. 

 
The output for this step is the exception; it does not appear in a tab at the bottom of the window; it will 
appear in a Repricing Preview window that will pop up while the tool is running.  
 

 
 
This window shows items that qualified for repricing based on the category automatic mark down tables.  
Each item is shown alongside its pertinent details.  Also included is the old and new pricing information.   
Check those items to proceed with repricing and select OK. 
 
Bonus Poster 
 
The output for this step is the Bonus Poster.  This is a poster that shows items that currently have spiff 
assigned.  It also shows the potential bonus commission an associate can earn for selling this item.  See 
the section entitled Bonus Poster for more information. 
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Signage Location Report 
 
The output for this step is the Sign Locations report.  This is a report that shows each item with in-case 
signage assigned to it.  The report is grouped by case location.  See the section entitled Sign Locations 
for more information. 

3.8.3 Open to Buy 
 The Open to Buy wizard is far more than a report.  It creates an entire purchasing schedule for non-bulk 
inventory for a store for an upcoming sales period based on past data, sales estimates, amount of 
inventory in stock, and inventory on order.    
 
Open to Buy requires a few steps for inputting data required.  Begin by selecting Inventory ► Open to 
Buy. After completing the fields in each step, select Next.  To change data in an earlier step, select 
Back. 
 
Step 1:  Dates 
 

 
 

Starting List the starting date for the proposed buy period.  This date must be in the future. 
Ending  List the ending date for the proposed buy period.  This date must be in the future. 
Include Special 
Orders 

Whether to include special order data in the output. 
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Step 2:  Sales Estimates 
 

 
 
Buy Period Lists the time periods entered in step 1 but for previous years’ sales. 

Total COGS The total cost of goods sold for the listed period for previous years’ sales. 
Special Orders The total COGS from special orders for previous years’ sales. 
Repeat Sales The total COGS from repeat sales for previous years’ sales. 
Net COGS The net cost of goods sold for previous years’ sales. 
(COGS) Sales 
(estimate) 

The Edge’s predictions, excluding special orders and repeat sales.  The 
default value will be weighted according to the previous three years of 
buying periods. 

Interim  The time period between today and the start of the target period but for previous 
years. 

Total COGS The total cost of goods sold for the listed period but for previous years. 
Special Orders The total COGS from special orders but for previous years. 
Repeat Sales The total of COGS from repeat sales but for previous years. 
Net COGS The net cost of goods sold but for previous years. 

Estimate The Edge’s summary of what to spend, excluding special orders and repeat 
sales.  The default value will be weighted according to the previous three years 
of buying periods. 
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To generate the report, select Finish.   
 
Results Page 1 
 
Page one reiterates the input values for reference. 
 

 
 
Results Page 2 
 
The remainder of the output shows the results which will show what you sold, what you have, and what 
you might want to spend on replacement inventory.   
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The buying plan analyzes your inventory purchases and successful selling in previous years to offer 
suggested changes to the upcoming buying season.  These changes amount to the OTB distribution of 
funds into different categories and price points.  For example, a category with a $10,000 investment may 
contain $5,000 worth of stock at a price point that sells rapidly in your store.  The remaining $5,000 may 
be in a price point that is moving very slowing, or not at all.  Based on past history, it may be determined 
that you do need items in this price point, just fewer than before. 
 

 

The Edge has an overriding rule that indicates that no matter how well a particular price 
point performed, we will never recommend that you buy so much that the new in-stock 
level exceeds two times the amount sold in the previous 365 days. 

 
Data fields shown in the Open to Buy report include:  
 
Category & Cost The category and cost range being presented. 
GMROI The gross margin return on investment.  The formula used to calculate this is 

profit divided by the cost of inventory. 
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Sold Last 12 The quantity of items in the category and cost range sold within the last 12 
months.  The quantity is broken down by turnover time:  fast seller (less than 180 
days), interim seller (180 days to 540 days), and those that took over 540 days to 
sell. 

Sold In Period 
LY 

The quantity of items in the category and cost range sold one year prior to the Buy 
Period as specified in step 1 on the UI screen.  The quantity is broken down by 
turnover time:  fast seller (less than 180 days), interim seller (180 days to 540 
days), and those that took over 540 days to sell. 

COGS Total cost of goods sold for each category/cost range for the Sold In Period LY 
quantities. 

In Stock Now The quantity of items in the category/cost range in stock.  This is broken down 
into quantities that have been on hand for less than 30/90/180 days, interim (180 
days to 540 days), and more than 540 days. 

Budget Recommended quantity of each of items to buy and the total cost of those items 
for each category/cost range. 

 
For all of the quantity numbers in the sections Sold Last 12, Sold in Period LY, In Stock Now, you can 
click on the value and a list of those items that make up that number will appear.  That will give you 
even better insight into what kinds of items are yielding those results. 
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 Inter-Store 

3.9.1 Overview 
To open the Transfer Screen, click Inventory > Inter-Store > Transfers. 
 

 
The form automatically refreshes every 5 minutes but can be manually refreshed using the Refresh 
Transfers button. 
 
The Transfer Screen is divided into three sections. 

A There are 5 tabs.  These control what is displayed in area B.  The number in the green circle 
indicates how many pending items are on that tab.  

Transfer Allows you to transfer items to other stores.   

Receive Allows you to receive items transferred to your store. 

Request Allows you to request items from other stores. 

Open Shows all open transfers; can be used to cancel a transfer. 

Print Allows you to print a transfer slip showing all items included on a specific 
transfer. 

 

B This form corresponds to the currently selected tab.  Fields and options will vary depending 
on which tab is selected.  See the next sections for specific information on each tab. 
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C This is a running log of transfer history for the current session.  Closing the Transfer Screen 
will end the session and clear the log. 

 

 

NOTE:  Double clicking on a transferred item in any of the Transfer tabs 
will open the item record. 

3.9.1.1 Transfer Tab 
This tab opens a form allowing you to transfer items to other stores.  It will also display items requested 
from your store for easy fulfillment.  This form is divided into top and bottom sections. 

 
The top of this form defines where and how the item is being transferred.  Fields and buttons include: 

Item # Scan or manually key in an item to transfer it.  You must specify 
shipping information first (Ship To is required, other fields are 
optional). 

Ship To The store being shipped to.   

Ship Date The date this item is being shipped.  It will default to today.  
Cannot backdate. 

Ship Via The method of shipment for this transfer.  List values are derived 
from the Shipping Methods list (Administrative > Lists).  This 
field also accepts text entry. 

Notes Notes to accompany this transferred item.  Check the Pop-up 
Notes box if you want the note displayed in a pop-up window when 
received.  

Tracking # The tracking # for this shipment (user-defined). 
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Transfer # The transfer # for this shipment (system generated).  After initiating 
a transfer, all subsequent items will be assigned this same # until 
you click Close Transfer & Send.   

Format: TR (Transfer) or RQ (Request) _ Store # _ Date _ 
Sequential digit. 

E.g. TR_ST1_4_4_2019_1 is a transfer request initiated from store 
01 on 4/4/2019 and 1 indicates it is the first transfer that day. 

 
Click this button to transfer the currently entered or selected 
item(s).   

 

Click this button to close the current transfer shipment.  This will 
increment the Transfer #.  If notifications are enabled, this will 
also trigger the email to be sent. 

The bottom of this form is divided into two tabs: Requested Items and Items. 

Requested Items show all items requested from your store.  The number in parenthesis indicates the 
number of unfulfilled requests.  To fulfill the request and transfer the item to the requestor, check it and 
click the Transfer button.  To deny the request, visit the Open tab, select the item, and click the Cancel 
Transfer button. 

 
Fields on the Requested Items tab include:  

Recent Request # This drop-down will show open requests.  Selecting an open request 
will filter the item list to only display items from that request. 

Item # The item # of the requested item. 

Note If there is a note on this request a green note icon will be displayed.  
Hover over the icon to review the note text. 

Qty Requested The quantity requested. 

UOM Requested For bulk, the measure requested. 

Requesting Store The store the request originated. 

Location The case location of the requested item. 

Vendor / Style The vendor & vendor style of the requested item. 

Request Date The date the request was submitted. 
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Transfer # The transfer # this requested item is assigned to. 

Description The description of the requested item. 

The Items tab allows you to search inventory for items that you want to transfer.   

 
Fields and buttons include: 

 
Click this button to use the Item Find filter to search for inventory.  
Items matching your criteria will be displayed allowing you to check 
those you wish to transfer. 

 
Click this button to clear the item list.   

Recent Invoice # This drop-down will show you recently entered invoices.  Selecting an 
invoice will show all items entered on that invoice.  The system option 
‘Number of Days to Load Invoices’ controls how many days back it 
goes. 

Item # The item #. 

Retail The retail price of the item. 

Cost The cost of the item. 

Vendor The vendor for this item. 

Vendor Style The vendor’s style # for this item. 

Date Entered The date this item was entered. 

Invoice The invoice this item was entered on. 

Description The description of this item. 

3.9.1.2 Receive Tab 
This tab opens a form showing all items transferred to your store that have not yet been received.   
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Fields and buttons include: 
 

 
Click this to receive the currently checked items. 

Location Use this drop-down to select a case location to receive items into.  The 
system option ‘Receive Items Requires Location’ can be used to make 
this required. 

Transfer # This drop-down will show open transfers waiting to be received.  
Selecting an open transfer will filter the list to only display items on 
that transfer. 

Note If there is a note on this transfer a green note icon will be displayed.  
Hover over the icon to review the note text. 

Date The date the item was originally transferred. 
Via The shipping method for this item. 

Tracking # The tracking number for this item. 
Qty The quantity of item transferred. 

Item # The item #. 
Vendor Style The item’s vendor style. 

Ship From The store where the item was transferred from. 
Transfer # The transfer # this item is assigned to. 

Description The description of this item. 

3.9.1.3 Request Tab 
This tab allows you to request items for transfer from other stores.  Note that items can also be requested 
from the Reorder Form, Levels, and the Item Record.  See the Requesting an Item section for more 
information. 
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Fields and buttons include: 

Item # Manually key in an item to request it.  You must specify Ship 
To. 

Ship To The store being shipped to. 

Notes Notes to accompany this requested item.  Check the Pop-up 
Notes box if you want the note displayed in a pop-up window 
when viewed.  

 

Click this button to request the currently entered or selected 
item(s). 

 

Click this button to close the current request shipment.  This 
will increment the Transfer #.  If notifications are enabled, 
this will also trigger the email to be sent. 

Transfer # The transfer # for this shipment (system generated).  After 
initiating a request, all subsequent items will be assigned this 
same # until you click Close Request & Send.   

Format: TR (Transfer) or RQ (Request) _ Store # _ Date _ 
Sequential digit. 

E.g. RQ_ST1_4_4_2019_1 is a request initiated from store 01 
on 4/4/2019 and 1 indicates it is the first transfer that day. 

 
Click this button to use the Item Find filter to search for 
inventory.  Items matching your criteria will be displayed 
allowing you to check those you wish to request. 

 
Click this button to clear the item list. 
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Item # The item #. 

Retail The retail price of the item. 

Cost The cost of the item. 

Vendor The vendor for this item. 

Vendor Style The vendor’s style # for this item. 

Date Entered The date this item was entered. 

Invoice The invoice this item was entered on. 

Description The description of this item. 

3.9.1.4 Open Tab 
This tab shows all currently open transfers.  This form can be used to cancel transferred items. 
 

 
 
Fields and buttons include: 

Show All Stores By default, only transfers to or from your store are displayed.  Check this 
to see all stores.  Requires ‘Transfer Items from Stores other than your 
current store’ permission. 

 
Cancel the selected item transfer or request. 

Note If there is a note on this transfer a green note icon will be displayed.  
Hover over the icon to review the note text. 

Type Specifies whether this is a transfer or request. 
Item # The item #. 

Qty The quantity of item transferred or requested. 
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UOM For bulk, the measure of item transferred or requested. 
Ship To The destination store for this transfer or request. 

Ship From The originating store for this transfer or request. 
Ship Date The date the item was shipped. 

Via The method of shipping. 
Tracking # The tracking # for this item. 
Transfer # The transfer # this item is assigned to. 

Description The description of the item. 

3.9.1.5 Print Tab 
This tab is used to print transfers.  Each printed transfer will show shipping information as well as a list 
of all included items. 
 

 
 
Fields and buttons include: 

Transfer # Enter a transfer # and click Find to search for it. 
Store To Choose a store # to filter Find results by store being shipped to. 

Search From Choose a date to filter Find results by shipped date. 
Store From Choose a store # to filter Find results by store being shipped from. 

 
After entering criteria, click this button to find matching transfers. 

 
After selecting a transfer, click this button to open the print preview. 

Type Specifies whether this is a transfer or request. 
Transfer # The transfer #. 
Ship Date The date this transfer was shipped. 

Ship To The destination store for this transfer or request. 
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Ship From The originating store for this transfer or request. 
 

3.9.1.6 Transfer History 
Transfer history keeps a running log of all transfer activity during this session.  Closing the Transfer 
Screen will end the session and clear the log. 

 
Fields and buttons include: 

 
Click this button to hide or reveal the history log.  This can be useful if 
you require more working area in the top of the form. 

 
Click this button to print out the current history. 

Item # The item #. 
Note If there is a note on this transfer a green note icon will be displayed.  

Hover over the icon to review the note text. 
Type Specifies whether this is a transfer or request. 

Qty The quantity of item transferred or requested. 
UOM For bulk, the measure of item transferred or requested. 

Ship To The destination store for this transfer or request. 
Ship From The originating store for this transfer or request. 
Ship Date The date the item was shipped. 

Via The method of shipping. 
Tracking # The tracking # for this item. 
Transfer # The transfer # this item is assigned to. 

Message Describes the action taken on this transfer. 

3.9.1.7 Other Options 
The bottom of the Transfer Screen includes other options and buttons that apply universally to all tabs. 
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Refreshes entire Transfer Screen form.  Note that the screens 
automatically refresh every five minutes. 

Show Images Check this to show images in the transfer grids. 

 
Click this to view the In-Transit report. 

3.9.2 How To 

3.9.2.1 Transfer an Item 
To transfer an item: 

1. Click Inventory > Inter-Store > Transfers.  The Transfer Screen will open. 
2. If you are not already on the Transfer tab, click on it on the left. 
3. Specify the store to Ship To, optionally enter other shipping info or notes, then either: 

a. Scan the item. 
b. Manually key in the item and press enter or click Transfer button. 
c. Use the Items tab to find and select one or more items, then click the Transfer button. 

4. Repeat for all items to be included with this shipment. 
5. Click Close Transfer & Send to complete this shipment. 

3.9.2.2 Receive an Item 
To receive an item that was transferred to you store: 

1. Click Inventory > Inter-Store > Transfers.  The Transfer Screen will open. 
2. On the left, click on the Receive tab.  A list of items shipped to your store will be displayed.  

Optionally, use the Transfer # drop-down to filter by a specific shipment #. 
3. Optionally, specify case location to receive items into.  The system option ‘Receive Items 

Requires Location’ can be used to make this required. 
4. Check one or more items, then click the Receive Items button.  Alternatively, you can scan the 

item barcodes. 

3.9.2.3 Request an Item 
There are four ways to request items from other stores. 
From Transfer Screen 

1. Click Inventory > Inter-Store > Transfers. 
2. On the left, click on the Request tab. 
3. Specify the store to Ship To.  Optionally, enter notes, then either: 

a. Manually key in the item and press enter or click the Request button. 
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b. Use the Find Items button to find and select one or more items, then click the Request 
button. 

4. Repeat for all items to be included with this request. 
5. Click Close Request & Send to complete this request. 

From Reorder Form 

1. Run the Reorder Form either as part of Weekly Buying Tools (Inventory > Buying Tools > 
Weekly Buying Plan) or standalone (Reports > Inventory > Ordering > Reorder Form). 

2. When running, you must change the Display Rows option to Show One Style Per Store. 
3. Use the drop-down at the beginning of the row to expand the style row to show individual 

counts by store. 
4. Check the store you wish to request from, then click Request Items button at the bottom. 

From Item Record 

1. Click Inventory > Items > Find and enter criteria to search for the item. 
2. Edit the item record. 
3. Click the Request button (located in the Inventory section, middle of form).  Note that this 

button will only be visible if the item is not already at your store. 

From Levels 

1. Click Inventory > Items > Levels and enter criteria to search for styles. 
2. Use the drop-down at the beginning of the row to expand the style row to show individual 

counts by store. 
3. Click the Request button next to the store you wish to request from. 

3.9.2.4 Cancel a Transferred or Requested Item 
To cancel a transferred or requested item: 

1. Click Inventory > Inter-Store > Transfers. 
2. On the left, click on the Open tab. 
3. Select the item then click the Cancel Transfer button in the top right. 

3.9.2.5 Print a Transfer 
To print a transfer: 

1. Click Inventory > Inter-Store > Transfers. 
2. On the left, click on the Print tab. 
3. Use the fields at the top to specify criteria, then click Find.  A list of matching transfers will be 

shown. 
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4. Select the transfer and click the Print button. 

3.9.2.6 Enable Email Notifications 
Email notifications can be setup so that designated associates get automatically notified when a transfer 
or request is sent to their store.  To use this feature, you must first setup email notifications.  See the 
Email Setup webpage for instructions on doing so (varies by email provider). 
To enable notifications for an associate: 

1. Click Administrative > Associates and Edit the associate record. 
2. Under Multi-Store Options on the right, click the Receive Transfer Notifications drop-down. 
3. Check one or more stores, then click OK. 
4. Verify the associate has an Email on file. 
5. Save your changes. 

3.9.3 Reports 
There are two transfer reports available. 

3.9.3.1 In Transit Report 
This report will show all open transfers.  To run: 

1. Click Inventory > Inter-Store > In Transit Report. 
2. There are no options to set; the report will automatically run and display all open transfers. 

 
Fields on this report include: 

Item Number The item #. 
Transfer # The transfer #. 
Ship Date The date this item was transferred. 

Ship From The originating store for this transferred item. 
Via The shipping method. 

Tracking The tracking #. 
Item Description The description of the item. 

 

3.9.3.2 Transfer Report 

http://download.edgeuser.com/EdgeUpdates/EmailSetup/emailsetup.html
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This report allows you to specify criteria and can be used to report on open, closed, and cancelled 
transfers.  To run: 

1. Click Inventory > Inter-Store > Transfer Report.  The Transfer Report window will 
appear. 

 
Fields and options include: 

Store Transferred To Allows you to select destination store 
Store Transferred 

From 
Allows you to select originating store 

Ship Date Allows you to select by shipped date 
Receive Date Allows you to select by received date 

Item Filter Opens item filter allowing you to set specific item criteria to 
search for 

Transfer or Request Choose whether to display transfers, requests, or both 
Open Transfers Only Check this to only include open transfers 

Include Canceled Check to also include canceled transfers 
Group By Check options to group by them.  Drag & drop items to the top 

of the list to sort by them. 
Page Breaks Check to include page breaks. 

See Cost Check to include cost. 
See Retail Price Check to include retail price. 

See Notes Check to include notes. 
Use Report Criteria 

Page 
Check to include the report criteria page 

2. Set desired criteria and click OK. 
3. The resulting report will show each transferred item meeting your criteria. 
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Vendor Style The item’s vendor style number. 

Item # The item #. 
Description The description of the item. 

Transfer Type Whether this is a transfer or request. 
Ref # The transfer #. 

From Store The originating store. 
To Store The destination store. 

Assoc Shipped The associate that transferred the item. 
Assoc Rec/Cancel The associate that received or canceled the transfer. 

Date Shipped The date the transfer was shipped. 
Date Rec/Cancel The date the transfer was received or canceled. 
Shipping Service The shipping type. 

Qty / UOM For bulk, the shipped quantity. 
Tracking The shipping tracking #. 

3.9.4 Settings and Security 

3.9.4.1 System Options 
To view the Transfer system options, click Administrative > System Options and scroll down to the 
Transfer Options section. 

Number of Days to 
Load Invoices 

Defines how many days back to load invoices into the Invoice drop-
down in the Transfer screen; default is 7 which will load invoices from 
the last 7 days. 

Receive Items 
Requires Location 

Set to True to require a case location when receiving transferred items. 

Transfer Emails Set to True to enable transfer notification emails. 

3.9.4.2 Permissions 
To view associate permissions, click Administrative > Associates and Edit the associate record.  The 
following permissions pertain to transfers: 
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Ship Items Inter-Store Allows you to ship items from your store to other stores 
Receive Items Inter-

Store 
Allows you to receive items shipped to your store 

Request an Item to be 
transferred from 

another store 

Allows you to request items from other stores 

Transfer Items from 
Stores other than your 

current store 

Allows you to transfer items between any stores, not just your own 

Cancel a Transfer or 
Request 

Allows you to cancel a transfer or request 

Run Transfer Report Allows you to run the transfer report 
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4 Managing Your Customer Base 
The Customer area of The Edge allows you to keep track of one of the most important aspects of your 
business:  your client base.  From this menu, you can access information about specific customers, add 
information about new customers, create mailing lists, export records, print statements, or find gift 
certificates.    

 Finding a Customer 
You can use the customer find filter for a number of functions within The Edge:  to work with customer 
records, for reporting, to make customer contact, and so on.  For a video tutorial about working with 
customer filters, go to http://www.screencast.com/t/MkdH1e7iQmqR.   
 
To find an existing customer in The Edge’s database: 
 
1. Select Customer ► Find.  The Find Customers window will appear with the General tab 

selected.  As always, the Presets feature allows you to save search parameters for future use.  See 
the section entitled Presets for more information. 
 
 

http://www.screencast.com/t/MkdH1e7iQmqR
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• For Name and all fields in The Edge search windows, entering no information will 
return the entire customer database.   

• These parameters are cumulative.  That is, the more parameters you enter, the 
fewer items will be returned.  For example, if you enter a last name and an 
amount spent, only items with matches in BOTH fields will be returned.  This 
applies to parameters on all the tabs. 

 

Entering, for example, Sm in the Last Name field will return any customer whose last 
name begins with Sm, such as Smith or Smedley. 

 
Fields and options in the General tab include: 

 
Last Name Returns customers with matching last names.   
First Name Returns customers with matching first names. 
Spouse/Partner Returns customers with matching spouse’s or partner’s name. 
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Company Returns customers with matching company accounts. 
Company Account Returns customers with company accounts.  If you leave this option 

unchecked, you will get personal accounts only.  If you select this 
option, you will get company accounts.  If you select it again, you will 
get both personal and company accounts. This state is indicated by a 
gray checkmark as opposed to black.  Note that selecting this will 
change the available fields in the window.  

Phone Returns customers with matching phone numbers. 
Preferred Phone Only Returns customers with matching preferred phone numbers only.   
Street Returns customers with matching street addresses. 
City Returns customers living in the entered city. 
State Returns customers living in the entered state. 
Zip Returns customers living in the entered zip code. 
Preferred Address 
Only 

Returns customers with matching preferred addresses only. 

Email Returns customers with matching email addresses. 
Preferred Email Only Returns customers with matching preferred email addresses only. 
License # Returns customers with a matching driver’s license number. 
ID# Returns customers with a matching ID number.  Because this 

information is so specific, all other search criteria will be ignored. 
Search Mode Contains options for data inclusion. 

 
Starts With Returns records whose fields start with the 

entered letters. 
Contains Returns customers who have any matches in 

any portion of the field, not just the 
beginning. 

Ends With Returns records whose fields end with 
something. 

Exact Match Only Returns only records whose fields exactly 
match the entry. 

 
For example, if you have a customer whose name is Doug and you 
remember that his phone number ended in 5555, you could enter that 
parameter and select Contains from the Search Mode drop-down list 
to get records with those matches. 

Sort Order Contains options for how results are to be presented. 
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Inactive Account Searches inactive account lists.  This option contains three states: 
• Unchecked searches only active accounts.   
• Checked searches only inactive accounts.   
• Unchecked again searches for both.  Note it will contain a gray 

checkmark. 
 

 

By default, a customer find will return ALL customer contact information.  This 
means that if a customer has three addresses on file, this information will appear on 
three rows in the resulting customer list.  This does not indicate three separate 
customer records, as they will all show the same customer number.  Use the Primary 
Address/Phone Only options in the Customer Find filter if you do not wish to see this 
secondary contact information.  Keep in mind that if no primary contact information 
exists for a customer, they will be excluded from the resulting list.  Because the 
options are cumulative, if you checked both primary address and primary phone only 
options, and a customer only had a primary address but not a phone, that customer 
would be excluded. 

 
2. Complete the General tab fields as needed, if any, to retrieve the appropriate data. 

 

 

Typing =any into any of the fields will return only results with some data in that 
specified field.  Typing =none will return only customers where that field is 
empty. 

 
3. Select the Results tab if needed.  
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The Results tab defines how to search and display matching customers.  It is a powerful filter by 
which to specify whom to include.    For example, under Addressee, you can narrow the results to 
include spouses/partners or just the individual.  Or you can use it to return only the spouse/partner.   
Specific options include: 

 
Addressee 

Primary Contact Records will be labeled with the primary account holder’s contact 
information. 

Spouse/Partner Records will be labeled with the spouse/partner’s contact 
information. 

Birthday Celebrant Returns the name of the birthday celebrant regardless of whether they 
are the primary contact or spouse on the customer record. 

Celebrant’s 
Spouse/Partner 

Returns the spouse of the birthday celebrant regardless of whether 
they are the primary contact or spouse on the customer record. 

Male Returns only male customers. 
Female Returns only female customers. 
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Couple Returns records with data matching either party and returns them as a 
couple in one record.  Transactions using a record from these results 
will be assigned to the primary ID.  The name on the receipt and 
other documents will be shown as a couple. 

Each Individually Returns records matching any information in any record regardless of 
whether it is primary or the spouse/partner.  Transactions using a 
record from these results will be assigned to the individual’s ID.  

If Gender is unknown 
Guess Gender Instructs The Edge to guess the gender based on customer’s name if no 

gender is on file. 
If Gender is still unknown 

Exclude customer 
from results 

Instructs The Edge to exclude customers whose gender cannot be 
determined. 

Include primary 
contact instead 

Instructs The Edge to include the primary contact on a customer 
record if the gender cannot be determined on either the primary 
contact or their spouse, regardless of Addressee options. 

Include 
Spouse/Partner 
instead (if any) 

Instructs The Edge to include the spouse contact on a customer 
record if the gender cannot be determined on either the primary 
contact or their spouse, regardless of Addressee options. 

Spouse/Partner Required 
Include customers 
with no 
spouse/partner 

Instructs The Edge to include customers with no spouse on file 
regardless of whether the Addressee option is set to only return 
customer spouse information.  The primary contact information will 
be shown in place of the spouse. 

Exclude customers 
with no 
spouse/partner 

Instructs The Edge to exclude customers with no spouse/partner on 
file. 

 
4. Select the Merchandise tab if needed.  
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The Merchandise tab allows you to search for customers based on items they have purchased in the 
past.  Fields and options in the Merchandise tab include: 
 
Has Purchased at Least this merchandise 

$Amount Returns customers who have spent at least this amount. 
No. Items Returns customers who have purchased at least this many items. 
Item Filter Returns customers who have purchased items specified in this shortcut to 

the Item Find feature. 
Date Range Returns customers who have made purchases during a specified date 

range. 
Couple Returns records in which the merchandise purchases of both the customer 

and spouse/partner are included in the query. 
Individual Returns records in which only the merchandise purchases of the individual 

customer are included in the query. 
 
Has NOT Purchased at Least this merchandise 

$Amount Returns customers who have not spent at least this amount. 
No. Items Returns customers who have not purchased at least this many items. 
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Item Filter Returns customers who have purchased items specified in this shortcut to 
the Item Find feature. 

Date Range Returns customers who have not made purchases during a specified date 
range. 

Couple Returns records in which the merchandise purchases of both the customer 
and spouse/partner are included in the query. 

Individual Returns records in which only the merchandise purchases of the individual 
customer are included in the query. 

 
5. Enter parameters as desired and select the Wishes tab.  

 

 
 
The Wishes tab allows you to search for a customer based on items saved in his or her wish list.  
Fields and options in the Wishes tab are two-fold.  The first window includes options as follows: 
 
• Don’t care about wishes 
• Wishes that match… 
• Wishes that do no match…. 
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If Don’t care about wishes is selected, no further action is required for the Wishes tab.  However, 
if Wishes that match or Wishes that do not match is selected, further options will be offered for 
narrowing the search by the type of wishes saved in the customer’s record.  Under these 
circumstances, fields and options offered in the Wishes tab for inclusion or exclusion in the search 
are: 
 
Wish Option A second opportunity to choose whether these filters are to be included in 

the results or excluded. 
Wish Status Returns customers whose wishes are open, already bought, or either. 
Date Entered Returns customers whose wishes were entered during a particular time 

frame. 
Wish Entered By Returns customers with wishes entered by a particular associate. 
Customer Returns customer who have entered wishes for a specified customer such as 

their spouse, etc. 
Comments Returns customers who have the specified key words in the wish list 

comments field. 
Item Options Returns customers who have entered wishes containing items that are in 

inventory, not in inventory, or both. 
Item Filter Returns customers whose wishes match an item as found using the Item 

Find feature. 
Sale # Returns customers who have wishes that were fulfilled using this sale 

transaction number. 
Store # Returns customers whose wishes were entered at a particular store. 
Vendor ID Returns customer whose wishes match a particular vendor. 
Vendor Style Returns customers whose wishes match a particular vendor style. 
Min. Price Returns customers whose wish list items contain an item of at least this 

amount. 
Max. Price Returns customers whose wish list items contain an item of less than this 

amount. 
Event Returns customers whose wish list items are designated for any of the events 

listed here:  Mother’s Day, Anniversary, Father’s Day, Valentine’s Day, 
Christmas, Birthday, or Other Holiday. 

Event Date Returns customers whose event as selected above falls within the specified 
date range. 

 
6. Complete the fields in the Wishes tab as required ad select the Dates tab.  

 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 207 
© 2020 Abbott Jewelry Systems, Inc. 

 
 
The Dates tab allows you to search for a customer based on special dates in his or her life.  Use of 
the date picker is described in the section entitled Filtering by Date.  Fields and options in the Dates 
tab include: 
 

Occasion Returns customers who have occasions listed in the specified date range.   
Birthday Returns customers by birthday. 
Spouse/Partner 
Birthday 

Returns customers by his or her spouse’s birthday. 

Anniversary Returns customers by anniversary. 
Other 
Birthday 

Returns customers by another birthday. 

Other 
Spouse/Partner 
Birthday 

Returns customers who have a related person with a spouse with a 
birthday in the specified range. 

Other 
Anniversary 

Returns customers by another anniversary. 

Other 
Occasion 

Returns customers by another type of occasion. 
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Ignore Year in 
Date 

This allows you to search for anniversaries on any day and month 
without specifying the year. 

Date Entered Returns customers by when a customer was entered. 

Date Modified Returns customers by when the customer record was modified. 
Pop-up Starts Returns customers for whom a pop-up is set to start on the specified 

date. 
Pop-up Ends Returns customers for whom a pop-up is set to end on the specified date. 
Pop-up Completed Returns customers for whom the pop-up activity was completed. 

7. Select the Other Keys tab if needed.  
 

 
 
Fields and options in the Other Keys tab include: 
 
Acquisition Returns customers based on the response to the Why In field on their first 

purchase. 
Custom 1-8 These are store-defined parameters for which the names can be altered in 

System Options.  Note that these labels are user-defined.  
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Notes Returns customers with specified keywords listed in the notes. 
Store Returns customers who have activity at a specified store. 
Group/Mailing 
List 

Returns customers belonging to a particular group or mailing list. 

Referred By Returns customers referred by another, specified customer. 
Associate Returns customers who have been assigned to a particular associate. 
Why In Returns customers whose visit to the store was recorded by a particular Why 

In? response at POS. 
 

8. Complete the Other Keys tab fields as needed, if any, to retrieve the appropriate data. 
9. Select the Amount Spent tab, if needed.  
 

 
 
Fields and options in the Amount Spent tab include: 
 
Has Spent This Much 

$Amount Returns customers who have spent the specified amount in any 
tender form. 

Exclude House Account Excludes store charges from this amount. 
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Date Range Includes customers who have spent this amount in the specified date 
range. 

Couple Returns records in which the purchases of both the customer and 
spouse/partner are included toward the specified amount. 

Individual Returns records in which only the purchases of the individual 
customer are included toward the specified amount. 

 
Has NOT Spent This Much 

$Amount Returns customers who have spent less than this amount. 
Exclude House Account Excludes store charges from this amount. 
Date Range Includes customers who have spent less than this amount during the 

specified date range. 
Couple Returns records in which the purchases of both the customer and 

spouse/partner are included toward the specified amount. 
Individual Returns records in which only the purchases of the individual 

customer are included toward the specified amount. 
 
10. Complete the Amount Spent tab fields as needed. 
11. Select the Repair/Custom tab if needed.  
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Fields and options in the Repair/Custom tab include: 
 

HAS at least this 
many repairs or 
custom jobs. 

For any of the parameters entered below, the intent is to require that results 
include records with these values as a minimum. 

Total Amt $ Returns records in which the customer has spent at least this amount 
on repairs or custom jobs in total. 

Min Each $ Returns records in which the customer has spent at least this amount 
on any particular repair or custom job. 

No. Items Returns records in which the customer has had at least this many 
repairs or custom jobs. 

Repair Filter Allows you to use the Repair Find feature to specify repairs to 
include. 

Individual Tasks Within the repair filter, allows you to narrow those parameters further 
to apply at the task level. 

Repairs That Include 
Qualifying Tasks 

Within the repair filter, allows you to narrow those parameters to 
specific task SKUs. 
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Couple Returns records in which the repair and custom job purchases of both 
the customer and spouse/partner are included in the query. 

Individual Returns records in which only the repair and custom job purchases of 
the individual customer are included in the query. 

DOES NOT HAVE 
this many repairs 
or custom jobs. 

For any of the parameters entered below, the intent is to require that results 
include records with values less than those indicated. 

Total Amt $ Excludes records in which the customer has spent at least this 
amount on repairs or custom jobs in total. 

Min Each $ Excludes records in which the customer has spent at least this 
amount on any particular repair or custom job. 

No. Items Excludes records in which the customer has had at least this many 
repairs or custom jobs. 

Repair Filter Allows you to use the Repair Find feature to specify repairs to 
exclude. 

Individual Tasks Within the repair filter, allows you to narrow those parameters 
further to apply at the task level. 

Repairs That Include 
Qualifying Tasks 

Within the repair filter, allows you to narrow those parameters to 
specific task SKUs. 

Couple Returns records in which the repair and custom job purchases of 
both the customer and spouse/partner are included in the query. 

Individual Returns records in which only the repair and custom job 
purchases of the individual customer are included in the query. 

 
12. Complete the Repair/Custom tab fields as needed. 
13. Select the Appraisal tab if needed.  
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Fields and options in the Appraisal tab include: 
 
HAS at least this 
many appraisals. 

For any of the parameters entered below, the intent is to require that 
results include records with these values as a minimum. 

No. Appraisals Returns customers with at least this many appraisals. 
Appraisal Filter Allows you to use the Find Appraisal feature to specify the appraisal 

options to include. 
Couple Returns records in which the appraisals of both the customer and 

spouse/partner are included in the query. 
Individual Returns records in which only the appraisals of the individual customer 

are included in the query. 
DOES NOT HAVE 
this many appraisals. 

For any of the parameters entered below, the intent is to require that 
results include records with values less than those indicated. 

No. Appraisals Excludes customers with at least this many appraisals. 
Appraisal Filter Allows you to use the Find Appraisal feature to specify the appraisal 

options to exclude. 
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Couple Returns records in which the appraisals of both the customer and 
spouse/partner are included in the query. 

Individual Returns records in which only the appraisals of the individual customer 
are included in the query. 

 
14. Complete fields in the Appraisal tab as desired. 
15. Select the Rewards/Referral tab if needed.  
 

 
 
Fields and options in the Rewards/Referral tab vary depending on the value selected from the Card 
drop-down menu.  They might include: 

 
Has a Rewards Card Returns customers who have rewards cards. 
Rewards Tier Returns customers with a rewards card that is assigned to 

the specified tier. 
Has a Rewards Balance Returns customers who balances on their rewards card. 
Issued Returns customers with rewards cards issued during the 

specified date range. 
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Expires Returns customers with rewards cards that expire during the 
specified date range. 

Redeem by Returns customers who have balances that must be 
redeemed by a date within the specified date range. 

Has Referred Other Customers Returns customers who have made referrals. 
Has Been Referred Returns customers who have been referred. 
Has Been Given a Referral Card Returns customers who have received referral cards. 

 
16. Complete the fields in the Rewards/Referral tab as desired.  Select the Postcards tab if needed.  
 

 
 

Fields and options included in the Postcards tab include: 
 

Postcards Sent  Used to retrieve records concerning customers who have received 
specified postcards. 

Date Range Returns customers who were sent postcards during the specified time 
frame. 

Postcard Info Returns customers who were sent the specified postcard(s). 
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Postcards Not Sent Used to retrieve records concerning customers who have not received 
specified postcards. 

Postcard Info Returns customers who were not sent postcards during the specified 
time frame. 

Date  Returns customers who were not sent the specified postcard(s). 
 
17. Once all of the desired information has been entered, select OK.  A list of matching customers will 

appear.   
 

 
 
Notice in these results that some records are highlighted in gray; the gray records do not represent 
unique customer records, but instead show additional contact information for a customer.  In the 
event of a mailing, only the primary information (shown with the bright white background) is 
included.   

 
18. From this window, you can: 
 

Add  Allows you to add a customer as described in the section entitled Adding a 
Customer.   

Disable Allows you to disable a customer record.  A customer can only be disabled if there 
has never been any activity on his record.  The record will be flagged as inactive. 

Edit Allows you to edit or view a customer’s record using the same fields that appear in 
the section entitled Working with Customer Records.    
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• These query fields are provided as a means of narrowing your search.  For 
example, if you select a customer whose name is Smith, then go to Amount Spent 
and indicate you only want those who spent at least $500, you will get only 
records that match BOTH those criteria. 

• Since results are provided in a table that can be sorted by any field, you have a 
choice of narrowing your search or sorting your results and making your 
selection from there.   
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 Working with Customer Records 
This section details the information found in each customer record.  From the customer record, you can 
make changes as described in each section.  To work with these tabs, find the customer record as 
described in the section entitled Finding a Customer.  From the results, select the customer record to edit 
and select Edit.  These records are also available from point of sale and other areas of The Edge. 

4.2.1 Customer General Tab  
Containing the basic contact information about the customer, the Edit Customer window will open with 
the General tab open.   
 

 

 

The primary customer is on the left and the spouse/partner is on the right.  If you use 
Switch to Spouse, primary and spouse/partner keep the same relationship but the 
data view focus will change.  To change who is actually primary, go to the Supervisor 
menu and select Set as Primary Customer.   

 
Fields and options in the General tab include: 
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General  
 Inactive Indicates whether the customer has been marked inactive. 
 ID # The customer’s/spouse’s Edge identification number. 
 Gender Indicate the gender of the customer/spouse. 
 Title Specify a title for the customer/spouse. 
 First/Middle/Last Specify the customer/spouse name.  If the first and last name fields for 

the spouse/partner are not completed, The Edge will not create a 
spouse/partner record. 

 Suffix Specify a suffix for the customer/spouse (Jr., Sr., etc.) 
 License Specify the customer’s/spouse’s license number. 
 Company Specify a company name for this customer record. 
 Birthday The customer/spouse birthday. 
 Camera icon ( ) Returns photo menu to capture an image of the customer as described in 

the section entitled Adding and Managing Photos. 
 Couple Defines how to display the customer and their spouse on receipts and 

mailings. 
 Anniv The customer’s wedding anniversary. 
 Company Account Indicates whether this is a corporate account. 
 Date Entered The date the customer was entered. 
 Last Merchandise 

Associate 
Associate that last processed a merchandise sale or service intake for this 
customer. 

 Last Transaction 
Associate 

Associate that last processed any type of transaction for this customer. 
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Contact Methods Lists contact methods for both the customer and any linked 
spouse/partner records.  You can show: 
My Contact Methods:  Those for just the customer 
All Contact Methods:  Those for the customer and any linked records. 
 

 
 
In the list of available contact methods, fields include: 
Method:  The contact method, i.e., phone, email, etc. 
Type:  Where the person will be reached. 
Who:  Whether it goes to the primary contact on the record or the 
spouse/partner. 
Contact Address:  The specific value. 
 

 

• Contact methods with a green circle indicate the 
preferred contact number for each contact method.   

• When you choose a different contact method other than 
the default, that is the contact method that will appear 
in the transaction record. 

• If a contact method is the same for both parties, there 
is no option to remove a party in the edit window.  To 
remove that contact from the record, use the Delete 
icon. 

To edit a contact method, select the green edit button ( ). 
To delete a contact method, select the red delete button ( ). 

 + Address  Offers the add Customer Address window where you can add a new 
address.  For more information, see the section entitled Adding a 
Customer Address. 

 + Phone Offers the Customer Phone Number window where you add a new 
phone number.  For more information, see the section entitled Adding a 
Customer Phone Number. 
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 + Email Offers the Customer Email window where you can add a new email 
address.  For more information, see the section entitled Adding a 
Customer Email Address. 

4.2.1.1 Adding a Customer Address 
To add a customer address:  

1. From the Customer Edit General tab, select +Address ( ).  The Customer Address 
window will appear.   

 

 
 
2. Indicate whether the address is the preferred address.  This indicates that the address will be used by 

default.  It will also serve as a filter when creating lists that have the Preferred Address Only 
parameter. 

3. Select a Type.  This indicates the location of the address, e.g., Home, Office, etc. 
4. Complete the address fields. 
5. Indicate whether this is the primary contact’s address, in this example, Mike’s Address or 

Stacey’s Address. 
6. Select OK.  The new address will appear in the Contact Method list. 

4.2.1.2 Adding a Customer Phone Number 
To add a customer phone:  

1. From the Customer Edit General tab, select + Phone ( ).  The Customer Phone 
Number window will appear.   
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2. Indicate whether the number is the preferred number.  This indicates that the number will be used by 

default.   
3. Indicate whether this number is a Do Not Contact number. If the number is checked, it will not be 

used in certain features such as text message marketing. 
4. Select a Type.  This indicates the location of the number, e.g., Home, Office, etc. 
5. Enter a phone number. 
6. If applicable, enter a telephone extension. 
7. Indicate whether this is the primary contact’s number, in this example, Mike’s Phone Number 

or Stacey’s Phone Number. 
8. Select OK.  The new number will appear in the Contact Method list. 
 
If there was previously no phone number, a newly added one will automatically be marked Preferred.  
You can uncheck it if necessary. 

4.2.1.3 Adding a Customer Email Address 
To add a customer email:  

1. From the Customer Edit General tab, select + Email ( ).  The Customer Email 
window will appear.   

 

 
 
2. Indicate whether the email address is the preferred email address.  This indicates that the email will 

be used by default.   
3. Select a Type.  This indicates the location of the email, e.g., Home, Office, etc. 
4. Enter an email address. 
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5. Indicate whether this is the primary contact’s email, in this example, Mike’s Email or 
Stacey’s Email. 

6. Select OK.  The new email address will appear in the Contact Method list. 
 
If there was previously no email, a newly added one will automatically be marked Preferred.    You can 
uncheck it if necessary. 

4.2.1.4 Working with Spouse/Partner Records 
In the Customer Edit window, General tab, there is a drop-down meu for the spouse/partner.  This 
contains options for working with the spouse/partner record.  
 

 
 
Options in the Spouse/Partner drop-down menu include: 
 

See Details Opens the customer record with the spouse/partner details. 
Switch to Spouse Reverses the customer record with the spouse/partner as active. 
Find Another Allows you to attach another customer record as the spouse/partner. 
Cancel Cancels out of this menu and returns you to the Customer Edit window. 

 

 

• When adding spouse information to a customer record, after you have entered 
and first and last name and tabbed out, The Edge will check for duplicate 
records as described in the section entitled Adding a Customer.   

• If the spouse/partner fields for first and last name are not populated, The Edge 
will not save the spouse/partner record. 
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4.2.2 Other Keys Tab 
 

 
 

Fields and options in the Other Keys tab include: 
 

Acquisition Indicates how the customer came to be associated with the store based on 
their response to the Why In field on their first purchase. 

Custom 1-8 These are store-defined parameters for which the names can be altered in 
System Options.  Note that these legends are user-defined.  

Referred By Allows you to use the Customer Find feature to indicate by whom the 
customer was referred to the store. 

Associate Allows you to assign an associate to manage this customer. 
Groups/Mailing Lists Indicates what groups and mailing lists the customer is included in. 
New Group/List Allows you to immediately create a new group or list and include the 

customer in it. 
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4.2.3 Balances Tab 

 

If a customer has outstanding balances, a green circle will appear on the Balances tab 
of the window.  Of course, for a new customer, there should be no balances. 

 

 
 
The Balances tab contains a listing of account balances, including house accounts, credits, and service 
jobs.   
 
In this tab, a supervisor can manually adjust a customer balance without the customer charging to or 
paying on the account. 
 

 

Use of this function is not recommended for day-to-day transaction corrections.  It is 
only recommended to correct conversion errors during the first days of using The 
Edge after conversion. 

 
Fields in the Balances tab include: 

 
Type Lists the type of balance: 

R  Repair 
L  Layaway 
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S  Special Order 
A  Appraisal 
CH  Store Charge 
CR  Store Credit. 

Key Transaction ID number. 
Balance The present balance on the listed account. 
Created Date the balance appeared on the record. 
Most Recent The most recent date sales were charged to the account. 
 

 

For couples, balances are blended to include transactions conducted by both parties. 

 
To adjust a balance: 
 
1. Select Adjust Balance from the Balances tab of the customer edit window.  The Adjust Customer 

Balance window will appear. 
 

 
 
2. In the Adjustment field, enter an amount by which to adjust the balance.  These balances are based 

from the store’s liability point of view. 
 

Rewards Account  To increase the rewards to the customer, enter a negative amount. 
Credit Memos  To increase the credit to the customer, enter a negative amount. 
House/Credit Accounts To decrease the amount owed by the customer, enter negative 
amount. 
Layaways  To decrease the amount owed by the customer, enter a negative 

amount. 
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These amounts will not appear as negative on the customer’s receipt.  Many of these activities will 
happen at point of sale in the form of payments. 
 
3. Enter a reason in the Reason field. 
4. Select a date from the Adjustment Date date picker. 
5. Select OK/Save & Close. 

 

 

Note that balance adjustments may impact your bookkeeping: 
• House Account and Credit Memo – These adjustments will post as sales activity 

on the specified adjustment date. 
• Layaway – Adjusting a balance here may require manual adjustments to 

accounting and will appear confusing on balance reports. Best practice:  Cancel 
the open layaway and re-enter the layaway with an updated price. 

• Special Order – Adjusting a balance here may appear confusing on balance and 
on account reports. Best practice: Adjust the price of a special order by editing 
the service record under Services ► Find. 

• Repair – Adjusting a balance here may appear confusing on balance and on 
account reports. Best practice: Adjust the price of a repair by editing the service 
record under Services ► Find. 

• Custom – Adjusting a balance here may appear confusing on balance and on 
account reports. Best practice: Adjust the price of a custom job by editing the 
service record under Services ► Find. 

• Appraisal – Adjusting a balance here may appear confusing on balance and on 
account reports. Best practice: Adjust the price of an appraisal by editing the 
service record under Services ► Find. 
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4.2.4 Wish List Tab 

 
 

The Wish List tab fields contain values entered at point of sale.  Fields and options in the Wish List tab 
include: 

 
See Wish Open a selected wish for more details. 
Remove Wish Removes the selected wish.  It is only active if a wish is selected. 
Show In Stock Only Items Indicates whether results should be limited to items available in the 

store. 
Show Bought/Removed 
Items 

Indicates whether results should include items that have already been 
purchased or removed from the list. 

Date Date the item was added to the wish list. 
Associate ID of the associate who entered the item. 
For If the item is intended as a gift, for whom it is intended. 
Comments Notes about the item for the purposes of the wish list. 
Item # The ID number of the item. 
Price The price of the item. 
Status The status of the item in inventory. 
Location The location of the item in the store. 
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Description A description of the item. 
Event The event for which the item is intended (birthday, anniversary, etc.) 
Event Date The date of the event above. 
 
Wish list entries are color coded as follows: 
 

White In-stock, current wish list items 
Green Wish list items that are on sale 
Red Sold wish list items 

 
To work with a wish from this window, double-click it.  For more on working with Wish List items, see 
the section entitled Wish List. 
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4.2.5 Activity Tab 

   
 

The Activity tab contains data concerning the customer’s transaction history.  Notice that spouse/partner 
activity is included, but highlighted in light blue.  Fields and options in the Activity tab include: 
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Criteria Allows you to narrow the list of transactions listed. 
 
• Merchandise 
• Repairs 
• Custom Jobs 
• Appraisals 
• Layaway 
• Special Orders 
• Postcards 
• Tender 
• Store Credit 
• House Account 
• Returns 
• Trade-In 
• Misc Items 
• Notifications 
• Care Plan 
• Other. 

All Allows you to quickly select all type of criteria. 
None Allows you to quickly clear all types of criteria. 
Joint Account Whether to include just the customer, just the spouse/partner, or both as a 

couple. 
See Sale For an item listed in the record, it generates a preview of the sales receipt. 
See Item/Services For an item or service listed in the record, it opens the record. 
Return Item For an item listed in the record, it takes you to the Point of Sale window to 

process its return. 
Print List Generates a hard copy of the activity list. 
Presets Allows you to load or save settings for Criteria. 
Date The date of sale. 
Sale# The transaction ID number. 
Item #/Service # The item ID number or ID number of the service activity. 
Sold Price for which the item sold. 
Retail The original full retail price. 
Desc A description of the item. 
 
The Activity tab of the Customer window includes a listing of transactions and other activities 
involving that customer.  From here you can work with sales, make returns, and provide information to 
the customer about his or her accounts. 
 
To work with activities: 
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1. From the Customer edit window, select the Activity tab.   
2. Optionally, filter by criteria; options available vary based on the type of activity.  The following 

sections outline those options. 

4.2.5.1 See Sale 
From the Activity tab of the Customer Edit window, select the transaction or event to be viewed and 
select See Sale.  The receipt for that transaction will appear. 
 

 
 
From here, you can use the Supervisor menu to void the sale, change the customer, change the 
associate, or change the Why In? value.  Note that voiding a sale is not recommended.  For record-
keeping purposes, it is best to reverse the transaction. 
 
Use the Associates tab to see commission data on the sale.  
Use the Inventory tab to see item data.  

4.2.5.2 See Item/Service 
To view the details of a sale or service: 
 
1. From the Activity tab of the Customer Edit window, select the sale to be viewed. 
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2. Select See Item/Service.  The transaction record will appear.   
3. Depending on the status of the item or service, you may be able to make changes.  For sales, you 

can void the sale or change the Why In? value. For services, you can work with the service as you 
would at point of sale.  However, we recommend reversing a sale rather than voiding it.  If the 
activity is a postcard, editing the record will return the postcard record. 

4.2.5.3 Return Item… 
Items are usually returned at point of sale.  But as an alternative, you can return them from the 
Customer Edit window.  To return an item from the Customer Edit ► Activity tab: 
 
1. From the Activity tab of the Customer Edit window, select the item to be returned and select 

Return item….  The Returned Item window will appear with the Point of Sale window.   
 

 
 

2. Verify the customer’s ID and select OK to accept the return.  The Point of Sale window will 
populate the return data as needed.   

3. Process the return as normal. 
4. Select OK/Save & Close. 
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4.2.6 Customer Notes Tab 
The Notes tab contains space for general information about the customer such as upcoming events and 
preferences.    
 

 
 

 

For couples, notes will appear at POS for both parties. 
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4.2.7 Customer Pop-Ups Tab  

 
 

Pop-ups are notices that appear at point of sale to remind associates to notify customers of messages.  
For example, it might prompt the associate that the customer’s anniversary is coming up and that they 
may wish to look at a gift.  Or it might be useful to prompt a customer about an item he had inquired 
about previously.   

 
Fields and options in the Pop-Up tab include: 

 
Entered The date the pop-up was created; this is entered by The Edge. 
Who If a couple account, to whom the pop-up is applied. 
Start The date the pop-up is effective. 
End The date the pop-up should stop appearing. 
Done Whether the pop-up was addressed at point of sale. 
Title The name of the pop-up. 
Add Allows you to add a pop-up. 
Edit Allows you to edit an existing pop-up. 
Delete Allows you to delete a pop-up. 
Inactive Allows you to see pop-ups that have been marked inactive. 
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To create a pop-up, select Add from the Pop-Ups tab.  The New Pop-Up window will appear. 
 

 
 

Fields and options in the New Pop-Up window include: 
 

Inactive Unlike Delete, Inactive stores a pop-up that is no longer used and is not 
visible in the list view unless you expressly select Show Inactive. 

Title A descriptive name for the pop-up. 
Extra Emphasis/Pop-Up Whether the pop-up should pop-up. 
Pop-Up Type Whether the pop-up should pop-up for just the individual customer or, if 

a couple account, both individuals. 
Pop-Up Starts When the pop-up should start popping up.  If this is left blank, the pop-

up will start immediately. 
Pop-Up Ends When the pop-up should stop popping up.  If this is left blank, the pop-

up will continue indefinitely.  
Marked as Done The date when the pop-up was resolved at point of sale by checking the 

Do Not Show This Pop-Up Again option at point of sale.   
Notes The content of the pop-up. 
Entered The date the pop-up was created. 
Last Modified The date, if any, the pop-up was last edited. 
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4.2.8 Options Tab 

 
 

Fields and options in the Options tab include: 
 

Tax Exempt Indicates whether the customer is tax exempt. 

House Account 
Customer 

Indicates whether the customer may use a store charge or house account.  

Never Send 
Statement 

Indicates whether the customer should receive statements of account. 

Tax ID# The customer’s tax identification number.  If you mark a customer tax-
exempt, this is required and cannot be overridden.   

Special Interest 
Rate 

Specifies a special house account interest rate for this customer.  This 
overrides the interest rate set in System Options. 

Minimum Payment The minimum payment for the customer’s house account. 
Credit Limit The credit limit for the customer’s house account. 
 

 

For couples, all values will be shared for both parties except Tax Exempt and Tax ID. 
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4.2.9 Appointments Tab 

 
 
The Appointments tab lists appointment activity for the customer. You can edit (act on) appointments 
or add new ones.  For more information, see the section entitled Appointments.   
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4.2.10 Rewards Tab 

 
 

The Rewards tab will only appear if you have rewards enabled in System Options and if the customer 
has a rewards card.  Fields and options in the Rewards tab include: 
 
Rewards Card # The unique identifier of the card. 
Expires When the card expires. 
Issued When the card was issued. 
Redeem By By when the rewards must be used. 
Original Value The value initially assigned to the card. 
Rewards Tier The tier assigned to the card. 
Inventory  

Active Whether rewards will accrue for inventory. 
Earns The amount per dollar spent in the store the customer will earn. 
Minimum 
Purchase 

The minimum amount a purchase must be to accrue rewards. 

Repairs  
Active Whether rewards will accrue for repairs. 
Earns The amount per dollar spent on repairs the customer will earn. 
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Minimum 
Purchase 

The minimum amount a repair must be to accrue rewards. 

Custom Jobs  
Active Whether rewards will accrue for custom jobs. 
Earns The amount per dollar spent on custom jobs the customer will earn. 
Minimum 
Purchase 

The minimum amount a custom job must be to accrue rewards. 

Appraisals  
Active Whether rewards will accrue for appraisals. 
Earns The amount per dollar spent on appraisals the customer will earn. 
Minimum 
Purchase 

The minimum amount an appraisal must be to accrue rewards. 

Print Summary Allows you to print a summary of these parameters. 
 

 

For couples, rewards credits are blended onto one reward balance. 

For more on working with rewards and referrals, see the section entitled Rewards Program.   
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4.2.11 Referrals Tab 

 
 

The Referrals tab will only appear if you have referrals enabled and when the customer has referral 
cards to hand out.  Fields and options in the Referrals tab include: 

 
Active Cards The number of active cards the customer has to hand out to friends and 

family. 
Referrals that 
Came In 

The number of new customers who came in to use the referring customer’s 
cards. 

Cards that Paid 
Out 

The number referral cards that generated a reward credit. 

Total Earned The amount the referring customer earned in referral bonus money. 
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 Customer Supervisor Menu 

4.3.1 Disable Customer 
Found in the Supervisor menu at the bottom of the customer record, Disable Customer allows you to 
mark a customer record as inactive.  It does not delete transactions with this customer.  You will be 
prompted to confirm the action. 

4.3.2 Merge Customer 
This feature is used to merge customer records.  This is useful if you have duplicate customer records, 
either because of accidental entry or as the result of a data conversion.  It contains two functions:  Merge 
Customer and Duplicate Check & Merge. 
 

Merge Customer Use this to merge any two customer records.  In cases of conflicting 
information (e.g. different spouses) you will be able to choose which 
information is retained. 
 

Duplicate Check & 
Merge 

Use this to automatically search for duplicates.  Probable matches will be 
returned and you can merge multiple records at once.  In cases of conflicting 
information the data from the originally selected customer will be retained.  
Any conflicts will be noted on the merged customer’s notes.  Please check 
the customer notes after merge. 

 
To use Merge Customer: 
 
1. Click Customer ► Find, search for the customer you wish to keep, and Edit the record. 

2. Click Supervisor ► Merge.  The Merge Customer window will appear. 
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3. Select Merge and click OK.  The Merge A Customer window will appear. 

 
4. Use the drop-down under Customer record to be consumed to open the customer filter. 

5. Enter criteria to search for a customer and click OK.  A list of matching customers will appear. 

6. Click the customer you want to merge and click Select.  The Merge A Customer window will 
appear showing the customer to be consumed on the left (customer you just selected) and the 
customer that will remain on the right (original customer you edited). 

 
7. Any information present on the record for each will be displayed.  Use the checkboxes to indicate 

which info to take from the consumed record.  This information will be copied to the remaining 
customer and will overwrite whatever was there. 

8. Click OK and then save your customer to complete the merge. 
 

 

 

Check your work carefully because customer merge cannot be undone. 
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To use level Check & Merge: 
 
1. Click Customer ► Find, search for the customer you wish to keep, and Edit the record. 

2. Click Supervisor ► Merge.  The Merge Customer window will appear. 

 
3. Select Duplicate Check & Merge and click OK.  The database will search for duplicates and either 

return a message that none were found or display a list of probable matches. 

 
4. Check one or more customer records and click Merge Customers to merge them.  Note this merge 

happens immediately and cannot be undone. 

5. Any row marked Conflict indicates your originally selected customer did not have a spouse listed, 
but these probable matches do.  If you select one, the spouse will be added when you complete 
merge.  If you select multiple records with different spouses, the software will pop the Spouse 
Selector window asking you to pick which one will remain on the merged record. 

 

 

The System Option “Customer Duplicate Check” determines what information 
The Edge matches duplicates on.  It is in the Customer Options section. 

 

 

Customer Merge cannot be undone.  Please verify you have selected the correct 
customers BEFORE you click Merge Customers. 

 

4.3.3 Remove Spouse 
Removes the spouse/partner, but keeps the spouse/partner’s record independently.  There is a System 
Option, Balances to Primary on Split, that dictates how historical transactions will be assigned during 
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this process.  Setting this to True indicates that all transactions conducted by the couple will be 
assigned to the primary account holder.   
 
Setting this to False indicates that transactions will be assigned based on the party to act on the 
transaction.  Here are the scenarios: 
 
• If the transaction is a sale only, it stays with individual who conducted it. 
• If the transaction has an intake step such as in repairs, special orders, custom jobs, appraisals, 

layaways, and memos, and no activity occurs on that transaction by the primary account holder, then 
the transaction stays with the individual. For instance, a repair intake is done by the spouse/partner 
and pickup is done by primary, that sale will go to the primary account holder. 

• If it is a house or credit transaction, the sale will remain with the individual. 
• Any house or credit or sales activity on a sale the changes to the primary account holder will also be 

assigned to the primary account holder. 
 

 

The anniversary and spouse/partner’s birthday will remain; it you want that removed, 
do so manually. 

4.3.4 Set as Primary Customer  
If you wish to change which person in the couple is the primary account holder: 
 
1. Use Switch to Spouse from the General tab to move Spouse/Partner to the left side of the 

General tab. 
2. From the Supervisor menu, Select Set as Primary Customer. 
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 Adding a Customer 
In The Edge new customers will primarily be entered using the Point of Sale window as described in the 
section entitled Gathering Customer Information at Point-of-Sale.  Alternatively, and to include more 
detailed data, you can use this Add New Customer function.  This method will take longer, but will 
allow you to include much more detail.  Required fields are determined by your System Options.  

To add a new customer to your Edge database: 
 
1. Select the Add tab from the Customer menu.  The Edit Customer <<New Customer>> window 

will appear with the General tab selected.     
 

 
 

2. Populate the fields in each tab as described in the section entitled Working with Customer Records. 
3. Select a save option.  
 
Depending on your System Options, The Edge may check to see if there is a similar record before 
proceeding with creating a new one or creating a new spouse record. If there is record in The Edge that 
is similar:  
 
1. The Possible Customer Matches screen will appear with a listing of possible and probable 

matching records.  
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2. From here, choose from one of two options:  select a customer from the list or add a new customer 

record based on the data entered to date. 
 

a. If the desired customer appears in the list, select the record and Select Customer.   
b. You will be prompted to confirm your selection, and any information you added to that point 

will be incorporated with the existing record.   
c. If there is a conflict, you will be prompted to choose the correct data.   
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d. Check Take to copy the Updated Customer Information into the existing record and delete 
Current Customer Information.  In this example, it would delete a good deal of data. 

e. Select Swap primary and secondary customer info to make the spouse/partner be the primary 
account holder. 

f. Select OK/Save and Close; the record will be saved. 
 
3. Notice that inactive customer records are highlighted in gray.  If you select one of those, you will be 

prompted to make the record active. 
4. If the desired customer is not one of the possible matches, select Add New and complete the entry. 

 

 

This feature will help you avoid creating duplicate customer records, but you might 
also search for the customer before adding him.  If no match is found, use the Add 
button from the resulting customer list window.  This will auto-fill your search 
criteria into the appropriate fields.  For example, if you searched for customer 
Woodrow Wilson and found nothing, press the Add button would automatically fill 
in the first name field with Woodrow and the last name field with Wilson. 

 

Wish List, Activity, and Balances tabs do not apply to new customers. 
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 Customer Postcards 
The Edge Postcard feature provides a means to select from a variety of attractive postcard designs, 
choose the criteria for customer to whom the postcards should be mailed, preview the mailing list before 
the postcard order is placed, select/deselect certain customers, and send the postcard order to our online 
printing service.  The postcards are then printed, personalized, postage paid, and mailed, all without any 
further attention from you.  This Edge feature provides you with a very affordable, personalized and 
easy-to-use marketing retention program that will build customer loyalty and drive business. 

4.5.1 Entering Store Information for Postcards 
To register for postcards: 
  
1. Select Postcards ► My Account.  The Postcard Account Details window will appear. 
 

 
 
Fields and options in the Postcard Account Details window include: 
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EdgeID The Edge-generated ID for your postcard account.  When you do a 
postcard mailing, this is the account to be charged.  It is attached to your 
license. 

Store Name The store from which the cards will be sent; this is for printing purposes.   
Slogan A slogan to appear on the postcard. 
Street Address The address of the store as it should appear on the postcard. 
Street Line 2 The second portion of the street address of the store if needed. 
City, State  ZIP The city, state and ZIP Code for the store as it should appear on the 

postcard. 
Store Phone The store's phone number as it should appear on the postcard. 
Website The website that should appear on the postcard. 
Location Message Any tips to provide the recipient:  On the corner of Main and Elm. 

 

The details provided in the top half of the Postcard window will be used to 
populate the postcard design you select later. 

 

Name The name of the person to contact for billing purposes. 
Phone The store's phone number to be used for billing purposes. 
Email The store's email address to be used for billing purposes. 
Notes Notes for the account. 
 

2. Enter your store information and select OK.  Much of this information will be pre-filled for you 
based on your store’s license. 

3. Your account status will change to Pending and soon thereafter an account manager will contact 
you to get your payment information and to obtain your logo files. 

 

 

For postcard designs, two logo files will be required:  one in white for dark 
backgrounds and one in black for light backgrounds.  We strongly recommend 
.EPS Vector files, but other formats may be acceptable.  If you cannot supply 
acceptable logo files, a service is available. 

 
4.  You will be notified by email once your account has been activated. 

 

 

Once your postcard account is activated, you can get back to your account 
settings via Supervisor ► My Account. 
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4.5.2 Sending Out (Ordering) Postcards 
To begin sending postcards: 
 
1. Select Postcards ► Order Now from the Customer function menu.  The Send Postcards to 

Customers window will appear. 
 

 
 

2. Select the desired postcard design from the Postcard Design dropdown list.  For a current list of 
available postcard designs along with previews, go to www.edgeuser.com.    

3. Enter the Offer and Disclaimer.  Depending on the design chosen, these fields control the custom 
text available on the card. 

4. Select your postage class. 
5. Use the Customer Criteria drop-down, which offers the customer find filter. 
6. Select OK to generate a list of matching customers.   
7. Check those customers you wish to include in your postcard mailing and select OK to submit it via 

the Internet. 

4.5.3 Scheduling Postcards 
Schedule is where you specify which postcards are to be generated each week.  To configure a job: 
 
1. Select Customer ► Postcards ► Schedule.  The Scheduled Postcard Jobs list window will 

appear.  The first time you see it, it will be empty.   
 

http://www.edgeuser.com/
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2. Click Add to specify a postcard job.  The Schedule Automatic Postcards window will appear. 
 

 
 
The Schedule Automatic Postcards window strongly resembles the Order Now functionality, with 
the addition of a new field to specify an identifying note or comment and a checkbox by which you 
can enable or disable the automatic nature of the job.  
 

3. Enter a descriptive name for the mailing. 
4. Select a Postcard Design.  Based on the design you choose, the Customer Criteria field will be 

populated for you and will appear in the filter Results tab, discussed later.  See step 8 for more 
information. 
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5. Enter the promotion or greeting in the Offer field.  You can provide a discount or simply say, 
“Happy Birthday.” 

6. Enter a disclaimer if desired.  For example, you may wish to limit the length of the offer or exclude 
a particular category. 

7. Select a postage class. 
8. From the Customer Criteria area, complete the parameters around which to generate the mailing.  

The Customer Criteria filter works just like customer find.  Go through each tab and narrow your 
target audience.  Let’s call attention to the Results tab.  Notice that many selections are made based 
on the postcard design you selected in step 4. 
 

 
 

9. Filter further only if required. 
10. Select the Dates tab and filter by the date of the event.   
11. Select Presets.   
12. Select Save Settings.  Enter a name for the preset settings.  For more about presets, see the section 

entitled Recommended Postcard Presets. 
13. Select OK. 
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• It is important to remember that each automatic postcard job will run each and 
every week, so each of your jobs should include customer criteria with a date 
range of 7 days.  The Rolling Dates feature allows you to set a minimum and 
maximum number of days, weeks, months, quarters, or years from the date of the 
job.  Note that a week in The Edge is Sunday to Saturday. 

• For example, if you are setting up an automatic mailing function, and you wish to 
always send cards 3 weeks in advance of an event, you would specify rolling weeks 
to Min 3/Max 3.  This way, the job will look and find any event 3 weeks ahead.  It 
will include associated targets that match within a week.   

• You should select the exact range based on your chosen postage class and your 
knowledge of your customer base. 

4.5.4 Recommended Postcard Presets 
Presets in The Edge allow you to save filters and settings for future use.  For the Auto Postcard function, 
they are particularly helpful because they allow you define mailing parameters for repeated use.  For 
example, if you want to send postcards to men with anniversaries in the next month, you can set those 
filters and save them.   We recommend weekly female birthday, weekly male birthday, weekly 
anniversary, weekly “Thank You,” weekly service reminders.  Therefore, when you are done setting the 
filter, select Presets to save the settings. 
 
Using the filtering steps described in the section entitled Scheduling Postcards, the following table 
outlines the settings for each of the recommended presets. 
 

Occasion Postcard 
Design 

Celebrant/ 
Target 

Dates Customer Field to 
Select 

Female 
Birthday 

Birthday 
Female 
Postcards 

Female Rolling 3 weeks 
in advance 

Birthday 

Male Birthday Birthday Male 
Postcards 

Male Rolling 3 weeks 
in advance 

Birthday 

Anniversary Anniversary 
Cards 

Couple Rolling 4 weeks 
in advance 

Anniversary 

Thank You Thank You 
card 

Primary Contact Rolling 2 weeks 
before 

Merchandise tab:  set a 
dollar amount spent 

Service 
Reminder 

Service 
Reminder 
Card 

Primary Contact Rolling 26 weeks 
before 

Merchandise tab:  set 
dollar amount spent 

4.5.5 Importing Existing Postcard Presets 
 
1. Select Customer ► Postcards ► Schedule.  Once you clear security, the Scheduled Postcard Jobs 

window will appear.  The first time you see it, it will be empty.   
2. Click Add to specify a postcard job.  The Schedule Automatic Postcards window will appear.   
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The Schedule Automatic Postcards window strongly resembles the Order Now functionality, with 
the addition of a new field to specify an identifying note or comment, and a checkbox by which you 
can enable or disable the automatic nature of the job.  This option can be disabled if a job is not to 
be run for a period of time. 

3. Select Presets and from the context menu, select Load Settings. 
4. From the Load Settings window, select the Show Similar checkbox. 
5. Select the preset that you want to import and select OK. 
6. Enter a name for the mailing. 

4.5.6 Running Postcard Jobs 
If you have properly set up both The Edge and Windows Scheduled Tasks, then your jobs will each run 
automatically.  
 
If something goes wrong with the automated mailing, or if you want to run an addition mailing, you can 
run the job again manually using the Run Now button.  In this case, do not go through the Windows 
Scheduler because that will result in duplicate automated mailings.  In this case, go into The Edge, go to 
the list of scheduled postcards, and run just that batch using Run Now. 
 

 

Selecting Run Now will not prevent the postcard job from running as scheduled 
automatically as well, and might very well result in some customers receiving 
duplicate postcards at extra cost to you.  You should only use the Run Now button if 
you know that the automatic job failed.  For this reason, the Run Now button requires 
a supervisor override. 

 
For more about Windows scheduled tasks, see the tip sheet entitled Setting Up a Windows Task at 
www.EdgeUser.com.  

4.5.7 Postcard History 
To see a history of postcards sent to your customers: 
 
1. From the Customer menu, select Postcards ► History.  The Postcard History window will 

appear. 
 

http://docs.edgeuser.com/TIP-2012-005_Setting_Up_a_Windows_Task.pdf
http://www.edgeuser.com/
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2. From here you can view details of a mailing, including the number of recipients, or print the list. 

4.5.8 Postcard Multi-Store Considerations 
A scheduled task will automatically run only in the store where it was created, even though the 
scheduled task definition will be transferred to the other stores. However, you can interactively run now 
any scheduled task. 
 
Postcards should be sent from one store.  If you have multiple stores, and you want to generate automatic 
postcards from each store (e.g., you want your postcards to have different return addresses), contact 
postcards@ajsllc.com. 

4.5.9 Best Practices for Customer Postcards 
It’s important to note that effective use of the Auto Postcard function hinges on good customer list 
maintenance.  If customer birthdays are wrong or if a customer has changed his address, you could 
offend someone or at least, waste the cost of the card and postage.  We recommend the following best 
practices: 
 

mailto:postcards@ajsllc.com
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1. When adding anything to the schedule, please remember that these cards go out WEEKLY, not 
monthly.  Therefore, anything you want to add to the schedule should be scheduled according to 
what timeframe you want it to hit mailboxes.  

2. You can preview the cards that are scheduled to go out that week, any day from a Monday to a 
Thursday before 11:00 p.m. by going to Customer ►Find ► Load Settings and choose which 
postcard you want to preview and highlight it.  Select OK and then OK once more.  

3. When you close up for the day, DO NOT TURN OFF YOUR PC, SERVER, OR ANY 
COMPUTER THAT WE SET UP THE TASK ON, usually on Thursday evenings. You can put it to 
sleep but do not turn it off. If you do the cards will not run and will not be ordered.  

4. If you change an admin password on your server PC and the password is not changed in the task, 
your cards will not go out. 

5. Periodically, at least twice a year, review your customer database to ensure the accuracy of your 
information. 

6. Occasionally do a manual filter of customers using the same filters of your postcard presets and 
view the results to ensure the list matches your desired results. 

7. Train your staff to take a moment with customers to review their information whenever they come 
into the store. 

 
If you need any assistance with setting up your Automatic Postcard Scheduler or presets for postcards, 
please call us at 1-866-580-3343 x 9903 or email us at service@ajsllc.com. 
   

mailto:service@ajsllc.com
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 SnapRetail Integration 
SnapRetail offers targeted customer contact in the form of email and social media.  Because The Edge is 
now integrated with SnapRetail, you can easily upload your Edge customer lists to SnapRetail for easy, 
consistent, and on-going customer promotions.  For more information about what SnapRetail can do for 
you, go to www.snapretail.com.   

4.6.1 SnapRetail Free Trial 
If you're new to SnapRetail and want to give it a try, get started by registering through The Edge: 
 
1. Select Customer ►SnapRetail ►Free Trial.  The Register for Free Trial window will appear. 
 

 
 

The Edge will populate many of the fields based on your license.  You may change them if you like. 
 
2. In the Password field, create a password for your SnapRetail account. 
3. To ensure accuracy, re-enter the same password in the Confirm Password field. 
4. Make notes of the email address and password used here.  They will be your SnapRetail credentials. 
5. Select OK.  The Edge will then automatically create your SnapRetail trial account and integrate it 

with your Edge license by automating a web browser window.  Please do not interact with the web 
browser window; it will disappear once integration is complete.  If an error occurs, the web browser 
window will remain visible so that you can take appropriate action. 

 

http://www.snapretail.com/
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6. Select OK.  Your account will be created and it will be integrated with your Edge license.  When 

integration is complete, a confirmation window will appear. 
 

 
 

4.6.2 SnapRetail Integrating an Existing Account 
If you already have a SnapRetail account, you need only integrate it with your Edge license: 
 
1. Select Customer ►SnapRetail ►Integrate Existing Account.  You'll be prompted to log in. 
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2. Enter your credentials and select Login.  You will be prompted to allow The Edge to access your 

SnapRetail account. 
 

 
 

3. Select Allow.  The connection will be confirmed. 
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4. Select OK.   

4.6.3 SnapRetail Uploading a Group 
After integration is complete, you will be ready to upload an Edge customer list.  If you do not have a 
list created, do so as described in The Edge User Guide in the section entitled Group/Mailing Lists.  To 
upload a group or mailing list:   
 
1. Select Customer ►SnapRetail ► Upload Group. The Upload a Group/Mailing List to 

SnapRetail window will appear. 
 

 
 

2. Select a mailing list from the Pick a Group/Mailing List drop-down menu. 
3. Select OK.  The list view will report back upload steps and results. 
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Changes to your customer data happen only in The Edge.  To refresh your SnapRetail list, perform an 
upload.  Make sure the list is accurate before a promotion goes out.  As a guide, periodically refer to 
your SnapRetail calendar.   

 

 
If you make changes to your data at the SnapRetail website, those changes will be 
overridden if you do an upload from The Edge. 
 

 

 
SnapRetail uses the email address as the unique identifier.  If multiple customers 
have same email address, only the first customer in the list will be uploaded.  If a 
customer has more than one email address, it will upload only the first email 
address listed in the customer record. 

4.6.4 SnapRetail Website 
The Website option (under SnapRetail in the Customer menu) takes you directly to the SnapRetail 
website. 
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 Generating Customer Mailing Labels 
Using The Edge's powerful customer find filter, you can generate mailing labels for all customers in the 
system or for a specific selection (e.g., those who have purchased diamonds within the last year).  For a 
video tutorial about working with customer filters, go to http://www.screencast.com/t/MkdH1e7iQmqR.   
 
To begin creating mailing labels: 
 
1. Select Labels from the Customer function menu.  The Print Customer Labels window will 

appear.  
 

 
 

2. Select the Customer Criteria drop-down menu to access the Customer Find feature.  Select 
criteria for the mailing list much as you would in finding a customer record as described in the 
section entitled Finding a Customer.  Narrow your criteria by entering as much information as is 
desired.  Use the Results tab to specify what name to use as the addressee for this mailing.  This tab 
is very useful in narrowing down your results and gives you a good degree of control in selecting 
specific lists of customers.  For example, you could use this to target the husbands of all married 
women who have a birthday next month.  Be sure to check the default format options as described 
below before you select the customer list.  

 

 

Selecting OK without entering any criteria will prompt The Edge to prepare 
mailing labels for everyone that has a preferred mailing address.  A mailing will 
not include customers without a preferred mailing address.  

 
3. Use the fields in the Label Format area to format the label. 

  
Nacross The number of labels that run across the printed page. 
Width Ea The width of each label. 
Left Margin The left margin of the page. 

http://www.screencast.com/t/MkdH1e7iQmqR
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Ndown The number of labels that run down the printed page. 
Height Ea The height of each label. 
Top Margin The top margin of the page. 
Inside Margins The margin on each edge of each label. 
Portrait Indicates that the page containing the labels is in portrait orientation, i.e., 

taller than it is wide.  
Landscape Indicates that the page containing the labels is in landscape orientation, i.e., 

wider than it is tall.  
Font Returns a standard font dialog. 

 

 

The default format for mailing labels conforms to Avery 5160. 

 
4. Select OK.  A list of customers to include will appear. 
5. Check the ones you wish to print. 
6. Select OK to preview the labels before they are printed.   
7. Select the Print from the lower left corner of the preview window to print the labels or select Close 

to go back and edit the list.   
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 Group/Mailing Lists 
The Edge allows you to create and maintain lists of customers for marketing and reporting purposes and 
those lists can be used throughout the program.  There are two ways you can accomplish this in the 
program.  The group/list option is found under Customer Export.  You can also add customers to lists 
through the Customer Filter under the Other Keys tab.  List membership also appears as a filter in the 
Customer Find filter.  For example, if you want to send an email, from the Customer Find area of the 
Email feature, specify the desired list and those members will be added to the email recipient list.  For a 
video tutorial about working with customer filters, go to http://www.screencast.com/t/MkdH1e7iQmqR.   

4.8.1 Creating a New Group/Mailing List from Customer Find 
1. Select Customer ► Find. 
2. Enter criteria for customers that should be in the list and select OK.  This will return a list of 

matching customers in a customer list window. 
 

 
 
3. Select Group/Mailing List from the bottom of the window.  The Pick a Group/Mailing List 

window will appear with existing groups. 
 

http://www.screencast.com/t/MkdH1e7iQmqR
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4. Select New List to create a new group.  This will return the New Group/Mailing List window 
where you are asked to provide a name for your new group.   
 

 
 

5. Enter a name and click OK.  You have successfully created and saved a list of customers. 

4.8.2 Managing Existing Groups/Lists 
To bring up an existing customer group/list: 
 
1. Select Customer ► Find and go to the Other Keys tab. 
2. From Group/Mailing List drop-down menu, select your list, and select OK. 
3. A list of customers in that particular group will be shown. 
 
To remove customers from an existing group/list: 
 
1. Using Customer ► Find, select the Other Keys tab 
2. Use the Group/Mailing List drop-down menu to find the group you wish to edit. 
3. Select OK to close the Group/Mailing List filter. 
4. Select OK from the Customer Find filter to start the search.  A list of customer in the group will 

appear. 
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5. Right click anywhere in the list and select Show Checkboxes from the context menu. 
6. Right click again anywhere in the list and select Check All. 
7. Go through the list and uncheck those customers you wish to remove. 
8. Select Group/Mailing List and choose your group/list again. 
9. Select the name and select Select. 
10. You will be prompted to indicate whether you wish to use all customers or just those you selected.  

Choose just those you selected. 
 

 
 

11. You will be prompted to indicate whether you wish to Replace or Append.  Select Replace. 
 
To add customers to an existing list: 
 
1. Use Customer ► Find to bring up those customers you wish to add. 
2. Right click anywhere in the list and select Show Checkboxes. 
3. Check all customers you wish to add to this list.  You can right click again to use the Check All 

option. 
4. Select Group/Mailing List at the bottom and choose the group/list to which you want to add these 

customers. 
5. You will be prompted to indicate whether you wish to use all customers or just those you selected.  

Choose just those you selected. 
6. You will be prompted to indicate whether you wish to Replace or Append.  Select Append. 

 

 

4.8.3 Managing Lists from the Customer Record 
You can manage what groups/lists a customer belongs to directly from their customer record.  This 
method only allows you to add/edit/delete one customer at a time from a group/list.  To do so: 
 
1. Select Customer ► Find, look up a specific customer, and double click to open his or her record. 
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2. Select the Other Keys tab. 
 

 
 

3. The pane on the right side contains all currently active groups/lists.  You can assign this specific 
customer to a group by checking it, or uncheck it to remove them.  Also, you can create new 
groups/lists here with the New Group/List button at the bottom. 
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 Exporting Customer Data 
The Edge can export customer records into a separate data file.  To export records from The Edge:  
 
1. Select Export from the Customer function menu.  This will offer the option to export For Mailing 

or For Other.   
 

• For Mailing will include only those customers who have a check in the box labeled Mailing 
Address in the customer record and meet the selected criteria.  Also, For Mailing will only 
return the name and address marked preferred.  Email addresses as well as mailing addresses 
will be included in the export. 

• For Other will include any customer record that meets the selected criteria and return all 
columns available regardless of their mailing address preference.   

 
The Customer Export window will appear.   

 

 
 
2. Select the Customer Criteria drop-down menu to access the Customer Find feature and narrow 

your list as needed.  
 

 

Selecting OK without entering any criteria will prompt The Edge to export all 
customer records with preferred contact information.  The results will include 
addresses marked as the mailing address. 

 

Select the Results tab while specifying customer criteria to specify the export 
output.  Be sure to select Addressee. 

 
3. From the Export Customers For Mailing window, select the Export To File Name drop-down 

menu.  A standard Windows file saving window will appear. 
4. Navigate to the folder where you want the file saved and enter a name for the file.  The file should 

have a .csv extension. 
5. Select Save. 
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6. Select OK.  The export will take place.  This may take a few minutes.  If you see a message that The 
Edge is not responding, do not close the window.  Wait for the process to finish.   

7. Results will appear in a list view.  Check the records to include. 
8. Select OK.  The file will be available where you saved it. 

 

 

The default file type when doing an export is comma separated values (.csv).  This is a 
standard format that can be imported into most applications, including spreadsheet 
applications (MS Excel), word processors (MS Word), and email clients (MS 
Outlook). 
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 Sending Out Customer Emails 
The Edge sends out emails to all of your customers at once.  This mass email function uses your own 
email address and server to send these emails, so you must have a valid email account to use this feature.   
Check with The Edge Support Team for email account compatibility with this feature.  For a video 
tutorial about working with customer filters, go to http://www.screencast.com/t/MkdH1e7iQmqR.   
 
To setup mass email functionality: 
 
1. Select Email from the Customer function menu. 
2. Select Supervisor ► Outbound Mail Settings. 
3. Specify your email account settings.  You may need to contact your Internet Service Provider (ISP) 

or email service provider to obtain this information. 
4. Select OK to save your settings. 
 
To send out mass emails: 
 
1. Select Email from the Customer function menu.  The Email Customers window will appear. 

 
2. Use the To field to specify a recipient’s email address or click the To drop-down to enter criteria to 

search your customer database. 
3. Specify the subject of your email. 
4. Write the body.   
5. Use the Merge Fields drop-down at the top to insert variables that will behave like a mail merge 

when you send the email.  The Edge will pull this data from the customer record and populate the 
email body. 

 

http://www.screencast.com/t/MkdH1e7iQmqR
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Available merge fields include: 
 
FullName Full name of the customer. 
FirstName First name of the customer. 
Spouse The customer's spouse's name. 
Birthday The customer's birthday. 
SpouseBirthday The customer's spouse's birthday. 
Anniversary The customer's wedding anniversary. 
Jobs The envelope numbers belonging to the customer. 
JobCount The number of service jobs associated with the customer. 
RewCurBal The customer's current rewards card balance. 
RewAccru The date to which rewards will accrue. 
RewExpire The date the rewards balance expires. 
RewTier The rewards tier to which this customer is assigned. 

 
6. Write the contents of the email, inserting merge fields where needed.  An example might appear as 

follows. 
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• You can directly edit the HTML code of a customer email by right clicking in 
the body and selecting View Source.   

• To insert an image, right click in the body and select Insert Image. 

 
7. Select any attachments.  This can include images, local files, or something with a URL. 
8. Select OK to generate a list of matching customers.  Select those you wish to email and select OK 

to send out the email. 
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 Working with Statements 
The Edge can automatically calculate and assess finance charges and minimum payments and include 
them on the printed statement.  In addition, with each closed period, the statement balances are aged to 
provide collection reporting for 30, 60, 90 days, and beyond.  Only Store Charge, aka House Account, 
balances are processed for interest and aging.  The Edge allows you to generate statements that include 
interest.  First you should close the billing period, then generate the statements to be mailed.  These 
processes are described below.  For a video tutorial about Statements and Aging, go to 
http://www.screencast.com/t/EgGYdCTuIyE7.   
 

 

Statements and aging must be managed from the headquarters store (usually store 
#1 or 0). 

 

Values for interest rates, minimum payments, and due dates must be set in System 
Options.  If the Statements System Options are not set up, statements will not 
generate as expected.   Customer records may override these settings. 

 

Consumer credit is governed by federal regulation “Title 12: Banks and Banking, 
PART 1026—TRUTH IN LENDING (REGULATION Z)” which applies to retailers 
who meet both of these criteria: 

• The offering or extension of credit is done regularly; and 
• The credit is subject to a finance charge or is payable by a written agreement in 

more than four installments. 
If you meet both of these criteria, then you must comply with several specific 
requirements that The Edge does not yet satisfy.  We are working on those additional 
requirements; for now, we cannot support this for retailers who meet both of these 
criteria. 

4.11.1 Using Statements the First Time Using Versions 6.1 and Higher 
The first time you use the Aging feature, which would be the first time you close a period or run 
statements after upgrading to any version of The Edge starting with v. 6.1, The Edge will accurately pull 
the amount due and will make the best attempt to determine whether the amounts are aged (e.g., 30, 60, 
90 days past due.)  You must verify or adjust this aging one time per customer.  You may wish to go to 
run the Customer Balances report before performing this task to prepare you for this reconciliation. 
 
The Aging feature will show what a customer owes and make an attempt to determine whether it is late 
based on the current statement settings for statements in System Options and historical records in the 
database.  System Options may have changed over time, and because of this, the most recent record for 
a customer might be marked as an estimate and require adjustment so the correct current and past due 
amounts are accurate.  This would also apply to a new user who adjusts statement balances as part of 
new user setup.   
 

http://www.screencast.com/t/EgGYdCTuIyE7
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Check your System Options before you being this process.  The Edge will back up your database before 
the process begins.   In addition, you may wish to check the records of customers for whom System 
Options do not apply.  This is managed in the Options tab of the customer record. 
 

 

This initial statement process should only happen one time.  However, if you have been 
using the store charge (house account) feature heavily or for a long time, be aware that 
it can be quite lengthy, possibly hours.  Be sure you have adequate time to run the 
process before you begin.  You may wish to run it over night or at least during non-
peak hours.  If your workstation goes to sleep during the process, it will start again on 
its own when the system comes back up. 

 
1. From the Customer menu, select Statements ► Print or Statements ► Close.  The Close Period 

window will appear. 
 

 
 
2. Change the dates as needed and select OK.  You’ll be prompted to confirm that you want to proceed 

with aging activities. 
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3. If you select No, you will be exited from the function.  If you select Yes, The Edge will close the 
current and all previous periods, begin processing statement data, and generate a Statement List.  
As mentioned above, this process may take considerable time, so be prepared. 

 

 
 
Shown is a list of customers who have a balance and for whom The Edge has estimated the aging 
for each balance.  In this case, The Edge runs the Statement Find with filters set for first-time 
aging.  In the future, when you use the Statement Find feature, you will be offered filtering options.  
For more information, see the section entitled Finding and Editing Estimates. 
 

4. Locate the record you wish to edit and open it.  Note that for any customer, only the most recent 
statement will be editable.   
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Fields and options to be edited in the Statement window include: 
 
Customer The name of the customer whose record is being adjusted.  Notice that if 

you select Customer, you will be taken to the customer record where you 
can work with the customer's settings or review activities.  

Closed Date The closing period end date of the record being adjusted. 
Minimum Aging 
Breakdown 

 

Current The amount due on the account for current period.   
1-30 Days The amount up to 30 days past due. 
31-60 Days The amount 31 to 60 days past due. 
61-90 Days The amount 61 to 90 days past due. 
Over 90 Days The amount over 90 days past due. 
Minimum 
Due 

Based on System Options, the amount due, usually including all 
overdue balances plus the Current Due. 

Total Balance The total balance on the account. 
Estimate Whether the amounts shown are estimated by The Edge based on 

previous statements.  If you alter the amounts above, this field will be 
cleared on the assumption that you have made all the desired 
adjustments. 

 
5. Make changes to the statement record and save.  Amounts shown under Aging Breakdown should 

add up to equal the Minimum Due. If you agree with the aging shown, uncheck the Estimate 
option. 

 

 

Once adjustments are made or the Estimate option is unchecked and you select 
Save, you cannot undo this action. 

6. Repeat for as many records as necessary. 
7. Note that if the account balance on the most recent statement is $0.00 or a negative value (in which 

a credit is owed the customer), no action is required at this time. 
8. After all adjustments are made, you can proceed with printing statements by selecting Statements 

► Print from the Customer menu. 
 
If you do not adjust/verify aging for all customers, any statements for them will have a disclaimer as 
described in System Options.  In addition, you will be prompted to verify aging next time you work 
with statements. 
 



The Edge User Guide v. 20.0.0.114 

278 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

4.11.1.1 Undoing the First Aging 
In the unlikely event that you wish to undo the initial statement aging, it must be done within 15 days.  
We recommend you contact The Edge Support Team before proceeding.  To undo the process above: 
 
1. Select Statements ► Close Period.  The Close Period window will appear. 
2. Select Period History.   
3. From the Supervisor menu, select Undo All Periods.   

4.11.1.2 Finding and Editing Estimates 
If you have chosen not to adjust or verify accounts as described above, and wish to do so without 
running Statements ► Close, do the following: 
 
1. From the Customer menu, select Statements ► Aging ► Find.  The Statement Find filter will 

appear. 
 

 
 
Fields and options in the Statement Find filter include: 

 
Customer Allows you use the Customer Find feature and returns matching 

records.  
Estimate Allows you to filter results based on whether the statement reflects an 

estimated balance. 
Adjusted Date Allows you to filter by a specific adjusted date.  This is the date that the 

account has been determined to be adjusted from initial estimation by 
The Edge.  For more information about adjustments, see the section 
entitled Using Statements the First Time Using Versions 6.1 and 
Higher. 

Closed Date Allows you to filter by a specific closed date. 
Show Current Only Only the most recent period is editable; this indicates whether to return 

only current closing periods. 
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2. Locate the records using the Statement Find filter.   Depending on the number of records you have, 
this could take some time.  As always, the Presets feature allows you to save search parameters for 
future use.  See the section entitled Presets for more information. The Statement list will appear. 

3. Locate the record you wish to edit and open it.  Note that for any customer, only the most recent 
statement will be editable.   

4. Make changes to the statement record and save.  Amounts shown under Aging Breakdown should 
add up to equal the Minimum Due. If you agree with the aging shown, uncheck the Estimate 
option. 

 

 

Once adjustments are made or the Estimate option is unchecked and you select 
Save, you cannot undo this action. 

5. Repeat for as many records as necessary. 
 

 

You can only adjust an estimate and confirm the aging once for each record. 

4.11.2 Close Period 
You will want to maintain aging, statements, and finance charges on house accounts based on System 
Options.   Closing the period tracks aging and financial information based on the period end date.  The 
Edge then makes that available for printed statements and related customer reports.  When you close the 
period, The Edge will post finance charges and applies aging to accounts.   
 
To close the period: 
 
1. From the Customer menu, select Statements ► Close Period.  The Close Period window will 

appear. 
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2. The Start Date and End Date will be populated based on your System Options and the billing 
cycle that has yet to be closed.  You can use the Prev and Next buttons to scroll through the billing 
cycles.   

3. Check the dates and select OK.  An end date earlier than the current date must be specified. 

4.11.2.1 Undoing Close 
In the event you close a period and later find adjustments are necessary to customer balances, fees, or 
other options, you may undo the period close.  This can be done up to 15 days after the closing of the 
current period.  To undo a close or statement printing: 
 
1. Select Statements ► Close Period.  The Close Period window will appear. 
2. Select Period History.   
3. From the Supervisor menu, select Undo Current Period.  You cannot undo any but the most 

recently closed period. 
 

 

• You cannot undo a close for a period that is more than 15 days closed.   
• Stores who manage house accounts and do not post finance charges should 

still use Close Period function when they print monthly statements because it 
is the only means to track aging.  

• If you attempt to adjust accounts that are from a previously closed period, 
you will be prompted use Undo Close Period to undo the close and close again 
after making adjustments. 

4.11.3 Voiding Statement Finance Charges 
You can void finance charges for a whole batch of statements. This can only happen within 15 days of 
the closing.  For changes to individual finance charges and account balances, do so through the 
Customer Balances tab of the customer record.  To void finance charges for a particular customer: 
 
1. Locate the transaction using any of the following methods: 

• Customer ► Sales ► Find as described in the section entitled Find Sales. 
• Point of Sale ► Review Receipts as described in the section entitled Review Receipts. 

2. Void that transaction, which may be labeled a sale, even though it is an interest charge (under 
Supervisor functions). 

 

 

• When working with statement finance charges, be sure to select the transaction 
that represents the finance charge, not the purchase. 

• To void a whole batch of statement finance charges, use the Undo Close Period 
process described in the section entitled Undoing Close. 

 

 

Finance charge transactions are easily identifiable in receipt lists as they will always 
show up at 11:59 p.m. of the day you applied them. 
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4.11.4 Generating Billing Statements 
The Edge makes it easy to generate billing statements for charge accounts.   
 

 

Statements are generated and sent to the primary customer.   

 
To review and print customer statements: 
 
1. Select Statements ► Print from the Customer menu.  The Customer Statements window will 

appear.   
 

 
 
Fields and options in the Customer Statements window include: 
 
Start Date Allows you to select the date after which activity will be detailed. 
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End Date Allows you to select the date after which activity will not be included. 
Print Date Allows you to specify a different print date from today. 
Due Date Allows you to narrow results by due date. 
Prev Automatically bumps dates back by one period. 
Next Automatically bumps dates forward by one period. 
Customer(s) Allows you to select the customer or customers for whom statements 

should be generated. 
Include Details Indicates that the statement should include item details.  Note that there 

are no item details for a store charge or store credit. 
Include Customers 
with no Mailing 
Address 

Indicates that statements should be generated even for customers who 
have no mailing address, such as those to whom statements can be given 
in person. 

Include Zero 
Balances 

Allows you to select records with zero balances. 

Include Negative 
Balances 

Allows you to select records with negative balances. 

Account Types Allows you to select from a number of different account types: 
 
• House Account 
• Store Credit 
• Layaway 
• Special Order 
• Repair 
• Appraisal 
• Custom Job 
• Memo Out. 
 

Print Lines and 
Boxes 

Indicates whether the lines and boxes between fields should show. 

Preprinted Forms Indicates whether your statements print on preprinted paper forms. 
 
2. Select the desired criteria for the statements you want to generate.   
3. Select OK.    If you have not closed the period, you will be prompted to do so. 
4. The first statement will appear on window.  Please note that the total number of pages will appear in 

the Total Page No. field.   
5. Print the statements.  We recommend printing to the report printer. 
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House account statements should contain only amounts charged to the house 
account, but customers may want an accounting of other outstanding balances such 
as layaway, repair, custom jobs, etc.  If such balances exist, The Edge will run 
statements with sections for both:  a section containing house account activity and a 
section containing other types of account activity.  Further, you can control what 
appears on the latter using the Account Types option described above. 
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House Account Page 
 

 
 
In the event of aged balances, there is a line that reads “x% interest on $x average balance.”  This is the 
calculated finance charge based on the parameters that you set up in System Options.  Note that the 
“average balance” is calculated as the balance per day added together then divided by the number of 
days in the billing cycle. 
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You will also notice the legend “Please pay $x by xx/xx/xx” at the bottom of the receipt.   This is the 
minimum payment calculated according to the parameters that you specified in System Options. The 
date is the payment due date and can be different from the close date. 
 
Descriptions will be truncated at 255 words. 
 

 

As The Edge becomes more compliant with the Fair Credit Reporting Act, payments 
and tracking of items such as layaways and repairs may not be included in the total 
due shown on statements.  It will be necessary to exclude these items from the total 
amount due to ensure compliance.   
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Services Page 
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• Statements will indicate transactions made on a house account, but not detailed 
information about transactions.  Instead, the store charge account will show 
payments and purchases made and the current total balance due.   

• Repair, custom, and appraisal jobs that are marked “Estimate Only” and have 
not been approved will not show on customer statements. 

4.11.4.1 Off-Cycle Statements 
You can specify starting and ending dates to print a statement that covers a period of time that does not 
start or end on a cycle and/or a longer or shorter period than one cycle.  This may be useful if you want 
to give a customer a statement of all charges or just charges within a certain time frame.  However, this 
may cause the amount due and the aging to appear inconsistent. 
 
In the case of off-cycle statements, the statements will be footnoted for full disclosure.  The wording for 
this disclosure can be set in System Options. 
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 Working with Gift Certificates 

4.12.1 Finding and Editing a Gift Certificate 
Gift certificates are usually issued and redeemed at Point of Sale.  But to track details about gift 
certificates purchased at your store, use the Gift Certs function in The Edge’s Customer menu.  Gift 
certificate features can be turned off in System Options.  
 
To review details about gift certificate transactions: 
 
1. Select Gift Certs ► Find from the Customer menu.  The Find Gift Certificates window will 

appear.    
 

 
 
Fields and options in the Find Gift Certificates window include: 
 
Certificate # Returns certificates with the specified ID number. 
Include Allows you to select whether used, outstanding, or both types of certificates 

should appear. 
From Returns certificates purchased by a selected customer set. 
Sale # Returns certificates purchased during a particular transaction. 
Sale Date Returns certificates purchased during a particular date range. 
To Returns certificates intended for a particular person.  
Used by Returns certificates used by a particular customer. 
Sale # Returns certificates used during a particular transaction. 
Sale Date Returns certificates used on a particular day. 
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2. Complete the fields as needed to retrieve the appropriate data. 
3. Select OK.   
4. The Gift Certificate List along with basic information about each will appear on the window.   

 

 
 

To edit a gift certificate: 
 
1. Select a gift certificate from the Gift Certificate List and select Edit or double-click on the record.  

The Edit Gift Certificate window will appear. 
 

 
 
Fields and options in the Edit Gift Certificate window include: 
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Bought By Customer who purchased the gift certificate. 
Recipient Person for whom the gift certificate was purchased. 
Gift Amount The value of the gift certificate. 
Gift Date The date the gift certificate was purchased. 
Expires On Date the gift certificate expires. 
Greeting The recipient as you want the name to appear on the gift certificate. 
Message Personalized message to be included on the gift certificate. 
Pick a Standard 
Message 

Allows you to create and/or select a predefined message from a list in The 
Edge. 

Closing Closing of the message. 
 

2. Edit fields as desired. 
3. Select a save option. 
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 Rewards 
For a video tutorial about using Rewards and Referrals, go to http://www.screencast.com/t/2nzjGmVi. 
To work with customer rewards: 
 
1. Find the reward by selecting Customer ► Rewards ► Find.  The Find Rewards Cards filter will 

appear. 
 

 
 

2. Narrow the parameters as required and select OK.  The Reward Card list window will appear. 
3. Select the record with which you wish to work and select Edit.  The Edit Rewards Cards window 

will appear with the General tab open. 
 

http://www.screencast.com/t/2nzjGmVi
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Fields and options in the General tab include: 
 

Card Number The number of the card to be reviewed/edited. 
Issued To The name of the customer to whom it was issued. 
Rewards Initial Amount The amount originally put on the card. 
Earns Rewards Until The date until which the card can earn rewards. 
Redeem Rewards Until The date until which the customer can use the rewards on the 

card. 
Rewards Tier The tier of the card.  See the section entitled Rewards Program 

for more information. 
Memo Allows you to make notes about the card. 

 
4. Select the Referrals tab to work with referral cards. 
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Fields and options in the Referrals tab include: 
 

Referrals Enabled Indicates that the card can be used for referral bonus money as well 
as rewards.  This can be used to provide a retroactive referral bonus. 

Referred By Allows you to use the Find Customer feature to indicate the 
referring customer. 

Applies to purchases up 
to 

For the referrer to get a bonus, the date by which the referee must 
spend the qualifying amount as entered in the When customer 
purchases qualifying items totaling or more field.   

Referrals Initial 
Amount 

The initial amount of the referral card. 

Referrer Earns… The amount the referring customer will get when the referred 
customer makes a purchase.  This takes the form of a credit memo. 

…When customer 
purchases qualifying 
items totaling or more 

The amount which the referred customer must spend for the referring 
customer to earn the credit indicated in the previous field. 



The Edge User Guide v. 20.0.0.114 

294 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

Included Sale Types Types of sales to include in this referral account: 
 
All Tender 
Inventory 
Repairs 
Custom Jobs 
Appraisals 
Gift Cards. 

 
5. Make changes in the Referrals tab as required and select the Inventory tab. 
 

 
 

The Inventory tab spells out the earnings for inventory purchases, as opposed to services purchases.  
Fields and options in the Inventory tab include: 

 
Inventory Enabled Whether inventory sales will count toward referrals.  The default 

tier will allow more specific inventory types. 
Customer Earns… How much the customer earns for each qualifying purchase. 
For every The basis against which the earnings will be calculated. 
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Minimum Price For rewards to be awarded for the purchase of an item, the item 
must not cost less than this amount. 

Max Item Discount For rewards to be awarded for the purchase of an item, the item 
must not be discounted by more than this amount. 

 
6. Make changes to the fields in the Inventory tab as needed and select the Services tab. 
 

 
 

Fields and options in the Services tab include: 
 

Repair Rewards 
Enabled 

Indicates that rewards and referrals can be accrued on repairs.  

Customer Earns How much the customer earns for each qualifying 
purchase. 

For every spent on each 
qualifying purchase 

The basis against which the earnings will be calculated. 

Minimum Purchase For rewards to be awarded for the purchase of an item, the 
item must not cost less than this amount. 
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Custom Job Rewards 
Enabled 

Indicates that rewards and referrals can be accrued on custom jobs. 

Appraisal Rewards 
Enabled 

Indicates that rewards and referrals can be accrued on appraisals. 

 
7. Make changes to the inventory options as needed and select the History tab, which contains a 

history of card activity.  It cannot be edited. 
 

 
 
8. When all changes are made, select a save option. 

4.13.1 Activating a Rewards Card from Rewards Activation 
Reward and referral cards are usually activated at point of sale, but they can be done from the customer 
record as well.  To do so:  
 
1. From the Customer menu, select Rewards ► Activate.  The New Rewards Card window will 

appear with the General tab open.   
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2. With few exceptions, the fields and options are the same as the Edit Rewards Default Settings.  

The default settings will populate the window.  Enter or accept values as desired.  If you type in an 
amount that exceeds the maximum specified in System Options, an override will be required. 

3. Enter a card number in the Starting Number field.  Alternatively, if you are activating a number of 
cards with sequential numbering and the same settings, you may enter the Starting Number and the 
Ending Number.  If you intend to scan the numbers in, select the Scan and Save option and begin 
scanning numbers.  These need not be sequential. 

 

• When creating rewards cards, you do not have to fill in the issued to or referred 
by customer fields.  These can be blank. 

• If you want to set up a number of rewards cards and then activate them at point 
of sale with these settings.  If you do complete the Issued To customer field and 
the Referred By customer field, the card will default to a rewards card and will 
not pay out the referral bonus because it will not be a new customer at this point. 

• The Rewards/Referrals feature is further detailed in the section entitled Referral 
Cards. 

 
To activate a new card for a specific customer, select Customers ► Rewards ► Find ► Select a 
Rewards Card.   
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 Clienteling 
One of the benefits of a customer database like the one you have in The Edge is that you can use the 
information to build relationships with customers that go beyond passive retail transactions.  By using 
the Clienteling feature, you can view customer history, special anniversaries and dates, and other 
information to help you reach out to customers and offer services, point out promotions, or remind them 
of events that will bring them to you.  Clienteling is knowing to whom to speak about various events and 
when.  Triggers to initiate a clienteling session include: 
  
• Birthdays 
• Anniversaries 
• Big Purchase – 180 days 
• Big Purchase – 11 months 
• Bridal-30 days 
• Bridal-60 days 
• Bridal-90 days 
• Additional bridals. 
 
The Edge produces a form from which the clientelers can work.  Presets will be used to produce the 
appropriate forms each week.  The form will contain: 
 
• Contact Information (Name/Address/telephone #/cell #/email address for both the husband and 

wife) 
• Conversational Information (occupations, activities, kids and their activities, pets, etc.) 
• Purchase History (preferably with images) 
• Items on Wish List with images also when available. 
 
The form will have room for notes as these will be used off-line when phoning customers.  All data will 
be presented even if the field is blank. The clienteler’s job changes with the presence or absence of data 
(i.e., when there is no purchase history or wish items for bridal customer, the clienteler must get in touch 
with the woman and get her to come into the store.  When she is in the store, the clienteler might 
encourage the woman to select a couple of items to go on her wish list so when the anniversary rolls 
around they have choices for the husband). If there is a purchase history or wish list items, the clienteler 
might go after the significant other to plant ideas. 
 
Clientelers are responsible for updating conversational information on an ongoing basis.  A Note field is 
used to record conversational info. 
 
To find customers to target for clienteling activities: 
 
1. Select Customer ► Clienteling.  There you will find a filtering dialog that allows you to filter on 

two levels. 
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• The Customer drop-down returns the customer find filter.  Use it to select target customers for 

the clienteling campaign. 
• The Purchase History drop-down offers a filter that looks like item find.  Use it to identify 

meaningful items that will appear for discussion purposes on the clienteling form.  For example, 
you might only be interested in purchased items over $100.  

 
Although the Purchase History filter and the Merchandise tab of the customer find filter each look 
like item find, the Merchandise tab of the customer find filter is used strictly to select customers 
(e.g., customers who bought an engagement ring within a certain date range), while the Purchase 
History filter is used strictly to determine which items are shown on the clienteling forms for those 
selected customers. 

 
2. Using these filters, create the list of customers you wish to target and list of items to show on the 

form. 
 

 

For clienteling, some values are pre-populated based on typical client-building 
parameters. 

 
3. When the list is returned, it will contain options at the bottom of the window: 
 

Edit Allows the client record. 
Group/Mailing List Allows you to assign clients to a group or mailing list. 
Print Client Profiles Allows you to print a profile of these clients. 

 
4. To see the profiles, select Print Client Profiles.  It might take some to generate the profiles.  A 

client profile might look like this: 
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 Find Wish Lists 
Useful for maintenance, purchasing, follow up calls, etc., you can use this feature to locate customers 
based on their wish list.  To do so: 
 
1. Select Customer ► Wish Lists ► Find.  The Find Wish Lists filter will appear. 
 

 
 
2. Enter parameters that describe the wishes you’re looking for.  As always, the Presets feature allows 

you to save search parameters for future use.  See the section entitled Presets for more information. 
3. Select OK.  A list of customers with matching wish lists will appear. 

 

 
 

4. Select Edit to edit a wish list record.  More detail is provided in the section entitled Wish List.   
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4.15.1 Email Wishes 
Wishes taken at point of sale include the option to send a notification to a potential customer.  However, 
using the Email Wishes feature in the Customer area, you can create a mailing for a number of wish 
lists.    
 

 

• This process could take some time to run.  You might want to wait until off hours 
to run it. 

• The recipient of the list is the person indicated in the original wish creation.  
Make sure you check the recipient before sending these emails. 

 
To send wish list emails: 
 
1. Select Customer ► Wish Lists ► Email Wishes.  The Wish List Email Filter will appear. 

 

 
 

You can develop a mailing list for wish list emails in one of three ways: 
• By individual customer 
• By a group of customers 
• By the associate or associates who took the wish. 
 

2. Use the appropriate find filter to create the desired list.  A matching list of wishes will appear. 
a. Individual customer. The Wish Lists to be mailed window will appear with a list of that 

customer’s wishes.   
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Use the down arrow next to the customer’s name to see his or her wishes.  By default, the 
customer’s wishes will be checked.  Use the checkboxes, All Wishes or No Wishes to 
determine what wishes should be emailed.   
 

b. Several customers.  The Wish Lists to be emailed window will appear with matching 
customers and their wishes.  
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Using the down arrows next to each customer’s name, you can see his or her specific wishes.  
By default, all customers and all wishes will be checked.  Use the checkboxes, All Customers, 
No Customers, All Wishes, and No Wishes to specify which emails to send.   
 

 

You can use the Wishes tab of the find filter to build the list. 

 
c. By associate.  Use the Associate drop-down from the Wish List Email Filter to select the 

associates whose customers’ wishes you want to send. The Wish Lists to be emailed window 
will open.  It works just like the results using several customers.  Make your selections. 
 

3. Select the Email Settings tab to set up the email template.   
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The Edge will complete the name and email address for selected recipients when the emails are sent. 
Note that email headers, footers, and greetings are set in Administrative ► Notifications, so 
opening text is optional.  For more information, see the section entitled Notifications.   
 

4. Select Include to include the salutation shown. 
5. If desired, enter additional or custom text for an opening paragraph.   
6. Enter an additional email address if desired.  Use a semicolon to separate multiple entries.  
7. When all selections and settings are complete, select Email & Close.  The emails will be sent.  

 
A sample wish list email might appear as follows. 

 

 

4.15.2 Wish List Notifications 
You may want to review notifications about wish list activities.  This feature allows you to find the 
notifications concerning wish list items.  For notifications about services, see the section entitled Service 
Job Notifications.   
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To work with wish list notifications: 
 
1. Select Customer ► Wish Lists ► Notifications ► Find.  The Find Wish List Notifications filter 

will appear. 
 

 
 
Fields and options in the Find Wish List Notifications filter include: 
 
Customer Returns records of notifications sent to specified customers. 
Notification Created Returns notifications containing the specified creation date. 
Notification Completed Returns notifications containing the specified sent date. 
Notification Type Returns notifications with the specified type: text message or 

phone call. 
Store Returns notifications with the matching originating store. 
Only Completed Notifications Returns records containing only completed notifications. 
 

2. Make filter selections as desired. 
3. Select OK.  A list of matching notifications will appear. 
 

 
 

4. To work with a record, select See Item/Service.  The Wish List item record will appear. 
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5. Make changes to the record as desired.   
6. Select OK/Save and Close.  You will be prompted to send a notification that the wish list was 

updated. 
7. Select Yes or No.  If yes, The Edge will send the notification.   
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 Email Layaway Reminders 
You may notice that customers are putting things on layaway and not following up. Using the Layaway 
Email feature, you can locate layaways that are inactive and remind customers about them.    
 

 

This process could take some time to run.  You might want to wait until off hours to 
run it. 

 
To send layaway emails: 
 
1. Select Customer ► Layaway Inactivity.  The Past Due Layaway Email Filter will appear. 

 

 
 

Fields and options in the Past Due Layaway Email Filter include: 
 
Customer Filter Returns records of layaways for the specified customers. 
Min Days Since Activity Returns records of layaways that haven’t had any payment or 

other activity for at least this number of days.  For example, 
you only want to see records for layaways that have not had 
activity for at least 30 days (which is the default). 

Max Days Since Activity Returns records of layaways that haven’t had any payment or 
other activity for at most this number of days.  For example, 
you only want to exclude records for layaways that have not 
had activity for more than 60 days (which is the default) so you 
can create a window.  By running the filter for more than one 
window, you can assign a different email, e.g., one with more 
emphasis. 

 
2. Use the Customer Filter to specify customers to contact.   
3. Change minimum and maximum dates if desired. 
4. Select OK.  The Inactive Layaways to be Emailed window will appear. 
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5. For each record, indicate whether to include the customer in the mailing. Note that if there is no 

preferred email address, the email will be blank.  Use the drop-down menu to select an email or 
select the customer name to add an email address. 

6. Select the Email Settings tab to set up the email template.   
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The Edge will complete the name and email address for selected recipients when the emails are sent. 
Note that email headers, footers, and greetings are set in Administrative ► Notifications, but 
opening text is still needed.  For more information about email setup, see the section entitled 
Notifications.   
 

7. Select Include to include the salutation shown. 
8. Enter the message.   
9. Enter an additional email address if desired.  Use a semicolon to separate multiple entries.  
10. When all selections and settings are complete, select Email & Close.  The emails will be sent.  

 
A sample wish list email might appear as follows. 
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 Text Message Marketing 
Much like email marketing, you can use text messaging to send customers texts about available 
products, sale items, and reminders.   
 

 

This process could take some time to run.  You might want to wait until off hours to 
run it. 

 
To create a new text message: 
 
1. Select Customer ► Text Message Marketing.  The Customer Find filter will appear. 
2. Using the Customer Find filter, specify the customers to whom you wish to send the text.  Note 

that by making use of the filter options and building more specific texts, you can refine your 
campaign well.  Based on the results, the Text Messages to be Sent window will appear with a 
listing of contacts.   

 

 
 
3. Check the list and select phone numbers for each recipient.  The preferred number is offered. 

Results with missing or invalid numbers will be outlined in red.  These must be resolved or a 
message will not be sent.  Notice that every customer has a hyperlink to the customer record so you 
can update contact information. 
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To prevent spamming, SMS carriers may limit the number of text messages 
you can send at a time.  We recommend you send fewer than 1,000 text 
messages per day and even send them in batches of less than 200.  If you must 
send more, contact The Edge Technical Support team for assistance. 

 
4. Using the message fields at the top, write the text message. 
 

 
 

a. Use the merge fields to have The Edge pull actual values from the customer record and place 
them into the text message as selected.  

b. Enter text for the message.  When you come to a place for custom information, select the 
Merge Field you wish to insert.   

c. Continue entering text. 
d. Use the Preview field to see an example of how the final text will appear.  Add punctuation and 

spaces as needed. 
 

 

If the character count goes over 160, your messages will be divided into two or more 
separate messages and will be treated as such for the purposes of text message 
charges.  Further, notice that the preview uses dummy text for merge fields; actual 
values may be longer.  Be sure to allow for additional characters when approaching 
the character count. 

 
e. You can include hyperlinks in the body of the text as well. 

5. When you are sure of the recipients and the text, select Send Texts & Close.  The messages will be 
sent. 

 
A history of texts sent will be recorded in Administrative ► Notifications ► Text Message 
Administration and in the customer record Activity tab. 
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 Find Sales 
You can find sales to work with history or returns.  For a video tutorial about working with sales 
transaction record filters, go to http://www.screencast.com/t/JktYkvvS.  
 
To find a list of sales: 
 
1. Go to Customer ► Sales ► Find.  The Sale Criteria window will appear.  This is also available 

from the Point of Sale window. 
 

 
 

2. Narrow your criteria by entering a sale number, sale date or range of dates, customer name, sales 
associate name, store number, station number, station name, or item number. 

3. Select OK.  A list of matching sales records will appear.   
  

http://www.screencast.com/t/JktYkvvS
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4. To print the list, select Print List….   
5. To include voided sales, select Show Voided Sales. 
6. To review the sales receipt for an item, double-click on a particular record or highlight a record and 

select Details…. A preview of the receipt like the one shown during point of sale will appear.  See 
the section entitled Review Receipts for more information. 
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7. To take action on this sale, use the Supervisor menu.  See the section entitled Find Sales Supervisor 
Options.   

4.18.1 Find Sales Supervisor Options 
Notice that the Record Navigation Bar includes a Supervisor option.  Selecting this option will return 
a drop-down list of actions.  
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Void Sale Voids the sale and presents the receipt again listing each entry as void.  You can 
void a transaction that included a trade-in provided the traded-in item is still in 
the original category in inventory or not yet taken in as inventory.  

 

For record-keeping purposes, we recommend reversing a sale 
rather than voiding it. 

 

• If a statement period has been closed, the void button may 
not be available on a store charge. 

• Posting to QuickBooks will include voiding transactions, but 
the check and credit card payments are not removed.  They 
will appear as refunds due. 

 

Change 
Customer 

Offers the Find Customer filter to assign the new customer.  You will be offered 
a dialog box confirming the action.  

Change 
Associates 

Offers the ID The Associate(s) window, as seen in the section entitled Starting a 
New Transaction.  This allows you to enter a new associate ID or split the credit 
among associates.  

Change Why-In/ 
Promo 

Allows a supervisor to change the reason for the customer’s visit.  

Cancel Ends the supervisor options. 
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 Wizards 

4.19.1 Mass Pop-Ups 
This feature allows you to create a Pop-Up and apply it to a selection of customers. 

To use Mass Pop-Ups: 

1. Click Customer ► Wizards ► Mass Pop-Ups.  The Customer Pop-Ups Wizard will appear. 

 
2. Click Next.  Use the Customer Filter drop-down to enter criteria to find customers and click the 

Search button.  A list of matching customers will populate the lower portion of the window.   

 



The Edge User Guide v. 20.0.0.114 

318 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

3. Select the customers you wish to include and click Next. 

4. Enter a Title, choose whether the Pop-Up applies to Couple or Individual, set your dates, and enter 
Notes.  See Customer Pop-Ups Tab for more information. 

 
5. Click Create Pop-Ups to add these to the selected customers. 

4.19.2 Mass Appointments 
This feature allows you to create an appointment and assign it to a selection of customers. 
To use Mass Appointments: 
1. Click Customer ► Wizards ► Mass Appointments.  The Mass Appointments Wizard will 

appear. 
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2. Click Next.  Use the Customer Filter drop-down to enter criteria to find customers and the Contact 
Method drop-down to choose contact type, then click the Search button.  A list of matching 
customers will populate the lower portion of the window.   

 
3. Select the customers you wish to include and click Next. 

4. Specify your appointment details.  See Appointments Tab for more information on appointments. 

 
5. Click Create Appointments to add these to the selected customers. 
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5 Conducting a Point-of-Sale Transaction 
To provide maximum benefit, The Edge’s point-of-sale feature is quick and easy to learn and use.  We 
have designed the point-of-sale process around a single window that will keep the learning curve to a 
minimum and encourage everyone to use it as intended. 
 
This function may be the primary function used for most associates and may be open on most 
workstations most of the time.  Many customer and inventory tasks can be reached from here as needed 
to conduct a transaction. 
 
For a basic video tutorial of working with the Point of Sale function in The Edge, go to 
https://www.screencast.com/t/xAsaOjDydj.    

 Starting a New Point-of-Sale Transaction 
To start a new point-of-sale transaction: 
 
1. Select the POS tab from the Main Navigation Bar.  The Point of Sale window will appear. 

 

 
 

2. Enter the Associate number or use the Associate drop-down list to select the user by name.  Note 
that there is an option labeled Share that allows you to credit more than one associate on a given 
transaction.   

 
a. To enter multiple associates, select Share.  The ID The Associate(s) window will appear. 

 

https://www.screencast.com/t/xAsaOjDydj
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b. Enter the ID of each associate along with the percent of the sale to be credited.  The Even 
button automatically assigns an even split among the listed individuals.   

c. Select OK. 
 

 

For reporting purposes, the associate listed first in the ID the Associate window 
will be considered primary.  On layaway, repair, and special order transactions, 
commission is credited to the associate who originally processed the intake 
regardless of who processes subsequent payments and pickups. 

 
3. The Why In field offers an opportunity to track sources of store traffic.  This information is key to 

marketing strategy.  Select from the Why In drop-down list options, which is populated with a list 
of promotions, or enter a new response.  System Options may be set to require a reply before the 
transaction can take place or allow text entry.   

 

 

If this is the customer's first interaction with the store, the results will be saved in 
the Acquisition field of the customer record, which can later be reported out as a 
history of first-time transactions. 

 
4. Use Find Cust or New Cust to associate a customer with the transaction.  See the section entitled 

Finding a Customer at Point of Sale or the section entitled Adding a Customer at Point-of-Sale.  
5. Proceed to the section entitled Sell Item at Point-of-Sale to continue the transaction. 

5.1.1 Finding a Customer at Point of Sale 
  
The abbreviated Find Customer window uses the same filtering logic as the full Find Customers filter, 
which are described in the section entitled Querying Data, except there are fewer fields with which to 
work.  The Find Customer from point of sale will use your presets from the larger Find Customer.   
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• Results lets you tell The Edge to look for only individual names or couples’ names.  The type of 

result record, individual or couple, will dictate to whom the transaction is assigned.  If you select 
Couple’s Names, the transaction will be assigned to the couple using the primary ID.  If you 
want a specific individual, use Individual Names.  The default selection is selected in System 
Options.  

• Contact Results indicates whether to show only preferred contact methods or all.  
 

 

Remember that from POS, you can use the Notes/Edit button to see the customer 
record.  You can use the Switch to Spouse feature from there as well. 

 
From the abbreviated Find Customer window, if you wish to access the full Find Customers filter, 
select More.  Also, there is a system option to set the default customer find at POS to be the full 
customer find filter.   
 
When using this filter, The Edge will strip extra characters from the phone number.  This means that 
dashes or periods typed differently here will not result in a mis-match. 
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5.1.2 Adding a Customer at Point-of-Sale 
Recording transactions conducted by a customer is important to maintaining customer relations and 
tracking customer activity. You can add customers using the Add a Customer function described in the 
section entitled Adding a Customer.  If you do, customer information can be found using the Customer 
Find filter.   
 
To complete the Customer information section during a point-of-sale transaction, ask the customer his 
or her name and perhaps whether this is their first visit to the store.  If you know the customer is new or 
if you can't find a record using the Customer Find filter, you can create the customer record at point of 
sale as follows:  

 
1. Selecting Add from the search results window or New Cust from the Point of Sale window. The 

Add a Customer window will appear.  The window may appear in three different ways, depending 
on your System Options:  Fast, Fast Plus, and Full.   

 
The Fast customer add option is abbreviated:   
 

 
 
In this window, the More button will return the full Customer Add window.  These fields are 
similar to those in Add A Customer, but streamlined into one window. 

 
The Full customer add option window contains many more of the fields used at Customer ► 
Add.   
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2. Populate the fields in each tab as described in the section entitled Working with Customer Record.  
Required fields are determined by your System Options. 

3. Select a save option.  
 

If there is record in The Edge that is similar:  
 
1. The Possible Customer Matches screen will appear with a listing of possible and probable 

matching records.  
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2. From here, choose from one of two options:  select a customer from the list or add a new customer 

record based on the data entered to date. 
 

a. If the desired customer appears in the list, select the record and Select Customer.  You will be 
prompted to confirm your selection, and any information you added to that point will be 
incorporated with the existing record.   

b. If there is a conflict, you will be prompted to choose the correct data.  Checking Take will 
incorporate the information highlighted in green into the existing record. 

 

 
 

c. Select OK/Save and Close; the record will be saved. 
 

Notice that inactive customer records are highlighted in gray.  If you select one of those, you will be 
prompted to make the record active. 
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3. If the desired customer is not one of the possible matches, select Add New and complete the entry. 
 

 

The duplicate customer feature will help you avoid creating duplicate customer 
records, you might also search for the customer before adding him.  If no match is 
found, use the Add button from the resulting customer list window.  This will auto-
fill your search criteria into the appropriate fields.  For example, if you searched for 
customer Woodrow Wilson and found nothing, press the Add button would 
automatically fill in the first name field with Woodrow and the last name field with 
Wilson. 

5.1.3 Scanning an ID at Point-of-Sale 
To scan customer data directly from a driver's license or business card, use the ScanShell OCR ID 
scanner.  For information about connecting the ScanShell ID to The Edge, see the tip sheet found at 
http://docs.edgeuser.com/TIP-2014-046_ScanShell_ID_Scanner.pdf. 
 
To scan the data: 
1. The ScanShell OCR software must be running in the background.  Start it by double clicking the 

icon that was placed on the desktop during ScanShell software installation. 
2. From the ScanShell application, select the source from the Category drop-down menu.  It will 

default to driver's license/business card. 
3. Go to Point of Sale, click New Cust.  The Add a Customer window will appear. 
4. Scan the license.  The data will be populated in the Add a Customer window and saved to the data 

file.   
5. Scan a business card if available.  The additional data will be populated into the Add a Customer 

window. 
6. Check the data and make changes if necessary.  
7. Select OK. 
8. Continue with the point-of-sale transaction as usual. 

 

• If you scan the back of the driver's license where there is a barcode using the 
ScanShell scanner (not your barcode scanner), you will get a more accurate 
scan, but not the photo.  This is especially helpful if the driver's license is worn 
and unclear.  To do so, select 2D Barcode from the Category drop-down menu. 

• The ID Scanner process only works in the POS New Customer window.  It does 
not work for adding a new customer through the Customer function. 

 
 
 
 
  

http://docs.edgeuser.com/TIP-2014-046_ScanShell_ID_Scanner.pdf
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5.1.4 Other Customer Options at Point of Sale 
Custom data appears at point of sale as follows. 
 

 
 
The following details are shown for returning customers: 
 

A Total number of items ever purchased from your store. 
B Total price of all items purchased from your store. 
C The number of transaction with your store. 
D Total amount tendered with your store. 
E The date this customer was entered into The Edge. 

 

 

Customer data shown here is blended and includes the totals for both parties in the 
couple. 
 

 

Double clicking the customer name from the Point of Sale window will return the full 
customer record for editing. 

 
If an area has activity on record for the customer, the button will be green. Buttons may vary based on 
customer activity. For example, the Rewards button becomes green when there is a rewards balance and 
even lists the amount of balance. 
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No Name 
 
For a customer who does not wish to be saved in the database, from the Point of Sale screen, select No 
Name.  Cash Customer will appear in the Customer field.  Avoid using this on transactions such as 
repairs, layaways, and special orders that have multiple steps, e.g., intake, payment, pickup. 
 
Notes/Edit 
 
Use the Notes/Edit option to add customer notes or edit information as described in the section entitled 
Working with Customer Records.  If you select a different contact method, that is the information that 
will appear in the point of sale window. 
 
Wish List 
If Wish List is active, select it to see items that the customer has expressed an interest in in the past.   
 
Ship… 
 
If an item is to be shipped:  
 
1. Select Ship… to enter shipping information.  The Ship To window will appear. 

 

 
 
a. Enter shipping destination information.   
b. To copy an address from a customer record, use Copy From…. 
c. To cancel the changes you’ve made, select Cancel. 
d. Select OK. 
 

2. Select a save option.   
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The Edge uses this information to apply sales tax as required for the destination as 
opposed to a walk-in customer.  Please consult local tax laws regarding taxation of 
out-of-state sales. 

 
Contact Methods 
 
Use the Contact Methods option to quickly update a customer’s contact information as described in the 
section entitled Customer General Tab.   
 

 
 

 

• Contact methods circled in green are the preferred contact number for each 
contact method.   

• Check the contact method(s) to show on the receipt.  When you choose a different 
contact method other than the default, that is the contact method that will appear 
in the transaction record. 

 
Appts 
 
Use the Appts option to add appointments or work with scheduled appointments.  The Customer Edit 
window will appear with the Appointments tab open.  In this example, because the customer is there in 
your store, you can use the opportunity to address the appointment right there.  Further, you can go to 
any tab in the customer record.   
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Rewards 
 
After you have entered sale items and services for the transaction, you can use the Rewards option to 
indicate that some items should not have rewards. See the section entitled Rewards Tab.   
 

 
 

 

Leaving an item checked means you want rewards applied.  Check All means all of 
these items should have rewards.  Check None means none of the items should have 
rewards applied. 

 

5.1.5 Linked Customer Accounts 
If you have a customer record with a linked Spouse/Partner there is a system option that controls how 
layaways, special orders, repairs, memos, and custom jobs will show at POS and how they will appear in 
the Payment / Pick Up screens. 
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The system option is found under POS Options & provides two choices: 

 
 

True Only display this customer’s available services for payment and/or pick up. 
False Display customer & spouse/partner’s available services for payment and/or pick up. 

 
Example 1 
Customer Pam Smith and spouse John Smith have a linked account. 

 
 
John has a layaway in his name only (1 service). 
Pam has a repair & special order in her name only (2 services). 
 
With this option set to False, all transactions show at POS regardless of customer selected. 

 

 
 
 
With this option set to True, only transactions for the selected customer show. 
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Example 2 
John picks up his layaway and no longer has any services in his name (0 services). 
Pam still has a repair and special order in her name (2 services). 
 
With this option set to False, all transactions show regardless of customer selected. 

 

 
 
 
With this option set to True, only transactions for the selected customer show.  However in this case 
John doesn’t have any transactions, but there are transactions available under his spouse.  To make the 
associate discreetly aware the buttons are highlighted in a light green and do not display the number of 
available transactions. 
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When you do a payment or pick up there is a radio button in the upper right that controls what is shown.  
The system option controls how this defaults but can still be changed at POS. 
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 Sell Item at Point-of-Sale 
To sell an item: 
 
1. Scan the barcode on the item tag.  Fields will appear containing a stock number, description, retail 

discount as either a percentage or a dollar amount, and the price, with and without tax.   
 

 
 

 

With IUOM and PRE stock, it is important to treat sales to account for both the 
amount (ct, grams, etc.) and the quantity (1 diamond, 1 piece, etc.)  This means 
that when working at POS, create a sale line for each piece and enter the unit of 
measure in each.   For example, if you sell three watchbands at $10 each, enter a 
line item for each one.  If you create only one line item for $30, this would not 
properly reduce the physical quantity available in stock and your resulting 
inventory would be off. 
 

 

• If a customer has more than one item, continue scanning as many times as 
needed to add lines.  Delete Line will remove any lines not needed. 

• If you scan an item that is supposed to be located at another store, The 
Edge will require an override to sell it from the scanning store. 

 
2. If you are not using the barcode scanner, select Sell Item from the Point of Sale window.  A new 

line item will appear.    
3. Enter the item ID into the Stock Number field, or select Find/New for the Item Find feature. 
4. The item information will appear on the Point of Sale window.  The More button contains further 

options for working with the item.  For more information, see the section entitled More Button. 
5. The Edge allows you to adjust the sale price in different ways by entering the appropriate amount 

into one of the fields provided for that purpose.   
 

Retail Retail price as defined by the system.  This cannot be changed at point of sale. 
Disc % Percentage by which to discount the item.  This can be changed or be built into 

item record (e.g., item on sale). 
$  Dollar amount to discount the item.  This can be changed or be built into item 

record. 
Price Price as figured by retail and discount fields or may be entered.  
Tax Tax as figured by system settings; this cannot be changed. 
Net Price plus tax.  If you enter a net here, The Edge will calculate Price and Tax for 

you.  If you enter a price here, it will constitute an out-the-door price. 
 
Values in any of these fields will adjust the others as needed. 
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• For any prices or discounts that result in a price lower than the minimum 
markup, as defined in the category and or vendor record for the item, a 
supervisor must approve the transaction. 

• Tax-exempt sales are accommodated by pressing Alt X or clicking on the tax box 
at the bottom right of the window.   

5.2.1 Delete Line 
Notice that after the item is entered, in the item line is an option to delete the sale line.  If you use the 
Delete Line option, you will lose the sale line without any confirmation. 

5.2.2 More Button 
In the item sale line, there is a button labeled More.  The More button contains options for working with 
the item directly from point of sale.  If there are notes associated with the item, the More button will be 
green.  If there is a pop-up note, the More button will blink.   
 

 
 
Depending on the situation and the item, options in the More button include: 
 
View Notes View notes in the item record. 
View Pop-Ups View pop-ups from the item record. 
Item Details Opens the full record for the item. 
Find Item Opens the Find Item filter to locate a different item or the item record. 
New Item Allows you to add inventory at point of sale.  Permission may be required. 
Print Appraisal Generates an appraisal of the item.  This field appears only if an appraisal is 

available for the item. 
Memo Out Changes the item status to indicate that the customer has taken possession of 

the item before deciding to purchase it.  Once this is done, it works much like a 
layaway.  You can take a deposit, take payments, etc.  The difference is that 
with memo out, the item leaves the store.   
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Collection Brings up other items that are part of that collection.  See the section entitled 
Collections for more information. 

Giveaway Marks the item as a promotional giveaway.  See the section entitled 
Promotional Giveaways for more information. 

Donate Marks the item as a donation.  See the section entitled Donating an Item for 
more information. 

Cancel Closes the More sub-menu. 

5.2.3 Working with Item Pop-Ups at Point of Sale 
If an item has a pop-up associated with it, when you scan or enter it at point of sale, a pop-up window 
will appear.  To work with such pop-ups: 

1. Scan or enter the item.  The appropriate pop-up window appears. 

  

2. Work with the customer or item as directed in the window.  
3. If the pop-up is no longer needed, for example if it’s for a specific reminder, check the Do no show 

this Pop-Up again option. 
4. To dismiss the pop-up for this instance, select OK. 
5. If the information within the pop-up is needed again while making the sale, use the More button 

menu and select View Pop-Ups.  

5.2.4 Frequently Sold Items 
Popular items that are frequently sold can be flagged so that they are easily accessible from Point of 
Sale.   
 
To mark an item as frequently sold: 
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1. Use Item Find to search for and edit the item record. 
2. On the General tab, check the Frequently Sold checkbox. 

 
3. These items are tracked by vendor and vendor style.  When you mark an item as frequently 

sold, all other items of matching vendor and style will also have their Frequently Sold 
checkbox updated. 

4. Save your changes. 
 

To use a frequently sold item at POS: 
1. From the POS screen, click Sell Item.  This will add a new blank sale line. 
2. On the sale line, click Find/New, then select Frequently Sold from the menu. 
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3. The Frequently Sold Items window will appear showing all items that have been marked 
frequently sold.   

 
4. Choose the item you wish to sell and click Select to add it to the sale. 
5. Finish the sale normally. 

 

 

• If there are multiple fine jewelry items of the same vendor and style marked 
frequently sold, the oldest one will always be selected for sale first. 
 

• To see which items you currently have marked frequently sold, use the Point of 
Sale Frequently Sold Items checkbox on the Item Details tab of Item Find. 

 
To remove an item from the frequently sold list: 
1. Use Item Find to search for the item record.  If there are multiple items for the same vendor 

and style, you can choose any individual item. 
2. Uncheck the Frequently Sold checkbox. 
3. Save your changes. 
4. For individual items, all items matching this vendor and style will automatically have their 

records updated to remove them upon save. 
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 Other Point-of-Sale Transaction Options 
This section details the use of the Transaction Options area in the Point of Sale window. 
 

 

5.3.1 Make Payment 
Payments on account could be for special orders, appraisals, repairs, custom jobs, layaways, or store 
charges.  At any time after the balance is created, payments can be taken on account.  To do so: 
 
1. From Point of Sale window, identify the customer, and select Make Payment.  A list of open 

orders (special orders, appraisals, repairs, custom jobs, layaways, and store charges) will appear.    
 

 
 
Note that in the Make a Payment window, multiple layaway items on one layaway sale will appear 
as one item.  Fields and options in the Make a Payment window include: 
   

Date The date the charge was incurred. 
Type The type of balance. 
Sale # The transaction ID that included the charge. 
Updated The date of the last transaction against the balance. 
Balance The balance due. 
Minimum Due For house accounts, the minimum payment due for the current statement 

period including all past due balances. 
Description A description of the transaction. 
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2. Select the items for which payments are to be applied.   
3. Select OK.  A sale line item will be added to the Point of Sale window for each payment to be 

made.   
 

 
 

 

• After taking the payment, a tender method is still required as described in 
the section entitled Tender Options. 

• Taking payments on special services is entirely optional.  Customers will 
often pay in full when items are picked up. 

 
4. The Description field will show current amount due and any late payments due for house accounts.  

The Balance field will be populated with the total statement amount due.  The Payment field can be 
modified.  The receipt will also contain this information. 

5. Choose the form of payment being made as described in the section entitled Tender Options. 

5.3.1.1 Payments Using Rewards Cards 
While payment by rewards card can be taken for pickup, The Edge does not allow rewards cards to be 
used for deposits and interim payments.  However, if deposits or interim payments were made in cash, 
The Edge does allow for final payment by rewards card and refund of the cash. 

5.3.2 Pick Up/Finish Special Orders, Layaways, etc. 
If a customer has a special order, layaway, repair, custom job, or appraisal that is ready to be picked up, 
the Pick Up button will be active.  Layaways can be picked up at any time.  Special orders are not 
deemed ready for pickup until the item has arrived in the store and allocated to the special order record.  
Repairs are not deemed ready for pickup until they are marked as done.  To complete that sale or 
transaction: 
 
1. Find the customer for whom the items are being held. 
2. Select Pick Up from the Point of Sale menu.  Alternatively, if the customer presents a receipt for 

the item to be picked up, scan the barcode on the receipt.  In either case, the Pick Up window will 
appear. 
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If you selected Pick-Up, each layaway item for the customer is shown separately; you must select 
the desired item.  If you scanned the item off a receipt, the system knows which item you wish to 
work with and presents only that item.  For repairs, a location will also be shown. 
 

 

Until they are picked up, repair/layaway/special order transactions are not 
counted as sales. 

 

 

• For the customer’s references, the receipt includes a total due at pick-up 
entry. 

• If there are multiple items in a job, items can be picked up separately by 
selecting from the pick-up window only the items desired. 

• Often, conditions must be met before a particular transaction is available 
for pickup.  Repairs, for instance, should be marked done to be made 
available for pickup. 

 
3. A list of items ready to be picked up will appear.  Select the item(s) to be picked up as part of this 

sale, and then select OK.   
4. A sale line item will be added for each item to be picked up, with each price set to the remaining 

balance.  The prices can be adjusted or discounted in the same way as a regular sale line. 
5. When the sale is complete, the order records will be updated to reflect that the customer has picked 

up the items.  If the order was for multiples of the same item, but only some of the items were 
picked up, the system will track that information. 

5.3.3 Canceling an Order at Point-of-Sale 
To cancel an order that has previously been placed: 
 
1. Find the customer for whom the order is to be canceled. 
2. Select Cancel Order from the Point of Sale window.  The Cancel an Order window will appear.   
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Note that in the Cancel an Order window, layaway items are listed separately. 
 

3. Select the item that the customer wants to cancel by checking the appropriate box.   
4. Select OK.   The item number and description number will appear on the Point of Sale window as 

an item with a note confirming cancellation of the item.  The customer’s deposit on the item appears 
as a credit to his or her account. 
 

 
 

5. Enter a fee if applicable. 
6. Proceed with the customer’s transactions. 

5.3.4 Misc Charge 
Misc Charge is used to offset coupons or to sell items not in inventory.   

 

 

The use of Misc Charge for regular sales is discouraged.  Because there are no 
offsetting costs or supporting inventory records on these sales, using this function may 
skew your profit reports. 

 
To enter a miscellaneous charge: 
 
1. Select Misc Charge from the Point of Sale menu.  A line item will appear. 
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2. Click the drop-down list in the line item.  A list of miscellaneous transactions will appear. This list 
varies with your system setup. 

 

 
 

3. Select the desired transaction type. 
4. Edit the description of the miscellaneous charge if desired in the Description field.   
5. Enter the dollar amount of the miscellaneous charge in the Price field.   
6. Check whether the item is taxable. 
7. Proceed with payment as detailed in the section entitled Tender Options. 

5.3.5 Trade/Buy at Point-of-Sale 
To enter a trade-in: 
 
1. Select Trade/Buy from the Point of Sale window.  A line item will appear with Trade In 

automatically appearing in the Stock # field. 
 

 
 

2. Enter a description of the piece in the Description field.   
3. Enter the dollar amount of the trade-in in the Price field.   
4. If permitted by tax law, you may wish to reduce the sales tax by the taxable amount of the trade-in.  

To do so, select the Pre-Tax option. 
5. Proceed with payment as detailed in the section entitled Tender Options. 

 

 

If a trade-in category was specified in System Options, then the trade-in item will 
be created in that category.  Otherwise, no item is automatically created. 

5.3.6 Sell Gift Certificate 
To sell a gift certificate: 
 
1. Select Sell Gift Certificate from the Point of Sale window.  The Sell Gift Certificate window will 

appear.   
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2. Insert as much information as possible, including who bought the certificate, who will receive the 
certificate, the dollar amount, the time period the certificate is good for, and the message listed on 
the certificate.  By selecting Pick a Standard Message…, prewritten messages may be edited, 
added, or selected for use.   

3. Select OK.  The gift certificate will appear as an item. 
4. Print the receipt and the gift certificate will print as well. 

 

 

• If a customer name has already been entered into the Point of Sale window, it will 
automatically come up in the Bought By field of the Gift Certificate window.  In 
addition, a standard closing will automatically appear but can be changed as 
desired.   

• The standard time period for a gift certificate is one year.  When Sell Gift 
Certificate is selected, the current date will be automatically listed and the 
Expires On date will be set as one year later.  The Gift Date and Expires On date 
can both be changed as desired.  Your local government may have restrictions on 
expiration dates. 

• Gift certificates cannot be issued to couples; the individual customer ID will be 
used. 

 

 

It is necessary to specify a recipient on a gift certificate.  If none is known at the time, 
you should create a generic customer record to act as a placeholder.  We often 
recommend using “Gift Certificate Recipient.”  Once the customer comes in to 
redeem the certificate, you can overwrite the customer record with their correct 
information. 

 
  



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 345 
© 2020 Abbott Jewelry Systems, Inc. 

5.3.7 Sell Tender Card 
To sell a tender card: 
  
1. Scan the tender card.  The tender card’s ID number will appear as a line item on the Point of Sale 

window.  If you must enter the tender card ID manually: 
a. Select Sell/Activate Card from the Transaction Options of the Point of Sale window.  The 

Sell/Activate a Card window will appear.   
 

 
 

b. Enter the number of the card to be used.   
c. Select OK or press Enter.   
d. After the card number has been entered, the sale will appear as a line item on the Point of Sale 

window.   
2. Enter the value of the card to be assigned. 
3. Proceed with transactions. 

 

 

Tender card numbering follows a formula that makes the numbers specific to your 
store.  For this reason, you MUST contact The Edge Support Team before ordering 
these cards.  Failure to do so may result in incompatible cards. 

5.3.8 Taking Return 
To take a return for an item with a receipt: 
 
1. Scan the barcode on the receipt. 
2. The line item will appear.  The customer will be identified automatically. 
3. Complete the transaction as usual. 
 
To process a return for an item that has been previously purchased, but for which no receipt is available: 
 
1. Find the customer record. 
2. Select Return/Adjust from the Transaction Options section of the Point of Sale window.  The 

Return Item window will appear.   
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3. A list of items purchased by the customer will appear.   
4. For adjustments on repairs and custom jobs, see the section entitled Adjust a Repair. 
5. Select the item to be returned by double-clicking on it.  If the item to be returned does not appear in 

the list: 
 

a. Select SKU….  The find item filter will appear.   
b. Enter the search parameters, include to whom the item was sold. 
c. Select OK.  The stock number, description, and price of the item to be returned will appear on 

the Point of Sale window.   
 

 
 

 

• To view the original sales receipt for the item, select See Sale.  The See Sale 
button is highlighted in green to remind you that it is useful to determine the 
original tender or check for a trade-in because that might affect the type of 
refund issued, if any.  If this return involved a trade-in, this button would 
appear in red as an extra alert. 

• If returning an item that was sold together with a promotion item, the 
promotion item may now be ineligible for that discount or giveaway.  The 
Edge will prompt for an override.  It may also only refund the difference 
between the returned item and the promotional item.  Check your System 
Options concerning these settings.  
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6. The Amount Due back to the customer will appear at the bottom of the window.  Proceed with 
payment as detailed in the section entitled Tender Options.  System Options determine when cash 
refunds may be made or when a store credit must be made. 

 

 

To accommodate vendor agreements, The Edge allows you to accept returns for items, 
especially bulk, that you don’t normally carry in inventory.  The Edge will attempt to 
create a record for the item using the lowest price sold or based on information 
provided by the vendor.  Be sure to account for such returns in inventory and in 
QuickBooks if you use it. 

5.3.8.1 Care Plan Returns 

 

Sales that contain warranties cannot be voided or altered. 

 

Return data should be uploaded daily from The Edge to your care plan provider 
along with sales data. 

5.3.8.1.1 Item with Care Plan Return 

If an item with a care plan is returned within the care plan return period, the care plan is returned as well.  
The care plan return period is specified in System Options ► Care Plan Max Return Period.  Check 
with your state’s laws on this.  To do such a return: 
 
1. At point of sale, find the customer. 
2. Select Return/Adjust and locate the desired line item. 
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3. Select OK.  The Edge will automatically populate two line items, one for the item to return and one 

for the care plan to return. 
 

 
 
4. Continue with the return transaction as usual. 

5.3.8.1.2 Care Plan Only Return 

The plan alone can be returned as well.  To receive a refund for the plan, it must be returned within the 
care plan return period.  To do so: 
 
1. At point of sale, find the customer. 
2. Select Return/Adjust and locate the desired line care plan to return. 
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3. The Edge will populate the return line item. 
 

 
 
4. Process the return as usual. 

5.3.8.1.3 Care Plan Returns Outside of Return Period 

If the item or care plan return is outside the care plan return period, check with your care plan provider. 
The care plan fee may be prorated.  It cannot be returned through The Edge.    

5.3.9 Special Order Intake 
A customer may request a special order.  To process a special order: 
 
1. Select the Special Order option from the Point of Sale window.  The New Special Order window 

will appear. 
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Notice that as selections are made in the New Special Order window, fields pertinent to the special 
order will appear.  Fields and options in the New Special Order window may include: 
 
Vendor Info Enter or select from the drop-down list a vendor for the item. 
 ID The vendor’s ID in The Edge. 
 Style# The vendor’s style number. 
 Style Note Text added to the style number that will help identify the item.  For 

example, it might be stone type, size, etc. 
Item  
 Item Type Enter a generic type of item desired. 
 Category Enter or select a category for the item.  
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Either Item Type or Category is required.  When either field is specified, an 
additional section regarding item details is enabled. 

Pricing Contains pricing options. 
 Price is 

Estimated 
Indicates that the price is an estimate.  It will show as such on the receipt.  If 
you do check this box, you will be offered three additional options: 
 
To Be Determined Indicates that the estimate should be provided 

when more information about the order is 
available. 

Call Before Starting Indicates that the customer wants to know the real 
price before you place the order. 

Do Not Exceed… Indicates that if the price is over the indicated 
amount, the customer does not want the item. 

 Cost Cost of the item to the store. 
 Price Price of the item to the customer. 
 Quantity Quantity of the item desired. 
 Ext Extended price, or price times quantity. 
 Tax Whether tax is to be collected; the amount will be calculated based on the 

price. 
 Total Total of the price plus tax.  This is calculated for you. 
 Deposit Amount the customer is paying as a deposit. 
Need More 
Info 

If the item cannot be ordered from a vendor until more information is gathered, 
select this option.   

Location To be populated using the Move Envelope function. 
Notify Allows you to select the method by which to notify the customer when the order 

is in.  For more information, see the section entitled Notifications.   
Details These fields vary according the item type or category, similar to the way the 

Item Entry window works.  
ETA Estimated Time of Arrival.  The date that this item is expected to arrive. Enter or 

select a specific date from the date picker.   
ETA is 
Estimated 

Indicates that the ETA might not be accurate. 

Notes Notes for this special order.  These will print on the envelope, but not on the 
receipt. 

Description The description of the item to be ordered.  This should be detailed enough to 
place the order.   
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Copy Details Allows you to select a similar item from which to copy details.  After which, you 
can alter details as needed to meet requirements for this special order. 

2. Enter as much information as is available from the options listed on the window.  If you enter a style 
number that has been used before, The Edge will prompt you to copy the details into this record.  
You can then refine the information for this order. 

3. Select OK/Save & Close to save the data and add a new sale line to the Point of Sale window.   
 
For more about working with and receiving Special Orders, see the section entitled Special Orders.  

5.3.9.1 Taking Special Order Payments 
Sometimes a customer may want to make a payment against an outstanding special order prior to pickup.  
To process a payment: 
 
1. Go to Point of Sale. 
2. Select Find Cust and search for the customer (or scan the claim check). 
3. Select Make Payment. 
4. The Make a Payment window will appear containing any open balances.  Check the special order 

record and select OK. 
5. Enter amount of payment. 
6. Finish the transaction. 

5.3.9.2 Special Order Pickup 
A special order item will only be available for pickup if an item has been matched to it.  To do so: 
 
1. From Point of Sale, select Find Customer and search for the customer (or scan their claim check).   
2. Select Pickup/Finish (lights up green when transactions available for pickup). 
3. The Pickup window will appear with any available pickups.   
4. Check the special order record and select OK. 
5. Finish the transaction.  Any remaining balance will be due. 
 

5.3.9.3 Taking Special Order Returns 
In The Edge, special order return is treated just like any other item.  The store must establish and 
enforce, apart from The Edge, its own rules regarding returns of special order items.  As part of this 
policy, you should decide whether returned special order items retain the special order stock type or 
whether they should then become stock items.  This is adjustable via the stock type field on the item 
record.  By default, The Edge will leave this set to special order. 

5.3.10 Appraisal Intake 
To document an order being accepted for appraisal: 
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1. Select Appraisal Intake from the Point of Sale window.  The Appraisal Intake window will 
appear.   
 

 
 
Fields and options in the Appraisal Intake window include: 
 

Item # If an item is or was part of The Edge inventory, use the drop-down 
options to find the item. 
 

 

If the selected item has a completed Pre-Appraise tab, 
that information will be added here automatically. 

 

Camera icon ( ) Allows you to photograph the item for reference.  See the section entitled 
Photographing an Item for more information.  Note that many 
photographs can be added when performing the appraisal.  You can also 
insert an existing image file.  For more information, see the section 
entitled Adding and Managing Photos. 

Liability Value The value of the item, pre-appraisal, in the event of a loss. 
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Item in our 
possession  

Whether the item was left at the store as opposed to doing the appraisal 
based on existing records. 

Appr Fee The fee to be charged to the customer for the appraisal service. 
Fee is Estimated Whether the fee is fixed or an estimate to be confirmed. 
Tax Whether the fee is taxable.  If it is, the tax field will be calculated by The 

Edge. 
Subtotal The fee plus tax.  This value is calculated for you. 
Deposit The deposit to be left by the customer toward the fee. 
Due at Pickup The remainder of the subtotal to be paid when the item is picked up. 
Cost The cost of this appraisal. 
Notify Allows you to select the method by which to automatically notify the 

customer when the appraisal is complete.  For more information, see the 
section entitled Notifications. 

Need by The day by when the customer requires the appraisal. 
ETA Estimated day when the appraisal will be complete and the item available 

for pickup. 
Description A description of the item. 
Notes Additional notes about the item or the appraisal request.  These notes 

appear only on internal documents, not on any document the customer 
should see. 

ETA is Estimated Whether the ETA is estimated or firm from the appraiser. 
 
2. When as much information as possible about the item has been entered, select OK.  The appraisal 

will be added as a sale line item to the Point of Sale window.   
 

 

You are not actually doing the appraisal at this time, just taking it in as an order.  
See the section entitled Appraisal for information on managing the actual appraisal. 

5.3.11 Repair Intake 
To accept an item for repair, select Repair Intake from the Point of Sale window.  The Repair Intake 
window will appear with the Tasks tab showing.  The Repair Intake window is divided into two 
sections.  The top section takes information about the item to be repaired and the bottom section takes 
information about the required repair details.   
 
For a video tutorial about Repair and Custom Job Intake at POS, go to 
http://www.screencast.com/t/KvV0G9Wprc.  

5.3.11.1 Repair Information 

http://www.screencast.com/t/KvV0G9Wprc
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Data fields in the top part of the Repair Intake window deal with taking information about the item 
before repair and working with tasks required to perform the repair. 
 

 
 
Fields and options available in the top portion of the Repair Intake window include: 
 

Item Description (for 
customer receipt) 

A description of the item that will appear on the receipt. 

Already Finished In the event the item is repaired while the customer waits, check this 
option to indicate that tracking is not necessary.  Doing so creates a one-
step repair that does not require pickup and is counted as finished 
immediately. 

Camera icon ( ) Allows you to photograph the item for reference.  See the section entitled 
Photographing an Item.  Note that multiple photographs can be added to 
the repair history. 

Declared Value The customer’s declared value of the piece.  This is very important in the 
event of a loss; the insurance company will only pay up to this amount.  
Whether this is a required item is controlled by system settings. 
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Private Notes Notes about the item that the customer will not see on a receipt. 
Condition Notes Notes about the condition of the item.  This will not appear on the 

receipt. 
Express Service Select this if the customer requires a quick turnaround. 

 

 

If the Express Service option is selected, an estimated 
date of arrival must be entered in the ETA field.  This 
will increase the price by a factor specified in System 
Options. 

 

Estimate Only Indicates that this is an estimate, and work should not be performed until 
the customer has approved it.  
 

 

If you’re using estimates, you must record customer 
approval under Repair Edit. 

 

Who The associate to whom the task is being assigned.  It is a drop-down 
menu of associates who are listed as jewelers in their associate records.  
Go to Administrative ► Associates to change an associate’s status. 

Show All Associates Changes the Who drop-down menu to include associates who are not 
listed as jewelers so that you can assign the task to anyone. 

Notify Allows you to select the method by which to automatically notify the 
customer when the repair is complete.  For more information, see the 
section entitled Notifications. 

Item # For items sold by your company, enter the item number for easy record 
keeping. 

 
Enter information about the item as described above and complete the Tasks portion of the Repair 
Intake window.  The bottom portion includes three tabs:  Tasks, Parts, and History. 
 

 

System Options may require that a photo be taken of every repair taken in. 

5.3.11.2 Repair Tasks 
Found on the lower half of the Repair Intake window, the Tasks tab is one of three sections in the 
Repair Intake window used to collect repair instructions and information.  At least one task must be 
entered. 
 
To complete the Tasks portion of the Repair Intake window: 
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1. Select the Tasks tab.   
 

 
 
Task lines can be slimmed down to allow more lines to fit on the window.  This is a setting in 
System Options.  If you have that turned on, use the Task Details button to see the information that 
would be on the full-sized task line.  
 

 
 

2. Type in a SKU or select Find SKU to search the SKU database.  Or select the SKU drop-down 
menu for a list of frequently-used SKUs.  Alternatively, you can bypass the SKU field and manually 
enter your task details and pricing information.  To find a SKU in the database: 

 
a. Select Find SKU.  The SKU Lookup window will appear.   

 

 
 

b. Select from the Frequent SKUs drop-down menu. 
c. Search for a SKU from the search field (indicated by the magnifying glass icon). 
d. Type in a Task Keyword or choose from the drop-down list.   
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e. After a Task Keyword has been selected, you may enter a second Task Keyword or enter a 
Task Description manually or by using the drop-down list. 

f. In addition, you may browse through SKUs by using the Prev and Next buttons to view SKUs 
currently in the system.   

g. Select the desired SKU. 

 

Selecting Pick… will bring up a list of all matching Repair SKUs in the 
system. 

 
h. Select OK. 
 

3. The task details will be retrieved from the database of repair tasks and the other fields on the task 
line will be pre-filled from the database.  Note that dollar amounts will automatically be listed for 
price, labor, and additional price.  Select whether tax is applicable by checking the box next to each 
item.   

4. To add another repair task to the item, select Add Task.  A second task line will appear to be 
completed as above.   

5. To cancel a previously entered task, which was already saved, select Cancel/Uncancel Task.  This 
will also remove the cancel date and renew the task if selected again. 

6. To change the order in which a task appears on the list, select the Move Task Up or Move Task 
Down buttons from the bottom portion of the Repair Intake window.   

7. To enter more specific details about a task, select Task Details.  The Repair Task Detail window 
will appear.   
 

 
 
The General tab allows you to enter more detailed information about the repair.  There are two tabs 
on this window.  Fields and options in the General tab include: 
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SKU Enter or browse for a SKU appropriate for this task. 
Done Use the drop-down list to enter a completion date. 
Canceled Use the drop-down list to enter a cancellation date. 
Task Desc A description of this task. 
Details Enter any notes about the task that might assist the technician. 
Who Enter the associate ID number of the repair technician to whom the task was 

or is assigned. 
Where Enter the workstation or outside location where the task was or is to be 

performed. 
Cost The following fields apply to cost. 
Revised Parts Enter the updated cost to the store for parts. 
Revised Labor Enter the updated cost to the store for labor. 
Revised Other Enter the updated cost to the store for other repair expenses (shipping, etc.). 
Revised Total Enter the updated total cost to the store. 
Original Parts Contains the original cost to the store for parts. 
Original Labor Contains the original cost to the store for labor. 
Original Other Contains the original cost to the store for other expenses. 
Original Total Contains the original total cost to the store. 
Price The following fields apply to price. 
Revised Parts Enter the updated price to the customer for parts. 
Revised Labor Enter the updated price to the customer for labor. 
Revised Other Enter the updated price to the customer for other expenses. 
Revised Total Enter the updated total price to the customer. 
Original Parts Contains the original price to the customer for parts. 
Original Labor Contains the original price to the customer for labor. 
Original Other Contains the original price to the customer for other expenses. 
Original Total Contains the original total price to the customer. 

 

 

The Revised fields offer entry fields for original data if this is a new task or for 
an update if task expectations change.  The Original fields will be empty the first 
time the task is entered, but will contain values if the record is changed. 

 
TX Parts Whether the price of parts is to be taxed. 
TX Labor Whether the price of labor is to be taxed. 
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TX Other Whether the price of other expenses is to be taxed. 
ETA Use the drop-down list to select a date that the task should be completed. 

 
 
In the Parts tab of the Task Details window, parts for the task will be listed.  Fields and options in 
the Parts tab include: 
  

In Stock Indicates whether the part is available in-house or must be ordered. 
Vendor The vendor from whom the part was or is to be ordered. 
Style The style number for the part. 
Metal The type of metal of which the part is made. 
Material The material of which the part is made. 
Size The part size required for the repair. 
Price The price of the part to the customer. 
Add Allows you to add a part to the task in a separate window that contains fields 

similar to those listed above as well as others. 
Task# Parts are assigned to tasks rather than the repair in general.  This is the task 

for which this part is needed. 
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Item# If the part is an item in the store’s inventory, the SKU to be taken out of 
inventory and used in this task. 

Remove Remove a part from the task. 
Details Contains part details. 
Recommended Offers a list of recommended parts.  This information can also be found in 

the Parts tab in the Task Details area of the Repair Intake window.   
 

 

With IUOM and PRE inventory used as parts, it is important to treat consumption 
for service jobs to account for both the amount (ct, grams, etc.) and the quantity (1 
diamond, 1 piece, etc.).  For service, it means creating a part line for each part and 
enter the unit of measure.  For example, if you use three .10-ct diamonds for a job, 
you must specify this by adding three separate parts, each being .10 carats.  Do not 
add one part of .30 carats as this would not properly reduce the physical quantity 
available in stock and your resulting inventory would be off. 

 

Details about parts used in the repair can also be viewed by selecting the Parts tab 
from the bottom half of the Repair Intake window. 

 
8. Add parts by selecting Add from the Parts tab of the Repair Details window.  The New Part 

window will appear.  
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Fields and options in the New Part window include: 
 

Task The task number in the repair and its description. 
Item # The item ID, if the item is sold in the store. 
Vendor The vendor ID. 
Ven Style# The vendor’s style number or SKU for the item. 
Barcode The barcode for the item, if it is sold in the store. 
Metal Type The type of metal the item is made of, if applicable. 
Metal Color The color of the metal, if applicable. 
Metal Weight The metal weight of the item. 
Item Style The style of the part. 
Size The size of the part. 
Length The length of the part, if applicable. 
Description A description of the part. 
Quantity How many of the part is required. 
UOM How the parts are quantified, e.g., each, per ounce, per inch, etc. 
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Price Each The price to the customer for each unit of measure. 
Cost Each The cost to the store for each unit of measure. 
Belongs to 
Customer 

The part is provided by the customer for use in the job.  If checked, the 
price of the part will be hidden.   
 

 

If this is checked, the Price Each and Cost Each fields on 
this window will disappear.  A new field, Declared Value, 
will appear.  This allows you and/or the customer to provide 
an estimated value from the customer for liability purposes.  
Finally, it changes the part status from Non-Inventory to 
Customer-Owned. 

 

In Stock and 
Ready to Use 

The part is readily available. 

Ordered When the part was ordered.  This must be done in purchasing. 
Received When the part was received. 
Canceled If and when the part order was canceled. 

 
9. Enter an estimated time of arrival in the ETA field or select a date from the drop-down calendar.  If 

estimated time of arrival is estimated, select ETA is Estimated.   
10. After a task is entered, a price will be listed at the left of the window.  If this price is estimated, 

select the Price is Estimated box.  When selected, this box will ask you to choose from the 
following: 

 
• To Be Determined 
• Call Before Starting 
• Do Not Exceed… 
 
Select all that are appropriate by checking the boxes.  If Do Not Exceed… is selected, a dollar 
amount must be entered into the adjoining field.   

5.3.11.3 Repair Parts 
After adding the details described above, the Parts tab of the Repair Intake window will show that part.  
It includes details about the parts used in the repair, including vendor, style, metal, material, size, and 
price.   
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The Parts window lists parts required for the repair.  Data listed in the Parts tab includes: 
 
In Stock Indicates whether the part is available in-house or must be ordered. 
Task Indicates for what task the part is needed. 
SKU The SKU for the part. 
Vendor The vendor from whom the part was or is to be ordered. 
Style The style number for the part. 
Metal The type of metal of which the part is made. 
Material The material of which the part is made. 
Size The part size required for the repair. 
Price The price of the part to the customer. 
Add Directs you to add a part to a task. 
Remove Directs you to remove a part from the task. 
Details Contains part details. 
Recommended Offers a list of recommended parts.  This information can also be found by 

selecting the Parts tab in the Task Details area of the Repair Intake window.   
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5.3.11.4 Repair History 
The History tab provides information about the history of the piece in for repairs, including details about 
previous repairs, who worked on the piece, and any additional notes that were recorded. 
 

 

The history tab can be used to take additional photographs of this repair.  You may 
add one additional photograph per added note.  This is useful for documenting 
before-and-after on a repaired piece. 

 
Select Save & New from the bottom of the window to record additional repairs in a separate envelope or 
select OK/Save & Close to complete the repair order, close the Repair Intake window, and return to 
the Point of Sale window.   

5.3.11.5 Adjust a Repair 
Occasionally, it may be necessary to make adjustments to repair or custom jobs that are already marked 
as picked up.  These adjustments could be simple monetary changes (refunding money or collecting 
more) or could be changes such as adding tasks or parts.  Here are a couple examples. 
 
Example 1.  A customer decides some quick additional work is necessary, which is done while the 
customer waits when they bring the job back in.  Additional tasks can quickly be added and charged for 
as an adjustment on the existing job. 
 
Example 2. A customer is dissatisfied with work performed and you decide to refund the money paid.  
This could be done as an adjustment in a similar to performing a return of merchandise. 
 

 

• Adjustments made to repair or custom jobs do not change the status of the job to 
open. 

• If a repair is adjusted, the adjustment cannot be voided later. 

 
The following steps will guide you through a simple adjustment to refund money to a customer: 
  
1. From Point of Sale, locate the customer record.   
2. Select Return/Adjust.  A list of the customer’s activities will appear.   
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You can filter the results by item type, repair, or other transaction. 
 
3. Find the repair in question and double click it or select it and select OK.  The Point of Sale window 

will open the repair record. 
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4. Change the Parts, Labor or Other price fields to reflect the amount being refunded.  If the charges 

are being refunded in full, select Set All to Zero. 
 

 

• All adjusted fields in the Adjust Repair will be highlighted in yellow. 
• Right click any adjusted field and choose original value to undo the 

adjustment. 
• Revert button will undo all adjustments on the window. 
• If the job was previously adjusted, “Previously Adjusted by (associate) and 

Date” will appear in red. 
• Original total and adjustment total will appear on the window. 
• Any money due back to or from the customer will be tendered at the Point of 

Sale window after saving the adjustment. 
5. Select a reason for the adjustment from the Adjustment Reason drop-down menu. This is required.  
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To modify Adjustment Reasons, go to Administrative ► Lists and edit the 
Repair/Adjustment Reason list. 

 
6. Enter a description in the Adjustment Description field.  This is required. 
 

 

This text from both the Adjustment Reason field and Adjustment Description field 
will appear on the customer’s receipt. 

 
7. To quickly refund everything and set all price amounts to zero, select Set All to Zero. 
8. Select OK/Save & Close.  
9. Continue with the other sales transactions as normal. 

5.3.11.6 Working with Care Plan-Covered Repairs 
Before charging the customer for repairs, be aware of what types of repairs are covered and for how 
long.  Some care plan providers may provide a list of places where customers can take their repairs, but 
we feel they will most likely come to you.  
 
If a customer brings in an item from repair and the item was bought from your store, at intake: 
 
1. Bring up the customer at point of sale. 
2. Select Repair Intake.   
3. From the Item # drop-down menu, select Bought.   A list of items purchased by the customer will 

appear. 
 

 
 
4. Select the item to be repaired.  The Repair Intake window will show that the item has a care plan. 
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5. Complete the repair intake fields as usual. 
6. When you get to the repair SKU, select Find SKU.  The Repair SKU Lookup window will appear.  

The Care Plan SKU option will appear on the bottom of the window. 
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7. Select Care Plan SKU.  The keywords Care Plan will appear in the keywords field. 
8. The Task Desc and SKU drop-down menus will be populated with services available for covered 

repairs or services.   
9. From the Task Desc drop-down menu or SKU drop-down menu, select the desired repair. 
10. Select OK. 
11. Complete the repair intake as usual.  Notice that costs to the customer are all 0. 
 

 
 
12. When you upload activities at the end of the day, your claim for reimbursement from your care plan 

provider will be submitted. 
 

 

At some point you must visit your care plan provider portal to confirm that the 
customer is eligible for the repair.  We recommend that it be after a brief initial intake 
before the work is performed.  Then we recommend that you obtain a verbal approval 
to proceed before doing the work.  Finally, at some point, the customer will be asked 
to sign off that they understand they have used that benefit. 

5.3.12 Custom Job Intake 
A customer may request custom work, either to modify an existing item or to create a new item.  
 
For a video tutorial about Repair and Custom Job Intake at POS, go to 
http://www.screencast.com/t/KvV0G9Wprc.   
 

http://www.screencast.com/t/KvV0G9Wprc
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To perform a custom job intake, select Custom Job Intake from the Point of Sale window.  The custom 
job intake window is split into four tabs.  
 

 

5.3.12.1 Custom Job General Tab 

Describe End 
Product 

Enter a description of the expected final product.  Information entered here 
will print on the receipt. 

Other Details Enter details specifically for internal reference.  Information entered here will 
not print on the receipt, but will print on the job envelope. 

Already Finished Check this box to make this a one-step custom job.  With this checked, a 
custom job is taken in and picked up on the same receipt. 

Express Service Check this to apply the express service markup price modifier as specified in 
System Options. 

Estimate Only Check this if this custom job is only a quote and no work is to be actually 
performed at this time. 
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Price is Estimated Indicates that the price is an estimate.  It will show as such on the receipt.  If 
you do check this box, you will be offered three additional options: 
 
To Be Determined Indicates that the estimate should be provided when 

more information about the order is available. 
Call Before Starting Indicates that the customer wants to know the real 

price before you start on the job. 
Do Not Exceed… Indicates that if the price is over the indicated 

amount, the customer does not want you to do the 
work. 

Item # If applicable, allows you to use the Item Find feature to associate an 
inventory item record. 

Declared Value Enter the declared value of any items being taken from the customer that are 
being used in this custom job for liability reasons. 

Subtotal The total of the custom job without tax. 
Tax Total tax on the custom job. 
Total Final total of the custom job with tax. 
Deposit Enter the amount being put down with the custom job intake. 
Due at Pickup This is the amount due before this custom job can leave the store.   
ETA The estimated completion time for this job.   
ETA is Estimated If the ETA listed above date is not firm, check this box. 

Camera icon ( ) Use this feature to capture or attach an image. 

Notify Allows you to select the method by which to automatically notify the customer 
when the job is complete.  For more information, see the section entitled 
Notifications. 

5.3.12.2 Custom Job Tasks 
The Tasks tab is one of four sections in the Custom Job Intake window used to collect custom job 
instructions and information.  At least one task must be entered. 

 
To complete the Tasks portion of the Custom Job Intake window: 
 
1. Select the Tasks tab.   
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2. Type in a SKU or find a SKU using the Find SKU option.  Or, use the SKU drop-down menu to 

choose from frequently-used SKUs.  Alternatively, you can bypass the SKU field and manually 
enter your task details and pricing information.  To find a SKU in the database: 

 
3. Select Find SKU.  The SKU Lookup window will appear.   

 

 
 

4. Select from the Frequent SKUs drop-down menu. 
5. Search for a SKU from the search field (indicated by the magnifying glass icon) 
6. Type in a Task Keyword or choose from the drop-down list.   
7. After a Task Keyword has been selected, you may enter a second Task Keyword or enter a Task 

Description manually or by using the drop-down list. 
8. In addition, you may browse through SKUs by using the Prev and Next buttons to view SKUs 

currently in the system.   
9. Select the desired SKU. 

 

Selecting Pick… will bring up a list of all matching Repair SKUs in the system. 

 
10. Select OK. 
11. The task details will be retrieved from the database of repair tasks and the other fields on the task 

line will be pre-filled from the database.  Note that dollar amounts will automatically be listed for 
price, labor, and additional price.  Select whether tax is applicable by checking the box next to each 
item.   
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12. To add another custom job task to the item, select Add Task.   A second sale line will appear to be 
completed as above.   

13. To cancel a previously entered task, which was already saved, select Cancel/Uncancel Task.  This 
will also remove the cancel date and renew the task if selected again. 

14. To change the order in which a task appears on the list, select the Move Task Up or Move Task 
Down buttons from the bottom portion of the Custom Job Intake window.   

15. To enter more specific details about a task, select Details.  The Custom Job Task window will 
appear.   
 

 
 
The General tab allows you to enter more detailed information about the repair.  There are two tabs 
on this window.  Fields and options in the General tab include: 
 

SKU Enter or browse for a SKU appropriate for this task. 
Done Use the drop-down list to enter a completion date. 
Canceled Use the drop-down list to enter a cancellation date. 
Task Desc A description of this task. 
Details Enter any notes about the task that might assist the technician. 
Who Enter the associate ID number of the repair technician to whom the task was 

or is assigned. 
Where Enter the workstation or outside location where the task was or is to be 

performed. 
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Cost The following fields apply to cost. 
Revised Parts Enter the updated cost to the store for parts. 
Revised Labor Enter the updated cost to the store for labor. 
Revised Other Enter the updated cost to the store for other repair expenses (shipping, etc.). 
Revised Total Enter the updated total cost to the store. 
Original Parts Contains the original cost to the store for parts. 
Original Labor Contains the original cost to the store for labor. 
Original Other Contains the original cost to the store for other expenses. 
Original Total Contains the original total cost to the store. 
Price The following fields apply to price. 
Revised Parts Enter the updated price to the customer for parts. 
Revised Labor Enter the updated price to the customer for labor. 
Revised Other Enter the updated price to the customer for other expenses. 
Revised Total Enter the updated total price to the customer. 
Original Parts Contains the original price to the customer for parts. 
Original Labor Contains the original price to the customer for labor. 
Original Other Contains the original price to the customer for other expenses. 
Original Total Contains the original total price to the customer. 

 

 

The Revised fields offer entry fields for original data if this is a new task or for 
an update if task expectations change.  The Original fields will be empty the first 
time the task is entered, but will contain values if the record is changed. 

 
TX Parts Whether the price of parts is to be taxed. 
TX Labor Whether the price of labor is to be taxed. 
TX Other Whether the price of other expenses is to be taxed. 
ETA Use the drop-down list to select a date that the task should be completed. 

 
 In the Parts tab of the Task Details window, parts for the task will be listed.   
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Fields and options in the Parts tab include: 
 
In Stock Indicates whether the part is available in-house or must be ordered. 
Vendor The vendor from whom the part was or is to be ordered. 
Style The style number for the part. 
Metal The type of metal of which the part is made. 
Material The material of which the part is made. 
Size The part size required for the repair. 
Price The price of the part to the customer. 
Add Allows you to add a part to the task in a separate window that contains fields 

similar to those listed above as well as others. 
Task# Parts are assigned to tasks rather than the repair in general.  This is the task 

for which this part is needed. 
Item# If the part is an item in the store’s inventory, the SKU to be taken out of 

inventory and used in this task. 
Remove Remove a part from the task. 
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Details Contains part details. 
Recommended Offers a list of recommended parts.  This information can also be found in the 

Parts tab in the Task Details area of the Custom Job Intake window.   
 

 

Details about parts used in the job can also be viewed by selecting the Parts tab 
from the bottom half of the Custom Job Intake window. 

 
16. Add parts by selecting Add from the Parts tab of the Custom Job Task window.  The New 

Custom Part window will appear.  
 

 
 
Fields and options in the New Custom Part window include: 
 
Task The task number in the repair and its description. 
Item # The item ID, if the item is sold in the store. 
Status The status of the item, e.g., inventory, non-inventory, etc. 
Vendor The vendor ID. 
Ven Style# The vendor’s style number or SKU for the item. 
Barcode The barcode for the item, if it is sold in the store. 
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Metal Type The type of metal the item is made of, if applicable. 
Metal Color The color of the metal, if applicable. 
Metal Weight The metal weight of the item. 
Item Style The style of the part. 
Size The size of the part. 
Length The length of the part, if applicable. 
Description A description of the part. 
Quantity How many of the part is required. 
UOM How the parts are quantified (e.g., each, per ounce, per inch, etc.). 
Price Each The price to the customer for each unit of measure. 
Cost Each The cost to the store for each unit of measure. 
Belongs to 
Customer 

The part is provided by the customer for use in the job.    If checked, the price of 
the part will be hidden on the receipt.   
 

 

If Belongs to Customer is checked, the Price Each and Cost 
Each fields on the New Part window will disappear.  A new 
field, Declared Value, will appear.  This allows you and/or the 
customer to provide an estimated value from the customer for 
liability purposes.  Finally, it changes the part status from Non-
Inventory to Customer-Owned. 

 

In Stock and 
Ready to Use 

The part is readily available. 

Ordered When the part was ordered. 
Received When the part was received. 
Canceled If and when the part order was canceled. 

 
17. Enter an estimated time of arrival in the ETA field or select a date from the drop-down calendar.  If 

estimated time of arrival is estimated, select ETA is Estimated.   
18. After a task is entered, a price will be listed at the left of the window.  If this price is estimated, 

select the Price is Estimated box.  When selected, this box will ask you to choose from the 
following: 

 
• To Be Determined 
• Call Before Starting 
• Do Not Exceed… 
 

19. Select all that are appropriate by checking the boxes.  If Do Not Exceed… is selected, a dollar 
amount must be entered into the adjoining field.   
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5.3.12.3 Custom Job Parts 
The Parts tab provides a listing of the parts used in the custom job, including vendor, style, metal, 
material, size, and price.  The parts are collected from all the task details that included adding a part. 
 

 
 
The Parts window lists parts required for the repair.  Data listed in the Parts tab includes: 
 

In Stock Indicates whether the part is available in-house or must be ordered. 
Task Indicates for what task the part is needed. 
Task SKU The repair SKU. 
Item # If the part is an inventory item, the item number. 
Vendor The vendor from whom the part was or is to be ordered. 
Style The style number for the part. 
Metal The type of metal of which the part is made. 
Material The material of which the part is made. 
Size The part size required for the repair. 
Price The price of the part to the customer. 
Customer 
Owned 

If the customer provided the part, it should be indicated in the Part window by 
checking Belongs to Customer. 

Declared Value Enter the declared value of any items being taken from the customer that are 
being used in this custom job for liability reasons. 

 

 

With IUOM and PRE inventory used as parts, it is important to treat consumption 
for service jobs to account for both the amount (ct, grams, etc.) and the quantity (1 
diamond, 1 piece, etc.)  For service, it means creating a part line for each part and 
enter the unit of measure.  For example, if you use three .10-ct diamonds for a job, 
you must specify this by adding three separate parts, each being .10 carats.  Do not 
add one part of .30 carats as this would not properly reduce the physical quantity 
available in stock and your resulting inventory would be off. 
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5.3.12.4 Custom Job History 
The History tab provides information about the history of the custom job, including details about 
previous repairs, who worked on the piece, and any additional notes that were recorded. 
 

 

The Job History tab can be used to take additional photographs of this custom job.  
You can add one photograph per added note.  This is useful for documenting before 
and after on a repaired piece. 

 
Select Save & New from the bottom of the window to record additional repairs in a separate envelope or 
select OK/Save & Close to complete the repair order, close the Repair Intake window, and return to 
the Point of Sale window.   
 

 

For more about working with custom jobs, see the section entitled Repairs and 
Custom Jobs. 

5.3.13 No Sale Tracking 
The No Sale Tracking button indicates that a customer was served, but no sale is to be recorded.  
Associates will be required to key in their IDs and passwords so the information can be included in the 
attendance report.  Such an action can take place during another associate’s activity without interfering 
the sale. 
 
This information is reported on the Attendance Report found under Management ► Staff.  
Specifically, the # No Sales column indicates how many customers the associate assisted, but did not 
sell.   

5.3.14 Backdating 
The Edge allows you to backdate transactions prior to entering them at point of sale.  This is useful for 
keeping time sensitive reports (such as Daily Activity or Sales Tax) accurate.  To backdate a transaction, 
press the button that displays the current date and time at point of sale. 
 

 
 
The resulting window allows you to change the time and date. 
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After you are finished entering past transactions, be sure to revisit the backdate button and set the time 
and date back to normal. 
 

 

Once a sale has been entered, the only details that can be altered are the customer 
and/or the sales associate on the transactions.  If other changes are needed (such as 
altering payment type), you will need to void and re-enter that transaction.  Be sure to 
backdate in these instances. 

 

5.3.15 Park 
To pause the transaction while you work with another customer, select Park. 
 
To return to the parked transaction, find the parked window in the task bar at the bottom of your window 
and open it back up. 

5.3.16 Start Over 
To cancel a transaction and erase all items from the window, select Start Over.  A dialog will appear to 
confirm the action.  Select Yes to clear all current information and clear the data.   

5.3.17 Open Drawer 
Select Open Drawer to open the cash register drawer.  This action may require proper authorization or 
may be disabled entirely.  These authorizations are controlled in System Options. 

5.3.18 Review Receipts 
You can look up receipts to review or make changes to a transaction.  For a video tutorial about working 
with sales transaction record filters, go to http://www.screencast.com/t/JktYkvvS.  
 
To review receipts of past transactions: 
 

http://www.screencast.com/t/JktYkvvS
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1. Select Receipts from the Point of Sale window.  The Sale Criteria filter will appear.  This is also 
available by selecting Sales ► Find from the Customer area. 
 

 
 

2. View a specific transaction by entering a sale number in the Sale Number field or a range of 
receipts by entering a range in the Sale Date field using the drop-down list.  To further narrow 
search criteria, enter a specific store, station number, and/or associate.   

3. When finished, select OK.  All sales that match the criteria will appear.   
4. To print the list, select Print List….   
5. Double-click on a specific sale or highlight a specific sale and select Details to view the receipt and 

details about the sale and inventory.   
 

 

Selecting Review Receipts has the same effect as performing a Customer ► Sales ► 
Find command. 

5.3.19 Promotional Giveaways 
The Give this Item feature allows you to keep proper accounting for items given away for promotional 
reasons.  In giving items away, there are no particular tax benefits, unlike in donating items, which are 
tracked in the Donate this Item feature.   

5.3.19.1 Giveaway Setup 
1. Go to Administrative ► System Options and scroll down to POS Options. 
2. Enter a value in the Giveaway Threshold Amount – Percentage option.  This option sets the most 

a giveaway can be as a percentage of the sale.  For example, if this threshold is set at 20 percent, and 
you sell a $100 item, the value of the giveaway cannot exceed $20.  If this threshold is exceeded at 
point of sale, an override will be required. 
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3. Also in System Options ► POS, scroll down to Return Items when on a Sale with a Giveaway 
Item to set the level of security needed to permit giveaway returns. 

4. Scroll down to System Options ► Receipt Options and indicate whether the percent threshold 
should be shown in Show Discount Percent Threshold. 

5. Scroll down to System Options ► Wording Options and indicate how you want giveaways to be 
described on receipts. 

5.3.19.2 Conducting a Promotional Giveaway at Point-of-Sale 
To give away an item: 
 
1. Conduct a sale from the Point of Sale window as usual.   
2. Create sale item lines as usual. 
3. To indicate an item is to be given away, in the line item, select More…. 

 

 
 

4. From the More… sub-menu, select Giveaway.  The item will appear with its retail cost as usual and 
the sales price as $0. 
 

 
 

5. Continue the transaction as usual. 
6. Depending on System Options settings, the receipt will indicate that the item is a giveaway.  This 

may be pertinent if the item is brought back for return. 
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• For reports on promotional giveaway activities, go to Reports ► Inventory ► 
Giveaways. 

• For those using integrated accounting with QuickBooks, assign the Giveaway 
feature to an appropriate expense account with the guidance of your accountant.   
Accounts are changed in Administrative ►QuickBooks ► Setup QuickBooks 
Integration ►Accounts. 

• Giveaways can be put on gift receipts like any other item.  The gift receipt list 
selector DOES show giveaway in the beginning of the description.  If you wish to 
exclude it, there will be no indication that it was free on the receipt. 

5.3.20 Donating an Item 
The Donate Item feature in The Edge allows you to donate items and track the activity.  To donate an 
item: 
 
1. Conduct a sale from the Point of Sale window as usual.   
2. Create sale item lines as usual using Sell Item. 
3. To indicate an item is to be donated, in the line item, select More…. 
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4. From the More… sub-menu, select Donate. 
5. The sale line item will indicate a price of zero. 
6. Continue the transaction as usual. 
 

 

• The customer must have a designation as being a tax-exempt entity, and there 
must be a tax ID number on record.  To designate a customer as tax exempt, find 
the customer record, and in the Options tab, check the Tax Exempt option.  This 
cannot be overridden. 

• Donated items can only be transacted alone or with other items to be donated.  
• Donations may only be returned by the person to whom they were donated. 

 

 

• For those using integrated accounting with QuickBooks, assign the Donation 
feature to an appropriate expense account with the guidance of your accountant.   
Accounts are changed in Administrative ►QuickBooks ► Setup QuickBooks 
Integration ►Accounts. 

• A donation may facilitate the need for a gift receipt.  The gift receipt list selector 
does show “donation” in the beginning of the description in case you wish to 
exclude it. 

• New item status, donation, can be included or excluded on any inventory or filter 
using the letter code N. 

• To see a report of donation activity, go to Reports ► Inventory ► Donations. 

5.3.21 Suggesting from Collections 
Collections allow you to do some suggestive selling based on items created as a collection. To see how 
to create collections and enter items, see the section entitled Collections.  To work with collection pop-
ups: 
 
1. If an item from a collection is sold at point of sale, a window will appear suggesting other items 

from the collection.   
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2. Offer to show the customer the items. 
3. If they wish to buy one, select it from the list and select OK.  A sale line will appear.  The More 

button will contain options for viewing the collection. 
4. Continue with the sale as usual. 

 

 

If a customer expresses interest in an item from a collection but does not plan to 
purchase it right away, you can save it in their Wish List. 

5.3.22 Scanned Service Menu 
The POS system option Display_a_Menu_on_Service_Scan controls the behavior at POS when a 
service job envelope is scanned.   
 
If this option is set to False, scanning a service job will add the job to the sale as a pick up if available 
(i.e. job marked complete) otherwise it will add the job to the sale for payment. 
 
If this option is set to True, scanning a service job will bring up the Scanned Service Action menu: 
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5.3.23 OFAC Sanction List Check 
Federal law stipulates any retailer that annually purchases $50,000 or more in over-the-counter buys is 
required to check any sellers’ contact information against the Office of Foreign Asset Control (OFAC) 
sanction list.  Learn more on the official OFAC website here. 
 
To facilitate this, The Edge now integrates with the OFAC sanction list and will check customer contact 
information against the list when a Trade/Buy is completed at POS.  If there are any matches, they will 
be displayed along with how probable of a match it is. 

5.3.23.1 Setup 
To setup and enable the OFAC sanction list check: 

1. Click Administrative > System Options. 
2. Scroll down to POS Options. 
3. Find the option OFAC List URL and copy/paste in this URL: 

https://www.treasury.gov/ofac/downloads/sdn.xml 
4. Find the option OFAC Probable Match Threshold and set this to 0.8. 
5. Click OK to save your changes. 
6. Restart The Edge. 

5.3.23.2 Use 
Once enabled, the OFAC check will happen when you complete a POS transaction that includes a 
Trade/Buy.  If there is a potential match this window will appear.  

 
 
The OFAC Warning window will show potential matches along with the probability that they are a true 
match.  This probability is based on comparing both the name and address. 
If you believe the match may be valid: 

1. Navigate to https://sanctionssearch.ofac.treas.gov/ and run the search with the customer’s name 
and address to verify the match is real. 

https://www.treasury.gov/resource-center/sanctions/pages/default.aspx
https://www.treasury.gov/ofac/downloads/sdn.xml
https://sanctionssearch.ofac.treas.gov/
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2. Validate the customer information is accurate. 
3. Follow the steps outlined here:  

https://www.treasury.gov/resource-center/faqs/sanctions/pages/faq_compliance.aspx#start 

 

https://www.treasury.gov/resource-center/faqs/sanctions/pages/faq_compliance.aspx#start
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 Working with Care Plans at POS 

 

We recommend that your associates introduce the care plan during the sales process, 
when showing the piece and talking about the benefits and pricing before getting to 
point of sale.  That way it’s not sold as an add-on or interpreted as an upsell.  There is 
an option in the Categories Tags tab to add the care plan price or price plus item retail 
to item tags. 

 
To work with product care programs at POS: 
 
1. When making a sale at POS, after you have entered the associate, found the customer, scanned the 

item, you’ll see that each sale line contains an option to add the care program. 
2. If your license allows more than one kind of plan, use the drop-down menu to see care plan 

available.  If not, the default will show. 
 

a. Multiple Plans Available  
 

 
 
b. Single Plan Available  
 

 
 

3. Explain the care program to your customer and ask if they would like to purchase it; you can refer to 
the drop-down menu to offer various programs and prices. 

4. When the customer agrees, select the appropriate plan and the Include Care Plan checkbox. 
5. The care plan price will appear in the sale line below the final item price.  Change it if desired. 
 

 
 

 

• If you’re selling more than one of the same quantity, but the customer only 
wants protection on one or some of them, sell the items in separate sale lines 
and indicate the care plan in only the desired sale line. 

• If the customer wants to add the plan after the sale is complete, return the 
item and resell it with the plan. 
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6. The transaction total will include the fee and, if applicable, sales tax on it.  Talk with your 
accountant and see the section entitled Setup Tax Definitions if your tax jurisdiction requires tax on 
such fees. 

7. Complete the sale as usual.   
8. Depending on your System Options, if you select Done without checking the Include Care Plan 

checkbox, you will be prompted to confirm that you talked with the customer about it. 
 

 
 

9. Select Yes or No and discuss the plan with the customer. 
10. Continue with the sale. 
11. When you select Done, if the customer does not have an address, phone number, and email address 

on record, you will be prompted to provide this information: 
 

 
 

a. Select OK to see the Select a Phone Number, Email and Address that you want for the 
warranty window. 
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b. Select + Address, + Phone, or +Email as requested and enter the desired information. 

 

 
 

c. Select OK.   
d. Select Done again to complete the sale.   
 

12. The receipt will show the plan. 
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13. Some care plan providers offer an email or printable version of the term.  To view and print the care 
plan terms, select Care Plan from the receipt window.  If the receipt is to be emailed, the terms will 
go out with the email.  You can also go to the shared folder (e.g., 
C:\ProgramData\AJSLLC\edge\CarePlanTerms) and print them out ahead of time. 
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• Your sales data should be reported to your care plan provider on a daily basis 
using the process described in the section entitled Uploading Transactions and 
you will be billed accordingly.  Be sure this data matches that in the Care Plan 
Report. 

• There is no sales tax shown on the sale line in POS, but it will be added to the 
total and on the receipt. 
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 Tender Options 
The Tender Options section of the Point of Sale window allows you to select one or more types of 
tender and complete a transaction.  To process payment of an item or service, select a payment type from 
the options listed on the bottom left corner of the window.   
 

 
 
When making a sale using The Edge, the subtotal and total will automatically update as items are added 
and removed.  Likewise, the Tendered and Due category will update as payments are made.   

 

 

Multiple tender options can be used on the same transaction, even multiple tenders of 
the same type (e.g., two different Visa cards).  Further, when the Tender window 
comes up, it will default to the remaining amount due. 

5.5.1 Cash 
To receive a cash payment: 
 
1. Select Cash.  The Cash Tender window will appear.  The dollar amount required to satisfy the 

remaining balance of the purchase will automatically appear in the Amount field.   
 

 
 

2. Select OK if this is the amount to be paid in full or, if accepting a partial payment, manually enter 
the amount to be paid. 

3. Select OK.   
 

 

To process change, select Cash once and enter the amount given.  Select OK.  Select 
Cash again, and select OK, and the change due back will appear.  The receipt will 
reflect this change. 
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5.5.2 Check 
To accept a payment by check: 
 
1. Select Check.  The Check Tender window will appear.   

 

 
 

2. Enter the check number in the Check # field.  The dollar amount required to satisfy the remaining 
balance of the purchase will automatically appear in the Amount field.   

3. Select OK if this is the amount to be paid in full or, if accepting a partial payment, manually enter 
the amount to be paid. 

4. Select a check type from the Check Type drop-down menu. 
5. Select OK.   

5.5.3 Credit Card 
Credit card processing varies slightly based on your credit card processing company and the type of card 
reader.  The following video tutorials for taking credit cards at POS are available:   
 

Credit Card Processing with the PAX S300 http://www.screencast.com/t/9BETcnjM  

Credit Card Processing with the VX805 http://www.screencast.com/t/RTr01QS3b4 

 
Generally, to accept a payment by credit card, use the following process allowing for those variances: 
  
1. Select Credit Card.  The Credit Card Tender window will appear.   

 

http://www.screencast.com/t/9BETcnjM
http://www.screencast.com/t/RTr01QS3b4
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Fields and options in the Credit Card Tender window vary by system type, but might include: 
 
Amount The amount to be charged to the card.  It will default to the sale 

amount. 
Card Number The credit card number. 
Card Type The kind of credit card:  Visa, MasterCard, etc. 
Exp MMDD The expiration date of the card. 
Name on Card The name of the person on the credit card account. 
Auth Code The authorization code returned by the processing company. 
Voice Authorized/Forced Indicates that authorization was obtained on the phone or forced 

by the associate. 
Reset Allows you to clear the fields. 
Click Here… The Edge Support Team cannot assist with credit card 

processing issues.  This link to the credit card processor for 
assistance. 

OK Allows you to continue with charging the sale to the card. 
Cancel Cancels the credit card transaction. 
 
Most of these fields will automatically populate when you slide or insert the card through the reader. 
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2. The dollar amount required to satisfy the remaining balance of the purchase will automatically 
appear in the Amount field.  Change the amount if necessary.   

3. Check the amount due and select OK.  That tells The Edge to start interaction with the card reader.  
The reader will not begin until OK is pushed. 

4. When prompted to do so, swipe the credit card.  For cards with an EMV chip, insert into it the chip 
reader. Alternatively, select the Manual Entry tab and process as described below.  

5. If it was a debit transaction, when prompted, allow the customer to enter the PIN.  
6. Press OK on the keypad.  The processor will obtain the card information and return to The Edge 

Credit Card window with the authorization code. 
7. Verify that tender as shown in the Tender area is complete. 
8. Select OK. 

 

 

Credit card choices are defined by a system list.  See the section entitled Lists for 
information on editing this list. 

If you must record the credit card transaction manually: 
 
1. Conduct the sale as you normally would. 
2. Select Credit Card from the tender area. 
3. Select the Manual Entry tab if the processor has one.  Otherwise, go to step 5. 
4. Select OK; this is important to enable the entry fields and tell The Edge to start interacting with the 

card reader. 
5. Use the keypad on the card reader to enter the account number, month and year of expiration, the 

customer’s ZIP code, and the security code from the card.  The reader may ask if the card has an 
EMV chip; if so, answer Yes.   

 

 

When a card number is hand-entered and the terminal device prompts for the ZIP 
code, be sure to enter the customer’s actual billing ZIP code.  Entering an incorrect 
ZIP code or bypassing the ZIP code field could result in a decline or higher fees. 

 
6. Select OK on the keypad. 
7. The Edge will process the data, populating the fields in the Credit Card window. 
8. When it is complete, finish the sale by checking the tender amount and completing the sale. 
 
For some devices, manual entry is similar; you will need to use The Edge Credit Card window to enter 
the data. 
 
For voice authorization: 
1. Conduct the sale as you normally would. 
2. Select Credit Card from the tender area. 
3. Check the Voice Authorization checkbox. 
 
If you are working offline from your credit card processor: 
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1. Select the Offline tab. 
2. Complete the remaining fields manually. 
3. Select OK.  This will record the sale in The Edge only. 
4. Make arrangements to upload the transaction data to your credit card processor. 

5.5.3.1 Cancelling a Credit Card Transaction before Completing the Sale 
In The Edge, a credit card transaction gets sent to the processor when it is approved, before you select 
Done to complete the transaction.  To cancel it:   
 
1. Before selecting Done, select the tender line from the tender area of the Point of Sale window. 
 

 
 
2. Select Del Line.  You'll be prompted to confirm the action. 
3. Select Yes.  The tender line will be deleted. 
4. Select another tender method and complete the transaction. 
5. Be sure to provide the receipt to the customer reflecting the cancelled charge. 
 
If you need to cancel the whole transaction after the credit card has been processed, but before you 
complete the sale: 
 
1. Void the payment as described above. 
2. Delete all the sale lines or use the Start Over option.   
3. Complete the transaction by clicking the Done button to view and print the receipt. 

5.5.3.2 Voiding a Credit Card Transaction After Completing the Sale 
If you must correct an error, and if settlement has not occurred, you can void a sale, although we 
recommend that you avoid this wherever possible. 
 
To void a credit card transaction: 
1. Locate the sale from the Point of Sale window using the Receipts feature or from Customer ► 

Sales ► Find. 
2. Open the sale record. 
3. From the Supervisor menu, select Void Sale. 
4. You may be prompted to swipe, insert, or tap the credit card. 
5. Complete the void as usual. 
6. Be sure to provide a receipt to the customer. 
 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 399 
© 2020 Abbott Jewelry Systems, Inc. 

 

Debit transactions cannot be voided. 

 

Voiding credit card transactions, or any transaction, is not recommended.  It is better 
for record-keeping purposes to reverse the transaction.  Only void a transaction when 
there is an actual error.  Finally, if there are technical issues precluding proper 
processing, do not void the transaction.  Resolve the transaction with the credit card 
processor and then reverse the transaction.  If technical issues remain, the reversal 
may require assistance from the credit card processor as well. 

 
For more about credit card processing, see our video tutorial at: 
 

Credit Card Processing with the PAX S300 http://www.screencast.com/t/9BETcnjM  

Credit Card Processing with the VX805 http://www.screencast.com/t/RTr01QS3b4 

 
For more about credit troubleshooting, see the section entitled Credit Cards.   

5.5.4 Gift Certificate 
If a customer has a gift certificate outstanding, the Gift Certificate payment option will be green.  
However, if it is not, the customer may still have a valid gift certificate to present for payment.  You may 
or may not feel the need to match up the customer with the gift certificate.   
 
To accept payment by gift certificate: 
 
1. Scan the gift certificate barcode.  If you don’t have a barcode scanner, or if the barcode is obscured, 

select Gift Cert.  The Redeem Gift Certificate window will appear.   
 

http://www.screencast.com/t/9BETcnjM
http://www.screencast.com/t/RTr01QS3b4
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2. Select the gift certificate to be used by selecting it from the list shown or, if the certificate is not 

listed, select Cert#....  The Key in Gift Certificate # window will appear.   
 

 
 

3. Enter the gift certificate number and the full face amount in the appropriate fields. 
4. Select OK.  The value of the certificate should appear.  If the gift certificate is not found, a window 

saying that the gift certificate is not on file will appear and ask if you want to use it anyway.  To do 
so, enter your associate number and password.  This is useful for accepting gift certificates not 
issued through The Edge. 

 
If the recipient of the gift certificate does not match the user:  
 
1. From the Key in Gift Certificate # window, enter the certificate number.  The Customer ID 

Mismatch window will appear. 
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In the Present Customer ID field, the person presenting the gift certificate for use will appear.  In 
the Customer Who Bought the Item field, the person for whom it was purchased will appear.   
 

2. Based on the data, select an option: 
 

Keep the Present Customer The Edge will accept the gift certificate using the 
presenting customer. 

Switch to Customer on Gift 
Certificate 

The Edge will repopulate the Customer field on the 
Point of Sale window to be the person for whom the 
gift certificate was bought. 

Do Not Accept This Gift Certificate The Edge will not apply any gift certificate and will 
await new tender instructions. 

 
3. Continue with the sale as usual. 

 

 

Gift certificates are always applied in full to a transaction.  If a gift certificate is larger 
than the current purchase, you should issue a new gift certificate for the remainder.  
Gift certificates are never partially used. 

5.5.5 Rewards/Tender Cards 
While payment by rewards card can be taken for pickup, The Edge does not allow rewards cards to be 
used for deposits and interim payments.  However, if deposits or interim payments were made in cash, 
The Edge does allow for final payment by rewards card and refund of the cash.   
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To accept a rewards card toward a purchase or refill a tender card: 
 
1. Scan the reward card’s barcode.  The Tender Card window will appear with the card number and 

balance.   
 

 
 
In this example, the purchase price was deducted from the card balance and the remaining amount 
was left on the card for future use. 
 

2. Select OK. 
 
If the card number must be entered manually: 
 
1. Select Tender/Reward Card.  The Tender/Reward Card window will appear. 
 

   
 

2. Enter the amount to be tendered in the Tender Amount field or select Use Max to use the 
remaining balance of the card towards a purchase.   

3. Select OK if this is the amount to be paid in full or, if accepting a partial payment, manually enter 
the amount to be paid.   
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There is far more detail about working with reward and referral cards in the section 
entitled Rewards under Administrative. 

5.5.5.1 Applying Earnings to Rewards Cards 
To indicate that some items in the sale should or should not apply to rewards earnings: 
 
1. Conduct the sale as usual. 
2. Before selecting a tender option, select the Rewards button that appears near the customer 

information box. 
3. A dialog will appear indicating, based on rewards settings, the items available to earn credit.   
 

 
 
4. To disallow credit from an item, uncheck it.  To accept the items to apply, leave them checked.   
5. Select OK. 

5.5.6 Layaway 
To put an item on layaway: 
 
1. Select Layaway.  The Layaway Items window will appear.   
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2. Select the items to be put on layaway.  If all items are to be put on layaway, select Check All from 
the bottom left corner of the window.   

3. Enter the amount put on deposit or the amount to be put on layaway; when you complete one of 
these fields, the other will be calculated.  Alternatively, select the minimum or maximum values to 
enter them in the deposit and layaway fields.   

 

 

The minimum deposit and maximum layaway amounts to be accepted are listed 
to the right of the Deposit and Layaway fields as defined by System Options. 

 
4. Select OK.   
 

 

When using a trade-in as part of the deposit towards a layaway, it is important to include 
the trade-in amount in the amount defined as the deposit on that layaway.  For instance, 
if a customer put an item on layaway for $1,000 and gave you $200 cash and a trade-in 
valued at $100, you should enter $300 as the deposit amount on the layaway.  This also 
applies to special orders and repairs. 

 

5.5.7 Store Credit/Credit Memo 
Once a customer is identified, if he has store credit on file, the Store Credit button will be green.  Credit 
memos are blended for couples and can be used by either party. To accept a credit memo as payment: 
 
1. Select Store Credit from the Point of Sale window.  The Store Credit Tender window will 

appear. 
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2. The amount of the credit up to the amount of the sale will be the default amount applied.  Accept the 
default value or change the amount to be used from this credit memo by entering a different amount 
in the Use Credit Amt field.   

3. Select OK. 
 

 

• To issue a store credit, select the Store Credit option while an amount is due back 
to the customer.  The appropriate negative amount will be pre-filled.  

• Remember that earned referral rewards post to the referring customer’s credit 
memo account. 

• The label on this button can be changed in System Options. 

5.5.8 House Account 
To accept store charge as payment: 
 
1. Select House Account.  The House Account window will appear.   
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2. The default amount to be charged to the account is the amount due.  If you wish to change that, 
enter the new amount in the Amount field.   

3. To refund an amount to a store charge card, enter a negative amount in the Amount field.   
4. Select OK if this is the amount to be paid in full or, if accepting a partial payment, manually enter 

the amount to be paid. 
5. Select OK. 
 

 

Customer house accounts are disabled for all customers by default.   You can enable 
them on an individual basis or change the System Options to enable them for all 
customers by default. 
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 Wish Lists 
 Wish lists allow you to save items and ideas in a customer record for future reference.  They can be 
saved as reminders of what your customer wants to get or your customer can have the list sent to 
someone else, which is done through The Edge’s notifications and email features.   

5.6.1 Entering Wish List Items 
There are two ways to enter items into a customer’s wish list: using Save to Wish List, which is most 
efficient for quickly scanning in-stock items and using Wish List Entry Mode, which allows for both 
stock and non-stock wish list entry. 

5.6.1.1 Entering Wish List Items Using Save to Wish List 
First, from the Point of Sale window: 
 
1. Find the customer record. 
2. Enter the item to be added as if it were a sale. 
3. Instead of taking payment and completing the sale, select Save to Wish List from the bottom right 

corner of the Point of Sale window.  The Wish List window will appear. 
 

 
 

Fields and options in the Wish List window include: 
 
Comments Allows you to add information or instructions for the wish. 
Whose wish list is this? Indicates who wishes for the item.  The default is always SELF.  
Who should be notified 
about this item? 

Indicates who should be notified about the item.   
The default is the spouse/partner of the person whose wish list 
you are entering.  Click Different Customer to notify a different 
customer altogether. 
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Notify Allows you to pick from the existing contact information of the 
person to notify about where send the notification.  You can also 
add contact information.  For more information, see the section 
entitled Notifications.   
 
Selecting Add allows you to specify a new method of contact, 
which will be saved on the customer account record. 

Event Indicates for what occasion the item might be a gift. 
Event Date Indicates the date of the occasion.  If the event is an anniversary 

or birthday, it will be stored in the customer’s record and can be 
queried for many marketing reasons. 

 
4. Complete the fields as desired and select OK.  The item will be added to the customer’s wish list. 
 

 

When you select Save to Wish List, you will be prompted to remove any sale line entry 
in the Point of Sale window that is inappropriate for a wish list. 

5.6.1.2 Entering Wish List Items Using Wish List Entry Mode 
Wish List Entry Mode offers a view of the Point of Sale window that allows for much more wish list 
flexibility.  It does not require that the item be in stock.  In fact, wish list items can be rough ideas or 
descriptions of items.  To use Wish List Entry Mode: 
 
1. From the Point of Sale window, find the customer record as usual. 
2. From the upper left corner of the window next to the customer information, select Wish List.  A 

sub-menu of wish list actions will appear. 
 

 
 
3. From this menu, select Wish List Entry Mode.  The Point of Sale window will change to remove 

non-Wish List functions. 
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4. Select Save to Wish List.  Only fields required for wish list entry will appear. 
5. To add items, select Wish List Item.  The item line More button will change to read Modify Wish 

and flash black and red.   
6. Select the Modify Wish button.  The Wish List window will appear with some of the fields 

populated based on the data entered at point of sale. 
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Fields and options in this Wish List window include: 
 
Item # Use this to indicate that it is not a stock item, or use the drop-down 

menu to start the Item Find function and locate a particular item. 
Vendor ID Enter or find the vendor of the item. 
Vendor Style Enter or find the vendor style. 
Description This is an opportunity to express a wish for a non-stock item.  It’s also 

an opportunity to discuss options and ideas with the customer.  Enter a 
description of the item.  The more the customer can tell you about what 
he or she wants, the more useful it will be for the buyer. 

Price Range Use the Min. and Max. fields to enter a bottom and top monetary 
range. 

Quantity Enter the number desired. 
Comments Other information that might help a gift-giver. 
Whose wish list is 
this? 

Indicates who wishes for the item. The default is self. 
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Who should be 
notified about this 
item? 

Indicates who should be notified about the item.  The default is Spouse.  
Select Different Customer to notify a different customer altogether.  It 
will offer a list of related records or you can select a completely 
different customer. 

Notify Allows you to pick from the customer’s existing contact information 
about how to send the notification.  For more information, see the 
section entitled Notifications.  Selecting Add allows you to specify a 
new method of contact, which will be saved on the customer account 
record.  Once the record is saved, the notification will be sent.  Because 
each wish list item has its own record, a separate notification will be 
sent for each one.  Supervisors can resend a wish list.  Find the wish, 
double click it to edit, and select Supervisor, and then Resend 
Notification.   

Event Indicates for what occasion the item might be a gift.   
Event Date Indicates the date of the occasion.  If the event is an anniversary or 

birthday, it will be stored in the customer’s record and can be queried 
for many marketing reasons. 

 
7. Complete the fields as desired and select OK. 
8. The item will be saved to the customer’s wish list. 

 

 

• Only Whose wish list is this? and Description are required.  This gives customers 
much more flexibility. 

• Wish list entries from Wish List Entry Mode can be reset by selecting Start Over. 
• If a wish list item is changed, a new notification will be sent. 

5.6.2 Other Wish List Options 
From POS, if you have a customer selected and select Wish List ► Show My Wish List Items, The 
Edge returns a listing of items associated with the customer.   For more about working with this list, see 
the section entitled Wish List Tab.   
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Use Buy Now… to send the selected item to a sale line in the POS screen. 
 
Show Another Customer’s Wish List Items returns the Find Customer function to locate a customer 
and obtain his or her wish list. 

5.6.3 Finding a Customer’s Wishes 
To find a customer’s wish list:   
 
1. Locate the customer record using Customer ► Find. 
2. Open the Wish List tab. 
 

 
 
3. Double-click the record to work with and edit as needed. 
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5.6.4 Selling Wish List Items 
To sell a wish list item to a customer:   
 
1. Open Point of Sale and perform a Find Customer.   
2. Select Wish List► Show My Wish List Items.  A list of wishes will appear. 
3. Locate the item to be purchased and double click the record.  The Wish List window will appear, 

this time with a Buy Now option. 
 

 
 
4. If the item is the desired item, select Buy Now.  The item will be created as a sale item in the Point 

of Sale window. 

5.6.5 Alternate Items 
If an item is no longer in stock, you will be prompted with a selection of alternative items.   
From here, you can go directly to the Special Order intake or Item Find functions. 
 

 

• Once a special order item is created to fulfill a wish list, the system considers the 
wish satisfied and removes it from the customer record.   

• If you return an item from a wish list will set the wish list item back. 
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5.6.6 Deleting a Wish List Entry 
To delete a wish list entry: 
 
1. Locate the customer record using Customer ► Find. 
2. Open the Wishes tab. 
3. Select the wish to be deleted and select Remove Wish. 

5.6.7 Wish List Filters and Reports 
Querying wish lists and running wish list reports are offered in three ways, but use the same basic 
filtering mechanism. 

5.6.7.1 Find Customers by Wish Criteria  
To find customers or to market to customers with a specific type of wish:   
 
1. Select Customers ► Find.  The Customer Find filter will appear. 
2. Select the Wishes tab from the filter window.   
3. In the Wishes tab, you will see the Wish Option drop-down menu, select from three options: 
 

Don’t care about wishes  In this case, no filtering by wishes will occur. 
With wishes that match  To filter by wishes that match criteria to be specified. 
With wishes that don’t match To exclude wishes with criteria to be specified. 

 
4. Select the filtering option and select OK.  The Wish filter with options that apply to your match 

selection will appear. 
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5. Enter parameters that describe the wishes you’re looking for. 
6. Select other tabs to further narrow the kind of customer you’re looking for. 
7. Select OK.  A list of customers with matching wishes will appear. 
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5.6.8 Best Practices and Tips for Wish Lists 
Here are some ways wish lists can be used. 
• Save to a wish list a collection of items a customer has shown interest in. 
• Enter Wish List Entry Mode to add in-stock items, non-stock items, and generic wish list entries: 

o Example: A vendor/vendor style number that is available but the store has never stocked it. 
o Example2: Customer desires ½-carat diamond studs, but there is no specific vendor, item, etc. 

• Store event type and date information while adding a wish list: 
o Event and date information will update on the customer’s account record. 
o If event date differs from that shown in the customer record, you will be prompted to update it. 

• Notifications allow you to set “who to notify” and “how to notify” while entering wish lists: 
o Notifications can be sent automatically via email or text message with required setup. 
o Adding a new contact method for notification automatically updates contact record for account. 
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 Working Appointments at POS 
If a customer with open appointments comes into the store, when his record is brought up at Point of 
Sale, a green button will come up near his customer information. This allows you to act on the 
appointment right there.   
 

 
 
To work with the appointment: 

1. Select Appointments.  The customer record will appear with the Appointments tab open. 
2. Open the desired appointment record.   
3. Make notes and indicate next action as described in the section entitled Appointments.      

You can also add appointments from this window as described in the section entitled Appointments. 
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 Sales Tax Option 
The Sales Tax option can be checked or unchecked as necessary for each sale.  Also, because there may 
be more than one jurisdiction collecting sales tax, a drop-down list is available to the right of the Tax 
field allowing you to turn off one or more taxes. 

 Completing the Transaction 
When all items have been entered into the Point of Sale window, and payment has been made 
satisfactorily, use Done to complete the transaction. 
 
Depending on System Options settings, The Edge will offer a combination of four options when you 
select Done: 
 

 
 
1. It will proceed directly to printing the receipt. 
2. It will offer an option to provide a preview before printing.   
3. It will offer an option to email a receipt; you will be prompted to select or enter the email address to 

which it should be sent.  See the section entitled Email Settings for email receipt setup. 
4. It will offer a gift receipt.  
 
Once you select one of these options, either the window will clear with a message that the sale is 
complete, or the receipt preview will appear.  
 
The content of the receipt appears as follows: 
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Information featured on the receipt is customizable through System Options.  By default, the 
following information is provided: 
 
A Receipt number.  This can be entered to bring up records for returns or pickups. 
B The barcode for the receipt number.  This can be scanned to bring up records for returns or 

pickups. 
C Date and time of transaction. 
D Associate who handled the transaction. 
E Customer number. 
F Customer name and contact information. 
G The item number. 
H The barcode for the item number. 
I Type of transaction for that item number. 
J Description of the item 
K Total, tax, and payment information. 

 
In addition, credit card receipts will have addition information in the receipt.  Credit card receipts 
include: 
 
• Card number 
• Authorization code 
• Approval data 
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• Invoice number 
• A place for the customer signature. 
 
Features and options in the Preview Receipt window include: 

 
Previous Page View the previous page of the receipt. 
Next Page View the next page of the receipt. 
Zoom In Enlarge the image. 
Zoom Out Shrink the image. 
Receipt Print a receipt. 
Discounts Show discounts on the receipt. 
Addr/Phone Show the customer’s address and phone number on the receipt. 
Email Show the customer's email address on the receipt. 
Balances Show charge balances on the receipt. 
Store Credit Show any store credits on the receipt. 
Repair Envelope Print a repair envelope. 
Balance on Repair Envelope Show the amount due on a repair on the repair envelope. 
Appraisal Envelope Print an appraisal envelope. 
S/O Env Print a special order envelope. 
Layaway Env Print a layaway envelope. 
Notifications on Envelope Show notification information on the envelope. 
Gift Receipt Prints a gift receipt without amounts. 
Print Print the receipt as previewed. 
Email Email the receipt; you will be prompted to select or enter an 

email address. 
Presets Opens the Presets menu for receipt settings. 
Fit Page Fit the page image on the window. 
Cancel Closes the Preview window.  The sale is completed, but no 

receipt is printed. 
 
For information about working with completed sales transactions, see the section entitled Find Sales.   

5.9.1 Envelopes 
Services such as repairs, special orders, and appraisals include an envelope insert along with the receipt.  
It is intended to fold up and slip into a clear envelope that contains the item on which to be worked.  
Envelopes are generated in the Preview Receipt window, usually as a second page to the receipt. 
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5.9.2 Gift Receipts 

5.9.2.1 Generating Gift Receipts 
Gift receipts are printed similarly to regular receipts, with some additional options.  To print a gift 
receipt: 
 
1. Conduct a transaction from point of sale as usual, selecting Done to complete the transaction.  If set 

in System Options, a preview of the receipt will appear. 
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To turn on receipt previews, use System Options ► Receipt Options ► Receipt 
Preview and set it to True. 

 
2. From the lower left corner of the Preview Receipt window, select Gift Receipt.  The Gift Receipts 

window will appear. 
 

 
 

Fields and options in the Gift Receipts window include: 
 
Check the items that should 
appear on the gift receipt 

Select types of transactions to include gift receipts for: 
Merchandise, Misc, Repair, Custom Job, Appraisal, and 
Other. 

Check All Select all items listed for gift receipts. 
Check None Unselect all items listed for gift receipts. 
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Print on Individual pages Allows you to print each receipt on separate pages for 
distribution to separate gift recipients. 

Print Proceed with printing of the gift receipts. 
Close Close the Gift Receipts window. 
Presets Use presets to set the behavior for the gift receipt form.   

 
3. Select options as required and select Print.  A second Gift Receipts preview window will appear 

without pricing. 
 

 
 

4. If the receipts look correct, select Print.  If not, select Cancel and make changes. 

5.9.2.2 How System Options Impact Gift Receipts 
If Ask Before Printing Receipt is set to True, it will prompt for printing receipts, but also prompt 
“Would you like a gift receipt?”  
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If Ask to Print Gift Receipt is enabled (it is the default), when a receipt is printed, you will be 
prompted as to whether you want a gift receipt.  If you select Yes, the Gift Receipt window as described 
above will appear. 
 
If your store has Preview enabled, you have full control of the Gift Receipt functions; the button is 
present. 
  
If you have Preview enabled AND Ask to Print Gift Receipt set to True, when you select Print from 
the preview, you get the prompt again. 
 
If you have Ask Before Printing Receipt set to True and Preview to False, when you select Done from 
Point of Sale, a button offering if you would like a gift receipt will appear. 
 
If you have both Preview and Ask Before Printing Receipt set to False, AND Ask to Print Gift 
Receipt set to True, The Edge prints a receipt silently as usual, but will offer the “Would you like a gift 
receipt?” option. If you select Yes, the gift receipt picker will appear. 
 

 

• If you forget to print a gift receipt, you can do so any time just as you would 
reprint any receipt.  Lookup the sale, select it, and select Gift Receipt from the 
preview.  To do so, use Customer ► Sales ► Find ► or use Point of Sale ► 
Review Receipts. 

• Gift receipts are available for any completed transaction (e.g., item sale, repair 
pickup, layaway pickup). 

• Transactions such as intake, payments, returns, and trades, which are part of the 
current transaction, are automatically excluded to make the gift receipt 
appropriate. 

5.9.3 Jewelers Mutual Insurance Option 
As an add-on, you can offer your customers a quote insurance on their new purchase right at point of 
sale.  For more information, see the section entitled Jewelers Mutual Insurance Company.   

5.9.4 Podium 
Podium is a reputation management company that helps you obtain and publish store reviews on several 
popular listing sites such as Google and Facebook.  It also has a text messaging (SMS) component that 
integrates with The Edge notification system.  This can be setup to automatically notify a customer via 
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text when their job is ready for pickup.  Podium includes a website allowing you to manage, view, and 
reply to text messages from your customers. 
 
For more information and to sign up for Podium, contact The Edge Customer Service team at 
service@ajsllc.com.  
 
Once you have Podium licensed, it works according to the Podium Contact Method System Option, 
which offers values as follows. 

• Only Send Correct Phone Email:  Without offering options at POS, Podium will 
automatically send the customer a text message or email, if correctly formatted information is 
provided, asking for a review. 

• Open Phone Email Selector Every Time:  Offers the prompt at POS with every 
customer transaction asking for verification of data and whether to send text or email. 

• Open Phone Email Selector When Addresses Not Correct:  If the phone number 
or email address are not available or of the correct format, The Edge will open the selector window 
for further action. 

To work with Podium at POS for reviews: 
 
1. Complete the transaction as usual.  When you select Done, one of two things will happen according 

to the System Options listed above: 
a. If you have Only Send Correct Phone Email selected, Podium will seamlessly send a text or 

email, whichever is first available with good data.  The Edge will proceed to complete the sale 
and you should work with receipts as usual.  You will not have any interaction with Podium.   

b. If you have Open Phone Email Selector Every Time or Open Phone Email Selector When 
Defaults are Not Correct, and the defaults are indeed incorrect, the Podium window will 
open.  Proceed to step 2. 

2. The Select a Cell Phone Number and/or Email to Send a Review Request window will appear. 
 

mailto:service@ajsllc.com


The Edge User Guide v. 20.0.0.114 

426 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 
 
3. Verify that the data is correct and/or select the desired contact method. 
4. To add a phone number or email address, select the appropriate add (+) button.  The new contact 

information will be saved to the customer record. 
5. To change a phone number or email address, use the edit button.  The changed contact information 

will be saved to the customer record. 
6. If you do not want a request to go to the customer at all, select Don’t Send.   
7. Otherwise, select Send. 
8. Continue with processing the receipt. 
 

 

The Edge and Podium want to make sure your customers are not overburdened.  If a 
customer has been sent a request from your store within 60 days, you will be notified 
that the customer has already been sent a request and should not be sent another.  
You can increase this number in System Options. 

 

 

Podium System Options can dictate whether a request should be sent for interim 
transactions or only at final transaction, such as repair intake vs. final pickup. 

 
To use Podium for notifications: 
1. You must enable Podium text notifications.  This is done by going to System Options, navigating to 

Podium Options, and setting Use Podium for Text Notifications to True. 
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2. On job intake, there is a Notification dropdown.  Clicking this will yield a window allowing you to 
select the preferred cell phone number. 

 
3. When the job is marked Done the system will automatically send the customer a text message alert.  

A window will pop-up at the bottom of your screen indicating this has been sent. 

 
4. You can utilize the Podium website to manage, view, and reply to any of these customer texts. 

 

 

Podium only works for job notifications.  It does not support customer marketing 
texts. 
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6 Special Services 
Layaways, special orders, and other services are all multi-part transactions within The Edge.  Each of 
these types of transactions share the following characteristics: 
 
1. These services are initiated and completed at point of sale, that is, when a customer makes the 

request and later picks up the item.  Those activities are described in the section entitled Other 
Point-of-Sale Transaction Options.   

2. Multiple payments can be made over time at POS. 
3. The functions described in the following sections will allow you to edit the records, update the 

status of the orders, and move them from location to location. 
4. Each may be cancelled at POS. 
5. A pickup must be completed.  The pickup indicates that the transaction is complete, the taxes are 

then considered due, and commissions are to be paid.  
 
For a video tutorial about managing service records, go to http://www.screencast.com/t/jcMmnBj9.   

 Repairs and Custom Jobs 

6.1.1 Finding and Editing a Job Record 
To manage repairs: 
 
1. Select Services ► Find ► Job.  The Find Job filter with the General tab open will appear; it can 

be used to find repairs, custom jobs, or both. 
 

http://www.screencast.com/t/jcMmnBj9
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Fields and options in the General Tab of Find Jobs window include: 
 
Sale # Returns records with matching sale numbers. 
Store # Returns records with the matching store ID. 
Job # Returns records with the matching job number. 
Envelope # Returns records with matching envelope number. 
Location Returns records with the matching repair workstation. 
Loc Type Returns records with the matching location type. 
Description Returns records with matching phrase in the description. 
Task SKU(s) Returns records with a matching task SKU.  You can select from a tree 

structure. 
Intake Assoc Returns records with matching intake associate. 
Job Type Returns records of type repair, custom job, assembled, or built. 
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2. To filter by status or dates, select the Status/Dates tab.   
 

 
 
Fields and options in the Status/Dates tab of Find Repairs/Custom Jobs window include: 
 
Entered Returns records entered on this date or date range. 
Original ETA Returns records with matching original ETA date(s). 
Revised ETA Returns records with the matching revised ETA date(s). 
Complete Toggles between including only complete job, only incomplete jobs, or all 

jobs. 
Cancelled Toggles between including only cancelled jobs, only jobs that are not 

cancelled, or all jobs. 
Any Change Returns records that underwent any change to their record on this date(s). 
Adjustment Returns records with specified adjustment activity. 
 

3. Complete Find Repair/Custom Job fields as needed to retrieve the appropriate data.  
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4. Select OK.  A list of matching repairs or custom jobs will appear.   
 

 
 
Fields in the Repairs/Custom Job list include: 
 
Job # The job intake transaction ID. 
Type The type of job it is:  repair, custom, etc. 
Envelope # The number on the repair envelope. 
Customer The name of the customer who order the job. 
Entered The date the repair was taken. 
Original ETA The original estimated time of arrival. 
Current ETA The current estimated time of arrival. 
Location The location within the job process of the item. 
Express Whether the job was considered an express job. 
Done When the repair was completed. 
Picked Up When the repaired item was picked up. 
Intake Associate The associate who originally took the order. 
Description A description of the item. 

 
5. Select or double-click on a specific line for more information to edit the repair.   
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6. Make changes as needed. 
7. Select OK/Save & Close. 
 
Notice that these fields are very similar to the Repair Intake or Custom Job Intake window.  See the 
section entitled Repair Intake or Custom Job Intake for more information about these windows. 

6.1.2 Job Save & Print 
On the Job window, there is Save & Print menu.  From here you can print the job details sheet or the job 
envelope.  We recommend you print to the report printer. 
 

 
 

Job Details Sheet A full-page form containing selected details needed for reference.  Used in 
concert with presets, this form can be used in-house, for vendors, or for 
customers.  This sheet can be printed from the preview to the report printer.  
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You can send the job details sheet via email.  Use this option to preview the 
job details sheet, and use one of the Email button on the lower left portion 
of the window to generate an email version of the sheet.  See the section 
entitled Configuring Email Settings for Email Receipts and Job Details 
Sheets for more about configuring email settings.  You will be prompted 
indicate whether cost information should be included. 
 

 
 
If you are emailing to the customer, select the correct address. You can use 
New Customer Email to enter a new customer address, which will be 
saved.  If you are emailing to another party, such as an outside repair shop, 
select Other Email and enter an email address for the recipient.  This email 
address will not be saved.   
 
For some jobs, those that do not have a customer associated with them, you 
will be taken directly to entering another email address. 

Job Envelope Used to insert into the item envelope to identify the piece. 
Cancel Cancels out of this menu. 

6.1.3 Moving Through the Job Process 
Essential to the repair and custom job processes is the ability to track the location of each job in the 
process.  The Edge provides a Move function to update the system’s knowledge of where each envelope 
is located.  You must have supervisor status to move a repair from one location or envelope to another.  
To do so: 
 
1. Select Move Envelope from the Services menu.  The Move Envelopes window will appear.   
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2. Select a location to which the job should be moved from the To Location drop-down menu. 
3. Scan the barcode of the envelope or enter it manually via the keyboard and press Enter. 
4. The updated information should appear in the data portion of the window.  Review the information 

to ensure that it is correct.   
5. Enter additional moved custom jobs if applicable.   
6. To print the list of moved repairs, select Print List…. 
7. To close the list when you have finished reviewing it, select Close.  The job records will record the 

new locations. 
 

 

You can move a number of envelopes by completing these fields once and then 
scanning each envelope in succession. 
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 Special Orders 

6.2.1 Special Order Overview 
In The Edge, special orders are a three-part process: 
 
1. Initial intake at point of sale. 
2. Receiving special order merchandise into inventory and matching it to the open order 
3. Final pickup at point of sale. 
 
Steps 1 and 3 are common customer service activities and detailed in the sections entitled Special Order 
Intake and Special Order Pickup.  Step number 2 is detailed in the section entitled Receiving Special 
Order Inventory. 
 

 

• Special orders are not recorded as sales until time of pickup.  
• Commission is not rewarded on a special order until pickup.  
• Special orders cannot be picked up until they are filled (readied for pickup). 
• When you attempt to pick up a special order but the pickup button is not lit, this 

is because the order has not been filled with an item. 
• Inventory ordered as part of a special order is treated differently as it pertains to 

the aging process and the Levels feature.  For example, a special order item is 
often in your possession for a short period of time until it is picked up.  This 
should not be confused with being a fast-seller.   

6.2.2 Editing Existing Special Orders 
Sometimes it may be necessary to update a special order after the initial intake.  To update or modify an 
existing special order: 
 
1. From The Edge Main Menu, select Services ► Find ► Special Order. 
2. The Find Special Orders window will appear.   
3. Enter criteria here to search for your special order and select OK. 
4. Any special orders that matched your search criteria will appear in the list: 

 

 
 

5. Double click on or highlight the desired record and select Edit.  The special order record will 
appear.  
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Fields and options in the Edit Special Order window are similar to those in the Special Order 
Intake window with the addition of the following Quantities fields: 
 
PO# The purchase order number associated with the order. 
Placed The quantity placed on order with the vendor.  If you use this field, manual 

matching will be required when the order is received.  We recommend you 
use the Purchase Order feature to record and track vendor orders.   

Received The quantity received. 
Matched The quantity received and matched with the order. 
Canceled The quantity canceled from a vendor order. 
Complete The quantity complete. 
Cust Return The quantity the customer returned to the store. 
RTV The quantity you returned to the vendor. 
 

6. Make any necessary changes and select OK/Save & Close to save them. 
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6.2.3 Receiving Special Order Inventory 
Before a special order will be available for final pickup, it must have an item received and matched to it 
to fulfill the order.   

 

 

It is impossible to pick up a special order unless an inventory item has been matched 
to it. 

There are two ways to match an item to a special order:  Automatic Matching and Manual Matching.  
In either case, once the special order item arrives at the store, it should be added into inventory just like 
any other item through Inventory ► Items ► Add. 

6.2.3.1 Automatic Special Order Matching 
Whenever the user enters incoming inventory into the system, The Edge searches the special order table 
for items that match the vendor ID and vendor style number.  If there is a match, the user will be 
prompted to indicate the item’s disposition.  Because multiple quantities are possible, the allocation 
window requests the number of items to be allocated to each special order and to each store in the 
system.  If the user allocates the inventory to a special order, then the item is entered as inventory type O 
for special order, and is marked as being sold to the customer in question.  This method is referred to as 
automatic because it will happen automatically when the special order item is entered into inventory. 

 

 

To use automatic special order matching, it is necessary to provide the exact vendor 
and vendor style information on the special order. 

 
1. Select Inventory ► Items ► Add and select Items.   
2. Enter the vendor and style number.  If there are matching items, you will be prompted to copy 

details.  If one matches a special order, it will be highlighted in purple. 
 

 
 
3. Select the desired item.  The Allocate window will appear. 
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4. Enter a 1 in the allocate column next to the desired special order source. 
5. Select OK to this window.  A new window will open offering to copy the item details from the 

special order to this new inventory record.  Do so. 
6. Finish entering the item. 

6.2.3.2 Manual Special Order Matching 
This method allows you to manually link an item to a special order.  Before proceeding, please make 
sure the item has been entered into inventory.  This method should be used if: 
 
• Automatic matching failed to work 
• Item already in inventory and not applicable to automatic matching 
• The wrong item was matched, and it is necessary to unmatch and match correct item. 
 
To manually match an item: 
 
1. Select Services ► Find ► Special Order.  The Find Special Orders filter will appear.   
2. Enter criteria here to search for your special order and select OK.  A window will appear listing 

special orders matching your search criteria.   
3. Double click on the special order to open it. 
4. Select Save & SKU.  The Force Item to Match Special Order window will appear. 
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5. Enter the item SKU here or use the drop-down menu to search for the item in inventory. 
6. Select OK. 
7. Select OK/Save & Close to save the special order record. 

6.2.3.3 Reconciling Special Orders 
If for some reason a user did not allocate entered inventory to outstanding special orders, or if existing 
inventory could have been used to avoid a special order but a special order was entered anyway, a 
special order record can be matched against existing inventory.  To find a special order item in 
inventory: 
 
1. Select Services ► Find ► Special Order. 
2. Select Details.  The Special Order window will appear.   
3. Select Save & Match from the Record Navigation Bar, and a list of matching inventory items will 

appear.  Alternatively, you can locate a record by SKU by selecting Save & SKU. 
4. Select the items you wish to allocate to the special order up to the quantity not yet allocated.   
5. Select OK. 

6.2.3.4 Unmatching a Special Order Item 
1. Select Services ► Special Order ► Find.  The Find Special Orders filter will appear.   
2. Enter criteria here to search for your special order and select OK.  A window will appear listing 

special orders matching your search criteria.  Double click on the special order to open it. 
3. Select Save & Match.  The Items Matching Special Order window will list any in stock inventory 

matching the vendor and vendor style on this order. 
 

 
 
If an item is already matched to this order, it will have a check next to it.   
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4. Uncheck the item and select OK. 

6.2.4 Finding a Special Order Transaction 
To check on the status of a special order: 
 
1. Select Services ► Find ► Special Order.  The Find Special Orders window will appear.   

 

 
 
Fields and options in the Find Special Orders window include: 
 
Customer Returns records containing the customer selected using the Customer Find 

process offered in the drop-down list. 
Job # Returns records matching the ID number for the special order transaction. 
Sale # Returns records matching the ID for the sales transaction that contains the 

special order. 
Env # Returns records matching the ID for the job envelope. 
PO # Returns records matching the specified purchase order number. 
Location Returns records matching the specified location. 
Location 
Type 

Returns records matching the specified location type. 

Entered Returns records matching the date the special order was placed.  Note the 
default is All Dates. 
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ETA Returns records matching the estimated time of arrival indicated.  Note the 
default is All Dates. 

Received Returns records with matching dates the item was received in the store. 
Vendor Returns records matching the entered or selected vendor ID. 
Store # Returns records with matching receiving store numbers. 
Associate Returns records with matching intake associate. 
Notifications Returns records with notifications created or completed on a specified date. 
Status Returns records that return any of the following statuses: 

 
• Need More Info 
• Need to Order 
• Waiting on Vendor 
• All Here 
• Part Here 
• Complete or Canceled. 

 
2. Complete Find Special Orders fields as needed to retrieve the appropriate data.   

 

 

When using the special order find filter, at least one status box must be selected to 
perform a search. 

 
3. Select OK.  A list of special orders matching the criteria will appear.   

 

 
 
Fields in the Special Orders list include: 
 
Key The special order ID. 
Customer The name of the customer who placed the order. 
Phone The customer’s phone number. 
Entered The date the order was taken. 
ETA The estimated time of arrival. 
Vendor The vendor with whom the order was placed. 
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Style The vendor’s style number. 
NMI Whether more information is required. 
NTO Whether the item has yet to be ordered.  The item is considered ordered once 

a PO (purchase order) number has been saved in the record. 
Status Whether any or all of the order has arrived in the store. 
Desc A description of the item. 
Hide Completed 
Orders 

Whether this list should include orders that have been completed and picked 
up by the customer. 

4. Select the specific line for more information or to edit the special order.  
5. To print the entire list of matching special orders, select Print List….  
6. To close the list when you have finished reviewing it, select Close.   

6.2.5 Editing Special Orders 
To edit a special order record: 
 
1. Find the record as described above.   
2. Select the desired record and select Details.  The Special Order window will appear. 
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Fields and options in the Special Order window include: 
 

Vendor Info  
 ID The vendor ID. 
 Style # The vendor’s style number. 
Item  
 Item Type The item type. 
 Category The category ID for the item. 
Pricing  
 Price is 

Estimated 
Whether the price is estimated. 

 Cost Cost to the store for the item. 
 Price Price to the customer for the item. 
 Quantity The number requested.  Note that this cannot be changed once entered at 

intake. 
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 Ext Quantity times subtotal. 
 Tax Whether tax should be applied.  The amount will be calculated. 
 Total The total due. 
 Deposit The amount required as a deposit. 
Quantities  
 PO Represents the number of items that you have ordered from the vendor.  

This is the only field that affects the system’s knowledge of whether the 
item has been ordered. 

 Received The number received in the store. 
 Matched The number that matched the customer’s request. 
 Canceled The number canceled. 
 Complete The number of items in the order that are complete. 
 Cust Return The number of items in the order that the customer returned. 
 RTV The number of items returned to the vendor. 
Need More Info Whether more information about the item is required to complete the 

order. 
Price Estimate  
 To Be 

Determined 
Indicates that the price is to be determined by the cost or other input. 

 Call Before 
Starting 

Indicates that the customer wants to know an exact price before the 
order should be placed. 

 Do Not Exceed Indicates that the customer does not want the item if it exceeds this 
amount. 

Description Description of the item. 
ETA Estimated time of arrival. 
ETA is Estimated Indicates that the ETA is estimated. 

 
3. Edit the record as desired and select the appropriate save option. 
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 Appraisals 

6.3.1 Finding and Editing an Appraisal Record 
To find and manage appraisals:  
 
1. Select Find ►Appraisal from the Services menu.  The Find Appraisals window will appear. 
2. Filter for the appraisal with which you wish to work. 
3. Open the desired appraisal record.  The Appraisal Edit window will appear with the General tab 

selected. 
 

 
 

4. Edit fields as needed.   
5. Select the Appraisal Details tab.   
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Fields and options in the Appraisal Details tab include: 
 
Title The title of the appraisal document. 
By Associate or vendor who will conduct the appraisal. 
Show paragraph Values Show these values on the appraisal document.  Must be included for 

appraisal to show the details of the item. 
Show value summary Show the value summary listing on the appraisal document.  Must be 

included for a total value to appear on the appraisal. 
Print Intake Photo Include the photo taken at intake on the appraisal document. 
Print intake info as first 
paragraph 

Include information taken about the item as the first paragraph of the 
appraisal document. 

Photo Take a photo of the item at this time.  See the section entitled 
Photographing an Item for more information. 

Description The paragraph title to follow on the appraisal document.  The 
following field contains space in which to write the description. 

Use Sum Inst Rather than specifying an appraised value, use the sum of the part 
values. 

Step Lists the step number listed. 
Photo Shows a photo of the step. 
Paragraph Header/Text The paragraph title and text describing the step. 
Value The value of the step. 
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New Page When checked, starts the paragraph on a new page in the generated 
appraisal document. 

Sum The total value. 
 
6. For each item in the lot, or for each aspect of the item to be described, select Add.  A line item will 

appear on the Appraisal Edit window. 
7. Enter a name for the paragraph. 
8. Enter the text describing the item or aspect. 
9. Enter the value. 
10. Enter as many items or aspects as needed by repeating steps 5 through 9. 
11. Rearrange the order in which the paragraphs appear by selecting Move Up or Move Down. 
12. Edit or complete these as desired and select the Preview tab. 

 

 
 
The Preview tab shows an approximate print preview of the appraisal.  The Edge comes loaded with 
five appraisal templates, one default and four alternates.  Based on the locations you set in System 
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Options, your chosen default template will be used automatically.  Other available templates will 
appear in the drop-down menu.   
 
Options in the Preview tab include: 
 
Choose Document 
Template 

Select the desired appraisal template, if not the default.  If you do not 
see a list of templates, check your System Options; there should be 
a value in Appraisal Template Folder Location. 

Save to PDF Save the appraisal as it appears so far to a PDF file. 
Print Print the appraisal as it appears so far to paper. 
Save As Save the appraisal as an .rtf. 
Print Done Date When printing, The Edge can print the current date on the appraisal 

or the date the appraisal was completed.  This option indicates that 
you want the completion date printed. 

Show Scales If there is a diamond, the appraisal will include a graphical guide of 
color and clarity for reference. 

Generate Appraisal Refreshes the preview to reflect changes in settings. 
 
13. To select a different appraisal template, select one from the Choose Document Template drop-

down menu.  Note that if you are editing an existing appraisal, the template you used before will be 
used unless you select a different one. 

14. Select the appropriate save option from the Record Navigation Bar. 
15. To see a preview of the actual printout, select Print Preview. 
16. To retain the appraisal completion date on the printed copy, select Print Done Date.  Otherwise, the 

current date will appear. 
17. To print the document, select Print from the Preview tab.  We recommend printing to the report 

printer. 
18. Use the Notes tab to record any unofficial information about the appraisal or the pieces included in 

it. 

6.3.2 Editing Appraisal Templates 
If you wish, it is possible to edit these templates or create new ones from an old one and make changes 
to that.  To do so: 

1. Use Windows Explorer or Windows File Manager and browse to The Edge folder where the 
templates are kept.  See your System Options to locate that path. 

2. Open the file with Microsoft® Word or another .rtf editor.  
3. Save the template under a new name, if you wish to create a new template.   
4. Make changes to the template and save it.  You can change the location of text, add new text, and 

change font size and type.  You can add text and some design elements. Feel free to work with the 
design and test it in The Edge. 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 449 
© 2020 Abbott Jewelry Systems, Inc. 

 

• Notice that there are merge fields built into the template. They are delineated by 
brackets ({mergefield}).  If you delete one of these fields, that data will not show 
in the generated appraisal. 

• If the file is open in your .rtf editor and you try to use the Preview Appraisal 
function, The Edge will give an error. 
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 Job Tracking 
While working on a piece, it is necessary to track progress and organize the parts.  Therefore, these 
processes offer a job details sheet that can be inserted into the envelope.  To obtain a job envelope, select 
Save & Print from the Item window; it can either be the job details sheet or the item details.  You can 
send the job details sheet to customers via email.  See the section entitled Job Save & Print for details.   
 
Then, using the Move Envelope, you can track the location of a job.  To move a job as it moves through 
processing: 
 
1. Go to Services ► Move Envelope.  There are System Options that may require Who information 

concerning who performed the change.  The Move Envelopes window will appear. 
 

 
 
2. Select the location to which you want the item to be moved.   
3. Scan the envelope or enter the envelope number. 
4. The item record will reflect the new location.   
5. Any notifications associated with the change will be sent; if the notification is a success, it will 

appear in the status window in blue.  If it fails, it will be shown in red. 
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 Completing the Job 
While working on a piece, it is necessary to track progress and organize the parts.  Therefore, these 
processes offer a job details sheet that can be inserted into the envelope.  To obtain a job envelope, select 
Save & Print from the Item window; it can either be the job details sheet or the item details.  By 
default, it will print to the report printer.  You can send the job details sheet to customers via email.  See 
the section entitled Job Save & Print for details.  Then, using the Done, you can track the location of a 
job.  This is important if you're using System Options that require an item to be marked done before it 
can be picked up.  To mark a job as complete: 
 
1. Select Done from the Services menu. 
2. The Mark Services Done window will appear. 

 

 
 

 

Scanning an envelope or service job barcode will prompt you to confirm which of 
the tasks in the job to mark done.  Check System Options to set actions and 
prompts.  

3. Scan the envelope number, repair number, or task number or enter them manually. 
4. To edit the task, select Edit Task when Scanned.  Thereafter, every time you scan to indicate a task 

was completed, a Task Edit window will appear. 
5. As items are scanned or typed in, the updated information should appear in the data window of the 

window.  Review the information to ensure that it is correct.   
6. Enter additional completed repairs if applicable.   
7. When finished, select Report to generate a report of completed repairs.   
8. To close the list when you have finished reviewing it, select Close.   

 

 

You can mark a number of envelopes as complete by completing these fields once and 
then scanning each envelope in succession. 
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 Service Job Notifications 
If you wish to locate a job based on a notification sent to a customer:   
 
1. From the Services menu, select Notifications ► Find.  The Notifications Criteria window will 

appear. 
 

 
 

Fields and options in the Notifications Criteria window include: 
 

Customer Returns job records containing notifications sent to a customer 
specified using the Customer Find filter. 

Notification Created Returns job records containing notifications created in the specified 
date range. 

Notification Completed Returns job records containing notifications completed in the 
specified date range. 

Notification Type Returns job records containing notifications of a specified type such 
as email or text message. 

Store Returns job records containing notifications created at the specified 
store. 

Only Completed 
Notifications 

Returns jobs for which a notification was successfully sent. 

Services Returns job records containing notifications pertaining to a 
particular appraisal, repair/custom job, or special order.  For each of 
these categories, you can do a job find to narrow the results further. 

 
2. Complete the fields as desired and select OK.  The Notifications Matching list view will appear.  

Work with the jobs as needed. 
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6.6.1 Resending Service Job Notifications 
Notifications can be resent on a case-by-case basis from the job record Supervisor menu.  However, if 
you wish to resend notifications to many customers concerning a services such as custom jobs, repairs, 
appraisals, or special orders:   
 
1. From the Services menu, select Notifications ► Re-Notify.  The Re-Notify filter will appear. 
 

 
 
Filters and options in the Re-Notify filter include: 
 
First Notification Date Returns records with the selected initial notification date. 
Last Notification Date Returns records with the selected last notification date. 
Notification Type Returns records with notifications that were of the specified type: 

• Email 
• Phone 
• Text. 

Store Returns records with notifications sent from the specified store. 
Services Returns records of notifications of the specified services: 

• Appraisals 
• Special Orders 
• Repairs 
• Custom Jobs. 

 
2. Make filter selections and select OK.  A list of matching records will appear. 
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3. Check the records you wish to re-send, and select Send.  The notification will be sent and the record 

will be updated to reflect the last notification sent. 
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7 Reports 
The Edge contains a number of meaningful reports, each of which have unique filters.  Once you are 
familiar with the report filter windows, they will enable you to pick and choose the content of the report.  
From this panel you can to access the report of your choice.  For example, if you want to see how much 
inventory you have in stock from a given vendor or how many pieces you sold from that vendor, 
selecting Inventory will call up those types of reports.  Reports related to customer matters are found 
from this panel by selecting Customers.   
 
For video tutorials concerning reports, see the following links: 
Working with Reports:  http://www.screencast.com/t/aUmThjGnDUk 
Memorized Reports:  http://www.screencast.com/t/KYaUAQO58b 

 Creating a Report 
In general, to create a report: 
 
1. Select Reports from the function menu. 
2. From the Reports menu, select the category of report.  Within each category, there will be common 

features to the query process.  Specific report selections will automatically narrow the parameters by 
which The Edge will search.  Some of the report queries will resemble record queries found in the 
find item or find customer filters. 

 
Activity Transaction activity such as daily sales, sales tax, miscellaneous sales 

activity, trade-ins, returns, timing, tender activity. 
Inventory Inventory status and activity. 
Customers Customer reports such as occasion lists, wish lists, charge balances, thank 

yous, and transactions by location, demographics, or acquisition. 
Management Performance, advertising, and personnel reports. 
Job Repair/custom job activities. 

 
3. From the category, select the specific desired report.  The menu may offer more detailed options.  

The query option window for that type of report will appear.  The following example is for Activity 
reports.   

 

http://www.screencast.com/t/aUmThjGnDUk
http://www.screencast.com/t/KYaUAQO58b
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The query options offered here allow you to narrow the report results by various parameters 
depending on the report type.  

 
Sale Number Allows you to specify a particular transaction. 
Old Sale 
Number 

If you had a previous system, the transaction number as imported into The 
Edge. 

Sale Date Date or dates that are to be included in the report results.  A drop-down list 
containing a variety of date range options will appear.  The default will be the 
current day’s date.  In the Date Range window, there is a much greater variety 
of date ranges from which to select.  This can be helpful when saving presets 
that include a period of time.  More detail about the selecting dates is 
contained in the section entitled Filtering by Date. 

Sold To Allows you to narrow to a particular customer range by offering a query 
window similar to that found in the section entitled Finding a Customer. 
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Sold By Allows you to specify the ID number of a particular salesperson.  Notice the 
drop-down list that allows you to select from a list. 

Store Allows you to specify a store. 
Station Allows you to specify the station from which transactions occurred. 
Show Trades As Allows you to indicate whether trades should be treated as tender, goods, or 

something else. 
Item Number Allows you to specify an item number. 
Group By…. Allows you to specify how the results will be grouped, if at all.  You can only 

group by up to four groupings. 
 

 

The order of these options also dictates how the data will 
be sorted.  You can drag and drop these options to reorder 
the way they will appear in the report.  Check the Group 
By boxes to create groups for subtotaling.  Sections are 
grouped hierarchically.  For example, if you group first by 
store then by date, each store will appear with date groups 
below.  If you put date on top and store next, date groups 
will appear with all the store groups beneath them.   

 

Exclude Empty 
Sales 

Allows you to exclude sales that had no financial transaction.  

Use Report 
Criteria Cover 
Page 

Checked by default, can be unchecked to run just this report in this instance 
without the criteria cover page.  For more about the report criteria cover page, 
see the section entitled Working with Report Results.    

 
4. Select output options from the right side of the screen as desired: 

• Grouping and sorting parameters 
• Whether to show cost 
• Whether to show photos 
• Whether to show short version or long version 
• Whether to show just summaries or include line items 
• Whether to provide a preview of where page breaks will be when printed automatically default 

on.   
 
5. Select OK.  The report will appear. 
 

 

Some reports may take some time to compile.  Do not interrupt the task until the 
report appears. 

 

The Presets function allows you to predefine reports.  For example, you could create 
a series of month-end reports. 
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7.1.1 Working with Report Results 
 
Cover Page 
 
Depending on your System Options, the first page of most reports is the cover page. 
 

 
 
The cover page contains the report name, date, and the store. 
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Criteria Page 
 
The second page of most reports is the criteria page. 
 

 
 
The criteria page lists who ran the report and the date along with selections for sorting, grouping, 
options, and search criteria.  This page will vary greatly depending on the report and the options you 
selected.  
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Report Toolbar 
Each report is presented with a toolbar at the top of the window. 
 

 

 
 

A Export the report in a variety of formats.  This data can include CSV files, RTF files, and 
various XLS files.  If you select the data-only option, the file will not include report-style 
formatting.  This option can be enabled in System Options. 

B Refresh the report. 
C Toggle the Group Pane, which shows a tree view of the report results for easier 

navigation. 
D Go to the first page of the report. 
E Go to the previous page of the report. 
F Go to the next page of the report. 
G Go to the last page of the report. 
H Go to a specific page of the report. 
I Find a text string in the report. 
J Adjust the zoom. 
K Print the report.  This will bring up the Windows print dialog. Use it to set your printing 

options, including options to print a page range that might exclude the report cover or 
criteria page.  

L Export the report to a text file 
M Create a PDF version of the report. 
N Close current report view. 

 
Report Links 
 
Many report output fields include hyperlink functionality.  For example, from the report window, select 
the item number or customer name and the item or customer record will open. 
 
Specific Reports 
 
The following sections describe more about completing a report query window for the various types of 
reports and describe the expected results. 
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 Memorizing Reports 
The Edge Memorized Reports feature allows you to create a direct button for reports with commonly 
used presets.  They differ from running reports using presets in that it actually creates a new report 
button that can be placed anywhere on the Reports menu.  Memorized reports can be created from the 
Presets menu on any report filter.  Once they are created, you can manage them from the 
Administrative menu. And you can even run a group of reports together from a single button.  To 
memorize a report: 
 
1. From the Reports window, select the report that best models the report you wish to memorize. 
2. Enter report parameters as you would for any report. 
3. Do not select OK to run the report; select Presets from the lower left corner of the window. 
4. From the Presets menu, select Memorize Report.  You will be prompted to add a report title and 

text for the report tab as it will appear in the Reports window. 
 

 
 

5. Enter the data as prompted.   
6. If you wish to run this report the future without any manual prompting, select Run Report without 

a User Interface.  It will run using the memorized options without offering the Report filter. 
7. From the Output drop-down menu, select the format for output:   

• Display Only 
• PDF Only 
• PDF & Display. 
 
PDF output will be sent to the folder specified in Configuration Options.   
 

 

If a location is not defined in Configuration Options, The Edge will create a PDF 
folder in the Shared Folder and update your Configuration Options. 

 
8. Select OK. 
 
Once the report is memorized, you can run it just as you would any other. 
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7.2.1 Changing the Criteria of a Memorized Report 
To change a memorized report: 
1. Be sure the Run Report without a User Interface option is not turned on.   
2. In the Reports menu, find and select the memorized report to be changed.   
3. When the report filter appears, make changes as required. 
4. Do not select OK to run the report.  Select Presets ► Set as Default. 
5. Select OK if you wish to run the report. 
6. If desired, re-enable the Run Report without a User Interface option. 
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 Activity Reports 
All the reports in this section are used to report on transaction activity.  Though each report defaults to 
its most current select criteria, they all share a common filter that operates consistently between the 
different reports.  Each report can be run with/without detail and for any range of dates.  Furthermore, 
the reports can be sorted and grouped by a number of factors, such as associate, customer, date, year, etc.  
For more about report filters and settings, see the section entitled Creating a Report.     

7.3.1 Daily Activity Report  
The Daily Activity report details each transaction by sale number, customer, goods, services, pricing 
(including subtotal, tax, and total), tender received, which account the customer used, and notes about 
future activity.  The Activity report is useful for end-of-the-day reconciliation.  Sales and services will 
be broken out in separate columns for your review.  The report will show you the activity for a single 
day or multiple days.  Each line will show the sale receipt number, the customer’s last name, the total 
spent, and how that money was spent on merchandise or services, on layaway items, special orders, etc.  
You will see the type of tender used to conduct the transaction.   
 
In this example, we chose to sort the records first by Month and then by Date. 
 

 
 
In the next example, we used the same search parameters, but opted to group by Customer and moved 
Customer to the top of the Group By list.  Each customer has his own page in the report.  This is an 
example of the variety of results you can obtain from the various reports and options provided.   
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In either case, data fields in the activity reports results include: 
 
Sale # Lists the sale number. 
Customer Lists the customer name. 
Goods Lists the total sales from goods. 
Services Lists the total sales from services. 
Other Lists the total sales from other categories. 
Subtotal Subtotal of sales from goods, services, and other. 
Tax The tax collected on the sales. 
Total The total of sales and taxes. 
Tender The total of amounts paid at the time of sale. 
On Acct The total of amounts charged to a store account. 
Future Indicates future value of pending sales, for example, the full sales price of a 

layaway. 
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7.3.2 Sales Tax Collected Report 
The Sales Tax Collected report contains tax details for transactions as defined in the query window.  It 
is primarily run quarterly or annually to report taxable/nontaxable transactions.  System Options 
associated with layaways, repairs, and special orders will impact how tax is calculated and displayed on 
this report.  For more about report filters and settings, see the section entitled Creating a Report.      
 

 
 
Data fields in the Sales Tax report results include: 
 
Date Date of the transaction.  
Sale # Sale number. 
Ship Whether the item is to be shipped.   
Goods: 
Non-Taxable, Taxable, Tax 

For items sold in the line, in this case, the transaction, the amounts 
that were non-taxable and taxable and the amount of tax collected. 

Services: 
Non-Taxable, Taxable, Tax 

For services provided in the line, in this case, the transaction, the 
amounts that were non-taxable and taxable and the amount of tax 
collected. 

Other: 
Non-Taxable, Taxable, Tax 

For other transactions in the line, in this case, the transaction, the 
amounts that were non-taxable and taxable and the amount of tax 
collected. 
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7.3.3 Misc. Items Report  
The Misc Items report uses the same query window as the Daily Activity report.  Note that you can 
group by type, or any other column header, as desired.  Results of the Misc Items report details 
transactions that are considered miscellaneous, i.e., not part of regular sales from goods and services. For 
more about report filters and settings, see the section entitled Creating a Report.     
 
This report is useful for reporting on all miscellaneous sales transactions and correlates directly with the 
Miscellaneous Charge button in the Point of Sale window.  Transactions shown here often include non-
inventory sales, account adjustments, and donations. 
 

 
 
Data fields in the Misc Items report include: 
 
Sale # Sales transaction number. 
Date Date of transaction. 
Customer Customer name. 
Type Type of miscellaneous sales line. 
Description Description of the miscellaneous item. 
Amount Amount of the sale. 
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7.3.4 Trades Report 
The Trades report generates a report of trade-in transactions that occurred.  It uses the same query 
window as the Daily Activity report. For more about report filters and settings, see the section entitled 
Creating a Report.     
 
Though trades are shown on the Daily Activity report as well, this report is included as a quick way to 
isolate only trade-ins.  The report correlates directly with the Trade/Buy button at point of sale. 
 

 
 
Data fields in the Trades report include: 
  
Sale # Sales transaction number. 
Date Date of transaction. 
Customer Customer name. 
Description Description of the traded item. 
Amount Amount of the trade-in. 
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7.3.5 Returns Report 
The Returns report details return transactions of any kind. It uses the same query window as the Daily 
Activity report.  For more about report filters and settings, see the section entitled Creating a Report.     
 

 
 
Data fields in the Return Activity report include: 
  
Sale # Sales transaction number. 
Date Date of transaction. 
Customer Customer name. 
Description Description of the returned item. 
Amount Amount of the return. 
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7.3.6 Time & Day Report 
The Time & Day report details retail sales broken down by day of the week and hour of the day.  It is 
helpful in determining store traffic patterns.  This report also includes entries for sales by number of 
receipts.  It uses the same query window as the Daily Activity report.  For more about report filters and 
settings, see the section entitled Creating a Report.     

 

 

This report is only useful if point-of-sale transactions are made in real-time. 

 
The first page of the Time & Day report displays a chart with the days of the week across the top and 
the hours of the day along the left side.  This tabulates sales by hour and day with totals for each 
category. 
 

 
 
 
The second page of the Time & Day report shows the same data in a bar graph.  This allows you to see 
at a glance what the peak times and days are. 
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A third page contains a similar graph containing the sales represented by number of receipts generated. 
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7.3.7 Shipping Report 
The Shipping report details shipping activity by sale number, date, customer’s name, associate, store, 
and/or shipping.  It correlates directly with the Ship To button on the Point of Sale window.  For more 
about report filters and settings, see the section entitled Creating a Report.     
 

 
 

Data fields in the Shipping report include: 
  
Sale # Sales transaction number. 
Date Date of transaction. 
Customer Customer name. 
State/Province General location of the recipient. 
Recipient Name and address of the recipient.  This field may be truncated. 
Amount Amount of the return. 
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7.3.8 Tender Detail Report 
The Tender Detail reports generate information concerning the types of payments made.  There are two 
reports, one to detail tender transactions by specific credit cards and one to detail tender by all other 
options (cash, check, etc.).  It uses a query window very similar to the Daily Activity report.  For more 
about report filters and settings, see the section entitled Creating a Report.     

7.3.8.1 Credit Card Tender Detail 
The Credit Card Tender Detail report displays transactions with an emphasis on credit card details.   
 

  
 
Data fields in the Credit Card Tender Detail report include: 
 
Sale # The ID for the transaction in which the sale took place. 
Date The date of the sale. 
Customer The customer’s ID and name. 
Total Tender The total sale. 
Cash The amount of the sale in cash. 
Checks The amount of the sale in checks. 
VISA Card The amount of the sale charged to a VISA®. 
MasterCard The amount of the sale charged to MasterCard®. 
Discover The amount of the sale charged to Discover®. 
Wells Fargo  The amount of the sale charged to Wells Fargo®. 
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American 
Express 

The amount of the sale charged to American Express®. 

 

 

• The credit cards shown in the Credit Card Tender report are examples.  The 
credit cards that are actually listed will be those for which your system is 
configured to accept. 

• If a sale used more than one credit card payment, there will be an entry for each 
payment with a subtotal for the transaction. 
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7.3.8.2 Tender Detail Report 
The Tender Detail report details all tender transactions, not just credit cards.   
 

 
 
Data fields in the Tender Detail report include: 
 
Sale # Sales transaction number. 
Date Date of transaction. 
Customer Customer name. 
Total Tender The total tendered for the transaction. 
Cash The portion of the tender taken or returned in cash. 
Check The portion of the tender taken or returned by check. 
Credit Card The portion of the tender taken or returned by credit card. 
Credit Memo  The portion of the tender taken or returned by credit memo. 
Store Charge The portion of the tender taken or returned by store charge. 
Gift Certificate The portion of the tender taken or returned by gift certificate. 
Tender Card The portion of the tender taken or returned by tender card. 
Rewards Card The portion of the tender taken or returned by rewards card. 
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7.3.8.3 10k Report 
The IRS requires any business that receives more than $10,000 in cash or check payment from one 
customer, either in a single payment or series of connected transactions, must file Form 8300.  This is 
part of their anti-money laundering (AML) program. 
 
The 10k Report has been added to help you comply with this.  The report allows you to specify a dollar 
threshold and choose a date range.  Any customers whose total tender exceeded the threshold will be 
displayed along with their payment details. 
 
To run the 10k Report: 

1. Click Reports > Activity > Tender Detail > 10K. 

 

2. In the top right, specify a dollar Threshold.  Only customers who exceed this value for the date 
range given will appear. 

3. Specify the Sale Date range to analyze. 

4. Use the Check Types drop-down to choose check types to include. 

5. For Group/Sort By, check Customer. 

6. Check Include Customer ID. 

7. Check Show Details. 

https://www.irs.gov/businesses/small-businesses-self-employed/form-8300-and-reporting-cash-payments-of-over-10000
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8. Click OK to generate the report. 

The report will display any customer who exceeded the dollar threshold specified for the sale date range 
chosen.  It then displays each transaction along with the payment type and amount collected. 

 

7.3.9 By Department Report 
The By Department report contains a listing of activity by type:  appraisals, trades, sold items, repairs, 
and miscellaneous.  In the report filter, if you are working with trade-ins, there is an option to indicate 
whether the trades should be shown as negative or positive.  For more about report filters and settings, 
see the section entitled Creating a Report.     
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Data fields in the By Department report include: 
 
Type The type of activity:  sale, repair, etc. 
Pickup Date Date of transaction for sales, for pickup for repairs and services. 
Key The item ID. 
Customer Customer name. 
Amount The amount of the transaction. 
Description A description of the item or activity. 
Sale # The ID number of the sales transaction. 
Vendor Style The vendor’s style number, if applicable. 
 

7.3.10 Sales by State 
The Sales by State report breaks down sales by the state shipped to.  This can be useful for determining 
states where you have a tax collection obligation. 
 
To run the report: 
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1. Click Reports > Activity > Sales by State.  The Sales Total by State Report window will 
appear. 

 
2. Specify the Date Range you wish to analyze. 
3. By default, this report will only include sales shipped out of state.  To include sales shipped in 

your state, check Include My State. 
4. If you are a multi-store user, you can use the Store drop-down to run this for a specific store.  

Leave blank to include all stores. 
5. Click OK to generate the report. 

 
Fields on this report include: 

State The state the sales were shipped to. 

Store For multi-store users, a breakdown by store #. 

Sales Total The total sales amount. 

Tax Collected The total tax collected. 
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# of Transactions The # of transactions.  Click on this # to see a list of the sales receipts. 

# of Customers The # of customers.  Click on this # to see a list of the customers. 
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 Inventory Reports 
Through the use of inventory filters, The Edge allows you to produce general inventory reports for all 
items or very specific reports (e.g., a list of items in category 200 over 365 days old that cost between 
$300 and $500).  Each value entered into the filter will further refine the report.  For example, in a Sold 
Item report, selecting OK without entering anything would direct The Edge to produce a sold report of 
every item ever sold.  Entering a value of 200 in the Category field would limit the same report to only 
items sold from category 200.  Adding a vendor ID to the criteria would then produce a sold report of 
items from category 200 that were supplied by that vendor.  Most of the tabs in the Inventory report 
filters mirror those in the Item Find filter.  For a video tutorial about working with inventory filters, go to 
http://www.screencast.com/t/ICQVlzwB.   
 
When you select one of the Inventory reports, The Edge will present you with a query window similar to 
that of Find Item (see the section entitled Finding and Editing an Item).  The Options tab, however, will 
differ in that it will offer more options for the report output, including flexibility for how the report is 
grouped and sorted and the amount of detail.   
 
 

http://www.screencast.com/t/ICQVlzwB
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Fields and options in the Options tab include: 
Format How you want the report results to be laid out: 

• One line per item 
• Two lines per item 
• Two lines per item with primary photo 
• Two lines per item with multiple photos 
• 3x5 cards, landscape, with primary photo 
• 3x5 cards, portrait, with primary photo. 
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See Cost or Re-Cost Whether to show the cost or replacement cost: 
• Do not show Cost or Re-Cost 
• Show Cost 
• Show Re-Cost. 

Show Price Whether to show the item price. 
Show Stone Details Whether to show stone details (primary stone only) for each item on the 

report. 
Page Breaks Inserts a new page for each primary grouping.  For example, this is useful 

for separating inventory reports by vendor for use at show. 
Multi-Line 
Descriptions 

Whether to show whole descriptions if they take up more than one line. 

Show Details Whether to show retails for each item in the grouping as opposed to only 
showing totals. 

Show Consumed 
Details 

For items consumed in a job, whether to show the job number as part of the 
item description. 

Show Barcodes Whether to include the item’s barcode. 
Use Report Criteria 
Cover Page 

Whether to include report criteria cover page. 
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Group By Whether to group by any or all of the following: 
• Store 
• Category 
• Department 
• Item Size 
• Item Length 
• Item Metal Color 
• Item Metal Finish 
• Item Metal Type 
• Item Style 
• Item # 
• Inventory Type 
• Pricing Method 
• Status 
• Vendor 
• Invoice 
• Vendor Style 
• Location 
• Customer 
• Month Sold 
• Date Sold 
• Month Entered 
• Date Entered 
• Owner 
• Adv Media 
• Event 
• Why In 
• Primary Associate 
• All Associates 
• Primary Original Associate 
• Original Associates 
• Memo Expiration Date 
• Physical Inventory Associate 
• Physical Inventory Date 
• Payable Date 
• Collection 
• Enter by Associate 
• Sale # 
• Stone Clarity 
• Stone Color 
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• Stone Shape 
• Stone Type 
• Stone Weight (sort only) 
• Stone Size (sort only) 
 

 
  

7.4.1 In Stock and Sold Report 
These reports show inventory in stock or sold by category, by vendor, by location, or by customer.  
These reports require similar query parameters, but are automatically set to narrow results.  Note that 
unlike the Showing Returns report, this report’s primary filter is the current item status.  So if it has 
been returned, it will not show as sold.  For more about report filters and settings, see the section entitled 
Creating a Report and the high-level section entitled Inventory Reports.     

7.4.1.1 In Stock by Category Report 
The In Stock by Category report automatically lists and sorts items by category. 
 

 
 
Data fields in the In Stock by Category report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
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Description A description of the item. 
Count Number in stock, only in subtotals. 
Age The length of time the item has been in stock. 
Cost Cost of item to store. 
Price Retail price of item. 
 
 

7.4.1.2 In Stock by Vendor Report 
The In Stock by Vendor report automatically lists and sorts items by vendor. 
 

 
 
Data fields in the In Stock by Vendor report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number in stock, in subtotals. 
Age The length of time the item has been in stock. 
Cost Cost of item to store. 
Price Retail price of item. 
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7.4.1.3 In Stock by Location Report 
The In Stock by Location report automatically lists and sorts items based on where they are located 
within the store. 
 

 
 
Data fields in the In Stock by Location report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number in stock, in subtotals. 
Age The length of time the item has been in stock. 
Cost Cost of item to store. 
Price Retail price of item. 
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7.4.1.4 Sold by Category Report 
The Sold by Category report automatically lists and sorts the sales of items sorted by category. 
 

 
 
 
Data fields in the Sold by Category report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotals. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Price Actual sale price of item. 
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7.4.1.5 Sold by Vendor Report 
The Sold by Vendor report automatically lists and sorts the sales of items by vendor. 
 

 
 
Data fields in the Sold by Vendor report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotals. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Price Actual sale price of item. 
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7.4.1.6 Sold by Customer Report 
The Sold by Customer report automatically lists and sorts the sales of items by customer. 
 

 
 
Data fields in the Sold by Customer report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotal. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Price Actual sale price of item. 
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7.4.1.7 Showing Returns 
The Showing Returns report shows everything that was sold regardless of whether it was returned at a 
later date.  For example, an item that was sold in the month of May, but returned in the month of June, 
would still show as sold if this report was run for May alone.  Conversely, a standard Sold Items report 
for the month of May would not include an item that has since been returned. 
 

 
 
Data fields in the Showing Returns report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotal. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Price Actual sale price of item. 
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7.4.2 Ordering Reports 
Ordering reports help you evaluate sales and inventory for planning and ordering purposes.  They can be 
used to analyze parts needed for repair and special order, to calculate fast selling merchandise, and can 
be used to calculate a complete open to buy (OTB).  For more about report filters and settings, see the 
section entitled Creating a Report and the high-level section entitled Inventory Reports.    

7.4.2.1 SPO/Parts Report 
The SPO/Parts report is used to manage parts needed to fill repair jobs as well as custom-order and 
merchandise needed to complete special orders.  The SPO/Parts report window allows you to narrow 
inclusion parameters much as you would for a special order search.  For more information, see the 
section entitled Finding a Special Order Transaction. 
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Data fields in the Special Order report include: 
 
Job # The ID number for the special order. 
# Req The quantity of the item requested. 
#Ord The quantity of the item ordered. 
Entered Date the special order was created. 
Ordered Date the order was placed. 
ETA The estimated time (date) of arrival. 
Recvd The date the item was received. 
Vend The vendor ID. 
Style The vendor style number. 
Cost The cost of the item. 
Price The price to the customer. 
 

 

A star in the ETA field of the Special Order report indicates that the date and/or 
price is promised, not an estimate. 
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7.4.2.2 Rapid Reorder Report 
The Rapid Reorder report serves several purposes based on the selection chosen in the Include Sales 
section.  To run this report, you must choose at least one checkbox in the Include Sales criteria.  For 
example, checking Fast Sellers will return only inventory that meets your Fast Seller criteria.  The Edge 
uses your item Levels settings for minimum to be kept in-stock along with the designation as fast seller 
to ensure your inventory is always at the optimum level.  For more information about levels, see the 
section entitled Inventory Levels.   
 
Additionally, checking multiple options returns all items that match and identifies those items that match 
multiple criteria.   
 

 
 
Query options are extensive for the Rapid Reorder report: 
 
Sale Date Allows you to filter by transaction date. 
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Fast Seller 
Threshold 

Anything that sells in this number of days or fewer is considered a fast seller. 

Fast Seller Min ROI Indicates that items with an ROI of at least this much should be considered a 
fast seller.  This is an alternative to Fast Seller Threshold. 

Category Allows you to filter by category. 
Vendor Allows you to filter by vendor. 
Store Allows you to filter by store. 
Display Rows Multi-store only; choose between displaying per company (all stores 

combined) or per store. 
Include Sales Fast Sellers – identifies items that match the fast seller threshold and date 

range defined at the top of the window. 
Below Reorder point – corresponds with the Items ► Levels function in the 
item record that allows you to set minimum and maximum inventory levels 
per a specific vendor style.  
Others – allows you to include all sales. 
Styles that did not sell – identifies those items that have had no activity in 
the selected timeframe. 

Include Inventory 
Types 

Allows you to filter by specific inventory types. 

Options Allows you to specify output options. 
Include Pricing 
Methods 

Allows you to filter by pricing methods. 

Treat Layaways As Allows you to determine how layaways should be treated for the purposes of 
this report. 

Treat Giveaway as 
Sold 

Indicates that giveaways should be counted as sold items. 

Treat Donations as 
Sold 

Indicates that donated items should be counted as sold items. 

Use Report Criteria 
Cover Page 

Checked by default, can be unchecked to run just this report in this instance 
without the criteria cover page.  For more about the report criteria cover page, 
see the section entitled Working with Report Results.    

  
 
 
  



The Edge User Guide v. 20.0.0.114 

496 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 
 
Data fields in the Rapid Reorder Report include: 
 
Vendor The vendor from whom the item should be ordered. 
Category The item category. 
Store Multi-store only; displays break down by store for each style.  The first 

row of each style will show Totals if managing per store or All if 
managing by company. 

Suggest The quantity being suggested for order based on Reason.  A 
replacement item will be suggested for each item meeting fast seller 
thresholds.  Additional quantity will be recommended to meet Min 
levels if set.   
 
Note:  Suggested Fast Sellers are NOT taken into consideration when 
calculating stock level suggestions.  This means if you are out of stock 
on a particular style, have sold 1 qualifying item fast, and have a 
minimum level of 2, The Edge will suggest ordering 3.  1 to replace 
your fast seller and 2 to maintain stock level. 

Reason The reason the style should be ordered. 

Fast:  Style met fast seller criteria for this sales period. 
< Min: Style below reorder point. 

In Stock Quantity currently in stock for this style. 
Avg Days On Hand For in stock items, the average number of days they have been in stock. 
In Process The quantity currently queued for order or on order. 
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7.4.2.3 Reorder Form 
The Reorder form performs several ordering functions based on the selection chosen in the Include 
Sales section.  To run this form, you must choose at least one checkbox in the Include Sales criteria.  
Additionally, checking multiple options will return all items that match either, and also identifies those 
items that match multiple criteria.   
 
The Rapid Reorder report and form share the same options and return similar results.  The report is 
designed to be printed while the form integrates directly into The Edge ordering system allowing you to 
easily queue items to be placed on Purchase Orders. 
 
See the section entitled Rapid Reorder Report for an explanation of the options used to generate this. 
 

Sold Yr The number of the item sold this year. 
# Sold The number of the item ever sold. 
Fast Of # Sold, the quantity that met fast seller threshold. 
SPO Of # Sold, the quantity sold on special order. 
Margin The profit margin on the item. 
MR Cost The cost of the most recent sold item. 
MR Sold Price The retail price of the most recent sold item. 
Avg Days to Sell Of # Sold, the number of days in inventory before selling. 
Min The minimum number of this style number to have in inventory at any 

time.  This threshold is set in Inventory ► Items ► Levels. 
Max The maximum number of this style number to have in inventory at any 

time.  This threshold is set in Inventory ► Items ► Levels. 
Category Total Number of items in the category. 
Vendor Total Number of items by vendor. 
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The Rapid Reorder Form will generate an interactive form.  Data fields in the form include: 
 
Vendor The vendor from whom the style should be ordered. 
Style The vendor’s style number. 
Store Multi-store only; displays break down by store for each style.  The first row of 

each style will show Totals if managing per store or All if managing by 
company. 

Suggested The quantity being suggested for order based on Reason.  A replacement item 
will be suggested for each item meeting fast seller thresholds.  Additional 
quantity will be recommended to meet Min levels if set.   
 
Note:  Suggested Fast Sellers are NOT taken into consideration when calculating 
stock level suggestions.  This means if you are out of stock on a particular style, 
have sold 1 qualifying item fast, and have a minimum level of 2, The Edge will 
suggest ordering 3.  1 to replace your fast seller and 2 to maintain stock level. 

# Ordering Used in conjunction with Queue Items for Order button at bottom to queue 
items for placement on POs. 

Reason The reason the style should be ordered. 
Fast:  Style met fast seller criteria for this sales period. 
< Min: Style below reorder point. 

In Stock Number currently in stock. 
Avg Days On 
Hand 

For in stock items, that average number of days they have been in inventory. 

Queued Number currently queued for order. 
On Order Number currently on order. 
# Sold This Year Total quantity of this item sold this calendar year. 
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# Sold Total quantity of this item ever sold. 
Fast Sellers Of # Sold, the number that met fast seller threshold. 
SPO Of #Sold, the number that were sold on special order. 
MR Cost The cost of the most recently sold item. 
Avg Days To Sell For sold items, the average number of days they were in inventory before being 

sold. 
Min The minimum quantity as defined by Levels. 
Max The max quantity as defined by Levels. 
Description Description of this style. 
 
To queue styles for order: 
 
1. Check those styles for order. 
2. Enter quantity to order in the # Ordering field. 
3. Select Queue Items for Order.  The Queue items for order window will appear.  
4. Specify quantity to order, choose a category, and select OK to complete queuing this style. 

 

 

Queued styles will be waiting to be placed on Purchase Orders.  Use the Retrieve 
Queued button at the top of the Purchase Order form to add them. 

 

• Queued styles can be searched and managed via Inventory ► P/O ► Find 
Orders. 

• The Rapid Reorder Report and Form are both included in the Inventory Buying 
Tools function.   
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7.4.3 Bonus Poster 
When items are assigned a spiff (a bonus for the sales person in terms of percentage of profit margin), 
you can print a poster highlighting these items to your sales staff.   This report is intended to be printed 
and displayed for your sales associate to inform them of cash incentives for selling individual items.  
More often than not, the spiff is a means of encouraging your staff to move old inventory.   
 

 

If you pay commissions, the greater of spiff or commission will be paid, but not both. 

 

Items can be assigned a spiff individually by editing the Item Detail from Inventory ► 
Items or when running inventory repricing from the Administrative menu. 

 

 
 

1. Specify a title and subtitle for the poster. 
2. Specify the maximum number of photo pages and maximum number of items on the poster. 
3. Restrict the poster to certain inventory types or categories by using the Item Filter.   
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7.4.4 Sign Locations Report 
The Sign Locations report lists the signs in your store and their locations.  This is helpful in tracking 
changes to signage and ensuring accurate signage.  The Sign Locations report requires no parameters.   
 

 
 

Data fields in the Sign Locations report include: 
 
Item Number The item number for which the sign is posted. 
Sign Type The type of sign posted. 
Item Description A description of the item for which the sign is posted. 
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7.4.5 Giveaway Report 
The Giveaway report under Inventory summarizes promotional giveaways.   For more about report 
filters and settings, see the section entitled Creating a Report and the high-level section entitled 
Inventory Reports. 
 

 
 
Data fields in the Giveaway report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotal. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Price Actual sale price of item. 
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7.4.6 Donations Report 
The Donations report summarizes donation activity.   For more about report filters and settings, see the 
section entitled Creating a Report and the high-level section entitled Inventory Reports. 
 

 
 
Data fields in the Donations report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotal. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Price Actual sale price of item. 
 
 
 
 
 
 
 
 
 



The Edge User Guide v. 20.0.0.114 

504 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

7.4.7 Re-Cost Report 
The Re-Cost report provides details concerning re-cost activities.  For more about report filters and 
settings, see the section entitled Creating a Report and the high-level section entitled Inventory Reports. 
 

 
 
Data fields in the Re-Cost report include: 
 
Vendor Style # The vendor and style number. 
Item # The item number. 
Type Inventory type (regular stock, consignment, memo, special order, etc.).   
Status Inventory status (in stock, sold, on layaway, etc.). 
Description A description of the item. 
Count Number sold, in subtotal. 
Age The length of time the item was in inventory. 
Cost Cost of item to store. 
Re-Cost The re-cost amount. 
Re-Cost Date The date the re-costing was done. 
Diff The difference between the cost and the re-cost. 
Price Actual sale price of item. 
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7.4.8 Conversion Report 
The Conversion report assists in the conversion from an old item number system to a new one.   
 

 
 
Data fields in the Conversion report include: 
 
Old Item# The old item number. 
New Item# The new item number. 
Description A description of the item. 
Vendor ID The vendor’s ID. 
Vendor Style The vendor’s style number. 
Price The price of the item. 
Cost The cost of the item. 
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7.4.9 Performance By Reports  
Performance reports provide a detailing of sales activity by various parameters to help determine 
profitability.   
 
The reports generated are statistical in nature and are useful in determining sales success or failure 
broken down by category or vendor as well as price point and age.  The reports print in descending 
order, starting with the top selling and ending with the bottom selling based on percentage of sales. 
 
Additionally, the report calculates ROI for each price point, category, vendor, and a grand total for the 
store.  Any price point falling below the stores overall average ROI will appear in a salmon color. 
 
For more about report filters and settings, see the section entitled Creating a Report and the high-level 
section entitled Inventory Reports. 
 
Performance reports can be generated by: 
 
Category Performance of items in each category. 
Category By 
Age 

Performance of items in each category and by how long they’ve been in stock. 

Category By 
AIMS 

Performance of items by category based on the date ranges set for Automatic Mark 
Down per category.  Your settings impact these results. 
 

Vendor Performance of items provided by each vendor. 
Vendor & Age Performance of items provided by each vendor and by how long they’ve been in 

stock. 
Age Only Performance of items only by how long they’ve been in stock. 

Percentiles Performance of inventory based on user defined selection criteria.  This report 
differs from the other inventory performance reports and as thus is explained 
separately below. 

 
Each result is provided in two forms:  a bar chart and a table.  Within each report, a listing of parameters 
selected for the report is provided along the top. 
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7.4.9.1 Performance Report Bar Chart 

 
 
The bar chart results show at a glance how the designated grouping performed.  First, a chart of 
performance based on the retail price of the items is presented.  Next, performance based on the 
investment or cost of goods sold is presented.  It might be useful to change categories or vendors or work 
with different sort orders to present that data in a variety of ways.   In these two bar charts, the first is 
ordered by categories or vendors with the highest retail sales.  The second is ordered by categories or 
vendors with the highest dollar investment.  Detail area is presented as follows: 
 
A These are column headers to be used in the table portion of the report.  See the description below. 
B This is the dollar amount. 
C These are performance by category or vendor.  For each category, there are three bars: 

 
• Blue is retail sales. 
• Red is average dollars invested in the inventory for this category. 
• Yellow is the amount of profit generated. 
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7.4.9.2 Performance Report Table 

 
 
In the tabular version of the report, data fields include: 
 
Category or 
Vendor 

The category or vendor by which the items are being grouped.  This column type will 
vary depending on the type of report generated. 

Cost Range Each category or vendor can be further broken down by price ranges. 
% Total What percentage of total sales this category or vendor and price point accounts for.  It 

is calculated based on the selling price. 
# Sold The total number of items in that grouping sold. 
ADTS Average days to sell.  Of the items sold in this line, the number of days, on average, it 

took for them to sell. 
ARS Average retail sale. 
ANOH Average number on hand. 
#End Number of items remaining on hand. 
ADOH Average days in stock.  Average number of days that unsold items are in inventory. 
Retail The retail price of the items that sold. 
Profit The net profit of the sales from that grouping. 
% Margin The profit margin based on the items that sold. 
% Mkdn The discount that was taken at point of sale marked down from retail. 
ACOI The average value of inventory during the period. 
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GROI The gross return on investment for that grouping.  If the value is above 150%, it will 
appear highlighted in green. 

TROI The true return on investment for that grouping.  This figure takes into account the 
full amount of time the item was in stock during the reporting period. 

Turn Number of times that inventory investment turned at cost of goods sold. 

7.4.9.3 More on ROI 
GROI is gross return on investment and is figured as: 
 

Profit ÷ Average Value of Inventory 
 
In other words, an item in inventory 6 months will have an average cost of ½ its value, an item entering 
into a period over 1 year will reflect its full value.   
 
TROI is true return on investment and is figured as: 
 

 
 
For example, suppose an item costs $100 and sells for $200: 
 

 GROI TROI 
Item sold in 6 months 200% 200% 
Item sold in 9 months 133% 133% 
Item sold in 12 months 100% 100% 
Item sold in 18 months 100% 66% 
Item sold in 24 months 100% 50% 
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7.4.10 Sales and Stock Levels by Age Report 
The Sales by Age report shows amounts of inventory sold and in-stock by length of time in inventory. 
 
The first page contains a graphical representation of the number of items sold by age. 
 

 
 
The second page provides the details.   
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Data fields in the Sales by Age report include: 
 
Inventory Age Groupings of data by age. 
# Sold The number of items sold for that age range for the date range run. 
$ Sold The amount in dollars brought in for those items sold. 
GP % The percentage of gross profit yielded by those sales. 
Total Sales % The percentage of the total sales for the date range yielded by those sales. 
# In Stock The number of items in that age range that are in stock. 
$ Cost The total cost of those items that are on hand. 
$ Retail The total retail value of those items that are on hand. 
% of Inv. Cost The percentage of total inventory that this age group makes up in your 

inventory. 
 
By looking at these values, you can see how fast sellers are performing against older inventory and plan 
new inventory accordingly.  If you double click on the following data values, you’ll get a specific list of 
items included in the figure to help your further clarify what items are providing the indicated 
performance. 
 
• # Sold 
• $ Sold 
• GP % 
• Total Sales % 
• # On Hand 
• $ Cost 
• $ Retail 
• % of Inv. Cost. 
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7.4.11 Replenish Current Inventory Report 
The Replenish Current Inventory report shows categories that performed reasonably well and might 
make good areas for in which you might consider investing.  This report works in concert with the 
Replenish Base Stock report found in the Inventory Buying Tools feature. 
 

 
 
Data fields in the Replenish Current Inventory report include: 
 
Cost Range The cost range to which the data is categorized. 
% Total What percentage of total sales this category or vendor and price point accounts for.  It 

is calculated based on the selling price. 
# Sold The total number of items in that grouping sold. 
ADTS Average days to sell.  Of the items sold in this line, the number of days, on average, it 

took for them to sell. 
ARS Average retail sale for each item included in the number sold. 
ANOH Average number on hand during that time period. 
#End Number of items remaining on hand. 
ADOH Average days in stock.  Average number of days that unsold items are in inventory. 
Retail The total retail value. 
COGS Cost of goods sold. 
% Mgn The profit margin based on the items that sold. 
%Mkdn The discount that was taken at point of sale marked down from retail. 
ACOI The average cost of inventory.  In this case, it is the average cost of each item 

included in the number sold. 
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GROI The gross return on investment for that grouping.  If the value is above 150%, it will 
appear highlighted in green. 

TROI The true return on investment for that grouping.  This figure takes into account the 
full amount of time the item was in stock during the reporting period. 

Turn Number of times that inventory investment turned at cost of goods sold. 
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7.4.12 Recovered Cost of Aged Items Report 
The Recovered Cost of Aged Items report helps you plan the reinvestment of dollars recovered from 
the sales of aged items. When you put aged items on spiff or sale, you’ll move inventory that has been 
sitting around for a long time.  This is almost like found money that you can now think about investing 
in good performing categories.  It shows a more detailed view of recovered funds than that shown in the 
Recovered Funds Redeployment Guide. 
 

 
 
Data fields in the Recovered Cost of Aged Items report include: 
 
Category ID, 
Cost 

The category ID and cost range for items listed. 

% GROI Percentage gross return on investment for the category and price range. 
% TRIO Percentage true return on investment for the category and price range. 
Avg Cost of 
Inventory 

 

Cost Average cost per item in that group. 
# End Number of items still in stock at the end of the date range in that group. 
Pct The percentage of cost of goods in stock that can be attributed to that group.  
Cumu Running down the report results in that column, this is a cumulative total of the 

cost of in-stock inventory for groups included in the report. 
Pct Running down the report results in that a column, this is the cumulative 

percentage of the cost of in-stock inventory for groups included in the report. 
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Cost of 
Goods Sold 

 

Cost Total cost of goods sold in that group. 
# Sold Total quantity sold in that group. 
Pct The percentage of cost of goods sold that can be attributed to that group. 
Cumu Running down the report results in that column, this is a cumulative total of the 

cost of sold inventory for groups included in the report. 
Pct Running down the report results in that a column, this is the cumulative 

percentage of the cost of sold inventory for groups included in the report. 
Profits  

Profit Profit made for the group. 
Pct The percentage of overall profit that can be attributed to those sales. 
Cumu Running down the report results in that column, this is a cumulative total of the 

profit from sales of inventory for groups included in the report. 
Pct Running down the report results in that a column, this is the cumulative 

percentage of the profit from sales of inventory for groups included in the report. 
 
 
  



The Edge User Guide v. 20.0.0.114 

516 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

7.4.13 Transfer Report 
The Transfer Report provides a detailed history of store-to-store transfers.  Note that if the same item is 
transferred a number of times, the amounts shown may be inaccurate.  For more about report filters and 
settings, see the section entitled Creating a Report and the high-level section entitled Inventory Reports. 
 

 
 
Data fields in the Transfer report include: 
 
Vendor Style # The vendor style number of the transferred item. 
Item # The item ID number of the transferred item. 
Description A description of the transferred item. 
From Store The store from which the item was transferred. 
To Store The store to which the item was transferred. 
Associate Shipped The associate who shipped the item. 
Associate Received The associate who received the item. 
Date Shipped The date the item was shipped from the transferring store. 
Date Received The date the item was received in the receiving store. 
Shipping Service The shipping service used. 
QTY The quantity of the transferred item. 
UOM The unit of measure of the transferred item (single item pricing, 

UPC/SKU, individual unit of measure, unit of measure, PRE). 
Tracking The shipping service's tracking number for the item. 
Cost The cost of the item at time of shipment. 
Ref # An optional reference number used for your own tracking purposes. 
Retail The retail value/price of the item at time of shipment. 
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 Customer Reports 
Customer reports are key to maintaining the intimate customer/jeweler bond.  They allow you to keep 
track of upcoming special dates, wish lists, records, balances, and more.  For more about report filters 
and settings, see the section entitled Creating a Report.  For a video tutorial about working with 
customer filters, go to http://www.screencast.com/t/MkdH1e7iQmqR.   

7.5.1 Simple List Report 
The Simple List report is an alternative to printing the listed results in the Find Customer function.  It 
returns basic customer information and also includes a total tender activity to date.  In the report query, 
you can specify whether customers should be listed as couples or individuals.  For more about report 
filters and settings, see the section entitled Creating a Report.   
 

 
 
Data fields in the Simple List report include: 
 
Customer # The customer’s ID number. 
Customer Name and 
Address 

The customer’s contact information. 

Phone The customer’s phone number. 
Entered The date of the customer’s first activity. 
Tender$ The amount the customer has spent with the specified store in the 

specified time frame. 
 
There is the option to include the spouse’s name. 
  

http://www.screencast.com/t/MkdH1e7iQmqR
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7.5.2 Wish Lists Report 
The Wish List report gives your customers the opportunity to record items they would like to receive as 
a gift.  For more information on this feature, see the section entitled Wish List.  The Wish List report 
requires only that you select a time frame.  For more about report filters and settings, see the section 
entitled Creating a Report.   
 

 
 
Data fields in the Customer Wish List report include: 
 
Customer name, address, and 
phone number 

The customer’s name and contact info. 

Vendor Style # The style number of the item for which the customer wished. 
Item # Item ID of the desired item. 
Type Item type. 
Status Wish list status. 
Intended For  The person for whom the item is intended. 
Description The item description. 
Age The length of time, in days, that the wish has been in the system. 
Price The price the item sold for. 
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7.5.3 Percentiles Report 
It can be useful to know for marketing purposes what portion of your customers make up the largest 
portion of sales.  For example, it is not unusual for 10 percent of your customers to generate 80 percent 
of your sales.  The Percentiles report provides a percentage of sales as attributed to a specific section of 
your customer base.  It requires only that you select a time frame.   
 
Results 
 

 
 
Data fields in the Percentiles report include: 
 
Pie Chart Depicts the percentiles graphically. 
% Sales Percentage of sales in 10 percent increments. 
Sales The total sales in that percentile increment. 
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Cumulative 
Sales 

A running total of sales including sales from the previous percentile category. 
 

 

Clicking on a figure in the Cumulative Sales column of the Percentiles 
report will return the list of customers who made purchases toward it. 

 

Customers Number of customers in that percentile. 
Cumulative 
Customers 

A running total of customers including customers from the previous percentile 
category. 

Average 
Customer 

In that percentile, what the average customer spent. 
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7.5.4 Top “n” Customers Report 
The Top “n” Customers report lists the highest-spending customers.  It asks you to provide the value of 
“n,” which indicates the number of top customers to include based on either amount tendered or 
merchandise totals.  There is an option to exclude open layaways.  Beyond that, it requires only that you 
select a time frame. 
 

 

You can use the Category or Vendor filters to see your top customers for a particular 
category or vendor. 

 

 
 
Data fields in the Top “n” Customers report include: 
 
Customer ID The customer’s ID number. 
Name/Phone Customer’s name and telephone number. 
$ Amount/Number of Items The amount of the sale(s) and how many items were purchased. 
Average Item The average price of the items purchased by this customer. 
Month in which sale occurred The months in which sales were made and how many. 

 

 

The Top N Customers report is very useful in determining your top customers for 
purposes of marketing.  While not directly exportable, this report can be used in 
conjunction with the customer export function.  This is accomplished by taking the 
amount spent by the last person to make the cut (e.g. the amount spent by customer 
500 in a top 500 report) and plugging it into the Amount Spent field on a customer 
export or mailing. 
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7.5.5 By ZIP Report 
The By ZIP report shows the percent of customers in a period of time by ZIP Code and the percent of 
expenditures in a period of time by ZIP Code.  For more about report filters and settings, see the section 
entitled Creating a Report.   
 

 
 
Pie Chart Data  

% Sales Percent of sales by zip code. 
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% Customers Percent of customers by zip code. 
 

 
 
Data in the By ZIP report includes: 
 
Zip The zip codes that are included. 
$ Sales Dollar amount of sales generated by each zip code. 
% Sales The percentage of sales generated by each zip code. 
# Customers The number of customers in each zip code. 
% Customers The percentage of customers in each zip code. 
Avg Customer Amount spent on average by each customer in that zip code. 

 

 

In the By ZIP report, for records where the customer has no preferred address, they 
will appear as None.  On the pie chart, the top 10 zip codes are displayed, and Other 
contains totals for all others. 
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7.5.6 By Acquisition Report 
The By Acquisition report shows sales according to how the customer came to be a customer as 
indicated by the Why In field on the Point of Sale window.  It requires only that you select a time 
frame. 
 

 
 
 
Pie Chart Data  

% Sales Percent of sales by type of acquisition. 
% Customers Percent of customers by type of acquisition. 
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Data fields in the By Acquisition report include: 
 
Acquisition  The type of acquisition. 
$ Sales Dollar amount of sales generated by type of acquisition. 
% Sales The percentage of sales generated by type of acquisition. 
# Customers The number of customers in each type of acquisition. 
% Customers The percentage of customers in each type of acquisition. 
Avg Customer Amount spent on average by each customer in that type of acquisition. 

 

 

In the By Acquisition report, for records where no acquisition type was recorded, 
they will appear as None.  On the pie chart, the top 10 acquisition types are 
displayed, and Other contains totals for all the others. 
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7.5.7 By Why In Report 
If you track the occasion that brought a customer into your store, the By Why In report can help track 
such activity and help plan promotions, postcards, and other targeted marketing.  For more about report 
filters and settings, see the section entitled Creating a Report.   
 

 
 
Pie Chart Data  

% Sales Percent of sales by type of Why In? 
% Customers Percent of customers by type of Why In? 
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Data fields in the By Why In report include: 
 
Why In Lists promotional events. 
$ Sales The amount of sales produced by each promotional event. 
% Sales The percent of sales produced by each promotional event. 
# Customers The number of customers who came in because of the promotional event. 
% Customers The percent of customers who came in because of the promotional event. 
Avg Customer On average, the amount customers spent as a result of their visit. 
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7.5.8 Balances Report 
The Balances report summarizes customer balances, either credits owed to the customer or balances due 
to the store.  This report is automatically grouped by account type.  The filter allows you to select 
specific account/balance types.  For convenience, you may include the customer’s phone number or 
address to assist with follow-up. 
 

 
 
Data fields in the Balances report include: 
 
Customer The customer’s name. 
Account The type of account or account number, depending on the account type.  
Date Created The date the account was created. 
Last Activity The date of the last transaction. 
Balance The current balance on the account. 
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7.5.9 On Account Report 
The On Account report lists all customer deposits on account including open transactions such as 
layaways, special orders, repairs, etc.  This report is used specifically to account for customer deposits 
liability.  For this report, despite the date selection, this report query is modified to include balances 
forward from previous dates and activity for the specified date range.  The end date of the report will 
determine the cutoff point for the on account balances.  For example, if you wish to see detail for on 
account transactions for last month and by account type, run the report as follows:  Set the activity date 
to last month, check Account Type in the Group By field, and check all appropriate account types from 
the option that you want to report on.  The report returns balances for all accounts that have a balance as 
of the selected end date, regardless of start date.  Detail for transactions will be included for only the 
selected date range. 
 

 
 
Data fields in the On Account report include: 
 
Account # The ID for the transaction listed in the account. 

Start Date The date this transaction was started. 

Start Amount Total amount of transaction. 
Start Deposit Initial deposit given on inception. 
Activity Type The type of activity. 
Activity Date The date of last activity. 
Activity Amt Due The amount still due on this transaction. 
Activity On Account The total amount held on account towards this transaction. 
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7.5.10 House Account Aging Report 
The House Account Aging report shows account aging as of the most recent statement period.  
 

 
 
Data fields in the House Account Aging report include: 
 
Customer The customer’s name. 
Current The amount due for current statement period. 
1-30 The amount that is unpaid for between 1 and 30 days since the last closing. 
31-60 The amount that is unpaid for between 31 and 60 days since the last closing. 
61-90 The amount that is unpaid for between 61 and 90 days since the last closing. 
Over 90 The amount that is unpaid for over 90 days since the last closing. 
Minimum Due The minimum amount due on the account including all unpaid amounts. 
Days Late The number of days late/not paid the minimum amount due is. 
Total Amount The total balance. 
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7.5.11 Rewards Reports 
Rewards reports help you determine the amounts being awarded and what your outstanding rewards and 
referrals are.  For more about report filters and settings, see the section entitled Creating a Report.   

7.5.11.1 Rewards Detail Report 
The Rewards Detail report shows merchandise purchased affecting rewards and the amount rewarded. 
 

 
 
Data fields in the Rewards Details report include: 
 
Date The date a transaction occurred that generated rewards. 
Sale # The unique identifier of the sales activity. 
Description A description of the item sold that generated rewards. 
Type The type of sale made toward the reward. 
Sale Amount The total amount of the transaction that generated the reward. 
Reward The reward amount generated. 
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7.5.11.2 Rewards Summary Report 
The Rewards Summary report generates a list of customers who have rewards cards and general 
activity on them. 
 

 
 
Data fields in the Rewards Summary report include: 
 
Customer The customer with the rewards card. 
Card # The unique identifier of the rewards card. 
Issued The date the rewards card was issued. 
Count How many items were purchased that accrued awards. 
Sales Amount The total purchase amount of the items that were purchased that accrued 

awards. 
Earned The amount that was accrued. 
Original The value originally loaded onto the card. 
Redeemed How much was redeemed from the card since it was issued. 
Adjusted Indicates adjustments that were made to the rewards account. 
Balance The amount currently available for redemption. 
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7.5.11.3 Rewards Referral Report 
The Rewards Referral report shows the referral cards issued to customers for distribution, what 
customers have them and activity on them. 
 

 
 
Data fields in the Rewards Referral report include: 
 
Referrer The customer who was given the rewards card by the store to distribute. 

# of Cards The number of cards the referrer was given to distribute. 
Value of the Cards The initial value of the card. 
# of Cards Used The number of cards used by recipients. 
Card Amt Used The amount that has been used by recipients. 
Sale Amount The amount of total sales for cards distributed by that referrer. 

Customer Referred The customer who received the card from the referrer. 
Reward Card # The unique identifier of the rewards card given to the recipient. 
Date Issued The date the card was issued to the referrer for distribution. 
# Sales The number of sales for which the card was used. 
Sale Amount The total amount that has been used from the card. 
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7.5.12 Layaways Report 
The Layaways report lists layaway details for the specified parameters.  For more about report filters 
and settings, see the section entitled Creating a Report.   
 

 
 
Filter fields for the Layaway report include: 
 
Only include layaways for 
customers 

Returns layaway records for the specified customers. 

Only include layaways that 
were started 

Returns layaway records for the specified start dates. 

Only include payments up to 
and including 

Exclude payments after the specified date. 

Only include layaways with 
no activity on or after 

Returns layaway records that have had no activity for the specified 
date range. 

Include Item Details In the report, include details of the items put on layaway. 
Include Closed Layaways In the report, include layaways that have been picked up or 

canceled. 
Treat Zero-Balance 
Layaways as Closed 

In the report, consider layaways that have no outstanding balance to 
be closed. 

 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 535 
© 2020 Abbott Jewelry Systems, Inc. 

 
 
Data fields in the Layaway report results include: 
 
Customer The customer’s name and ID number. 
Layaway # The layaway ID number. 
Item # The ID number of the item on layaway. 
Start Date Date the item was put on layaway. 
Date Date the item was picked up or canceled. 
Total Amount Total amount of the purchase. 
Price The price of the item on layaway. 
Tax The tax calculated on the whole order. 
Tax The tax on the price of the item on layaway. 
Deposit The amount put down as an initial deposit. An asterisk in this column 

means the order was partially picked up or canceled; payments and 
deposits may have been partially applied to the items that were picked 
up or canceled; therefore, the other numbers might not add up. 

Description A description of the item on layaway. 
Payments A list of payments made on the layaway. 
Most Recent Payment The most recent payment amount and date. 
Total on Account The total paid toward the item. 
Total Due The total still to be paid before the item can be picked up. 
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7.5.13 Thank You Report 
The Thank You report details a combination of information useful for following up with customers.  It 
shows contact information and a sales history for customers.  This might be useful in helping you to 
thank a customer for his business.   The query for it is similar to that of activity reports.  For more about 
report filters and settings, see the section entitled Creating a Report.    
 

 
 
Data fields in the Thank You report include: 
 
Sale # The transaction number of the sale. 
Date The date the transaction took place. 
Description A description of the item sold. 
Amount The amount for which the item sold. 
Associate Groups customers by associate. 
Customer The customer’s name, phone, address. 

 

In this example, Store #, Associate, and Customer represent grouping options. 
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7.5.14 Notifications Report 
The Notifications report shows customer notification information and the number of notifications sent.  
For more about report filters and settings, see the section entitled Creating a Report.   
 

 
 
Data fields in the Notifications report include: 
 
Customer Name The name of the customer. 
Service The service for which the notification took place. 
Item The item on which the service was being done. 
Notify By The method of notification. 
Notify Address The destination of the notification. 
Requested When the item was needed by. 
Notified When the notification was sent. 
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7.5.15 Occasions Report 
The Occasions report allows you to generate a report of customers’ special occasions.  This could be 
used to export a mailing list for reminders and sale flyers.  The Occasions report filter requires only that 
you select a time frame, but you can also narrow by customer and occasion type.  You can also choose 
whether to show the results as couple records or individual records. 
 

 
 
The results are sorted by occasion date.  For more about report filters and settings, see the section 
entitled Creating a Report.   
 

 
 
Data fields in the Occasions report include: 
 
Customer number The customer’s ID number. 
Customer name, address, 
phone number 

The customer’s contact information. 

Date and nature of the 
occasion 

The occasion and the date. 
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7.5.16 Gift Card Report 
The Gift Card report lists gift cards and their balances. 
 

 
 
Data fields in the Gift Card report include: 
 
Card # The number of the gift card. 
Date The date(s) the gift card was issued or used. 
Sale # The transaction(s) containing the gift card sale and uses. 
Customer/Memo The customer ID(s) who bought or used the card. 
Amount The amount(s) of the transaction(s) on the card. 

7.5.17 Duplicate Customers 
The Duplicate Customers report is designed to identify potential duplicate customer records.  It is a 
good starting point when looking to clean up your customer database. 
 
To run the report: 
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1. Click Reports ► Customers ► Duplicate Customers. 

 
2. Use the Starting and Ending Letter fields to limit the report to a range of customers based on last 

name.  Leaving these blank will check the entire customer base for duplicates.  Depending on the 
number of customers and duplicates, this could take a very long time.  Also, the resulting report may 
be very long.  If that is the case make a plan to make this more manageable by attacking it a few 
letters at a time. 

3. The Comparison Options radio button works in conjunction with the checkboxes below it to 
control how the report searches for potential duplicates: 

Match Any Display customer records as potential duplicates if any of the criteria checked 
below matches. 
 

Match All Display customer records as potential duplicates only if ALL of the checked 
criteria matches (i.e. exact match). 
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4. Select your criteria and click OK to generate the report. 

 
5. Each customer will be listed in bold with potential duplicates showing beneath them.   

 

Working with the Duplicate Customer report: 

• The report is interactive.  You can click on the customer’s number or name to open the 
customer record.  From there you can use the Supervisor menu to merge duplicates.  Note that 
the report does NOT refresh, so it is up to you to keep track of where you left off. 

• Depending on criteria selected, this report may not match exactly to the results shown when 
using the Merge utility from the customer record. 

• Remember that you can use the report filter to limit this report by last name letter.  This can 
help make the process more manageable if you find the report is too long. 

• Because it is showing duplicates, you will see the same customer more than once.  In the 
screenshot above note that customer Don Acme (001-04354) has Don Acme (001-12714) as a 
potential duplicate, and below that they appear again in reverse order.   
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 Management Reports  
This variety of reports is of interest to general management for planning purposes. 

7.6.1 Advertising Reports 
Advertising reports detail sales as a result of paid advertising and special events.  Both Media and 
Events reports are displayed with a bar chart and a table listing results.  This is where the Why In field 
in the Point of Sale window is useful.  The advertising reports both require only a time frame for which 
events should be included.  
 

 
 
In the bar chart at the top, each campaign or event is shown in a different color.  The ranges on either 
side depict the sales attributed to that event.  In the table on the bottom of the report, data is as follows: 
 
Media The name of the publication or venue for promotion. 
Event The name of the event. 
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Sold@ The sales price of the item. 
Cost Cost of the goods sold. 
Comm. Commission paid on the sales. 
Adv. Cost Cost of the campaign or event. 
Net Net profit from the event. 
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7.6.2 Staff Reports 

7.6.2.1 Commission Report 
The Commission report details sales achieved by a particular associate and the commissions earned.  It 
requires that you select a time frame for transactions.  There is an option to include cost information, 
which results in the percent margin to be displayed.  In addition, you can narrow the report by customer 
criteria, store, and station number.   
 

 

There are four areas where you can work with setting commissions.  In general, 
settings that determine commissions are located in Administrative ► Associates.  At 
the category and vendor levels, commission overrides can be set.  See the sections 
entitled Adding a Category and Adding a Vendor.  Finally, System Options that control 
commission behavior.  Go to System Options and use the search field to find the term 
“commission.” 

 

 

• On layaway, repair, and special order transactions, commission is credited to the 
associate who originally processed the intake regardless of who processes 
subsequent payments and pickups. 

• If the Count Giveaway as a Penalty for % of Profit is checked, giveaways will 
affect the associates’ commission.  If it is not checked, giveaways will not penalize 
the associate’s commission.  This can only be calculated if the associate is set up 
for commission based on percent of profit.  If the associate is set up for percent of 
retail, then the commission calculated will always be zero anyway, as the sale 
price for a giveaway is zero.  If the associate is set up for commission based on 
percent of profit, and the box is checked, then the penalty for the giveaway will be 
the commission percentage times the giveaway item’s cost (not price). 

• Sales tax is not a factor in Commissions and therefore is not reflected in this 
report. 
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Data fields in the Commission report include: 
 
Associate # The associate’s ID number.  The report is grouped by associate, and within 

associate, is grouped by: 
 
• Regular 
• Bonus (spiff) 
• Repair 
• Returns. 

Associate Name The associate’s name. 
Sale # The transaction number of the sale. 
Item # The item number of the item(s) sold. 
Description A description of the item. 
Share Whether the sale is split between more than one associate. 
$Sold The price of the item. 
Age The length of time the item has been in stock. 
%Margin The profit margin. 
$Comm Commission earned on the sale. 
 
A summary appears at the bottom of the report: 
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7.6.2.2 Misc. Sales Report 
The Misc. Sales report details other kinds of sales activity conducted by each associate.  It requires only 
that you select a time frame for transactions. 
 

 
 
Data fields in the Misc. Sales report is grouped by associate and include: 
 
Sale # Transaction ID of the sale that included this item. 

Customer The customer’s name and ID. 
Item Description A description of the item sold. 
Amount The amount for which the item sold. 

 

 

• The Misc Sales report is included here as an aid to calculating commissions on 
sales of miscellaneous items because there is no built-in calculation for this.  If a 
sale were split between associates, a percentage indicator would appear. 

• There is a much more detailed sales report under the Activity reports function. 
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7.6.2.3 Attendance Report 
This report totals hours and sales for associates. 
 

 
 
Data fields in the Attendance report include: 
 
Punch In The date and time of each punch in during the specified time period. 
Punched Out The date and time of each punch out during the specified time period. 
Duration The length of time the shift lasted. 
# No Sales The number of times the associate used No Sale Tracking. 
# Sales The number of sales made. 
Rate The commission rate for the associate. 
Price The price of items sold. 
Cost Cost of goods sold. 
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7.6.2.4 Overview Report by Period 
The Overview Report by Period shows items sold, cost of goods sold, and pricing by associate, all 
broken by transaction type.  And it shows returns by associate, too, for net results.  There is an option to 
include the Cost column for Appraisals and Miscellaneous.   
 

 
 
Data fields in the Overview Report by Period include: 
 
SKU Items  

Qty Sold The total number of units sold by the associate for the period. 
Cost The total cost of goods sold by the associate for the period. 
Price The total selling price of the items sold by the associate for the period. 
GP % The percentage of gross profit for the period for that associate and sale type 

based on sales price and cost.   
Repairs  

Qty Sold The total number of units sold by the associate for the period. 
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Cost The total cost of repairs sold by the associate for the period. 
Price The total selling price of the repairs sold by the associate for the period. 
GP % The percentage of gross profit for the period for that associate and sale type 

based on sales price and cost. 
Custom  

Qty Sold The total number of custom job units sold by the associate for the period. 
Cost The total cost of custom items sold by the associate for the period. 
Price The total selling price of the custom items sold by the associate for the period. 
GP % The percentage of gross profit for the period for that associate and sale type 

based on sales price and cost. 
Totals  

Qty Sold The total number of units sold by the associate for the period. 
Cost The total cost of goods and services sold by the associate for the period. 
Price The total selling price of items, repairs, and custom jobs sold by the associate 

for the period. 
GP % The percentage of gross profit for the period for that associate and sale type 

based on sales price and cost. 
Appraisals  

Qty Sold The total number of appraisals sold by the associate for the period. 
Cost The total cost of appraisals sold by the associate for the period. 
Price The total selling price of the appraisals sold by the associate for the period. 

Miscellaneous  
Qty Sold The total number of miscellaneous sales by the associate for the period. 
Cost The total cost of miscellaneous sales by the associate for the period. 
Price The total selling price of miscellaneous sales by the associate for the period. 

Total Sales Total sales for each sale type. 
Returns The above fields are repeated for returns. 
Total Returns Total returns for each sale type. 
Net Total The net of sales and returns for each sale type. 
Percent Total Sales The percentage total sales (based on sales price) that each area constituted. 

7.6.2.5 Tasks Report 
The Tasks Report shows associate tasks and provides the due date, current status, and task information. 
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Data fields on the Tasks Report include: 
 

Due Date The date the task is due. 

Status The current status of the task. 

Subject The subject of the task. 

Category The category of the task. 

Priority The priority of the task. 

Assigned 
Associate The associate assigned to the task. 

 

7.6.3 Salesperson Reports 

7.6.3.1 Salesperson Performance Report 
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Intended to provide data for associate evaluation and coaching, the Salesperson Performance report 
provides sales performance broken down in a number of ways, by associate.  The report contains 
inventory only and may include or exclude layaways.  Special orders in progress are not counted.  They 
are included when they are picked up. 
 

 
 
Data fields in the Salesperson Performance report include: 
 
Name The associate’s name. 
Sales Performance Sales performance as broken down below: 

Gross Sales Gross sales are broken down by dollars and percentage of total sales by 
dollars (i.e., $ = 34,500; % = 12).  This would mean that the sales person sold 
$34,500 at retail that was 12 percent of all sales by dollar amount. 

Sales Quantity Sales quantity is broken down by number of sales and percentage of sales by 
quantity (i.e., # = 27; % = 8).   

Average Retail Average retail sale (ARS) and +/- which is the difference from the average 
retail sale amount each salesperson achieved (i.e., $34,500 in sales divided by 
27 (the # of sales) = ARS of $1,278).  If the average sale for everyone in the 
store was $555, this sales person would have a +723 in the +/- column 
indicating their average sale was that much greater than the stores. 

Gross Profit 
Performance 

Gross Profit Performance has three columns of information, one identified 
as dollars ($), another by % of Gross Profit and another as % of Markup.  
Gross profit is the amount that the store made on the sale above the cost of 
the item. GP% is the percentage of the total sale that was profit (an important 
retail metric) and % Markup is the multiplier a retailer would have to use to 
achieve the profit level on the report.  Example:  Item costs $48 and sells for 
$100, the GP would be 52%.  To achieve a 52% gross profit margin, items 
would have to be marked up 109% (48 + (48 x 1.09) = 100). 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 553 
© 2020 Abbott Jewelry Systems, Inc. 

Returns The Returns section has three columns also:  $ Sales, # Sales, and $ GP.  $ 
Sales is just that the dollar amount of return sales, # Sales is also just that the 
number of returns and $ GP is the amount of profit that was lost to returns. 

Selling Skills 
Performance 

Selling Skills Performance is intended to measure the effectiveness of the 
salesperson.  The columns are $ Disc, # Disc, $ Avg, % Avg, and Ratio. $ 
Disc is total discounted dollars, # Disc is the number of sales a discount was 
applied to, $ Avg is the average dollar discount per discounted sale, and % 
Avg is the average percentage of discount per discounted sale.  Ratio is the 
number of sales with a discounted price represented as a ratio (i.e., 1 in 5; 1 
in 9; 1 in 17, etc.). 
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7.6.3.2 Salesperson Category Performance Report 
The Salesperson Category Performance report shows data similar to that shown in the Salesperson 
Performance report, but by category.  It summarizes sales results and divides the same sales into major 
categories (i.e., Cat 100, Cat 200, etc.), to determine where sales persons’ skills are.  This report will 
reveal in what category sales people are making sales and perhaps illustrate difficulty with watches or 
high-priced diamond merchandise.  Layaways may or may not be included as with the report and special 
orders in progress are not included.      
 

 
 
Data fields in the Salesperson Category Performance report include: 
 
Salesperson The associate’s name. 
Category The category for which the breakdown is shown. 
Sales  Sales performance as broken down below: 

Total The total sales by the associate in that category. 
Percentage Percentage of that the associate’s sales that fall in that category. 
Number The number of sales made in that category.   
Average Retail Average retail sale (ARS) and +/- which is the difference from the average 

retail sale amount each salesperson achieve. 
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7.6.4 Exceptions Reports 
Exceptions reports are designed to help research inventory and associate activities such as voided sales, 
deleted inventory, inventory with cost changes, and customer-returned items. 

7.6.4.1 Voided Sales 
The Voided Sales report provides a list of voided transactions along with information such as the 
original sale date, who performed the void, and where.   
 

 
 
Data fields in the Voided Sales report include: 
 
Sale # The transaction number of the original sale that was voided. 
Customer The customer involved in the transaction that was voided. 
Sale Date The date of the original transaction that was voided. 
Void Date The date the transaction was voided. 
Associate The associate who made the void. 
Station Voided The station at which the void was made. 
Voided Store The store at which the void was made. 
 
  



The Edge User Guide v. 20.0.0.114 

556 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

7.6.4.2 Deleted Items 
The Deleted Items report provides a list of items that were deleted from the system.  If the bulk master 
was deleted by an earlier version of The Edge, bulk item costs may not be reflected. 
 

 
 
Data fields in the Deleted Items report include: 
 
Item # The item number of the item that was deleted. 
Description The description of the item from the item record. 
Associate The associate who deleted the item. 
Date The date the item was deleted. 
Location The location where the item was housed. 
Cost The cost of the item. 
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7.6.4.3 Cost History 
The Cost History report shows a history of changes to the cost of an item.  Older versions of The Edge 
might not have recorded cost history for bulk items.  Be aware that if a single item was changed more 
than once, it may be represented on this report more than one time.  Therefore, the value of the grand 
total may be inflated. 
 

 
 
Data fields in the Cost History report include: 
 
Item # The item number of the item. 
Description The description of the item from the item record. 
Store The store where the item is currently located. 
Station The station at which the cost was changed. 
Date Changed The date the cost was changed. 
Who Changed The associate who changed the cost. 
Old Cost The cost of the item prior to this change. 
New Cost The cost of the item after this change. 
Cost Difference The amount of this change in cost. 
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7.6.4.4 Customer-Returned Items 
The Returned Items report provides a listing of items returned by customers and put back in stock.  It 
contains detailed information about the item. 
 

 
 
Data fields in the Returned Items report include: 
 
Item # The item number of the item. 
Description The description of the item from the item record. 
Sale # The transaction number for the initial sale. 
Return # The transaction number for the return. 
Selling Associate The associate who initially sold the item. 
Returning Associate The associate who took the return. 
Date Sold The date of the initial sale. 
Date Returned The date of the return. 
Pricing The pricing method, i.e., bulk, etc. If it is blank, it is fine-item pricing. 
Sold Price Price of the item when sold. 
Cost Cost of the time when sold. 
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7.6.5 Giveaway (Management) Report 
The Giveaway report found on the Management Reports menu provides a breakdown of promotional 
giveaways by age and sale. 
 

 
 
Data fields in the Giveaway (Management) report include: 
 
Sale # The transaction ID for the sale that contained the giveaway. 
Customer The customer to whom the item was given away. 
Why In The initial reason for the customer’s visit to the store. 
Age The number of days the item was in stock. 
Retail The retail price of the item. 
Sold For What the price was at point of sale (after the giveaway). 
Item ID The item number. 
Item Description The description of the item. 
% of Sale The amount of the sale that it would have represented if sold at retail. 
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7.6.6 Security Log 
The Security Log report details certain associate activities. 
 

 

On this report, the criteria section and page will list all the permissions to be 
checked, which could be very lengthy.  To avoid this, use Pick All from the 
Permissions drop-down menu in the options window; in that case, criteria will 
simply read “Pick All.”  If you manually unselect any permissions after that, the 
lengthy, specific list will be returned. 

 

 
 
Data fields in the Security Log report include: 
 
Fail Status Indicates that a login attempt failed.  The details are shown in the Permission 

field. 
When  Date of the event. 
Who The associate involved in the event. 
Permission Activity that triggered the event. 
Store The store in which the event took place. 
Station The station at which the event took place. 
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7.6.7 Care Plan Report 
The Care Plan report lists care plans sold, the items associated with them, and their status. 
 

 
 
Fields and option in the Care Plan report include: 
 
Customer Name The customer name. 

Sale ID The transaction ID for the sale. 

Date Sold The date the item and care plan were sold. 

Who Sold The associate who conducted the transaction. 

Care Plan Name The name of the plan that was sold. 

Term The length of the plan. 

Status The status of the plan, i.e., whether the plan is still in effect. 

Retail The price paid for the plan. 

Cost The cost to the merchant for the plan. 
 
Care plan data will appear in Daily Activity reports as well, under Misc and marked with a W.   
 

 

Be sure to match this data with your billing statement from your care plan provider. 
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7.6.8 Sales Comparison Report 
The Sales Comparison report provides sales data by day, week, month, and year for a given date 
compared with the same time periods for the year before.   
 

 
 
To see this week’s sales compared with the same week last year, just enter today’s date in the Compare 
Date field.  To see an earlier year’s data, enter the date of the year after it in the Compare Date field.  
For example, if today is 1/1/2017 and you want to see data from 2015, enter 1/1/2016.  Optionally, use 
Compare To Date to select a different date with which to compare the Compare Date.  Note that 
improvements are shown in green and deficiencies are shown in red. 
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Data fields in the Sales Comparison report include: 
 
This Day [entered year] Total sales amount, percentage of sales difference from the beginning 

date to end date, number of sales, average sale amount, and cost of 
goods sold for the date you entered.  It also shows the total gross 
profit on this day and the percentage of gross profit. 

This Day [previous year] The same as above but for the previous year. 

Day +/- The difference in the values above for the period in the entered year 
compared with the period from the previous year. 

Week to Date  [entered 
year] 

Total sales amount, percentage of sales difference from the beginning 
date to end date, number of sales, average sale amount, and cost of 
goods sold for the week of the date entered.  It also shows the total 
gross profit for this week and the percentage of gross profit. 

Week to Date [previous 
year] 

The same as above but for the previous year. 

Week +/- The difference in the values above for the period in the entered year 
compared with the period from the previous year. 

Month to Date  [entered 
year] 

Total sales amount, percentage of sales difference from the beginning 
date to end date, number of sales, average sale amount, and cost of 
goods sold for the month of the date entered.  It also shows the total 
gross profit for this month and the percentage of gross profit. 

Month to Date [previous 
year] 

The same as above but for the previous year. 

Month +/- The difference in the values above for the period in the entered year 
compared with the period from the previous year. 

Year to Date  [entered 
year] 

Total sales amount, percentage of sales difference from the beginning 
date to end date, number of sales, average sale amount, and cost of 
goods sold for the year of the date entered.  It also shows the total 
gross profit for this year and the percentage of gross profit. 

Year to Date [previous 
year] 

The same as above but for the previous year. 

Year +/- The difference in the values above for the period in the entered year 
compared with the period from the previous year. 

 
For all of the quantity values, you can click on the value and the detail that made up that number will 
appear.   
  



The Edge User Guide v. 20.0.0.114 

564 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 Job Reports 
To help track repair activities, The Edge offers a variety of repair and custom job reports.  The query 
windows for these reports are similar to that of finding a repair.  See the section entitled Finding and 
Editing a Job Record for more information.  For more about report filters and settings, see the section 
entitled Creating a Report.   

7.7.1 Amount Due Report 
The Amount Due report lists repairs with an emphasis on amount due for completed repairs.  This is 
very useful for making reminder calls. 
 

 
 
Data fields in the Amount Due report include: 
 
Customer  Customer name, ID, and phone number. 
Envelope Number The number on the envelope containing the repair item. 
Item The item number and description. 
Jeweler If a jeweler is being used, his or her name and ID. 
Due By When the customer is expecting the item returned. 
Done When the repair was completed. 
Cost The cost of the repair to the store. 
Price The price of the repair to the customer. 
Amount Due The amount due on the repair. 
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7.7.2 Due Date Detailed Report 
The Due Date Detailed report lists repairs with an emphasis on due dates for incomplete repairs.  This is 
useful for following up with jewelers or outside vendors. 
 

 
 
Data fields in the Due Date report include: 
 
Customer Name Customer’s name. 
Customer Phone Customer’s phone number. 
Item Description A description of the item being repaired. 
Tasks A list of repairs to be made. 
Notes Any notes that might be useful in making the repair. 
Declared Value The estimated value of the item. 
Amount Due The amount due from the customer on the price of the repair. 
Due By When the repair is expected by the customer. 
Current Estimate When the repair is expected to be complete. 
Jeweler If applicable, the name and ID of the assigned jeweler. 
Station The station number of the in-house jeweler. 
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7.7.3 Waiting for Parts Report 
The Waiting Parts report lists repairs that are awaiting parts to be completed. 
 

 
 
Data fields in the Waiting Parts report include: 
 
Sale # The transaction number of the repair. 
Entered Date the repair was entered. 
Ordered Date the part was ordered. 
Received Date the part was received. 
Cust The customer’s name. 
Desc A description of the part. 
Qty The number of parts ordered. 
Cost  The cost of the part. 
Price The price of the part to the customer. 
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7.7.4 Repair/Custom Liability Report 
The Repair/Custom Liability report lists all customer goods in the store for repair and their declared 
values. 
 

 
 
Data fields in the Liability report include: 
 
Customer Name The customer’s name. 
Customer Phone The customer’s phone number. 
Due By The date by which the customer is expecting the item. 
Repair # The unique identifier for the repair record. 
Curr Est The estimated completion date. 
Jeweler If outsourced, the name of the jeweler making the repair. 
Amount Due The amount due from the customer. 
Declared Value The estimated value of the item. 
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7.7.5 Breakdown Report 
The Repair Breakdown report details the cost of parts and labor for repairs.  A useful feature of this 
report is the variety of grouping options available. 
 

 
 
Data fields in the Repair Breakdown report include: 
 
Task # The task within a repair to be detailed. 
Description A description of the task. 
Cost Parts The cost of parts to the store. 
Cost Labor The cost of labor to the store. 
Cost Other Other costs of the repair to the store. 
Cost Total The total cost of the repair. 
Price Parts The price charged to the customer for the parts. 
Price Labor The price charged to the customer for labor. 
Price Other The price charged to the customer for other costs to the store. 
Price Total The total price of the task to the customer. 
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7.7.6 Adjustments Report 
The Adjustments report generates a listing of adjustments to repairs and custom jobs.   
 

 
 
Data fields in the Adjustments report include: 
 
Type The type of the task or item being adjusted. 
Task # The ID of the task being adjusted 
Description A description of the adjustment 
Cost The cost of the repair to include parts, labor, and other, and the total cost. 
Adjustments The amount adjusted in any of parts, labor, or other, and the total adjustment. 
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7.7.7 Care Plan Repair SKU Report 
The Care Plan Repair SKU report lists repair SKUs used for care plan-covered repairs during the 
specified time period. 
 

 
 
Data fields in the Care Plan Task SKU report include: 
 
Repair # The transaction number for the repair. 
Customer The customer name and ID. 
Item # For repairs on items sold by the store, the item number. 
SKU The repair task SKU for the repair. 
Desc A description of the repair. 
Status The status of the repair. 
TotalCost The cost to the store for the repair. 
Rate The amount the care plan company has agreed to pay for the repair. 
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8 Associate Functions 

 Appointments 
To help you assign, track, and record calls and appointments with customers, The Edge offers an 
appointment module.  The primary purpose of this module is to allow you and your staff to create tasks 
that involve making contact with a customer to discuss potential sales, service jobs, and other business-
generating conversations.  This is not to be confused with clienteling and other broad marketing modules 
found in The Edge; it is designed to manage specific interaction with the customer for a specific 
objective. 
 
There are three primary functions within the appointment module: 

 
• Add Appointment 
• Find and Edit an Appointment 
• Bring Up the Next Appointment. 
 

8.1.1 Adding an Appointment 
To create a new appointment:  

1. Select Associate ► Appointments ► Add.  The Add Appointment window will appear. 
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Fields and options in the Add Appointment window include: 
Associate Offers the Associate drop-down menu; use it to assign the task or 

appointment to an associate. 
Customer Offers the customer find filter to indicate the customer.  This is required to 

proceed with further contact information.   
Contact Method Offers the method of contact options for the selected customer: 

• Phone 
• Email 
• In Person. 
 
For each contact type, there may be more than one contact method.  Select 
the correct phone number email address, or store location. 

Appointment 
Type 

Allows you to categorize appointments by type: 
• Registry 
• Service 
• Wish List 
• Sales Opportunity. 
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Details Allows you to record details about the task.  It should be a succinct 
description of the task as it will appear in the list view. 

Priority Indicates the priority of the contact on a scale of High, Medium, or Low. 

Dates You have the option to enter a specific, single time to fulfill the 
appointment, enter a date range, or enter a time range on a particular date.  
The options for entering those details change according which radio 
button you select: 
• Single Time:  Select a date from the date picker and select a time in 

30-minute intervals from the drop-down menu.  
• Date Range:  Begin Date and End Date fields will be offered; select 

accordingly.  No time frame is recorded, but The Edge will store the 
time as 12:00 a.m. 

• Time Range: Begin and end dates will be offered, but you can also 
pick times. 

Initial Notes Notes concerning the purpose of the contact, information about items or 
transactions to be discussed, etc.  There is space to be detailed here; you 
can include item numbers, descriptions, etc.  This information will not 
appear in the History area of the appointment record. 

2. Select an associate. 
3. Select a customer. 
4. Select the Contact Method drop-down menu.  The Customer Contact window will appear. 

 
  

5. Select the type of contact with the desired value from the available options. 
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6. Select OK.  You will be returned to the Add Appointment window.  The Contact Method and 
Contact Address will be populated. 

7. Complete the remaining fields and select OK/Save & Close.  The appointment will be saved and 
the window will close. 

8. When you are ready to act on the appointment, find it as described in the section entitled Finding 
and Editing an Appointment. 

8.1.2 Appointment Notifications 
Depending on System Options and associate contact information, the associate to whom the 
appointment is assigned will receive an email or text message informing him or her of the assignment.  
For example, if you're a manager, you can set appointments for associates.  Then, when the appointment 
is set, an email or text message will be sent to the associate.  In addition, a daily email can be sent to 
associates listing the day’s appointments. 
 
Text Message Sample 
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Email Sample 
 

 
 
For these notifications to work, you must have text messaging and email set up in The Edge.  For 
instructions, see the section entitled Notifications.    

8.1.3 Finding and Editing an Appointment 
To work with or fulfill and appointment:  

1. Select Associate ► Appointments ► Find.  The Find Appointments window will appear. 
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Filter options in the Find Appointments window include: 
 
Begin Date Returns appointments with the selected begin date. 
End Date Returns appointments with the selected end date. 
Result Type Returns appointments based on result type:  

 
• All 
• Contact Unsuccessful, Try Again Later 
• Made Contact, Need Follow-Up 
• Made Sale, Set New Opportunity 
• Did Not Make Sale, Set New Opportunity 
• Discontinue 
• Data Changed 
• Initial Note. 

Associate Returns appointments assigned to the selected associate.  If none are selected, 
it will default to the currently logged-in associate. 

Priority Returns appointment with the selected priority: High, Medium, or Low. 

Appointment 
Type 

Returns appointments based on type: 
• Registry 
• Service 
• Wish List 
Sales Opportunity. 

Status Returns appointments with the selected status:   
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• All Appointments 
• Completed Appointments Only 
• Not Completed Appointments Only. 

Customer Returns appointments with the selected customer. 

2. Enter values in the filter to narrow results and select OK.  The Appointment List window will 
appear.   

 

3. Select the appointment with which you wish to work and double-click or select Edit.  The Edit 
Appointment window will open.  In addition, the Customer Edit window will open for easy 
reference and to allow you to take notes. 
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The left side of the Edit Appointment window contains the data provided when the appointment 
was created.  The right side of the Edit Appointment window contains fields for recording activity:   
 
Type The type of result:  

• Contact Unsuccessful, Try Again Later.  You should make 
notes in the appointment and change the dates as needed. 

• Made Contact, Need Follow-Up.  You should make notes in the 
appointment.  A prompt for the follow up call within the appointment will 
appear. 

• Made Sale, Set New Opportunity.  The Edge will close the current 
appointment and prompt you to create a new appointment for the future. 

• Did Not Make Sale, Set New Opportunity.  The Edge will close 
the current appointment and prompt you to create a new appointment for the 
future.  

• Discontinue.  The customer doesn't want to be contacted on this opportunity 
anymore; the chain will come to a close. 
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Results Notes about the success of the appointment and what kind of follow up may be 
needed as described above. 

4. Complete these fields and select a Save option.  The newly recorded action will appear in the 
History area on the bottom of the window.  

8.1.4 Working with Appointment Results 
Example 1:  Initial Appointment 
 
Here is an initial appointment record in which we want to call a customer and tell her about an item she 
might want. 
 

 
 
Example 2:  Completed Appointment with New Opportunity 
 
When the appointment is complete, you can record the results and the appointment will be closed.  If the 
appointment is closed, either successfully or unsuccessfully, you will want to keep the conversation 
going, so The Edge will prompt you to make a new appointment in a new chain, closing the previous 
chain.  
 

 

 
The Appointment list view will show the new appointment and the results of the first. 
 
Example 3:  Appointment Requires a Follow-Up Call 
 
Suppose you try to fulfill the appointment, but the person is unavailable or unable to talk at that time.  
You will want to record your actions and set a follow up time.  In the case of a follow-up, the history 
window will show the next action in the same chain.   
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Here is the initial appointment. 
 

 
 
Here it is with the follow-up. 
 

  
 
Color coding for these actions is as follows: 
 

Green New opportunity opened by an Edge user 
Gold Closed opportunity with new opportunity opened by The Edge 
Cream System-generated messages pertaining to the opportunity 
Light Blue Recorded actions and next steps. 

8.1.5 Working the Next Appointment 
When it is time to work the appointment list, use the Next 50 Open option to return a list of upcoming 
appointments in order.  The number of next appointments to list can be changed in System Options.  To 
obtain the Next 50 Open list:  

1. Select Associate ► Appointments ► Next 50 Open.  The Next 50 Appointments window will 
appear with the current user's appointment list of up to as many appointments as are set in System 
Options. 

2. Select the record for the appointment with which you want to work and select Edit. 
3. Work the appointment and record the results as described in the section entitled Working with 

Appointment Results.   
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 Associate Tasks 
The Associate Tasks feature allows you to create tasks for your staff to complete.  Tasks can be created 
for specific associates or left open for any associate to complete.   
 
When creating a task, you can choose to have the associate automatically notified via text or email.  You 
can also assign a priority as well as categorize it.   
 
Tasks can be added from the main menu or from other record types.  Tasks created from other record 
types will retain a link to all related records (e.g. item, repair, customer, etc.). 
 
Utilize the Mass Task Wizard to easily create tasks based on specific criteria, such as recent customer 
purchases, service work, and more.  And define Task Automation Rules to automatically generate tasks 
when trigger conditions are met. 
 
Tasks are integrated with both the Store Calendar and Dashboards.  

8.2.1 Permissions 
By default, an associate can create a task for themselves with no special permissions. 
 
There are four associate permissions related to tasks.   
 

Add a task for someone else Allows you to create tasks for other associates as well as unassigned 
tasks that can be completed by anyone. 

Add tasks with mass task 
wizard 

Allows you to use the mass task wizard to add and manage batches 
of tasks. 

Delete / Cancel a task with 
the mass task wizard 

Allows you to delete tasks using the mass task wizard.  Only tasks 
originally created with the wizard can be deleted. 

Edit a task not assigned to 
you Allows you to edit tasks assigned to other associates. 

8.2.2 Task Categories 
Categories can be setup to organize tasks.  To create them: 

1. Click Administrative > Tasks > Categories.  The Edit Task Categories window will appear.  
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2. Click the Add button.  New Category will appear in the list. 

 

3. In the list, click on New Category, then enter a Name and choose a Color. 

 

4. Make desired category changes, then click Save/Close to save them. 

8.2.3 Adding Tasks 
There are five ways to create tasks: 
 
Add Task 
Opens task form allowing you to enter task details. 
 
Task Wizard 
Starts wizard that walks you through process of adding a single task. 
 
Mass Task Wizard 
Starts wizard that allows you to create and manage many tasks at once. 
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From Other Records 
Tasks can be added from customers, items, and service jobs (repairs, custom jobs, special orders, and 
appraisals).  They will retain a link to all related records. 
 
Task Automation Rules 
Define rules that will automatically generate tasks when trigger conditions are met. 
 

8.2.3.1 Add Task 
This form allows you to add a single task.  To use it: 

1. Click Associate > Tasks > Add.  The New Task window will appear. 

 
2. On the top left, choose the associate.  Tasks created for 0 – Any Associate can be completed by 

anyone. 

3. Optionally, use the Notify setting to choose whether a notification should be automatically sent 
to the associate via email, text, or both. 

4. Optionally, use the Category drop-down to select what type of task this is. 

5. Optionally, choose the Priority level for this task.  The default is Medium. 

6. Optionally, choose a Start Date. 

7. Enter a Subject and Due Date.  These are the only two required fields. 

8. Click Save/Close to save your task. 

 

To create a single task that can be completed by multiple associates you must use the Task 
Wizard and check the Selected Associate(s) Can Complete option when choosing 
associates. 
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8.2.3.2 Task Wizard 
The Task Wizard steps you through the process of adding a single task.  To use it: 

1. Click Associate > Tasks > Task Wizard.  The Task Creation Wizard will appear. 
 

 
2. Follow the onscreen prompts and use the Next button to advance through the wizard. 
3. When completed, click the Finish button. 

8.2.3.3 Mass Task Wizard 
The Mass Task Wizard allows you to create many tasks at once.  It can be used to create recurring tasks 
and has the capability to link tasks to customers, items, and service jobs.  Tasks previously created with 
this wizard can also be updated or deleted en masse.   
 
To use the wizard to create new tasks: 

1. Click Associate > Tasks > Mass Task Wizard.  The Mass Tasks Wizard will appear.  
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2. Select New Tasks and click Next. 

  
 

3. There are seven types of tasks that can be created: 

Date Related 
Tasks 

Create tasks that repeat on a set schedule, i.e. Daily, Weekly, or 
Monthly.  Weekly tasks allow you to select specific days.  Monthly 
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tasks allow you to repeat on a specific date (e.g. the 10th), the first day, 
or the last day of the month. 

Associate Tasks Create tasks for multiple associates at once. 

Customer Tasks 
Displays the Customer Filter allowing you to enter criteria to select 
customers.  Results are displayed when you click Next and you can 
choose one or more customers to create and link tasks to. 

Item Tasks 
Displays the Item Filter allowing you to enter criteria to select items.  
Results are displayed when you click Next and you can choose one or 
more items to create and link tasks to. 

Repair / 
Custom Job 

Tasks 

Displays the Job Filter allowing you to enter criteria to select repair or 
custom jobs.  Results are displayed when you click Next and you can 
choose one or more jobs to create and link tasks to. 

Special Order 
Tasks 

Displays the Special Order Filter allowing you to enter criteria to 
select special orders.  Results are displayed when you click Next and 
you can choose one or more special orders to create and link tasks to. 

Appraisal Tasks 
Displays the Appraisal Filter allowing you to enter criteria to select 
appraisals.  Results are displayed when you click Next and you can 
choose one or more appraisals to create and link tasks to. 

4. Select the desired type of task, fill out any required fields (e.g. dates or filters), and click Next. 

a. Date tasks will bring you directly to Task Details. 

b. For tasks that utilize a filter, the matching records will be displayed.  You must select 
one or more records before proceeding to Task Details. 

5. Task Details required fields vary by type and are noted on screen with an asterisk.   

6. Enter details, then click Next and Finish to create the tasks. 

 
To use this wizard to update previously created tasks: 

1. Click Associate > Tasks > Mass Task Wizard.   
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2. Select Edit Existing Tasks and use the drop-down to select the group of tasks you wish to 
update, then click Next. 

  
3. Task Details will be displayed.  Make any desired changes, then click Next and Finish to 

update existing incomplete tasks.  Note that completed tasks will not be changed. 

 
To use this wizard to delete tasks: 

1. Click Associate > Tasks > Mass Task Wizard. 
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2. Select Edit Existing Tasks, use the drop-down to select the group of tasks you wish to delete, 
and check Delete Incomplete Tasks.  

 
3. Click Next and Finish to delete the tasks.  Note that any task marked Complete will not be 

deleted. 

8.2.3.4 From Other Records 
Tasks can be added from customer, item, and service job (repairs, custom jobs, special orders, and 
appraisals) records.  They will retain a link to all related records including any applicable sales receipts.   
 
These links will be displayed in the task list view. 

 
 
On the task record, the links will appear as icons in the top right.  Clicking on the icon will bring up the 
corresponding record. 
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Each record type now has an Add Task button at the bottom. 
 

 
Repair 

 

 
Custom Job 
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Special Order 

 

 
Appraisal 

 

 
Customer 

 

 
Item 

 

8.2.3.5 Task Automation Rules 
Task Automation Rules give you the ability to create rules that will automatically generate tasks when 
trigger conditions are met.  This allows you to create task workflows.  
 
See section 13.13 Task Automation Rules 

8.2.4 Working with Tasks 

8.2.4.1 Find / Edit 
Find Tasks allows you to look up, edit, and complete tasks.  To use it: 
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1. Click Associate > Tasks > Find.  The Find Tasks window will appear. 
 

 
2. You can filter by the following criteria:  

Due Date Date the task is set to be due. 

Associate Associate the task is assigned to.  You can select multiple. 

Priority The priority level of the task. 

Status The current status of the task. 

Category The category or type of task. 

Store The store the task was created in. 
3. Enter desired criteria and click Find.  A list of matching tasks will appear. 

 



The Edge User Guide v. 20.0.0.114 

592 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

4. To edit a task, double click it or select it in the list and click the Edit button. 

 
5. To complete a task, click the Complete icon in the top left or set the Status drop-down to 

Complete. 

6. Make any desired changes, then click the Save / Close button. 

8.2.4.2 My Open Tasks 
My Open Tasks displays all open tasks currently assigned to you.  It can be used to look up, complete, 
and edit tasks.  To use it: 

1. Click Associate > Tasks > My Open Tasks. 

2. The login window will appear.  Enter your associate credentials. 

3. A list of open tasks for this associate will appear.  Note that only tasks assigned specifically to 
the associate appear here.  Tasks assigned to Anyone will not appear. 

4. To edit a task, double click it or select it in the list and click the Edit button. 

5. To complete a task, click the Complete icon in the top left or set the Status drop-down to 
Complete. 

6. Make any desired changes, then click the Save / Close button. 

8.2.4.3 Calendar 
The Store Calendar has a tile for Store Tasks.  This tile allows you to view and work with tasks. 
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8.2.4.4 Dashboards 
The Dashboards feature includes list view tiles that can display task information.  There are currently 
four available.   

Open Tasks All open tasks for selected associate(s) that are open. 

Store and Associate 
Open Tasks 

All open tasks for selected associate(s) as well as tasks assigned to ‘Anyone’ 
that are open. 

Open Tasks by Date All open tasks for selected associate(s) that are open filtered by dashboard 
date range. 

Store and Associate 
Open Tasks by Date 

All open tasks for selected associate(s) as well as tasks assigned to ‘Anyone’ 
that are open filtered by dashboard date range. 
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 Time Card 
The Time Card function is where associates punch in and out.  It also offers supervisors an option to 
view time card data. 

8.3.1 Time Card Find 
To view time card data: 
 
1. Select Time Card from the Associate menu. 
2. Select Find.  You will be prompted to enter your ID and password. 
3. Enter your ID and password.  
4. The Time Clock Criteria window will appear. 

 

 
 

5. Enter the desired criteria and select OK.  The results will appear in the Time Card Events list view. 
 

 
 

6. To edit an entry, select it and select Edit.  The time card record will appear. 
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7. Go to the Supervisor Menu and select Enable Time Changing. 
8. Enter the new time and select a save option. 

 

 

The Attendance report generates time card data. 

8.3.2 Time Clock Supervisor Override 
A supervisor can add an additional punch on behalf of an associate.  This can only be done from the 
Time Card list view. 
 
1. Select Time Clock from the Associate menu. 
2. Do a time card find. The results will appear in the Time Card Events list view. 
3. From the Time Card Events list view, select Supervisor ►Add Time Card Punch.  The New 

Time Card Record window will appear. 
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4. Select the associate for whom the entry is being made. 
5. Enter a store number. 
6. Enter a Date/Time In and a Date/Time Out. 

a. Use the drop-down arrow to pick a date from the calendar.   

 
 At the bottom of the calendar are fields to enter hour:minute and select A.M. or P.M. 

 
 

b. Type in the date and time. 
7. Select a save option. 

8.3.3 Punch In 
To punch in: 
 
1. Select Time Clock from the Associate menu. 
2. Select Punch In.  You will be prompted to enter your ID and password. 
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3. Enter your ID and password.  You are punched in and a confirmation will appear. 
 

 

8.3.4 Punch Out 
To punch out: 
 
1. Select Time Clock from the Associate menu. 
2. Select Punch Out.  You will be prompted to enter your ID and password. 
3. Enter your ID and password.  You are punched out and a confirmation will appear. 
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9 News  
The Edge News feed is a communication channel to keep you up-to-date about items of interest 
concerning The Edge.  This is the start page for The Edge and contains information about updates, 
releases, patches, webinar schedules, and training opportunities.  Headlines run down the left side and 
content occupies the main work area.  We recommend you review the Newsfeed daily. 
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10 Dashboards 
Dashboards allow you to put pertinent data at your fingertips in an intuitive, graphical display.  Each 
Dashboard consists of one or more tiles and each tile can be setup to display different data.  The data 
displayed can be based on specific associates or all associates.   
There are four types of Dashboard tiles: 

Numeric Displays a single number; recommended for use on 1 by 1 tiles. 

Gauge Displays a gauge where you can set a goal; recommended for use on 1 by 1 and 1 by 2 
tiles. 

Chart Displays a pie, bar, or doughnut chart; recommended for use on 2 by 2 tiles. 

List View Displays a list of actionable records; recommended for use on 2 by 2 tiles. 

 Creating Dashboards 
To create a new Dashboard: 

1. Click Dashboards > Add.  
 



The Edge User Guide v. 20.0.0.114 

600 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 
 

Button Text Label for the button; each Dashboard will show as its own button in 
the menu 

Dashboard Title Title that displays at top of Dashboard 

Button Color Color for this Dashboard’s button 

Dashboard 
Associate Associate that this Dashboard’s data is based on 

Associates that 
can View Associates that have permission to view this Dashboard 

Copy Dashboard 
From Copy initial Dashboard setup from an existing one 

2. All fields, with the exception of Copy Dashboard From, are required.  Fill them in and click 
OK.  The Dashboard Management window will appear. 

3. This window controls the positioning of the buttons in the hierarchy.  See the Dashboard 
Management section of this document for more information.  For now, click Save/Close in the 
lower right. 
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4. Your Dashboard button will appear on the left. 

 
5. Click on the button you just created.  The blank dashboard will load.  
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6. Click 2 by 2 to create your first tile, then click the Gear icon on the tile to enter setup.  

 
7. There are four types of Dashboards:  

Numeric Displays a number; recommended for use on 1 by 1 tiles  

Gauge Creates a gauge with goals; useful for tracking progress 

Chart Displays a pie, bar, or doughnut chart; best used with 2 by 2 tiles 

List View Displays a list of actionable records such as tasks, customers, appointments, 
etc. 

8. For this example, click on Chart. 
9. Use the drop-downs to select: 

a. Data Set:  Sales Data 
b. Data Value to Display: # Sales by Associate 
c. Chart Type: Pie Chart 
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10. The Tile Title will automatically fill in to match selected data, but you can change it if you like.  

 
11. Click Save to add this tile. 

 
12. Repeat to add as many additional tiles as you like. 
13. If you make a mistake or want to delete a tile, use the Remove Tile button. 
14. When done, click the Gear icon in the top right to toggle out of configuration mode. 

 Working with Dashboards 
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10.2.1 Organizing 
When creating new Dashboards, each will show up as a button on the left.  You can use Dashboard 
Management to change the order, and grouping, of these buttons.  To do so: 

1. Click Dashboards > Manage.  The Dashboard Management window will appear. 

 
2. This window will reflect the current button layout.  Each time you create a new Dashboard, it 

will show up at the bottom of the list. 
3. To change the button order, select the button and use Move Up / Move Down. 
4. To group buttons, first click New Group and enter text to display.  Then use Move Up / Down 

to position it.  Finally, to place buttons in the group, move them under it and use Move Right. 
5. When finished click Save/Close to save the menu structure. 

10.2.2 Viewing 
To view a Dashboard, click its corresponding button in The Edge menu. 
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10.2.3 Editing 
To change the button text, button color, dashboard title, or associates for an existing Dashboard: 

1. Click Dashboards > Manage.  The Dashboard Management window will appear. 

2. Select your Dashboard, then click the Properties button. 

3. Make desired changes, then click OK. 

4. Click Save/Close to save your changes. 

To change a Dashboard tile: 

1. Click on the Dashboard to open it. 

2. Click the Gear icon in the top right to enter setup mode. 

3. Click on the tile you wish to edit, then click on its gear icon. 

4. Make desired changes, then click Save. 

 

When changing the data displayed on an existing tile be sure to update the tile’s Title. 

10.2.4 Deleting 
To delete an existing Dashboard: 

1. Click Dashboards > Manage.  The Dashboard Management window will appear. 
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2. Select your Dashboard, then click the Delete button. 

3. Click Save/Close to save your changes. 

 

 Frequently Asked Questions 
Q:  What date range is the data based on?  Do I get to choose specific dates? 
 
A:  Dashboards give you the option to display data from Today, Yesterday, This Week, Last Week, 

This Month, or Last Month.  There is a drop-down date selector at the top right.  Note that this does 
not appear when you have configuration mode (Gear icon) toggled on. 
 

 
 
Q:  What is the sales data based on?  Do sales figures include services? 
A:  Services are not counted in any dollar figures (e.g. $ Sales, $ Profit) until they are finished and 

picked up.  The only exception to this is Total $ Tender which will always show all money taken in 
regardless of transaction type. 

 
Service transactions do count towards number of sales each step of the way, so doing a repair intake, 
then a payment, then a pick up would result in 3 sales, but would not be reflect on $ Sales until pick 
up. 
 
Data values containing the word ‘Sales’ include all transaction types.  Data values containing the 
words ‘Sold Item’ specifically look at items and do not count services, miscellaneous charges, or 
other transaction types. 
 
 

Q:  How often does the Dashboard refresh? 
A:  The Dashboard automatically refreshes every 5 minutes.  You can manually refresh at any time using 

the Refresh icon on the top left.  Note this icon is not visible if your dashboard is still in configuration 
mode. 

 
 
Q:  Can I move Dashboard tiles once they are created? 
A:  Not at this time; you can though change the data presented or remove and re-add tiles. 
 
 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 607 
© 2020 Abbott Jewelry Systems, Inc. 

Q:  Will you be adding more data types and choices?   
A:  Yes we plan to continue to add more data.  If you have a suggestion for something you would like to 

see please email it into Support@ajsllc.com.  We also have plans to add additional tile sizes and 
types. 

 
  

mailto:Support@ajsllc.com
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11 Store Calendar 
The Edge provides an interactive Store Calendar that allows you to see and act on: 
 

Customer Occasions 
Create mailing lists, directly email, or simply view customers with upcoming birthdays and 
anniversaries. 
 
Service Jobs 
View jobs (repairs, custom orders, special orders, appraisals, assemblies, and builds) and job 
tasks that are due, overdue for completion, and overdue for pickup. 
 
Customer Appointments 
Schedule and manage your appointments. 
 
Associate Tasks 
View and manage tasks for all or specific associates.  

 

 
 

A 
These checkboxes toggle which occasions, services, and tasks to display.  The drop-down 
allows you to filter these records by associate.  You can select a specific associate, see all 
associates, or only see records not assigned to any associate. 

B 
Customer occasions, service jobs, and tasks will always display at the top starting in the 
5AM timeslot.  The number in parenthesis indicates how many underlying records are 
present.  Double click on a tile to view matching records and possible actions. 

C Customer appointments will display at their respective times.  Double click an existing 
appointment to edit it.  Double click an open timeslot to create a new appointment. 
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 Using the Calendar 

11.1.1 Settings 
To access Calendar Settings: 

1. Click Associate > Calendar.  The Store Calendar will appear. 

2. In the top right, click the  (Settings) button.  The Calendar Settings window will appear.  

 
3. Use the Color drop-down to change the color used for each element of the calendar. 
4. Use the Show By Default checkbox to determine which occasions and services appear on the 

calendar by default.  These can always be changed on the fly from the main calendar view, too. 
5. Service Done Days defines the number of days a service job must be overdue before it starts 

appearing on the calendar, e.g. enter ‘14’ if you want jobs to show up as overdue once they 
have been completed but not picked up for 14 days. 

6. Occasions Associate allows you to determine which associate is assigned to each customer.  
There are three choices: 
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Assigned 
Associate 

Associate manually assigned on the customer record’s Other Keys 
tab. 

Last Transaction 
Associate 

Associate that last processed any type of transaction for this 
customer. 

Last 
Merchandise 

Associate 
Associate that last processed a merchandise sale or service intake. 

7. Make any desired changes, then click Save. 

11.1.2 Overview 

 

11.1.3 Occasions 
Double click the Occasions tile to open a list of matching customers. 
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11.1.4 Store Tasks 
Double click the Store Tasks tile to open a list of associate tasks that are due today or overdue. 

 

 

11.1.5 Job Tasks 
Double click the Job Tasks tile to open a list of job tasks that are due today or overdue.  Job tasks 
include repairs, custom orders, builds, and assemblies. 

 

 

11.1.6 Services Due 
Each service type (repair, custom job, special order, and appraisal) will have a Due tile, e.g. Repair Jobs 
Due, Custom Jobs Due, etc.  Double click this tile to open a list of service jobs that have an ETA of 
today and are not completed.   
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11.1.7 Services Overdue 
Each service type (repair, custom job, special order, and appraisal) will have an Overdue tile, e.g. 
Overdue Repair Jobs, Overdue Custom Jobs, etc.  Double click this tile to open a list of service jobs that 
have a past due ETA, but are not completed.  
  

 

 

 

11.1.8 Services Overdue Pick Up 
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Each service type (repair, custom job, special order, and appraisal) will have an Overdue Pick Up tile, 
e.g. Overdue Repair Pick Ups, Overdue Custom Pick Ups, etc.  Double click this tile to open a list of 
service jobs that are overdue for pick up.   
 

 

 

 

11.1.9 Appointments 
Each appointment will have its own tile in the corresponding timeslot on the calendar.  Double click the 
tile to open the appointment record. 
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12 The Edge Menu Bar 
The Edge Menu Bar at the top left corner of the window contains options common to most Windows-
type applications, with the exception of Administrative, which contains The Edge administrative 
functions. 
 

 

 File Menu 
The File menu contains options for printing, compacting the database, backing up the database, and 
exiting The Edge. 
 

 

12.1.1 Printer Setup 
Printer setup is generally dictated by Windows and the printer drivers.  Open each to see the properties 
available for the device and edit them as needed.  For example, if your receipts should be printed in 
color, select the printer’s color option. 
 

 
 
Options include paper size and location, portrait or landscape orientation, and margins.  The Edge 
generally has at least three printers associated with it. 
 

Receipt Printer Prints receipts for customer transactions. 
List Printer Prints lists for marketing and management use. 
Report Printer Prints reports.  This printer is used for item sheets, repair sheets, job 

sheets, and envelope inserts. 
 

 

For all printing types to print correctly, it is crucial that your printer margins are all 
set to .25”. 
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The tag printer is set up in Administrative ► Configure. 

To create PDFs, you need to install a PDF printer (generator). This installs and looks like a normal 
Windows printer, except when you print to it, it generates a PDF file of whatever you are printing. With 
this, you can print a document to PDF file, which you can then attach to an e-mail or save or print.  

12.1.2 Compact Database 
Compacting the database is a password-protected function available only to supervisors.  It defragments 
data and makes it more efficient.  This is not required unless directed by The Edge Support Team. 

12.1.3 Backup Database 
To be used as a safeguard before working on the database, creates an extra copy of your database.  This 
is in addition to any regular or automated database backups you make as described in the section entitled 
Backing Up the Database, which should happen regularly regardless of what you do here. 
 
To back up the database: 
 
1. Select File ► Backup Database.  You will be prompted to select a location to store the backup file.  
 

 
 

The prompt will default to your current database location.  In most cases, it is 
c:\ProgramData\AJSLLC\edge.   

 
2. If needed, change these settings.   
3. Select Save.   
4. Before continuing with other activities in The Edge, wait for the backup to be complete.  It may take 

a few minutes. 
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12.1.4 Exit 
Selecting Exit from the File menu has the same effect as closing The Edge using the close button.  
 

 
 
Notice that Exit will completely close The Edge, not just the selected window. 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 617 
© 2020 Abbott Jewelry Systems, Inc. 

 Window Menu 
The Window menu contains options for window arrangement and navigation. 
 

 
 
Tile Horizontally Displays open windows one above the other. 
Tile Vertically Displays open windows next to each other. 
Cascade Displays a series of windows in a splayed fashion. 
Arrange Icons Moves minimized windows to the bottom of The Edge screen. 
Windows Allows you to select from any open windows for immediate access. 
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 Help Menu 
The Help menu offers a few options for obtaining assistance about The Edge. 

12.3.1 Help 
Help contains access to The Edge’s online help system, which contains the same information as this 
document, indexed, and searchable for easy reference. 
 
Context-sensitive help is available from the Help tab on the side or corner of nearly 
all windows.  If you click on the Help tab, the Help system will open to the related 
topic.  The Help tab must be enabled in System Options.  Context-sensitive help is 
also available by pressing the F1 key (sometimes in conjunction with the FN key). 

12.3.2 Online Assistance 
To obtain assistance from The Edge Support Team on-line: 
 
1. Select Help ►Online Assistance.  The Online Assistance wizard will appear in a browser window. 
 

 
 
2. Call or email in advance as indicated in the window. 
3. Complete the fields as necessary to open a dialog. 
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12.3.3 Check for Updates 
You can check for software updates on demand.  To do so: 
 
1. Select Help ►Check for Updates.  The wizard will appear in a browser window. 
2. A notification of available updates will appear. 
3. Select the updates you wish to apply and select OK. 
4. The updates will be applied. 

12.3.4 Email Support 
Help also contains a command to allow you to email The Edge customer support directly. To do so: 
 
1. Select Help ► Email Support.  You will be prompted to take appropriate notes in preparation for 

your correspondence. 
 

 
 

2. Do so and select OK. 
3. An email using your default email client will open already addressed to The Edge customer support 

and a version number in the subject heading.   
4. Do not change the subject heading. 
5. Enter your message and send. 
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13 Administrative Menu 
Administrative on The Edge Menu Bar contains administrative options for The Edge that should not 
normally be accessed on a day-to-day basis or by store staff.  It is used for management of associates, 
taxes, database items, the QuickBooks® interface, and marketing. 
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 Managing Associates 
You must identify your employees to The Edge before they can effectively use it.  This will allow 
associates to automatically be credited with the appropriate commissions as well as track productivity.  
Reports concerning associate activities are described in the section entitled Commission Report.   

13.1.1 Adding a New Associate 
To add an associate: 
 
1. Select Administrative ► Associates.  The Associates window will appear with a list of current 

associates. 
2. Select Add.  The New Associate window will appear with the General tab selected.   
 

 
 

 
Fields and options in the General tab include: 
Inactive Whether this associate is still actively employed with the company. 
ID The associate ID number as assigned when the associate is entered. 
First Name The associate’s first name. 
Last Name The associate’s last name. 
Email The associate's email; depending on System Options, this might 

appear on customer-facing materials. 
Cell Phone The associate’s cell phone number; this will be used for text 

message notifications. 
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Password The associate’s password; required for access to certain password-
protected functions. 

Repeat Password The password should be repeated to preclude errors. 
Appraiser Details If applicable, the associate’s appraiser certification information. 
 Is a Jeweler Indicates whether the associate is a jeweler who can make repairs. 
 Is an Appraiser Indicates whether the associate is an appraiser.  
 Name as Printed If Is an Appraiser is checked, the associate’s name as it should 

appear on appraisals. 
 Credentials/Title If Is an Appraiser is checked, credentials earned by the associate. 

 
3. Complete fields in the General tab as appropriate.  Notice that they may vary based on the 

associate’s credentials. 
4. Select the Commission tab and complete the fields as described in the section entitled Associate 

Commissions.  Note that a commission must be entered, even if it is 0. 
5. Select the Security tab and complete the fields as described in the section entitled Security. 
6. Select the appropriate save option from the Record Navigation Bar. 

13.1.2 Editing an Associate’s Record 
To work with or edit an existing associate record: 
 
1. Select Administrative ► Associates.  The Associates window will appear with a list of current 

associates. 

 

Select Show Inactive Items to include associates who are not active in the list. 

 
2. Select an associate’s record and select Edit or double-click on the record.  The Edit Associate 

window will appear with the General tab selected.  See the section entitled Adding a New Associate 
for details on editing these fields. 

3. Select the Commission tab to edit the fields as described in the section entitled Associate 
Commissions.   

4. Select the Security tab to edit the fields as described in in the section entitled Security. 
5. Select the appropriate save option from the Record Navigation Bar. 
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13.1.3 Associate Commissions 
The Edge accommodates two types of commissions:  percentage of total retail price or percentage of 
profit on sale.  The percentage amount (10 percent, 20 percent, 30 percent, etc.) would be calculated 
according to the method chosen.  When using the percentage of retail method, 10 percent of a $150 sale 
would return $15.   
 
On the other hand, if we were paying 20 percent of gross profit, and a salesperson sold an item at retail 
at $150, the gross profit being $80, their commission would be $16.  If they discounted the item to $100, 
their gross profit would be $30, and their commission would be $6.   
 
Commission can be adjusted by assigning factors specified in the category and/or vendor definition.  
Each inventory category has a default commission adjustment of 100 percent.  Anything less would 
thereby reduce the amount of commission paid, as set in commissions, on items sold.  For instance, a 
commission adjustment of 50 percent would effectively cut the standard commission in half for items 
sold from that category; conversely a 200 percent adjustment would double the standard commission.   
 

 

You should use only the Salesperson Commission Report to process sales 
commissions. 

 

• All inventory sales will be reported on the Commission Report regardless of 
value.  A commission percentage must be entered in the Commission on 
Inventory area; 0 is a valid entry.   

• Entering a value in Repairs, Appraisals and Custom Jobs is optional.  However, 
there must be a value entered if they are to appear on the Commission Report. 

 

On layaways, repairs, special orders, custom jobs, and appraisals, commission is 
credited to the original intake associate regardless of who processes subsequent 
payments and pickups. 

 
To set up commissions: 
 
1. From the Administrative menu, select Associates.  A list of associates will appear.   
2. Select or add the associate with which you wish to work.   
3. The associate’s record will open.  Select the Commission tab.   
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Fields and options in the Commission tab include: 
  

Type Indicates the type of commission as described above.   
Gross Margin/ 
Commission % 

Indicates that, for items of various gross margins, the associate may receive 
different commission percentages.  The default is for all of the margins to be 
at a static rate.  You can use the other fields to indicate other ranges.  In this 
example, the commission is paid on anything with a gross margin more than 
0. 

 

Use this option to set minimum levels of gross margin for 
which commission would apply. 

 

Commission on 
Repairs 

Indicates the commission the associate should receive based on the price of a 
repair. 

Commission on 
Appraisals 

Indicates the commission the associate should receive based on the price of 
an appraisal. 

Commission on 
Custom Jobs 

Indicates the commission the associate should receive based on the price of a 
repair. 
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Commission on 
Care Plans 

Options are % of Price, which gives commission as a percentage of the 
price of the plan or Flat Rate, which gives a specified amount.  For % 
of Price, set the percentage to give.  For Flat Rate, set the dollar 
amount. 

Copy From Used to copy settings for the Commission tab from another associate record. 
 
4. Complete the fields in the Commission tab as appropriate or use Copy From to populate the fields 

from another associate. 
5. Select Save & Stay or Okay/Save & Close as required. 
 

 

Commissions can be specified by category and vendor as well.  See the sections 
entitled Adding a Category and Adding a Vendor. 

13.1.4 Security 
A list of all password-protected functions will be associated with every employee.  Those employees that 
have permission to access a function will have that function checked.  It is presumed that only the 
system administrator will have access to all users’ records and will check the permissions boxes 
accordingly.   
 
To work with security: 
 
1. From the Administrative menu, select Associates.  A list of associates will appear.   
2. Select or add the associate with which you wish to work.   
3. The associate’s record will open.  Select the Security tab.   
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4. Select the options required for this associate or use Copy From to populate security credentials 
from another associate. 

5. Select Save & Stay or OK/Save & Close. 
 

 

• Be aware that when a user has permission to administer users, they will then be 
able to set the password and permissions for every person in the store.   

• User permissions may change if updates are installed or other changes are made 
to the system.  All new permissions will be unchecked.  Turn these on manually 
after system changes are complete.  Sometimes a new permission restricts an 
operation that was previously uncontrolled.  In this case, users will find that 
they can no longer perform that operation unless the supervisor grants them the 
new permission. 
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 Managing Sales Tax 
Each location has unique tax requirements.  The Edge will allow you to set the tax conditions required 
by jurisdictions at your location.  You may need several tax definitions for one tax jurisdiction to 
accommodate requirements for things like luxury taxes or exempt items. 
 

 

If tax rates change, we recommend that you do not edit an existing tax rate, but 
give the existing tax rate an expiration date and create a new tax with a starting 
effective date. 

13.2.1 Tax Definitions 
To set up and edit tax definitions: 
 
1. Select Sales Tax from the Administrative menu.   
2. Select Tax Definitions.  The Tax Definitions window will appear. 

 

 
 

3. To add a new tax, select Add.  The New Sales Tax Definition window will appear with the 
General tab presented.  To edit a tax definition, select Edit.  The same window will appear, but will 
already be populated with data to edit. 
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Fields and options in the General tab include: 
ID The identification for the tax.  This can be a number or short descriptor. 
Inactive Indicates whether the tax is currently applicable. 
Description A detailed description of the tax. 
Rate % The percentage of sales to be collected. 
Rounding To what decimal tax calculations should be rounded. 
Qualifying Sales Allows you to define taxes based on prices or sales amounts.  There are three 

categories, all of which offers different options for values:   
• All:  All sales will be taxed at the rate specified. 
• Item:  Specify a price range to be taxed on an item-by-item basis.  For 

example, items of $0–$5,000 might not have this tax.  Items of $5,000 
and over might have it. If you want items over a certain amount, enter a 
value for of at least but leave but not more than blank.  This is an 
example of how one jurisdiction might require more than one tax 
definition. 

• Sales Totaling:  This is used just like Item, but only if the total sale 
drives the tax rate. 
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Qualifying 
Customers 

Allows you to specify certain categories of customers for whom the tax 
should be collected.  The most common example would be the collection of 
tax for customers shipping within the state, but excluding tax on shipments 
to out of state destinations.  This is set by using the Shipping to (or walk 
into store located) option.  It can also be refined by ZIP Code for shipping.  
If you have selected Shipping to, the All ZIPs and Some ZIPs options will 
appear. 

Exemptions  Allows you to specify sales amounts for which the tax should not be 
collected. This is only item-by-item regardless of qualifying sales.  This 
might be used in conjunction with Qualifying Sales and a number of tax 
definitions to layer progressive taxes.  The exemption will apply as specified: 
The First Tax will not be collected on the portion of the sale below 

this amount.  
The Amount 
Over 

Tax will not be collected on the portion of the sale above 
this amount. 

Dates Allows you to specify that the tax must only be collected during certain time 
frames.  Be sure that if you have an expiring tax definition, that a new one 
will begin afterword.   
Starting Date to start collecting the tax. 
Ending Last date to collect the tax. 

 
4. Complete the General tab fields as applicable.   
5. Select the Categories tab.   
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The Categories tab allows you to select categories of items for which the tax should be collected. 
 

6. Select the desired categories. 
7. Select the Stores tab. 

 

 
 

8. Indicate which stores will be required to collect the tax. 
9. Select the Misc tab. 
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10. Indicate those miscellaneous items for which the tax must be collected. 
11. Select the Other tab. 

 

 
 

12. Indicate those services and repair items for which the tax should be collected. 
13. Select the appropriate save option from the Record Navigation Bar. 
 
Example: 
Suppose you have a jurisdiction with a standard 6% sales tax on all items and a luxury tax of 8% that 
applies to any item costing more than $5,000 and is applied to only the amount over $5,000: 
 
1. Create a tax definition for items at 6% with no exemptions. 
2. Create a second tax definition for items over $5,000 at 2%.  
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13.2.2 Tax on Services 
Through this function, you can apply taxes to services rather than assign services to types of taxes.  For 
each type of service, select the tax definition to be applied. 
 

 

If the law changes concerning taxes on services in your state, be sure you double 
check tax applicability and rates at point of sale.  If tax law changes are extensive, you 
may need to cancel and reenter each open transaction.  This applies primarily to 
layaways. For special orders, custom jobs, and repairs, the tax due is typically applied 
when the customer takes possession, i.e., on final pickup.  Any tax shown on the order 
at intake is estimated. 

 
 
 

13.2.3 Shipping Tax Import Wizard 

13.2.3.1 Important Information 
The Shipping Tax Import Wizard can be used the import the free tax tables provided by Avalara™.  
Please read these important notes before proceeding. 

 This is only designed to import taxes for states you ship to.  Your “home” state taxes, which 
may include special rules or luxury taxes, should still be set up manually. 

 Consult a tax professional for assistance in determining sales tax obligations and applicable 
sales tax rates. 

 Avalara’s tax tables provide tax rates by ZIP code and include city, state, district, and special 
taxes.  This may not be appropriate for all states.  Some states only require state tax be 
charged on shipped purchases.  Consult a professional for assistance in determining which 
rates apply per state. 

 Importing many tax tables can impact the amount of time it takes to open POS.  This is 
especially true if you are accessing The Edge remotely, such as a multi-store setup sharing a 
database through a VPN, WAN, or cloud storage solution.  

 Make a database backup before importing any tax tables. 

13.2.3.2 Download Tax Tables 
Avalara™ tax tables are available online for free.  You can download multiple states at once, but each 
state will be a separate table that must be imported individually.     
 
To download: 

https://www.avalara.com/
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1. Navigate to the download site: https://www.avalara.com/taxrates/en/download-tax-tables.html 

2. Select one or more states and click Continue. 

 
 

3. On the Confirm tab, you must enter your name and email.  This is important; when tax tables 
are updated, you will receive an email so you can download and re-import the new rates. 

4. Click Download rate tables and allow the download to complete.  By default, these will save 
to your Downloads folder under the filename TAXRATES_ZIP5. 

To extract (unzip): 

1. Navigate to the folder where you saved the file (default is Downloads folder). 

2. Right click on the downloaded file (TAXRATES_ZIP5), then left click on Extract All. 

3. Choose the path where you would like to extract these files, e.g. Desktop.   

4. Note where you extracted the files – you will need to find this path when you import. 

13.2.3.3 Import Tax Tables 
Make sure you extracted (unzipped) the downloaded file before proceeding.  To import a tax table: 

1. In The Edge, click on Administrative > Sales Tax > Shipping Tax Import Wizard. 
 

https://www.avalara.com/taxrates/en/download-tax-tables.html
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2. Click Next.  Use the drop-down to navigate to the path of the extracted tax table.  Select the file 
to import and click Open. 

 
 

3. Choose which Rates (State, City, County, Special) to import and set import options, then click 
Next. 
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Condense 
Special Tax 

By 

Some tax tables include special tax rates.  These can be things like district 
taxes, stadium taxes, etc.  If present, this option defines how to add them.   
 

Amount Special taxes of the same amount will be condensed to a 
single definition. 

County Special taxes for the same county will be condensed to a 
single definition. 

Zip 
Code 

Special taxes for the same ZIP code will be condensed to a 
single definition. 

 

Rounding 
Defines threshold at which partial change gets rounded up.  The default is 
0.0050, e.g. $1.005 would round up to $1.01 while $1.004 would round 
down to $1.00. 

Start / End 
Date Dates these taxes will be effective. 

Tax Agency For QuickBooks, the tax agency to assign these to. 

4. Select which Categories these taxes will apply to, then click Next. 

5. Choose which Services and Stores these taxes will apply to, then click Next. 

6. Choose which Miscellaneous Items these taxes will apply to, then click Import Taxes to 
complete the import process. 

7. You must restart The Edge before these changes take effect. 
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 Lists 
Lists are used throughout The Edge to present the user with predefined choices for certain selection 
menus.  In addition, lists are used to setup and customize stones and related information (clarity, color, 
etc.)  By default, The Edge populates these lists with common entries.  To further tailor The Edge to 
meet the needs of your store, we highly recommend you examine these lists and make the necessary 
changes to accommodate your needs.   

13.3.1 Item Details Lists 
The Edge contains lists that populate drop-down menus, for example on the Details tab of category setup 
for each category.  For example, a category may contain a detail named Metal with a detail type of 
PrecMetals.  When an item is entered into this category, it will contain a detail field named Metal with 
a drop-down menu containing the predefined choices.  These predefined choices are pulled directly from 
the PrecMetals list.  The Edge knows to use this list because it is defined as the Detail Type for the 
detail Metal. 
 
Any custom list that you create will show up as an available Detail Type for any detail in any category.  
We recommend that you use lists were applicable to standardize the inventory process.  This is 
especially helpful if you have multiple associates entering inventory as it keeps them consistent.  Other 
management might include reordering lists according to your usage, i.e., the items in the list will appear 
in the drop-down menus in that order, so if you use a certain kind of item value a lot, you might order it 
near the top of the system list. 
 
You will usually be working with an existing list.  To do so:  
 
1. Select Administrative ► Lists.  The List of Lists window will appear. 
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2. Select the list with which you wish to work and select Edit. The List record will appear. 
 



The Edge User Guide v. 20.0.0.114 

638 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

 
 

Fields and options in the List record include: 
 

Add Item Used to add a value to the drop-down list. 
Delete Item Used to delete a value from the drop-down list. 
Edit Item Used to edit a value.  
Move Up Used to move a value up in the list.  This will make it appear higher in the 

drop-down list. 
Move Down Used to move a value down in the list.  This will make it appear lower in the 

drop-down list. 
 
3. Select a Save option. 
 
To create a new list: 
 
4. Select Administrative ► Lists.  The List of Lists window will appear. 
1. Select Add.  The New List window will appear. 
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2. In the List Name field, enter a meaningful name for the list. 
3. For each value to be included in the list, select Add Item.  The List Item window will appear. 
 

 
 
4. Enter a Short Value, which is analogous to a key or short cut. 
5. Create an Original ID, which is a unique identifier.  This can be the same as the short value. 
6. Enter a Long Value, which is a more descriptive list value name.  The long value is what shows on 

the screen. 
7. Select Save & New to add more list values or OK/Save & Close if you are done adding values. 
8. Be sure to go to the category record, Category Details tab and select the new list for a Detail Type. 

13.3.2 System Lists 
There are several other lists that are defined as System Lists.  These default to The Edge’s commonly 
used options.  We do not recommend modifying the short value of any record on the System List without 
consulting The Edge Support Team.     
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13.3.3 Stone Lists  
Stone lists allow you to customize the stones and attributes displayed when adding stones to item 
records.  This is managed using the Stones Wizard. 

13.3.3.1 Create New Stone Type 
To use the wizard to add a new stone: 

1. Click Inventory > Stones > Wizard. 
2. Click Next. 

 
3. Select New Stone Type and click Next. 
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4. Enter a Short Value and Long Value for your stone.   

 
5. Use the Copy From drop-down to specify an existing stone to copy details from.  To start with 

all available fields, select ‘** - Other’.  Then click Next. 
6. Stone attributes are split into six groups.  You can uncheck a group to stop it from showing up.  

Select the groups you wish to display, then click Next.  
 
                          Wizard 

 
 
 

 
                        Add Stone Form  

 

7. This screen allows you to customize the individual stone attributes. 



The Edge User Guide v. 20.0.0.114 

642 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

8. Available Data Types vary by attribute.  Text provides a field that accepts any characters, 
Number provides a field that only accepts numbers, and List links to a list of predefined 
choices. 

9. Make desired changes, then click Next and Finish to save your changes. 

13.3.3.2 Working with Stone Attributes 
Each stone attribute has a Data Type.  This defines how it appears when adding stones.   
For example, Certification will display on the stone form as Report # and will have a Text box that 
accepts any input. 

                                                        Wizard 

 

                   Stone Form 
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Some attributes will give you the option of changing Data Type.  For example, Finish can either be a 
Text box or linked to a List. 

 
 

 
And some attributes are hardcoded to only accept Numbers. 

 
 

 

13.3.3.3 Editing Existing Stones 
To use the wizard to update existing stones: 

1. Click Inventory > Stones > Wizard. 
2. Click Next. 
3. Select Existing Stone Type and click Next. 
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4. Use the drop-down to choose the stone you wish to edit.  The Edit Stone Types link will let 
you change the short value, long value, and order these appear. 

The remaining steps of the wizard are the same as creating a new stone.  Refer to Step 6 in the previous 
section. 
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 Promotions/Why In 
The Promotions/Why In feature helps track the results of advertising and other promotional activity.  
This function is based on the interface’s Why In field.  This section describes how to define the wording 
that will appear in that drop-down list. 
 
To work with Promotions: 
 
1. Select Administrative ► Promotions/Why In.  The Promotions/Why In window will appear. 

 

 
 

2. To add a new promotion record, select Add.  The New Promotion window will appear. To edit a 
promotion record, select it and select Edit.   
 

 
 
The data fields and options for both functions include: 
ID The ID number for the promotion. 

Event / 
Promotion 

The name of the promotional event generating the traffic. 

Media The proper name of the medium used to promote the event. 
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Description A more detailed description of the event.   
 

 

For a particular event, you’ll want to add a promotion for each ad 
taken to promote it.  Therefore, when a customer comes in and 
responds to the Why In question, you’ll have a drop-down item 
that matches the answer; e.g., “I saw your ad in The News.” 

 

Starts The date the event begins and the date the event should appear on the Why In 
list. 

Ends The date the event ends. 

Show Until The date until which the item should appear on the Why In drop-down list. 

Cost The cost to the store of the advertisement. 

3. Complete the Promotion fields as desired and select the appropriate save option from the Record 
Navigation Bar.   

 

 

Under System Options ►Promotions, Why In can be set to be a required entry at 
point of sale.  Be sure to make your promotion list flexible enough for your sales 
associates. 
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 Misc Sale Lines 
In Misc Sale Lines, you define things you can do at point of sale that do not fit in well in the predefined 
inventory or services areas.  The Edge offers many options for properly conducting transactions for 
donations or giveaways, but for things not defined, you can use Misc Sale Lines.  Such things might 
include shipping fees or restocking fees.  They can also be used as credits or coupons resulting from 
promotions. 

 

 

The use of Misc Charge for regular sales is discouraged.  Because there is no offsetting 
cost or support inventory records on these sales, using this function may skew your 
profit reports. 

 
To work with Misc Sale Lines: 
 
1. Select Administrative ► Misc Sale Lines.  The Misc Sale Line Definitions window will appear. 

 

 
 

2. To add a new line definition, select Add.  The New Misc Sale Line Definition window will appear.  
To change an existing record, select Edit.   
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The data fields and options for both Add and Edit include: 
ID The ID for the definition. 

Short Name The name for the definition. 

Description A more detailed description of the definition. 

Treat as Credit Whether this line should be treated as a credit. 

Show Taxable 
Checkbox at POS 

Whether to allow the option to toggle the tax collection. 

Inactive Indicates that this item is no longer used. 

3. Complete the fields as desired and select the appropriate save option from the Record Navigation 
Bar. 
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 Repair 
The Repair Intake function on the Point of Sale window is intended to offer as much data as possible 
for the user.  The options offered there are defined in the Administrative ► Repair functions. 
 
To work with Repair definitions, select Administrative ► Repair.  A drop-down list will appear. 
 

 

13.6.1 Repair SKUs 
When entering new repairs, you are asked to assign a SKU to the task.  These SKUs are defined in 
Repair SKUs.  To define a new SKU or edit an existing record: 
 
1. Select Administrative ► Repairs ► Repair SKUs.  The Repair Task SKU List will appear. 

 

 
 

2. Select Add to add a new SKU.  The Repair Task SKU (New) window will appear with the 
General tab selected.  To edit a record, select the desired record and the Repair Task SKU 
window, which is similar to the Repair Task SKU (New) window, will appear. 
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Fields and options in the General tab include: 
 SKU The SKU to be assigned. 
Alias For SKU The above-specified SKU is merely an alias for the SKU specified in 

this field.  Any reference to the above-specified SKU will 
automatically be converted to a reference to the SKU in this field. 

Department If you have more than one repair department, this would be the 
appropriate repair SKU department. 

This is a Sizing SKU Whether this task is a resizing. 
Makes Something 
Bigger 

Indicates this repair requires making something bigger. 

Quantity Label Labels the quantity field appropriately.  For example, for re-tipping 
ring prongs, the quantity might refer to number of prongs. 

“Old Size” Label Allows you to name the “old size” label. 
“New Size” Label Allows you to name the “new size” label. 
Search Keys These keys are user-defined parameters by which SKUs can be found.  

It is very important to be consistent across all lists.  
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Preserve this SKU 
when re-importing 
price book 

Whether this SKU should be saved when the book is re-imported. 

Add to Frequently-Used 
List 

For use in repair and custom job intake and service record 
management, this option will allow this SKU to appear in 
Frequently-Used SKU drop-down menus. 

Inactive Indicates that this SKU is inactive. 
Description A description of the task. 
Notes Any other information about the task. 

 
3. Complete the fields in the General tab as needed. 
4. Select the Pricing tab.  

 

 
 
Fields and options in the Pricing tab include: 
 
Method Method on which pricing should be based: 
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 Price per each: 
The price of the repair is the sum of the prices for each quantity of the 
task. 

 Flat price each row, last row per each addl: 
In the price of the task, price is determined by the flat price that 
corresponds to the user-specified quantity. 

Up to and including 
quantity 

The quantity at which the price breaks. 

Parts Cost Cost to the store for parts. 
Parts Price Price to the customer for parts. 
Labor Cost Cost to the store for labor. 
Labor Price Price to the customer for labor. 
Other Cost Cost to the store for other. 
Other Price Price to the customer for other. 
Total Cost Total cost to the store. 
Total Price Total price to the customer, before tax. 

5. Complete the fields in the Pricing tab as appropriate.  
6. Select the Recommended Parts tab.  

 

 
 
The Recommended Parts tab allows you to define parts usually used for this type of task.   
 

7. To remove a part, select the part and select Remove. 
8. To edit a recommend part record, select the part and select Details.  Fields will appear as described 

in the New Repair Part Recommendation window, described below. 
9. To add a part, select Add.  The New Repair Part Recommendation window will appear.  
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The New Repair Part Recommendation window is where details about the part are entered.  
Fields and options in the New Repair Part Recommendation window include: 
 
Automatically include this 
part on the repair when… 

Indicates that this part should always automatically be added to 
the task, as opposed to requiring that the part be added manually. 

Item # For parts taken out of store inventory, the item SKU (bulk). 
Quantity Quantity required for the task. 
Multiply this by the task 
quantity 

Automatically use as many of this part as number of times the 
task is being performed, as opposed to only needing one for a 
repair with the same task more than once. 

Vendor The vendor from whom the part can be obtained. 
UOM Unit of measure, e.g., number of pieces, inches, or grams. 
Vendor Style # The vendor’s ID number for the part. 
Metal The type of metal from which the part is made. 
Size The size of the part. 
Price Each The price of the part to the customer. 
Cost Each The cost of the part to the store. 
Description A description of the part. 

 
10. Complete New Repair Part Recommendation fields as appropriate. 
11. Select the appropriate save option from the Record Navigation Bar. 
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13.6.2 Import Repair SKU Table 
The Edge allows you to import repair SKUs (i.e., those available from David Geller).  To do so: 
 
1. Contact Jeweler Profit at 888-255-9848 or www.jewelerprofit.com to have your Edge license 

updated. 
2. When you get your new license, install it. 
3. Download the newest .edgetasksku file from EdgeUser and save the file to a place you will 

remember. 
4. From within The Edge, select Administrative ►Repairs ►Import SKU Table.  The Import 

SKU Table window will appear. 
 

 
 
Fields and options in the Import SKU Table window include: 
 
Import SKUs 
from File… 

Select source file for SKU import using the browse window and locating one 
of these files: 
• Edge Simple SKUs  
• Geller Blue Book. 

Method Method by which SKUs should be imported when some already exist: 
• New SKUs Only 
• Overwrite all SKUs 
• Preserve SKUs Created Here 
• Preserved SKUs Modified Here. 

http://www.jewelerprofit.com/
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Price/Cost 
Adjustment 

By how much costs and prices should be adjusted at import. 
• Cost Parts 
• Cost Labor 
• Cost Other 
• Price Parts 
• Price Labor 
• Price Other 

Round to 
Dollar 

Whether the prices above should be rounded to the nearest dollar. 

 
5. Use the Import SKUs from File… drop-down to browse to the saved file. 
6. We recommend that you opt to Overwrite all SKUs. 
7. Make other changes as needed. 
8. Select OK to proceed with the import process. 

 

 

The Geller data is licensed from Jeweler Profit.  You will not be able to import the 
full book unless you have purchased a license from Jeweler Profit.  Please contact 
them directly at 888-255-9848 or visit them on the web at www.JewelerProfit.com. 

 
 
 

http://www.jewelerprofit.com/
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 Locations 
For the purposes of tracking item locations within a store, The Edge offers a Location field in item 
records.  A location should be designated for every place in your store where you might look when 
searching for an item.  For example, you might have a showcase location such as Bridal, Window, or 
common locations like Vault, Safe, or Shop.  The Locations function works in conjunction with physical 
inventory in that you can assign items to a location while scanning or determine what is no longer there.  
 
The Move function provides an efficient way to keep items physical locations up to date and accurate.  
These features are detailed in this document.  For the purposes of this feature and document, “items” 
also refers to repairs, job envelopes, or anything that has a location. 
 
When adding an item, select the location from the Location drop-down menu on the General tab.  The 
Locations drop-down menu is also used in the inventory function and in the move function.  Available 
locations, those which appear in the Location drop-down menu, are managed from Administrative ► 
Locations.  
 
Assigning a location while adding inventory is not always practical, therefore an entry is not required.  
Once inventory has been added, consider updating that item location by manually editing the item 
location at a later date. 
 
If you're working with locations for the first time, The Edge will update the locations table with your 
previous locations.  Note that when using the Item Edit function, the Locations drop-down menu may 
include only active, inventory locations.  Repair and other service locations will only appear when 
appropriate for the function you're accessing. 

13.7.1 Adding a Location 
A location must be created before an item can be assigned to it.  Items can be assigned to locations one 
by one by editing the location field or en masse.  To create a new location to use in item records: 

1. Select Administrative ► Locations ► Add Location.  The New Location window will appear. 
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Fields and options in the New Location window include: 
Name The name of the location. 
Type The type of location: 

• Back Stock 
• Bin 
• On Display 
• Outside Vendor 
• Station. 

Inactive Whether the location is active and available for use. 
Location Availability What kind of availability the location has: 

• Inventory Location 
• Envelope Location. 

Moving a Job to this 
location marks it as 
done. 

Used for appraisals, builds, assemblies, and repairs, this indicates that 
when you move an envelope here, the job is also marked as done and 
the current date is applied as the done date. 

Notes Contains notes concerning the location and its use. 
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2. Complete the fields in the New Location window as needed.   
3. Select a save option.  The location will appear in the Location drop-down menu. 

13.7.2 Finding and Editing a Location 
To work with existing location records: 

1. Select Administrative ► Locations ► Location Find.  The Location Find window will appear. 

 
 
Filters in the Location Find window include: 
 
Store Returns records of locations in the specified store. 
Type Returns records with the specified type of location: 

 
• Station  
• Bin 
• Outside Vendor 
• On Display 
• Back Stock 
• Transit. 

Availability Returns records with the specified location availability: 
 
• Envelope  
• Transit 
• Inventory. 
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Done  Returns records of locations that indicate whether a job is done: 
 
• Don’t Care 
• Done Location 
• Not Done Location. 

Name Returns locations with a specified name. 

2. Select filters as desired. 
3. Select OK.  The Location list will appear indicating the name, type, and availability. 

 
 
In these results, notice that the location’s status as to done and its availability is marked with an 
asterisk. 

4. Select a location record and edit it as necessary. 
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13.7.3 Merge Locations 
Found in the Supervisor menu of the Location window, Merge Locations allows you to merge one or 
more location, and items, repairs, or jobs in it, with another.  Merge locations is useful in cleaning up or 
retiring locations.  Plan location merges carefully; it cannot be undone.  To do so: 

1. Select Supervisor ► Merge Locations.  The Location Merge window will appear. 

 

2. On the left, select the location to be merged from the Location record to be consumed drop-down 
menu.  You can select more than one location. 

3. On the right, the location from which you used the function will be listed in the Location record 
that will remain field.  This is the destination location. 

4. Select OK.  The Location window will return, showing the locations that are to be absorbed. 

To complete the merge, from the Location window, select a Save option. 
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 QuickBooks® 
The Edge/QuickBooks integration posts aggregated sales and inventory data from The Edge to 
QuickBooks.  It is our intent that The Edge be the sole owner of your customer and inventory details, but 
we understand that QuickBooks can better handle your accounting needs.  In this arrangement, your 
QuickBooks company file will not contain any of your customer records, nor any single inventory item.  
The Edge posts General Ledger (G/L) entries for almost everything.  In almost all cases, a full day’s 
activity is posted as a single G/L entry per account pair.  It does not post sales per se.  The sales reports 
in QuickBooks will not reflect sales handled by The Edge, but the profit/loss statement and balance sheet 
will accurately reflect all activity from both The Edge and QuickBooks.  Cash taken in at point of sale 
will be aggregated and posted to a cash-on-hand account (e.g., undeposited funds), but checks and credit 
card payments will be posted as individual payments, and will appear as undeposited funds, so as to 
facilitate your bank deposits.  
 
The Edge allows you to integrate features and map to your QuickBooks chart of accounts in a very 
flexible manner.  It is required that every feature in The Edge be mapped to an appropriate account in 
your chart of accounts, even if you do not use this feature.  This ensures all activity can be posted to 
QuickBooks, even if the feature is used some time in the future. 
 
Nearly every QuickBooks user has a chart of accounts different than any other user.  The design of your 
chart of accounts is a matter that you should discuss with your bookkeeper or, better yet, your 
accountant.  You should design a chart of accounts that works for your unique business situation, and set 
up The Edge so that it posts to the G/L accounts that make sense for you.   
 
You should be aware that The Edge will not do the following with QuickBooks: 
 
• Transfer vendor or customer details to or from QuickBooks. 
• Generate vendor bills. All bills must be entered manually into QuickBooks. 
• Write checks.  All checks must be written via QuickBooks. 
• Transfer commission figures to QuickBooks.  Commission calculations on The Edge are all ad-hoc, 

meaning that most jewelers will run commission reports several times, in several different ways, and 
sometimes make manual adjustments to the commissions due.  Commission checks should be 
written via QuickBooks and possibly included in payroll checks. 

 
To work with QuickBooks and The Edge, select Administrative ► QuickBooks®.  A drop-down list of 
options will appear. 
 

 
 
• Post to QB Now:  This is how a store posts the pending transactions to QB (typically daily). 
• GL Report:  This is a report that shows detail or summary data in Debit/Credit format. 
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• Set Up QuickBooks Integration:  This is where all the linkage between The Edge 
features/QuickBooks accounts are set. 

• Set Start Date:  This is where a store decides the From Date to post detail from The Edge to 
QuickBooks. 

 
First we’ll summarize Set Up and Important Operational notes, then explain Setup QuickBooks 
Integration in detail 

13.8.1 QuickBooks Operational Summary 
To properly integrate The Edge with your QuickBooks Company file, there are several steps to 
complete: 
 
• Assessment/Qualification: 

o Will integrating The Edge/QuickBooks save in bookkeeping time? 
o Am I ready to integrate The Edge with QuickBooks? 
o See “Should I Integrate” and “When Should I Integrate” in the section entitled QuickBooks 

FAQs. 
 

• Getting Prepared: 
o Purchase QuickBooks Pro Desktop or QuickBooks Online 
o Read The Edge/QuickBooks documentation (review with your accountant) 
o Create a new QuickBooks Company Files or prepare your existing company files by: 

o Adding the necessary point of sale Customer Record, Vendor, Payment Methods  
o Adding required accounts to your QuickBooks Chart of Accounts (COA) 

o Prepare the Chart of Accounts (COA) for integration 
o Plan The Edge/QuickBooks start date (with your accountant) for The Edge to begin posting 

detail to QuickBooks 
o Prepare starting balances (with your accountant) 
o Update The Edge (plan to install the latest version of The Edge before integration) 
o Consider obtaining the advice of a QuickBooks-certified retail consultant knowledgeable in the 

jewelry industry. 
 

• Integrating The Edge with QuickBooks: 
o Allow initial integration: 

o QuickBooks Desktop: Install QBFC from www.EdgeUser.com 
o QuickBooks Online: Authenticate server through Edge 

o Set QuickBooks Permissions (QuickBooks needs to be set to allow The Edge to post data) 
o Map The Edge with QuickBooks: 

• Link point of sale customer to a single customer record in QuickBooks (this is where are all 
sales data will post to in QuickBooks) 

• Link The Edge features to QuickBooks chart of accounts 
• Link MISC charges to QuickBooks chart of accounts and be prepared to update these links 

as your MISC charges change 
• Link Tax definitions to QuickBooks tax vendor 
• Link The Edge stores to QuickBooks classes (optional for multi-store users) 

http://www.edgeuser.com/
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• Link The Edge credit card types to QuickBooks payment methods (matched by the exact 
name).  Be prepared to update this as you add payment methods. 

 

 

Review all QuickBooks setup with your accountant and/or bookkeeper responsible for 
maintaining the accounts. 

• Initial Posting from The Edge to QuickBooks: 
o Set a QuickBooks start date (in The Edge) as planned with your accountant/bookkeeper (The 

Edge sets all prior data as “already posted”) 
o Post from The Edge to QuickBooks for the first time 
o Set starting balances for all accounts in QuickBooks (with guidance from your 

accountant/bookkeeper). 
 

• The Edge/QuickBooks Maintenance 
o Post from The Edge to QuickBooks regularly (perhaps each morning) 
o Make certain bookkeeping staff follows The Edge/QuickBooks Maintenance Procedures. 

 

 

Abbott Jewelry Systems, Inc. cannot be held responsible for the maintenance of your 
QuickBooks financial data.  The relationship between The Edge and QuickBooks is 
unidirectional, meaning The Edge posts to QuickBooks but is unaware of any 
journal entries, additions, or subtractions of data that occurs directly in 
QuickBooks. Resolving inaccurate financial information is not something with which 
we have the expertise to assist you.  You would need to seek assistance from your 
accountant.  Be sure to maintain your books! 
 

The Edge team has provided a procedural document which explains some important accounts and 
functions that must be managed directly in QuickBooks regularly.  Failure to maintain these procedures 
will result in inaccurate financial statements.  Contact The Edge Support Team for the current procedural 
document.  The following video tutorials may be helpful in reconciling accounts: 

 
QuickBooks:  Reconciliation Procedures:  
Undeposited Funds and Refunds http://www.screencast.com/t/rRHzEJT3h 

QuickBooks:  Reconciliation Procedures:  Memo 
Payments Due http://www.screencast.com/t/zxz073uHNxqu 

QuickBooks:  Reconciliation Procedures:  
Consignment Payments Due http://www.screencast.com/t/JDqLDjfn 

QuickBooks:  Reconciliation Procedures:  
Inventory RTV http://www.screencast.com/t/i7YczAICj 

QuickBooks:  Reconciliation Procedures:  
Inventory QB http://www.screencast.com/t/AntNGhJf 

 
 

  

http://www.screencast.com/t/rRHzEJT3h
http://www.screencast.com/t/zxz073uHNxqu
http://www.screencast.com/t/JDqLDjfn
http://www.screencast.com/t/i7YczAICj
http://www.screencast.com/t/AntNGhJf
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13.8.2 QuickBooks Setup 
The Edge supports both QuickBooks Desktop and QuickBooks Online.   

13.8.2.1 QuickBooks Desktop 
To integrate with QuickBooks Desktop you must first install QBFC.  This is an application provided by 
Intuit that allows The Edge to communicate with QuickBooks.  Once installed, you must then grant The 
Edge permission to access your company file.  To do so: 
 
1. Download and install QBFC using this link: 

http://download.edgeuser.com/edgeupdates/QBFC13_0Installer.exe 
2. Launch QuickBooks and open your QuickBooks company file. 
3. Resolve any QuickBooks reminders requiring your input (backups, updates, etc). 
4. Launch The Edge. 
5. Select Administrative ► QuickBooks ► Setup QuickBooks Integration. 
6. Use the drop-down under QuickBooks Enterprise to locate your company file. 
7. On the General tab, click the drop-down arrow on the Point of Sale Customer field.  This will 

initiate connection between The Edge and QuickBooks.  QuickBooks will begin blinking on your 
Windows task bar to alert you attention is required. 

8. Select QuickBooks.  You will be prompted to grant The Edge permission to read and modify your 
QuickBooks company file. 

9. Continue to section 11.8.2.3 Mapping The Edge with QuickBooks Accounts. 

13.8.2.2 QuickBooks Online 
QuickBooks Online requires Windows 10 or newer. 
 
To integrate with QuickBooks Online: 
 
1. Launch The Edge.  
2. Select Administrative ► QuickBooks ► Setup QuickBooks Integration. 
3. Change the radio selector to QuickBooks Online and click the Authenticate with QuickBooks 

Online button. 
4. Complete login into QuickBooks Online and select your company file. 
5. Once Intuit completed authentication you will be brought to a webpage prompting you to return to 

The Edge, do so now. 
6. Click Authenticate with Edge Server. 
7. Continue to section 11.8.2.3 Mapping The Edge with QuickBooks Accounts. 
 

13.8.2.3 Mapping The Edge with QuickBooks Accounts 
The Edge must be set up to ensure that every feature available has an appropriate account for posting to 
your particular QuickBooks Company File.  The account names used inside your QuickBooks Company 
file are at the preference of you and your accountant, just be certain to choose the appropriate account 
type.  In the section entitled The Edge QuickBooks Set Up Integration, features are grouped by Account 
Type.  

http://download.edgeuser.com/edgeupdates/QBFC13_0Installer.exe
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Be sure to map Edge accounts of the correct account type on your QuickBooks chart 
of accounts when linking Edge features.  For example, if The Edge mapping shows an 
account in a section labeled EXPENSE, be sure to map this Edge feature to an 
EXPENSE account or risk that this account will post financials on the wrong side of 
your general ledger. 

13.8.2.3.1 Recommended QuickBooks Accounts 

Make sure that all activities in The Edge have corresponding accounts in QuickBooks, you should have 
accounts for the following:  
 

Account Type Account Name Sub Account of… 
Other Current Asset Store Charges  
 Inventory Asset  
 Inventory QB  Inventory Asset 
 Inventory EDGE  Inventory Asset 
 Inventory Scrap Inventory Asset 
 Inventory RTV  Inventory Asset 
 Inventory 

Assembly/Disassembly 
Inventory Asset 

Expense Balance Adjustments  
 Missing Inventory  
 Rewards Cards  
 Referral Fees  
 Item Donation  
 Item Giveaway/Promotion  
Income Fee Income  
 Appraisal Income  
 Shipping Income  
 Interest Income  
 Product Sales  
 Showcase Sales Product Sales 
 Special Order & Memo Product Sales 
 Shop Sales  
 Jewelry Repair Shop Sales 
 Scrap Income  
 Care Plan  
Other Current Liability Customer Appraisal Deposits  
 Customer Layaway Deposits  
 Memo Out Deposits  
 Special Order Deposits  
 Repair Deposits  
 Gift Certificates  
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 Refunds Due  
 Store Credits  
 Memo Goods  
 Memo Payments Due  
 Consignment Goods  
 Consignment Payments Due  
COGS Cost of Goods  
 Special Order & Memo Cost of Goods 
 Showcase COGS Cost of Goods 
 Scrap COGS  

 

 

• We will use all of the above accounts in The Edge when we set up the 
QuickBooks integration. 

• Create a customer named “Point of Sale” in QuickBooks.  This is where The 
Edge will post all sales data. 

• Create a vendor account where you pay your sales tax to specify where The Edge 
should post tax liability. 

• Create a payment method in QuickBooks for each method of tender taken in 
The Edge. 

13.8.2.3.2 QuickBooks Setup General Tab 

To set up The Edge to post to QuickBooks: 
 
Select Administrative ►QuickBooks ►Set Up QuickBooks Integration.  The QuickBooks Setup 
window will appear with the General tab selected. 
 

 

Most Edge features post to accounts; no direct maintenance in QuickBooks is required.  
However, some features in The Edge post to an account in QuickBooks that may not 
represent the final step in bookkeeping.  In these cases, The Edge has taken the financials 
as far as it can go and a direct QuickBooks maintenance procedure will be required.   
 
In this section of the User Guide, the accounts marked with an asterisk (*) indicate a 
manual QuickBooks bookkeeping procedure is required. 
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The General tab contains three data entry fields: 
 
Company File Optional.  If you specify a QuickBooks company file here, The Edge will launch 

QuickBooks when you attempt to post.  If you leave this blank (which most do), 
The Edge will require you to have your QuickBooks Company File open before 
you can post. 

POS 
“Customer” 

The QuickBooks customer record to which all sales activity will be attributed.  
You should create a customer record in QuickBooks for this purpose and name it 
“POS,” for example. 

 

Over time, this single customer record in QuickBooks will 
accumulate a large amount of sales activity data and cause posting 
from The Edge to QB to take a long time.  To prevent this, you can 
occasionally create a new customer record in QuickBooks and 
then link The Edge point of sale customer to that new customer 
record.  Example:  POS Customer 2017. 

 

Maximum 
Refnum 
Length 

To prevent errors related to reference numbers that are too long, this field should 
be set to 16 by default.  Try 12 or 8 for older versions of QuickBooks.   

 
Browse to these values using the drop-down menu and select the Accounts tab. 

13.8.2.3.3 QuickBooks Accounts Tab 

The Accounts tab contains a tree view of The Edge features organized by account type. These accounts 
must be mapped to a corresponding account in QuickBooks.      
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The following table outlines each account in The Edge and its use. 
Accounts Receivable  
 Accounts Receivable Set up this account to match QuickBooks’ default accounts receivable 

account.  This is usually called “Accounts Receivable” but many 
users rename it to “Edge Pass-through Account.”   

 

For purposes of data integration, The Edge uses the 
AR account as required pass-through.  This account 
should not have a balance.  Do not mistake the use of 
this account as store receivables. 

 

Assets 
 Inventory Assembly/ 

Disassembly  
This should be an asset account, and is used when assembling an item 
from other items, or breaking an item into several other items.  This 
account also serves as a transitory account for cost of inventory used 
in repair or custom jobs that are not yet picked up. 

 *Returned to Vendor This should be an asset account, and is used when an item is marked 
returned to vendor.  Understand that The Edge is finished with items 
that are marked RTV, so this posting moves the item value from your 
primary asset account to this temporary sub-asset account.  You will 
have to post your own G/L entries to move assets from this account to 
other accounts when you actually ship items back to the vendor, 
and/or when you receive credit or payment from the vendor for 
returned items. 
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 *Scrapped Goods This should be an asset account, and is used when an item is marked 
scrapped. Understand that The Edge is finished with items that are 
marked SCRAPPED, so this posting moves the item value from your 
primary asset account to this temporary sub-asset account.  You will 
have to post your own G/L entries to move assets from this account to 
other accounts when you determine the retained value of the scrapped 
goods, and how much to write off. 

 Store Charges This should be an asset account, not a receivables account, and 
represents the amount of money people owe you on store charges 
(house account charges). 

 Uncategorized Trades Used when accepting trades at point of sale with no category.  There 
is a system option to assign categories and avoid use of this account. 

 Undeposited Funds This feature must be mapped to the “Undeposited Funds” account 
created by QuickBooks for managing bank deposits.  If you do not 
have this account presently in your chart of accounts, you must enable 
the feature in QuickBooks.  In QuickBooks, select Edit ► 
Preferences ► Payments ► Company Preferences and check the 
option Use Undeposited Funds as a default deposit to account. 

Expense  
 Appraisal Cost This should be an expense account.  When a cost is entered on an 

appraisal it is debited here. 
 Balance Adjustment This should be an expense account.  When you make an adjustment to 

a customer balance by selecting Adjust Balance from the Customer 
Balance tab, the difference is posted to this account.  You can either 
create a new account for this purpose, or use an existing account, for 
example, bad debt write-offs. 

 Donation This should be an expense account.  When an item is marked as a 
donation at point of sale, the cost is debited here. 

 Giveaway This should be an expense account.  When an item is marked as a 
giveaway at point of sale, the cost is debited here. 

 *Missing Inventory This should be an expense account.  When you mark an item lost, 
stolen, or missing, the cost of that inventory is posted to this account.  
If an item is later marked found, the value of that item is recouped 
from this account. 

 Referral Fees This should be an expense account.  When you award referral 
bonuses, these fees are a form of advertising expense.  

 Rewards This should be an expense account.  When a customer spends reward 
dollars at point of sale, this is a form of advertising expense. 

Income  
 Appraisal Income This should be an income account.  The fees that you collect for 

performing appraisals will be posted to this account. 
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 Care Plan Income This should be an income account.  The amount you collect for selling 
a care plan will be posted to this account. 

 Fee Income This should be an income account.  Restocking fees charged for 
returns and cancellations will be posted to this account. 

 Interest Income This should be an income account.  Interest charges applied to store 
charge balances (house accounts) will be posted to this account. 

 Shipping Charges This should be an income account. Money that you collect for 
shipping charges will be posted to this account.   
 

 

Do not confuse this with a shipping expense account 
for fees incurred in store shipping and receiving. 

 

Liabilities  
 Deposits (Money 

paid on account 
for the following) 

 

  Appraisal 
Deposits 

This should be a liability account. Funds that customers 
leave on deposit with you while you are appraising their 
goods are posted to this account. 

  Layaway 
Deposits 

This should be a liability account. Funds that customers 
leave on deposit with you to keep goods on layaway are 
posted to this account. 

  Memo Out 
Deposits 

This should be a liability account. Funds that customers 
leave on deposit with you while they take goods out on 
approval are posted to this account. 

  Repair/ 
Custom 
Deposits 

This should be a liability account. Funds that customers 
leave on deposit with you while you are working on their 
repairs are posted to this account. 

  Special 
Order 
Deposits 

This should be a liability account. Funds that customers 
leave on deposit with you while you are getting special 
order goods for them are posted to this account. 

 Gift Certificates This should be a liability account. Funds that you have collected by 
selling gift certificates or tender cards will be posted to store credit as 
described below. 

 *Refunds Due This should be a liability account. Funds that you need to return to 
customers will be posted to this account.   For example, if you process 
a return to a customer by check, The Edge posts the check amount to 
this account.  When you write a refund check to a customer, charge it 
against this account.  Note that the general ledger will indicate (in the 
memo field) to which customers the refunds are due.   
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 *Sales Tax Payable This should be the actual QuickBooks “sales tax payable” account.  
Any sales tax that you collect will be posted here and will be payable 
to your tax agency.  This will be depleted when you use “Pay Sales 
Tax” feature in QuickBooks. 

 Store Credits This should be a liability account. Funds that you are holding in lieu 
of giving a customer a cash refund (this is also known as a credit 
memo) will be posted to this account.  Gift certificates and tender 
cards fall under this category. 

 

Inventory, Repair, and Miscellaneous Income accounts will be set on their respective 
tabs. 

13.8.2.3.4 Mapping Accounts 

To map an account: 
 
1. Be sure an appropriate account exists in QuickBooks. 
2. From Administrative ►QuickBooks ►Set Up QuickBooks Integration, select the Accounts tab.   
3. Select an account from the account hierarchy. 
4. Select a QuickBooks account from the drop-down list at the bottom of the window.   

 

 

An information field will appear at the very bottom of the window that details 
how The Edge uses the selected account. 

 
5. Select OK.  Notice that the Accounts window will indicate the correlation. 

 

 
 

6. Repeat this process for each account on each of the tabs QuickBooks Setup window. 
 

 

If you encounter the error “QBFC must be installed,” revisit the steps in the section 
entitled Install QBFC. 

13.8.2.3.5 QuickBooks Inventory Tab 
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The Inventory tab allows you to specify how inventory-related transactions are posted to QuickBooks.  
This tab consists of a tree view on the left side and four groups of account drop-down fields on the right 
side. 
 

 
 
To indicate how transactions are posted to QuickBooks: 
 
1. Select the desired line from the tree view on the left side. 
2. Complete the drop-down fields on the right side. 

 

 

The first line in the QuickBooks mapping tree view, All Categories/Default Settings, 
applies to every piece of inventory in the system.  Point of fact, only this line must be 
selected and filled in.  All other lines in the tree view are for specifying exceptions to 
the default settings. 

 
The panel on the right allows you to specify the QuickBooks accounts where The Edge will post based 
on the Inventory Stock Type.  For example, you can specify a different Income account for Memo 
Goods so this income can be tracked separate of owned stock.  This is very flexible.  You should discuss 
the level of separation is needed with your accountant 
 

 

An information field will appear at the very bottom of the window that details how 
The Edge uses the selected account. 
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The drop-down groups are defined as follows: 
 

The “Stock/Inventory” Group 

Asset When a stock inventory item is added to inventory, the cost of that item is 
debited to this G/L account to increase the asset.  When a stock item is sold or 
picked up, this account is credited to decrease the asset.  

*(Asset) *This is a contra-asset account that must be maintained by you.  When a stock 
inventory item is added to inventory, the cost of that item is credited from this 
G/L account.  When the bookkeeper enters a bill in QuickBooks, the total 
inventory amount entered in The Edge should be posted to this account.  If all 
inventory items are accurately entered into The Edge and all bills are accurately 
entered into QuickBooks, this account should be 0. 

COGS COGS stands for Cost of Goods Sold.  When a regular inventory item is sold, the 
cost of that item is moved from the Asset account to this COGS account. 

Income When a regular inventory item is sold, the sale price of that item is posted to this 
income account.  The reverse amount is posted to Accounts Receivable.  Any 
tender taken on the sale is in turn used to offset accounts receivable. 

 
The “Special Order” Group 
The fields in this group have exactly the same meaning as in the “Stock/Inventory” group, except that 
they are used with respect to items of the inventory type Special Order.   
 
The “Assembled” Group 
The fields in this group have exactly the same meaning as in the “Stock/Inventory” group, except that, 
since this inventory is assembled from other items, there is no need for the contra-asset account.  The 
cost of these items will flow in and out of the asset account mapped to the feature Inventory 
Assembly/Disassembly (see the Accounts tab). 
 
The “Take-Off” Group 
The fields in this group have exactly the same meaning as in the “Stock/Inventory” group, except that, 
since this inventory represents pieces taken off of other inventory items, there is no need for the contra-
asset account.  The cost of these items will flow in and out of the asset account mapped to the feature 
Inventory Assembly/Disassembly (see the Accounts tab). 
 
The “Trade-In” Group 
The fields in this group have exactly the same meaning as in the “Stock/Inventory” group, except that 
they are used with respect to items of the inventory type Trade-In. 
 
The “Memo Goods” Group 
Asset When a memo item is added to inventory, the cost of that item is debited to this 

G/L account to increase the asset.  When a memo item is sold or picked up, this 
account is credited to decrease the asset. 
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Liability When a memo item is added to inventory, the cost of that item is credited from 
this G/L account.  This allows QuickBooks to keep track of goods in the store that 
are owned by a third party.  

COGS COGS stands for Cost of Goods Sold.  When a memo item is sold, the cost of that 
item is moved from the asset account to this COGS account. 

Income When a memo item is sold, the sale price of that item is posted to this income 
account.  The reverse amount is posted to Accounts Receivable.  Any tender taken 
on the sale is in turn used to offset accounts receivable. 

*Payable When a memo item is sold, the cost of that item is moved from the liability 
account to this Payable account, indicating that the vendor can now be paid.  Be 
sure to use a QuickBooks liability account for this purpose. An accounts payable 
account will not work properly.   

 
The “Consignment Goods” Group  
 
The fields in this group have exactly the same meaning as in the “Memo Goods,” except that they are 
used with respect to items on consignment from a customer.  Consignment items are liability items 
owned by customers and therefore “payable” can be applied differently than memo items, which are 
owned by a vendor. 
 
There is a System Option in The Edge where payment for a sold consignment item can be posted as a 
credit memo on account for the customer at the time the consignment item is sold. If this option is set to 
True, the payable will post to QuickBooks as to the Credit Memo account instead of a Consignment 
Payable account. 

 

 

• When a memo or consignment item is sold, the item record gets updated with a 
payable date to reflect that The Edge has posted to Memo or Consignment 
Payments Due. 

• If a sold memo or consignment item is returned to stock, it is assumed the item is 
now owned merchandise.  A supervisory function is available to remove the 
payable if appropriate. 

• An In Stock Memo or Consignment with a Payable Date is no longer a liability. 

13.8.2.3.6 QuickBooks Repair Tab 

The Repair tab controls how repair, custom, and assembled items are posted to QuickBooks. 
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The tree view on the left represents all repair SKUs on file, organized by their search keys.  As in the 
inventory tab, the topmost item of the tree will be the default for all repair tasks, regardless of whether 
the tasks have an SKU at all.  You need not specify anything at all for items other than the top item, 
unless you want to record expenses or income differently for that branch of the SKU tree. 
 
The panel on the right allows you to specify the QuickBooks accounts where The Edge will post the 
corresponding income and expenses.  For repair and custom jobs, this posting occurs only if and when a 
job is picked up at point of sale, with one exception:  “Parts (Consumed from inventory)” the cost of 
service parts consumed from inventory are held in the account linked to inventory assembly/disassembly 
until time of pickup. 
 
Notice the checkbox Treat Custom and Assembly Like Repair (default).  Uncheck this box to provide 
separate mapping accounts for:  
• Repair 
• Custom 
• Assembly. 
 
Fields in the Repair tab include: 
Parts (non-inventory) 
 COGS The cost of any parts used in the completion of a repair or custom job 

is posted to this account.  These are parts that are not part of The Edge 
inventory records. 
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 (COGS) The cost of any parts used in the completion a repair or custom job is 
deducted from this account.  These are parts that are not part of The 
Edge inventory records.  Often it is preferred to specify the same 
account for COGS and (COGS) which would result in posting with no 
net effect.  This is typically best because these parts have never been 
inventoried in The Edge and cost has likely been accounted for in 
QuickBooks already. 

 Income The price paid by your customer for any parts used in a repair will be 
posted to this income account. 
 

 

The COGS, (COGS), and Income postings occur at 
the time of pickup of the job. 

 

Parts (consumed 
from inventory) 

  

 COGS The cost of any parts (from inventory) used in the completion of a 
repair of custom job is posted here.  These are parts that are actually 
part of you inventory in The Edge. 
 

 

This COGS posting occurs at time of pickup of the 
job. 

 

 (COGS) This feature is automatically linked to the GL Account you have 
associated with the asset feature Inventory Assembly/Disassembly 
(see the Accounts tab).  The cost of the inventory item is credited 
from its inventory asset account and posts as a debit to this account.   
 

 

This posting occurs at the time the part is associated 
with the job. 

 
At time of pickup, this account is credited by the amount of the 
inventory parts cost and posted as a debit to the actual COGS account 
assigned above. 

 

The GL Account associated with the feature 
Inventory Assembly/Disassembly is a transitory asset 
account.  This account will have a balance as long as 
there are Inventory Parts assigned to an open repair 
or custom job (not yet picked up).  When the job is 
picked up, the Transitory Asset value is reduced and 
posted to COGS. 
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 Income The price paid by your customer for any inventory parts (actual 
inventory items in The Edge) used in a repair or customer job are 
posted to this account. 
 

 

The COGS, (COGS), and Income postings occur at 
the time of pickup of the job. 

 

Labor 
 COGS The cost of any labor used in the completion of a repair or custom job 

is posted to this account. 
 (COGS) The cost of any labor used in the completion of a repair or custom job 

is deducted from this account.  If you track labor as a payroll expense, 
you should specify the same account for COGS and (COGS) and 
there will be no net effect. Alternatively, when specifying this 
account, you should consider how you pay for this labor.  If your 
bench jeweler is on a fixed salary, you might want to deduct this 
amount from “payroll expenses.”   If repairs of this type are always 
sent out, you might want to deduct this amount from an “outside 
services” account. 

 Income The price paid by your customer for any labor used in a repair will be 
posted to this income account. 
 

 

The COGS, (COGS), and Income postings occur at the 
time of pickup of the job. 

 

Other   
 Other costs on a service job or task typically include shipping fees or insurance. 
 COGS The cost of any “other” charges associated with the completion of the 

repair is posted to this account.  This upcharge typically corresponds 
to the risk or liability of breakage. 

 (COGS) The cost of any other fees incurred in the completion of the repair is 
deducted from this account.  If you track other charges some other 
way in QuickBooks, you should specify the same account for COGS 
and (COGS) and there will be no net effect.  Alternatively, if you pay 
for outside insurance to cover your liability in this area, you might 
want to specify an insurance expense account here. 
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 Income The price paid by your customer for any other charges will be posted 
to this income account. 
 

 

The COGS, (COGS) and Income postings occur at 
time of pickup of the job. 

 

13.8.2.3.7 QuickBooks Taxes Tab 

The Taxes tab is for identifying the vendors, or governmental body, to whom sales tax is paid.   
 

 
 
For each sales tax definition in The Edge: 
  
1. Select the tax. 
2. Select a tax vendor from the Tax “Vendor” drop-down list at the bottom of the window.  For each 

definition, select the vendor on file that you write the tax payable check to, e.g., Department of 
Treasury. 

3. Select OK.  

13.8.2.3.8 QuickBooks Misc Items Tab 

The Misc Items tab is used to associate each of your miscellaneous sales line definitions to a 
QuickBooks account.  Whenever you sell via a miscellaneous sale line, the amount is posted to the 
corresponding G/L account, and an offsetting amount is posted to accounts receivable.  Any tender is 
then in turn posted against the accounts receivable. 
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To associate an account: 
 
1. Select the desired miscellaneous category. 
2. Select an account from the QuickBooks Account drop-down list. 
3. Select OK. 
 

 

Unlike other features in The Edge, we cannot control what Misc Sale lines are used 
for in daily operations.  You may have some Misc lines setup as Credits (such as 
coupons or donations) that should be mapped to expense-type accounts.  Misc sale 
lines should typically be mapped to either an Income or Expense account.  If you are 
not sure, you should consult your accountant. 

 

Check the Inactive Box to map any Misc Charges that have been used in the past. 

13.8.2.4 QuickBooks Stores Tab (optional) 
If you operate The Edge in a multi-store environment with transferred records, you can associate each 
Edge store number with a QuickBooks Class.  Associating store number with a separate QuickBooks 
Class will provide additional definition on QuickBooks reports.  If you are unsure how to setup 
QuickBooks Classes or to find out if this is right for you, contact your accountant. 
 
Edge users in a single store environment need not set this up. 
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13.8.2.5 Mapping Payment Methods to QuickBooks 
Before point of sale activity is posted from The Edge to QuickBooks, all payment methods used in The 
Edge must be present as payment methods in QuickBooks. 
 
To align payment methods between The Edge and QuickBooks: 
 
1. From The Edge, select Administrative ► Credit Cards ► Set Up Card Types. 
2. Make note of the QuickBooks Name associated with each Payment Type needed (these will need to 

match the name on the payment method setup in QuickBooks). 
3. From QuickBooks, select List ► Customer Vendor Profiles ► Payment Methods. 
4. Right click to add a new or edit existing payment methods in QuickBooks. 

 
You must ensure that there is a payment method here for each credit card type in The Edge and that it 
matches the QuickBooks name provided in The Edge exactly (spelling and spacing are significant; 
upper/lower case is not).  

13.8.2.6 Set Start Date in QuickBooks 
Before you start posting from The Edge to QuickBooks, you must set a date that signifies the earliest 
date when detailed records inside The Edge should post to your QuickBooks company file. 
 
When choosing a QuickBooks Start Date, you should: 
 
• Discuss and coordinate this date with your accountant  
• Strategize starting balances with your accountant (up to this date). 
• Consider a date that is a start of a month 
• Consider the accuracy and completeness of the data to be posted (are you too new to The Edge) 
• Understand that data converted from a former system should not be posted. 

 

 

Setting a QuickBooks start date is a maintenance step that may take time.  Backup 
The Edge first and perform the operation while no one is using The Edge. 

 
1. Select Administrative ► QuickBooks ► Set Start Date.  The Set QuickBooks Start Date 

window will appear. 
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2. Select a Start Date from the date picker or enter the date. 
3. Select OK. 

13.8.2.7 Posting to QuickBooks 
Once you have completed setup, you can post the pending transactions that have been stored in The 
Edge to QuickBooks.  The first time you execute this function it may take considerable time to post, 
depending on the QuickBooks Start Date provided.  
 

 

Be sure to make a backup of your QuickBooks Company before your post from 
Edge to QuickBooks.  There is no way to reverse a posting from Edge to 
QuickBooks.  Backup is essential. 

 

Review all setup with your accountant and/or bookkeeper responsible for 
maintaining the accounts. 

After that initial posting, you should post to QuickBooks on a regular basis.  We find posting daily or at 
least several times per week is best as it keeps the posting process efficient which helps prevent 
communication errors between the two programs.   
 
To post to QuickBooks: 
 
1. Select Administrative ► QuickBooks ► Post to QuickBooks.  The Post to QuickBooks Now 

window will appear. 
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The Edge prepares a summary reflecting the number of entries, earliest dated entry and latest dated 
entry that are pending to be posted. If the summary looks accurate, move on with posting. 
 
To see a listing of the data pending to post, run a GL Report and check “Unposted Items” within the 
date range reflected in the summary. 
 

2. Select OK to post the entries. 

13.8.2.8 G/L Report 
The G/L Report details how The Edge interacts with QuickBooks.  It is a useful tool in analyzing how 
The Edge data is translated into debits and credits.  To use the G/L Report, you must first integrate The 
Edge with QuickBooks.  See the section entitled Mapping The Edge with QuickBooks Accounts, for 
more information on this process.   
 
To run the G/L report:  Select Administrative ► QuickBooks ► G/L Report.  The G/L Report 
window will appear. 
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Fields on this report filter include: 
 

Sales Number Allows you to specify a single sale number.  Useful for seeing how a 
particular transaction will post or has posted to QuickBooks. 

Old Sales # Allows you to specify an old sales number. 
Sale Date Allows you to specify a sales period. 
Sold To Allows you to specify a customer or group of customers. 
Sold By Allows you to specify a sales associate. 
Store Allows you to filter by store. 
Item Number Allows you to specify a single item number.  Useful for seeing how a 

specific item will post or has posted to QuickBooks. 
Station Allows you to filter by computer station. 
Group by   

Store Breaks down the report by store. 
Month Breaks down the report by month. 
Date Breaks down the report by date. 
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G/L Account Breaks down the report by the general ledger accounts in QuickBooks. 
Sale # Breaks down the report by each transaction. 
G/L Account Type Breaks down the report by account type, e.g., liability, payables, etc. 

Show Details Whether to show detailed information or just a summary. 

Page Breaks Whether or break to a new page by grouping options. 
Unposted Items Whether to include transactions that have not yet posted to QuickBooks. 
Posted Items Whether to include transactions that have already posted to QuickBooks. 
VOID Sales Whether to include sales that were voided. 
Sales Transactions Whether to display transactions made through point of sale. 
Inventory 
Transactions 

Whether to display changes made to the inventory (adding, deleting, etc.). 

Multi-Line Memo Whether or not to give a full (multi-lined) description of each transaction. 
Show Full G/L 
Account Name 

Check this box to see the entire QuickBooks account name, including the 
parent account name. 

 
The results might look as follows: 
 

 
 
Data fields returned on this report include: 
 
Date The date the transaction took place 
Sale # The sales number of the transaction 
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Item/Job # Additional reference number for this transaction.  This could be a sales number, 
item number, repair number, or special order number depending on the type of 
transaction involved. 

G/L Account The account in the QuickBooks General Ledger that this posted to. 
Credit The amount posted to this account as credit. 
Debit The amount posted to this account as debit. 
Memo Gives a description of this transaction. 

13.8.3 QuickBooks FAQs 
Do I need to buy QuickBooks? 
If you want to integrate The Edge and QuickBooks together, then you will have to buy QuickBooks; it is 
not included in the purchase price of The Edge.   
 
The QuickBooks integration is optional. The Edge is completely functional in the absence of 
QuickBooks and many stores elect to manually post to QuickBooks or another accounting program. 
 
What version of QuickBooks do I need? 
QuickBooks Pro or better, version 2006 or higher.  We recommend that you update to the latest available 
version of QuickBooks Pro, as the newer versions provide a richer programming interface. 
Periodically, changes are made in The Edge and/or QuickBooks which result in a required upgrade to 
QuickBooks.  We do the best we can to inform all Edge Users of such a requirement in advance. 
 
How many copies of QuickBooks do I need to buy? 
You must have at least one PC where both The Edge and QuickBooks are licensed to operate.  This is 
the PC where Set Up and Regular Posting is performed.  If you plan to use QuickBooks on multiple 
computers, you would likely need to purchase a multi-user license.  This is not a requirement for use 
with The Edge. 
  
How should I set up my chart of accounts in QuickBooks? 
You should set up your chart of accounts according to your accountant’s recommendations.  The Edge 
Support Team can send you a simplified chart of accounts, as an example. After you set up your 
QuickBooks chart of accounts, you will connect each of The Edge’s accounts to the corresponding 
account in your QuickBooks chart of accounts.   
 
How do I get support for QuickBooks? 
You get support for QuickBooks from Intuit, or perhaps some third-party support organization. Intuit 
provides a certain amount of free support with respect to getting your QuickBooks program installed, 
after which all support is fee-based.   
 
The Edge Support Team will provide basic guidance to you in order to setup integration.  Beyond setup, 
we provide support with the mechanical linkage between The Edge/QuickBooks to ensure the link 
between the two programs is functioning correctly.   It is important that integration is managed and 
understood by your bookkeeping staff and/or accountant who can assist you with true accounting 
decisions. 
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What about other accounting systems? 
We are committed to providing our customers with every advantage that we possibly can.  QuickBooks 
has about 80 percent of the small business accounting market, and Intuit provides excellent support for 
developers, so it was an easy decision to integrate with QuickBooks.  At this time there are no plans to 
integrate with other accounting systems.  This is subject to change. 
 
Should I integrate The Edge with QuickBooks? 
You should consider whether integrating will improve bookkeeping methods or save you time.  Here are 
a couple questions to ask yourself.  
• Is your bookkeeping done off site?  The Edge cannot post to an offsite QuickBooks file without the 

addition of multi-store software. 
• Is your bookkeeping done part time?  Part-time bookkeeping itself is just fine; it simply must be 

considered whether it would be efficient for your bookkeeping staff to learn the integration in order 
to maintain the books? 

 
When should I integrate The Edge with QuickBooks? 
Plan to integrate once you are comfortable that your staff is operating The Edge every day effectively.    
Also be certain you have completed The Edge New User Checklist.  Example: If you have recently 
converted from another software system, have you: 
• Completed a physical inventory?   
• Entered all starting receivable and credit balances? 
• Are all repairs, layaways, and special orders entered and pending with accurate deposits? 
 
What if I use The Edge in a multi-store environment but the businesses are separate tax entities? 
The Edge QuickBooks Integration operates under the assumption that all business postings are part of a 
single corporate tax entity.  The Edge employs the use of classes in QuickBooks to create some 
separation of store data, but this does not constitute a separate taxable business. 
We would advise against integrating with QuickBooks if you use The Edge multi-store setup for the 
convenience of transferring records between two separate businesses. 
 
How does The Edge Post to QB when I do the X (x represents what you are inquiring about)?   
No matter type function you are trying to understand, you can get your answer from The Edge GL 
Report. 
 

 

Find a day where you know a transaction of that type has occurred and run the GL 
report for that day only, with details.  If the transaction is from point of sale, you can 
choose the GL Report option Group By Sale # (uncheck other group options) to see 
the debits and credits organized sale by sale. 

 
What is the difference between Inventory Edge and Inventory QuickBooks? 
The relationship between Inventory Edge and Inventory QuickBooks is a common cause of question and 
confusion when unfamiliar with our integration.  Inventory Edge is the default asset account used to post 
all Inventory On-Hand that is entered into The Edge.  Inventory QuickBooks is a contra-asset account 
used to hold the credit side of new Edge inventory entered.  This credit is posted to QuickBooks and 
should be managed in QuickBooks as vendor bills are entered.   
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Example: In The Edge, items are entered with a cost value of the merchandise.   
The Edge knows nothing of bench supplies, co-op advertising, credits, shipping costs, etc.   
The Edge does not create the vendor invoice and has no direct link to Accounts Payable. 
 
So if you add a single item to inventory from an invoice to The Edge, and the cost is $1,000. 
The Edge posts a $1,000 debit to Inventory Edge and The Edge posts a $1,000 credit to Inventory 
QuickBooks. 
 
At some point later the vendor bill is added to QuickBooks; for this example, the invoice is $1,050.00 
($1,000 in inventory and $50 in shipping).  You must expense the $1,000 to inventory QuickBooks (to 
knock the balance in the Inventory Contra Asset Account back to 0).  Expense the $50 to shipping or 
whatever expense account appropriate. 

13.8.4 Common QuickBooks Errors  
Error:  This application has not accessed this QuickBooks company data file before. The 
QuickBooks administrator must grant an application permission to access a QuickBooks company 
data file for the first time.   
 

   
 
Cause:  The Edge does not have permission to access QuickBooks.  This may happen after updating The 
Edge. You will probably be prompted to give permission.   
 
Solution:  Follow prompts to give the highest permission available. See the section in The Edge User 
Guide entitled QuickBooks Setup. 
 
Error: “incMisc(accountName) is not set up” 
Cause: There is a new Miscellaneous Sale Line setup that is being used at point of sale.  This 
Miscellaneous Line is not associated with a QuickBooks account. 
Solution: Select Administrative ► QB ► Setup QB Integration ► MISC.  Then select and map the 
unmapped Misc. Line to an account in QuickBooks.  See the section entitled QuickBooks Misc Items 
Tab for complete details. 
 



The Edge User Guide v. 20.0.0.114 

688 USR-2020-017 14 January 2020 
© 2020 Abbott Jewelry Systems, Inc. 

Error: QBXML … There is an invalid reference to QuickBooks PaymentMethod “XYZ” in the 
ReceivePayment. 
 
Cause:  There is a payment method in The Edge that is not setup in QuickBooks.  This may result in 
duplicate deposits.   
 
Solution:  Add a Payment Method in QuickBooks with the exact QuickBooks name as the payment 
method in The Edge.  See the section entitled Mapping Payment Methods to QuickBooks for complete 
details.  Additionally, to remove duplicate deposits: 
 
1. Then, in QuickBooks, go to Banking> Make Deposits and deposit what you know to be real and 

factual. 
2. This puts a checkmark on all the entries in undeposited funds leaving the duplicates as unchecked. 
3. Go the chart of accounts and double click undeposited funds. 
4. Scroll to the bottom (for the most recent) 
5. Highlight the first UNCHECKED entry and press CTRL+D 
6. Repeat for all remaining duplicates. 
 
Error: GL Account “xyZ123” is not set up 
 
Cause: A feature in The Edge is not mapped to a GL account (often because integration is incomplete). 
 
Solution: Check the window at Admin ► QB ► Setup QB Integration and ensure every feature is 
mapped to a QuickBooks account.  See the section entitled Mapping The Edge with QuickBooks 
Accounts for complete details. 
 
Error:  QBXML Status: Code = 3171, Severity = Error, Message = An attempt was made to 
modify a General Journal transaction with a date that is on or before the closing date of the 
company. 
 
Solution:  You will have to remove the closing date in order to post. To remove it: 
 
1. From QuickBooks, select Edit then Preferences.   
2. Select the Accounting tab then select Company Preferences. 
3. Clear the closing date at the bottom.  
4. Once the information has posted you can set the date again. 
5. Check for duplicate deposits as described above. 
 
Error:  QBXML Status: Code = 3180, Severity = Error, Message = There was an error when 
saving a General Journal transaction.  QuickBooks error message: You may not create or edit a 
transaction dated on or before the dividing date. 
 
Cause:  You are trying to post to QuickBooks, but there has been an accountants' copy made.   
 
Solution:  The accountants' copy should be merged back into your company file or the restrictions should 
be removed.  Check for duplicate deposits as described above.    
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 Sign Formats 

13.9.1 Finding a Sign Format 
To find a sign format record: 
  
1. Select Administrative ► Sign Formats.  The Sales Sign Definitions window containing a list of 

previously designed formats will appear.   
 

 
 
Fields in the Sales Sign Definitions list include: 
Key The sign name. 
RxC The number of signs or labels across (R for row) and down (C for column). 
Line 1, Line2, 
etc. 

The content of the sign. 

13.9.2 Creating a New Sign Format 
To create a new sign format: 
 
1. To create a new sign layout, select Add from the Sales Sign Definitions window.  The New Sign 

window will appear.   
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The options shown here are The Edge defaults and are designed to work for the forms available 
from an Edge partner supplier.  Options for sign layout include: 
  
Sign Name The name for the layout for future use. 
Copy From Copies the information from another sign layout. 
Lines As if working down the page, takes the text and data to appear on each line of 

the sign.  Fields include: 
Line # The line for which content is being defined. 
Prefix Static text to appear at the beginning of the line.  For example:  Sale, 

Clearance, Reduced, etc. 
Data Variable data to appear after the prefix. 
Suffix Static text to appear at the end of the line.  For example:  Off. 
Format Options for how numerical data should be presented. 
Font Offers a standard font and color selection dialog for each line. 
Align Options for centering or justifying text on the line. 
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Form Layout Contains layout options: 
 
# Across:  The number of signs across the printed page 
# Down:  The number of signs down the printed page 
Page W:  The width of the page in inches 
Page Ht:  The length of the page in inches 
Cut Guides:  Whether to show cutting guides. 

 
 
 
 

Page Margins Contains options for margins around the outside of the printed page 
Sign Margins Contains options for margins between signs laid out on the page. 
 
Note that there is a preview of the sign based on the form definitions.  In addition, there is a scroll 
option on the Record Navigation Bar for easy access to other sign definitions, which can be copied 
and modified. 
 

2. Make changes to the default sizes or margins as desired. 
3. Begin composing content by selecting a line number. 
4. Enter text for the prefix to the data that might appear on the line. 
5. Select the type of data to appear from the drop-down list:  Retail, Price, or Discount. 
6. Enter text that would follow the data. 
7. Select a format for the data.  For example, for a monetary amount, do you want a dollar sign to 

appear, do you want only whole dollar amounts or cents, too? 
8. Select a font using the font dialog.  Remember, it just applies to the current line. 
9. Select an alignment:  left, right, center, fit.  Fit will cause the system to override the 

value set in the font dialog and make the text fit on the line. 
10. Select a new line number and repeat steps 3 through 9 for each line of text.  
11. To quickly move from line to line, click on that line on the small preview window. 
12. Select a save option from the Record Navigation Bar.  

 

 

Once sign formats are defined, they can be employed by selecting a format from 
Admin ► Start a Sale or Categories ► List ► Edit ► Pricing ► Automatic 
Markdown. 

13.9.3 Editing a Sign Format 
1. Locate the sign record as described above. 
2. Select the record and select Details.  The Sign window will appear as shown above. 
3. Make changes to the fields and select an option from the Record Navigation Bar.  
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 Rewards Program 
This section describes The Edge Reward/Referral program, which helps you avoid discounting, retain 
valued customers, and acquire new customers. The Edge Reward/Referral Card Program is an extension 
of the Tender Card feature, and uses the same kind of tender card media for these two new purposes.   
 
For a video tutorial about the Rewards and Referral programs, go to 
http://www.screencast.com/t/2nzjGmVi. 

13.10.1 Rewards vs. Referral Cards 
Rewards cards are designed as an incentive to encourage repeat sales to existing customers. Rewards 
cards increase in value each time a qualifying purchase is made; that value can be used towards a future 
purchase.  Rewards cards can be issued to customers at the store owner’s discretion.  
 
Referral cards serve a purpose in addition to functioning as a rewards card. Referral cards are preloaded 
with a dollar value and given to good customers to give to their circle of friends and relatives who have 
the potential to become customers. Referral cards can only be used by new customers. The preloaded 
dollar amount is an inducement to get potentially good customer to visit your store. Referring customers 
are rewarded when referred customers spend a predetermined threshold amount. Referral cards are a 
great way to add qualified buyers to your customer base. 
 
Low cost of customer acquisition, increased sales, and less discounting are three great reasons to 
consider this feature. 
 

 
 
In the above illustration, you see that we are issuing a reward card to an existing customer, with a $25 
initial value, and also two $50 cards for him to give away. 
 
 
 
 
 
 

http://www.screencast.com/t/2nzjGmVi
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13.10.2 Rewards Set Up 

13.10.2.1 Rewards Default Settings  
While System Options enable how The Edge operates, default settings define typical use of the 
Rewards/Referrals Program.  Reward and referral settings are set up from the Administrative menu.  
There are three areas in which to set up rewards and referrals:   
 
• Rewards/Tiers 
• Assign Customer to Tiers 
• Referral Program. 

13.10.2.2 Creating Rewards Types and Tiers 
To set up rewards and tiers:  
 
1. From the Administrative menu, select Rewards Program ► Rewards/Tiers.  The Reward Card 

window will appear listing tier types.  Tiers are reward levels, such as Gold, Platinum, etc.  Tiers 
can be set up to define a category of sorts for rewards.   

 

 
 
2. To add a tier, select Add….  The New Rewards Tier window will appear with the General tab 

open. 
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Fields and options in the General tab include: 
 
Tier name Enter a name for the tier being defined. 

Rewards Initial 
Amount 

The value that is initially on the rewards card for this tier when it is 
activated.  At point of sale, you can change the value when activating a 
card; however, if it is over the maximum set in System Options, an 
override will be needed.  If a card is activated at point of sale as a rewards 
card, this value is used.  But if the card is activated as a referral card, then 
the referral initial amount is used.   See the Referrals section below for 
more information. 

Earns Rewards 
Until 

The date at which cards in this tier stop earning rewards.  We recommend 
using a rolling 365-day limit. 

Referral Card 
Expiration Date 

The date at which cards in this tier are no longer redeemable.    We 
recommend using a rolling 365-day limit. 
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Set as Default Tier Sets the selected tier to be the default for all new reward cards issued 
going forward. 

Memo A text field that allows you to enter any notes you may have. 

Start Bonus Allows you to set an additional reward percentage on specific items, for a 
specific date range, using the item filter.  

 

To add bonus rewards on all qualifying items, leave the 
item filter blank. 

 

End Bonus Allows you to cancel or stop any active rewards bonus. 

 

If you’ve made a mistake setting up bonus rewards, end 
bonus makes it easy to cancel that bonus and start over. 

 

 
3. Complete fields in the General tab as desired. 
4. Select the Inventory tab.    
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Fields and options in the Inventory tab include: 
 
Inventory Enabled Enables the option to specify which inventory earns rewards. 
 
Customer Earns… The values that are used to calculate how much a customer earns in 

rewards for every unit of money spent.  For instance, if a customer 
can earn .06 for every dollar spent, on a $21.00 sale, the customer 
would earn $1.26 in rewards. 

 
Minimum Price The lowest amount for which an item sold can accrue rewards.  The 

$21.00 item would earn rewards if the Minimum Price is set to 
$20.00. However, if Minimum Price is set to $25.00, the $21.00 
sale would not earn rewards. 

Max Item Discount The maximum percentage that an item can be discounted and still 
count towards the rewards program.  This is calculated by taking 
the price for which the item is sold and comparing it with the retail 
price.  If an item has a retail price of $100.00 and it is sold for 
$70.00, the discount would be 30 percent.   
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Print Summary The Print Summary button allows you to print the tier’s settings 
for reference.  

Category Filters Only available for the default tier.  If enabled, allows you to select 
which categories pay out rewards.  If you check the box, the items 
in this category will pay rewards.  If you uncheck the box, it will 
not pay rewards.   

Vendor Filters Only available for the default tier.  If enabled, allows you to 
indicate that items from specific vendors pay out rewards.  If you 
check the box, the items from this vendor will pay rewards.  If you 
uncheck the box, it will not pay rewards.  

 

For filters, if you want to select all or none, right click and select Check All or Check 
None. 

 

If you’re using both category and vendor filters, an item will only receive rewards if 
both the vendor and category for that item are marked selected for the rewards 
program. 

 
5. Complete fields in the Inventory tab as desired. 
6. Select the Services tab.   
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The Services tab functions the same as the Inventory tab but allows rewards to be paid out on 
specified repairs, custom jobs, and appraisal service. 
 

7. Complete fields in the Services tab as desired. 
8. Select OK/Save & Close. 
 
Add additional tiers if you plan to reward customers at different levels.  For example:  
 
• Tier 1 may pay $.03 for every 1.00 spent 
• Tier 2 may pay $.05 for every 1.00 spent. 
 
When adding a new tier, the same field definitions apply except the category and vendor filters.  
Category and vendor filters are specified under the default tier only. The same category and vendor filter 
applies to all rewards tiers. 

13.10.2.3 Assigning Customers to Tiers 
Customers can be reassigned to different tiers at any time.   Tier assignment will appear on the customer 
record Rewards tab so it is easy to see when the level of rewards was changed.  To assign existing 
customers to tier levels:  
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1. From the Administrative menu, select Rewards Program ► Assign Customers to Tiers.   The 

Assign Tiers window will appear. 
 

  
 

2. Use the Customers field to filter and select the customers to assign. 
3. Use the Rewards Tier drop-down menu to select the tier to which the selected customers should be 

assigned. 
4. Select Assign.  A list of customers meeting the filter requirements will appear.  
5. Check the customers to assign. 
6. Select OK.  A confirmation dialog will appear. 
7. Select OK. 
8. Close the Assign Tiers window by selecting Done. 

 

 

When selecting customers whose tier you wish to change, consider utilizing the 
Group / Mailing List button in the bottom left to save these customers to a mailing 
list so they can be notified of the tier change. 

 
 

 

When rewards assigning tiers, if no customer filters are set, a confirmation asking 
if you wish to assign all customers will appear. 

13.10.2.4 Referral Cards 
To work with referral cards: 
 
1. From the Administrative menu, select Rewards Program ► Referral Program.   The Edit 

Referral Card Settings window will appear with the General tab open. 
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2. Because this is the setup area, the card number is not applicable.  These settings will be applied to 
each newly issued card as the default. 

3. Select a redeem rewards date from the Referral Card Expiration Date drop-down menu.   
4. Select the Referrals tab. 
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Fields and options in the Referrals tab include: 
 
Referrals Enabled Allows you to enable the referrals feature. 
Applies to purchases 
up to 

The date until which the referral card generates referral bonus money 
to the referrer.  The referee can only use the referral one time.  After 
that, the card becomes a rewards card for the referee. 

Referral initial amount The amount that is initially on the referral card.  This value is different 
than the rewards initial amount.  If a card is activated at point of sale 
as a referral card, the value set here is used.  If a card is activated as a 
rewards card, the rewards initial amount is used.  If a card is activated 
through Customers ► Rewards ► Activate, this value is used as the 
initial amount if the referrals are enabled. 

Referrer earns The amount that the referring customers will earn as a credit memo 
when the customer has spent the allotted amount as set in the next 
field. 

When customer 
purchases… qualifying 
items totaling 

The allotted amount that must be spent by the referred customer in 
order for the referring customer to earn a credit.  This value can be set 
to 0 if you just want to pay a referral credit out for anyone that comes 
in and uses the card. 
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Sale Types Allows you to filter what types of sales count towards the qualifying 
items totals.  Example: If you want to include repairs, not just 
inventory.  Checking All Tender will disable filtering by sale types. 

13.10.3 Activating Rewards Cards 
There are two ways to activate rewards and referral cards:  Through point of sale and through the 
Rewards menu. 
 

 

Only one original value will be used for the card.  Initial amounts are now locked on 
records.  If for some reason they need to be unlocked and changed, which we 
strongly advise against, the supervisor menu has a lock and unlock function for the 
original amounts on it.  

13.10.3.1 Scan New Rewards/Referral Card at Point of Sale 
The easiest way to activate a new card at point of sale is to scan it.  It is not necessary to select any 
buttons before scanning the card.  Note that the prefix numbers in the card indicate whether it is a 
Reward Card or Tender Card.  If you have not specified prefixes in System Options for reward cards vs. 
tender cards, then a prompt to indicate what type of card you want to activate. 
 

 
 
After you make your selection (or immediately after scanning, if you have specified prefixes), a Reward 
Card or Tender Card line will be added to the sale.   

13.10.3.2 Using the Activate Card Button 
1. From the Point of Sale window, select the Sell/Activate Card option.  The Sell/Activate a Card 

window will appear.  
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2. Scan the card or type in the card number.  
3. If prefixes that specify card type are set in System Options, you can proceed with entering the 

value.  If not, you will be prompted to select the card type (if necessary), and select OK, then a line 
will be added to the sale.   
 

 
 

 

• If the rewards card is already active, an error message will appear.  
• If the customer to whom you are trying to assign the rewards card already has a 

rewards card, you will be prompted to consolidate the rewards to this new card; 
the old card will become inactive.  

• If you are assigning a new rewards card, you cannot ring out any merchandise or 
services on the same transaction. 

 
4. The initial amount/bonus amount will be taken from your default setup and added to the resulting 

sale line.  Otherwise, enter the card value. 

13.10.4 Accruing Rewards 
At point of sale there is a rewards button that appears up by the customer’s name.  This will bring up a 
picker that shows all the sale items that qualify for rewards and the amounts that would be earned.  If 
you want to exclude some item on the sale from earning rewards, uncheck the box next to the item and it 
will not earn rewards.  
 
To adjust a customer’s rewards amount, go to the customer record and adjust the balance.  This will 
write out a history row for traceability.  
 
After loading a customer at point of sale, you can select Rewards and the form title will have his or her 
balance in it. 

13.10.4.1 Identifying the Customer at Point of Sale 
Rewards are accrued by identifying the customer via his reward card.  This can be done by scanning the 
card at point of sale.  Instead of searching for the customer record, you can scan the customer’s reward 
card.  The customer will be identified, and the Tender/Reward card window will appear showing the 
card balance and also any notes you may have added to the card record.  You can dismiss the pop-up 
window by selecting Cancel or by pressing the ESC key on your keyboard. 
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Note that if this is a referral card, and this is a new customer, then of course the card will not 
automatically identify the customer, but, having scanned the card, you can see who the referrer was and 
the balance on the card.  As soon as you enter the new customer, the card will be associated with that 
customer and the customer can be automatically identified by the card on the next visit. 
 
Whenever a rewards card is associated with the current sale, the card number will appear above the 
customer name as shown below.  Notice that the Rewards button appears, indicating that the customer 
has rewards available. 
 
 
 
If a rewards card is issued to a particular customer, then that customer will accrue purchase rewards 
every time they make a qualifying purchase, whether or not they present the card at each visit.  Each 
qualifying item on the receipt will indicate the reward earned. 
 

 
 

If you have selected the option to show balances on receipts, then reward card balances will be included 
in that section. 
 

 
 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 705 
© 2020 Abbott Jewelry Systems, Inc. 

13.10.5 Redeeming Rewards 

13.10.5.1 Purchase Rewards 
Because purchase rewards are posted to a specific rewards card, the only way to spend the reward is to 
take the reward card as tender. 

13.10.5.2 Referral Rewards 
Because referral rewards are posted to the referring customer’s credit memo account, the only way to 
spend referral rewards is to use the customer’s credit memo account as tender. 

13.10.6 Rewards Program Reporting 

13.10.6.1 Customer Statements 
Referral awards show up on the referring customer’s statement under the credit memo account.  The 
credit will be identified as to who the new customer was. 
 

 

13.10.6.2 Rewards-Specific Reports 
Rewards-specific reports are not yet implemented.  The resulting list from the Find function will serve 
until reporting is implemented. 

13.10.7 Administrative Rewards Functions 

13.10.7.1 Find Card Records 
To look up the details of one or more reward/referral card: 
 
1. From the Customer menu, select Rewards ► Find.  The Find window will appear. 
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Fields and options in the Find Rewards Card window include: 
 
Card # Returns a card specified by typing in the number or scanning the card. 

Referred By Returns records of referral cards by the customer who had them to give away. 

Issued To Returns records of cards according to the customer to whom they were issued. 

Used By Returns records of cards according to the customer who redeemed them. 

Date Activated Returns cards activated during a specified date range. 

Date Used Returns cards used within a specified date range. 

Expires Returns cards set to expire during a specified date range. 

Redeem By Returns cards that must be redeemed by a specified date range. 

Memo Returns records that have a keyword in the memo. 

Include Returns cards that have a balance.  

Tier Returns cards that fall into a specified tier. 

2. Complete the filters as desired. 
3. Select OK.  A list of matching card records will appear. 
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4. Select the record with which you wish to work.   
5. Double click or select Edit.  The Edit Rewards Card window will appear. 
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The General tab shows the use of the card.  The Inventory, Services, and Referrals tabs break 
down what the customer should earn for each type of sale.  Note the defaults will be used unless 
otherwise specified. 
 
The History tab shows when the card was used at point of sale.  Both qualifying purchases and 
redemptions are listed.  To see qualifying purchases, select See Item or See Sale.  Note that See 
Item is not enabled for redemptions because redeeming rewards is treated as tender and is not 
strictly associated with the item or items that were purchased with the reward. 
 

6. Make changes as needed and select a save option. 

13.10.7.2 Rewards Supervisor Functions 
Below are procedures for some common supervisory functions.  

13.10.7.2.1 Balance Adjustments 

Reward card balances can be adjusted on the Customer Edit window in the Balances tab, just like any 
other balance. 
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13.10.7.2.2 Void a Card 

To void a card, adjust the balance down to zero, then remove the customer name. 

13.10.7.2.3  Replace a Lost or Stolen Card 

To replace a lost or stolen card, select Replace from the Supervisor menu.  

13.10.7.2.4 Merge Cards 

To merge two cards, void one of them as above, and then adjust the balance of the other card. 

13.10.8 QuickBooks Integration of Rewards Cards 
Referral rewards are immediately credited to the referring customer’s credit memo account.  As such, in 
your General Ledger, it will be posted as a liability in your account that corresponds to our Liabilities ► 
Store Credits account. This will be offset by an expense in your account that corresponds to our 
Expense ► Referral Fees account. 
 
Purchase rewards are not a true liability as they are only a promise of a future discount (one that can 
expire), similar to a coupon. As such, purchase rewards are not posted to the General Ledger until they 
are redeemed. When a customer redeems a purchase reward, it will be posted as an expense in your 
account that corresponds to our Expense ► Rewards account.   
 
For more about mapping to QuickBooks, see the section entitled Mapping The Edge with QuickBooks 
Accounts.   
 
It is strongly recommended that you make an appointment with support@ajsllc.com to adjust your 
Edge/QuickBooks setup for the rewards program. 

13.10.9 Rewards Program FAQs 
Should I buy different media for my reward cards vs. my tender cards? 
We strongly recommend it. Even though tender cards and rewards cards use the same type of media, 
they operate quite differently, and it is important for both you and your customers to be able to 
distinguish between them. 
 
If for some reason you must use a tender card as a reward card, please consider identifying the reward 
card with some permanent mark, such as an unusually shaped hole punch. 
 
What if somebody returns an item? 
If the item was bought with rewards, the rewards will be returned to the rewards card of the customer 
returning the item.  If the item earned rewards, the rewards will be removed from the card they were 
awarded to. 
 
What if I void a sale? 
Whatever effect the sale had on rewards will be undone. 
  

mailto:support@ajsllc.com
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 Notifications 
Customers can be notified via email or text message of completed services, such as repairs, special 
orders, or appraisals.  Customers can opt to receive notifications of completed services via email or text.  
No need for associates to manual calls and no need for your customers to call you.  Take advantage of 
electronic notifications for the convenience of your customers.  For example, rather than tell a customer 
to come back in an hour, you can tell them you’ll send an email or text when his or her order is ready. 

13.11.1 Configuring Email Settings for Notifications 
Email and test message notifications require setup.  The Edge must be configured to use the email 
settings associated with your store email account.   The fields marked with an asterisk below are specific 
to your email account.  You should contact your email vendor or ISP (Internet service provider) and ask 
them specifically for this information.  
 
To configure email settings to your SMTP server for Notifications: 
 
1. Select Administrative ► Email Settings ► Notifications.  The Outbound Email Server Settings 

window will appear. 
 

 
 
Fields to be completed in the Outbound Email Server Settings window include: 
 
From Name The name that you want to appear as the sender of the receipt.  This 

will probably be your store name. 
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From Email The email address from which the receipt is being sent.  This will be 
your store email account. 

SMTP Server* The outbound server as provided by your email provider.  It will 
probably be an SMTP account. 

Port #* The port number with which your email interacts. 
Server Requires SSL* Whether the outgoing server requires a secure socket layer. 
Server Requires 
Authentication* 

Whether the outgoing server requires authentication. 

User ID* The email account’s user ID. 
Password* The password for the email account. 

13.11.2 Configuration of Text Message Settings 
You can send notifications by text message to customers.  Text messaging is a feature that must be 
activated by The Edge Customer Support.  To use text messaging for notifications, contact 
admin@ajsllc.com.  If you sign up, you’ll be issued a new license, and then you need only enable the 
feature. 

13.11.3 Email Administration 
Before you can begin setting up and sending emails, you must configure the email function. For more 
information, see the section entitled Configuring Email Settings for Notifications.  Also, you must define 
the content of these items is described in the section entitled Email Headers and Footers. 
 
For email notifications, for each kind of service notification, you can select the header, footer, subject 
line, and greeting to automatically populate emails.  To do so: 
 
1. Select Administrative ► Notifications ► Email Administration.  The Email Administration 

window will appear. 
 
 
 

mailto:admin@ajsllc.com
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2. Select the email notification type from the drop-down window: 
 
• Receipt 
• Repair Done 
• Custom Job Done 
• Appraisal Done 
• Special Order Done 
• Wish List Saved 
• New Appointment 
• Today's Appointments 
• Wish List Being Emailed. 
 

3. For each of header, footer, subject, and greeting, select the content as desired (the content for each 
of these must be created as described in the section entitled Email Headers and Footers and the 
section entitled Email Subjects and Greetings). 

4. Select Preview to see how the resulting email will appear.   
5. Go back and make changes as needed. 
6. Select OK/Save and Close. 

13.11.4 Email Headers and Footers 
To create the content of headers and footers: 
 
1. Select Administrative ► Notifications ► Email Headers and Footers.  The Email Headers and 

Footers window will appear. 
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2. Select Add.  The Edit Email Header window will appear. 

  

 
 

3. Enter a meaningful name in the Title field. 
4. Enter a description of the header or footer in the Description field. 
5. Enter the content of the header or footer in the Input field.  For example, you may want each email 

to go out with header at the top that reads, "Your receipt from today's purchase."  Or a footer that 
reads, "Thank you for your business."   

6. Repeat creation of these headers and footers for all email scenarios as listed in the section entitled 
Email Administration.   

7. Select OK/Save and Close. 
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The new header or footer will appear in the Email Administration window to be assigned to an email 
type. 

13.11.5 Email Subjects and Greetings 
Subjects appear in the subject line of an email.  Greetings allow you to enter a salutation or greeting to 
the email. To create automated subject lines and email content: 
 
1. Select Administrative ► Notifications ► Email Subjects and Greetings.  The Email Subjects 

and Greetings window will appear. 

 
 

2. Select Add.  The Create new email subject or greeting window will appear. 
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3. Enter a meaningful name of the subject or greeting in the Title field. 
4. Enter a description of the subject or greeting in the Description field. 
5. Enter the text for the subject or greeting in the Text Input field.  
6. Select whether this is a subject or greeting. 
7. On the right is a drop-down menu to select the Message Type.  When you select a message type 

here, the available merge fields listed in the Notification Type Merge Fields will be populated with 
data fields appropriate for that notification.   

8. Select merge fields from Notification Type Merge Fields and select Insert.  The appropriate data 
for the transaction or customer will be dropped into the notification when it is sent. 

9. Notice the system default is provided; this is what will be used if you don’t create any messages. 
10. Select OK/Save and Close.  The subject or greeting will now be available in the Email 

Administration window. 

13.11.6 Text Message Administration 
To choose what messages to associate with types of notifications: 
 
1. Select Administrative ► Notifications ► Text Message Administration.  The Text Message 

Administration window will appear. 

 
 

2. For each of Repair Done, Custom Job Done, Appraisal Done, Special Order Done, and New 
Appointment, select whether to use the system default message, or a pre-defined message.   

To define messages, see the section entitled Text Messages. 
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13.11.7 Text Messages 
To define text messages for use in the Text Message Administration window: 
 
1. Select Administrative ► Notifications ► Text Messages.  The Create New Text Message 

Notification window will appear. 

 
 

2. Enter a meaningful name of the message in the Title field. 
3. Enter a description of the message in the Description field. 
4. Enter the text for the message in the Text Input field.  
5. Be sure to select what kind of notification with which this is to be associated from the Notification 

Type drop-down menu.  This will populate the Notification Type Keywords with those appropriate 
to the notification type. 

6. Use the Insert option to enter variable information such as your store name, the date, the envelope 
number, the number of jobs done, the number of repair jobs done, the number of jobs not done, etc. 

7. Notice the system default is provided; this is what will be used if you don’t define any messages. 
8. Select OK/Save and Close.  The subject or greeting will now be available in the Email 

Administration window. 

13.11.8 Best Practices for Notifications 
When setting up email or text message notifications, you’ll want to consider what happens when a 
customer replies or tries to call the cell number.  When setting up your email and text headers, footers, 
and default messages, you might consider indicating that the email or number is not monitored.   
 
To find a job or appraisal by notification data, see the section entitled Service Job Notifications.   
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 ZIP/Postal Codes 
The Edge uses ZIP Codes in the USA and Postal Codes in Canada.  The ZIP/Postal Codes function 
offers a way to update the ZIP/Postal Code database automatically at your convenience. 
 
To update ZIP/Postal Codes: 
 
1. First, download the zip code file from http://www.edgeuser.com.  It can be found under Downloads 

► DataDownloads.  Use the Save As option when prompted by Windows.  Be sure to make a note 
of where you save the file.   

2. Select Administrative ► ZIP/Postal Codes ► Import File.  You will be prompted to provide a 
file to import. 

 

 
 
3. Locate the file saved in step 1 and select Open.  The Import Status will appear. 
 

 
 
4. When the download is complete, a confirmation dialog will appear. 

 

There are significantly more postal codes in Canada than ZIPS in the USA 
(855,000 vs 43,000).  For this reason the Canadian Postal Code import will take a 
long time to complete, particularly if you are running an Access database.  
Consider performing this import procedure overnight. 

 

http://www.edgeuser.com/Downloads/DataDownloads.aspx
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To delete the ZIP/Postal Code file:  
 
1. Select Administrative ► ZIP/Postal Codes ► Delete All.   
 

 

Selecting OK will cause the ZIP/Postal Code file to be deleted without further 
confirmation. 

2. To proceed, complete the Need Override fields and select OK.  The ZIP Code file will be deleted. 
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 Task Automation Rules  
Task Automation Rules give you the ability to create rules that will automatically generate tasks when 
trigger conditions are met.  This allows you to create task workflows.   
 
Many triggers include filters that let you specify additional criteria.  For instance, the Inventory Sold 
trigger includes an item filter that allows you to set specific item parameters.   
 

 

Task Automation Rules are not compatible with Microsoft Access databases.  You must be 
running a SQL database. 

13.13.1 Create Rule 
To create a rule: 

1. Click Administrative > Tasks > Automation Rules.  The Automation Task Rules list will 
appear. 

2. At the bottom, click Add Rule.  This will open the Automated Tasks Wizard.  

3. Enter a Name for this rule and click Next.  Note if you are a multi-store user you will also need 
to choose a Store. 
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4. Choose the type of trigger and click Next. 

 

5. Click the Triggers drop-down to see available triggers for this type.  After selecting a trigger, 
use the drop-down below it to open the filter.  The filter will vary depending on the type of 
trigger, e.g. Inventory Sold will include an item filter that lets you specify inventory criteria.   

 
 

6. After defining criteria, click OK to save the filter and then click Next. 
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7. At the top of this window, choose the associate for this task.   

 
Assigned Associate will use the associate that triggered the rule. For example, if this is an 
Inventory Sold rule, Assigned Associate would be the person who rang out the transaction.  
Use Specific Associate if you always want to assign the task to the same person 

8. Use the bottom half of this window to specify whether you want this task to use a Due Date or 
Start Date, then choose how many days or months out you want that date to be.  If using a 
Start Date, use the bottom field to specify how many days between Start and Due Date.  Click 
Next when done. 

9. Finally, enter the task details and Finish adding the rule. 

13.13.2 Edit a Rule 
Existing rules can be edited at any time.  Note that this will not update any tasks that were already 
generated by this rule. 
To edit a rule: 

1. Click Administrative > Tasks > Automation Rules.  The Automation Task Rules list will 
appear. 

2. Select the rule you want to edit and click Edit Rule.  Alternatively, you can double click on the 
rule. 

3. Step through the wizard by clicking Next and make any desired changes. 
4. Complete the wizard by clicking Finish at the end. 
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13.13.3 Delete a Rule 
Rules are never truly deleted.  Instead, they get marked inactive and will not show in your list unless you 
check Show Deleted at the bottom.  Note that deleting a rule will not delete any tasks that it already 
generated. 
To delete a rule: 

1. Click Administrative > Tasks > Automation Rules.  The Automation Task Rules list will 
appear. 

2. Select the rule you want to delete and click Delete Rule. 
3. You will see the rule turns red and the Is Active column will change to No. 

13.13.4 Un-Delete a Rule 
To un-delete a rule: 

1. Click Administrative > Tasks > Automation Rules.  The Automation Task Rules list will 
appear. 

2. Check the Show Deleted box at the bottom. 
3. Double click or edit the rule you wish to make active again. 
4. Click Next all the way until the wizard completes.  Once you click Finish the rule will be active 

again. 

13.13.5 Examples 
Thank you on new purchases 

Rule New purchase – thank you 

Trigger Type Sale Committed 

Trigger Inventory Sold 

Filter Item Filter General tab 
Defaults (all blank) 

Type & Status tab 
Pricing Methods: Item 
Pricing 
Inventory Type: Inventory 

Task Associate The Assigned Associate 

Date Adjustment 7 days 

Task Details Thank you follow up on new purchase 
 
 
Notify customer repair ready 

Rule Repair ready – notify customer 
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Trigger Type Repair or Custom Job Change 

Trigger Repair Marked Done 

Filter Job Filter General tab 
Job Type:  Repair 

Status/Dates 
tab 
Defaults (all 
dates) 

Task Associate The Assigned Associate 

Date Adjustment 0 days 

Task Details Repair ready – notify customer 
 
 
Engagement ring 6 month inspection/cleaning follow up 

Rule Engagement Ring – 6 month inspection/cleaning 

Trigger Type Sale Committed 

Trigger Inventory Sold 

Filter Item Filter General tab 
Category: 100 

Type & Status tab 
Inventory Type: 
Inventory 

Task Associate The Assigned Associate 

Date Adjustment 6 months 

Task Details 6 month engagement ring follow up – offer inspection/cleaning 
 
 
New customer referred, thank referrer 

Rule New customer referral – thank referrer 

Trigger Type Customer Change 

Trigger Customer Created 

Filter Customer Filter Rewards/Referral tab 
Has Been Referred 

All Other Tabs 
Defaults 

Task Associate The Assigned Associate 

Date Adjustment 0 days 

Task Details New customer referral – thank referrer 
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New repair needs to be completed 

Rule New repair needs to be completed 

Trigger Type Repair or Custom Job Change 

Trigger Repair Created 

Filter Job Filter General tab 
Job Type:  Repair 

Status/Dates tab 
Defaults (all dates) 

Task Associate Specific associate:  your jeweler 

Date Adjustment 0 days 

Task Details New repair needs to be completed 
 
 
Care plan annual follow up 

Rule Care plan sold – annual follow up 

Trigger Type Sale Committed 

Trigger Care Plan Sold 

Filter Item Filter General tab 
Defaults (all blank) 

Type & Status tab 
Defaults  

Task Associate The Assigned Associate 

Date Adjustment 12 months 

Task Details Care plan sold – annual follow up 
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 Import Images 
The Import Images wizard allows you to mass import images from a vendor.  These images are then 
matched to your inventory based on the style number.  Note that this only works if the images are named 
after the vendor’s style number. 
 
To use this wizard: 

1. Click Administrative ► Import Images.  The Import Images Wizard will appear. 

 
2. Click Next.  Use the top drop-down to select the folder containing your vendor images.  Use the 

bottom drop-down to select the folder to save the images (this defaults to your Edge photos folder). 
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3. Click Next.   

 
 

Vendor Use this drop-down to select the vendor for these images. 

When savings images Append to Current will add new images and keep any existing.  
Overwrite All will remove existing images and add new (images 
are removed from Edge, but not deleted from your computer). 

Make Image Primary When appending, check this to make the newly imported image 
the primary. 

If the style code starts with 
the file name then add 
images 

Check this to match images of the beginning of the file name 
matches the beginning of the vendor style (e.g. file 12345.jpg 
would match to style 123456-14K-WG). 

4. Specify your criteria and click Next.  The software will compare the images to the items in your 
database and display the number of matches found. 

 
5. Use the Import Images button to import the matching styles.  Depending on the number of images 

this may take a few minutes to complete. 
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 Manage Reports Menu 
Memorized reports appear in the Reports window navigation bar.  By default, reports will be saved at 
the bottom of the Reports menu for that report section.  For example, if you created a report based on 
any of the Activity reports, your memorized report will be saved at the bottom of the Activity reports 
list.  To change how those items appear and manage other settings: 

1. Select Administrative ► Manage Reports Menu.  The Manage Memorized Reports window 
will appear. 

 
 

The hierarchy of reports shown will mirror what is shown in the main Reports window.   Also 
notice that the reports you created are in italics.  What you arrange here is what will appear in the 
Reports window.  Options in the Manage Memorized Reports window include: 

Expand Expands the hierarchy to show the whole list of reports. 
Collapse Collapses the hierarchy to show only the top-level list. 
New Group Allows you to create a new category of reports. 
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Add Run All 
Button 

Allows you to add a button to the Reports menu to run all reports in that 
section. 

 

The Run All feature may constitute a lot of reporting and 
will consume system resources for some time. 

 

Deactivate/Activate Allows you to mark the report inactive or active according to whether you 
want it to appear in the Reports window.  If you select Deactivate, it will 
be saved, so you can mark it active at a later time. 

Delete Deletes the report.  A backup file will be saved; this can be used to 
reactivate the report using Import option described below. 

Properties Shows the settings for the button, but does not permit editing of the report 
filter. 

Supervisor Provides options such as: 
 
• Import Memorized Report:  Allows you to import memorized reports 

exported by The Edge or other stores.   This also allows you to recover 
a deleted report. 

• Export Memorized Report:  Allows you to export memorized reports 
for use in sharing with other stores. 

• Reset to Program Defaults:  Returns the Report menu to those 
initially provided with The Edge. 

Move Up/Move 
Down/Move 
Left/Move Right 

Allows you to move the memorized report button relative to others in the 
hierarchy.  For example, to place a button in the Activity report section, 
move it up to the Activity section, select Move Right or Move Left to 
position it under a different level. 

Revert Reverts the hierarchy to the state it was in since the last save. 
Save/Close Saves the changes made to hierarchy and closes the window. 
Cancel Closes the window without saving changes. 

 

2. Make changes to the structure as desired and select Save/Close.  The Report will reflect that 
structure. 
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To erase memorized reports and go back to the pre-packaged reports, select 
Administrative ► Manage Reports Menu ► Supervisor ► Reset Reports to System 
Defaults. 

13.15.1 Creating Groups of Reports 
To create a group of reports to run regularly: 
 
1. Create reports to be run in the group.  For each one, decide whether they should run without further 

filtering using the Run Report without a User Interface option. 
2. Using the Administrative ► Manage Reports Menu, select Create Group. 
3. Name the group as desired. 
4. Using the Move Up/Move Down/Move Right/Move Left buttons, move the group to the desired 

location in the hierarchy, then move the newly memorized reports under the group. 
5. Optionally, add a Run All button under the group.   

 

 

The Run All command will apply to the group under which it is located.  If it is at the 
top of the hierarchy, it will run ALL! 

13.15.2 Changing Report Button Properties 
To change memorized report button properties (not report filters): 
 
1. Using the Administrative ► Manage Reports Menu, select the report and select Properties. 
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2. Make changes as needed and select OK. 
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 Care Plan Administration 
The Edge has integrated jewelry care programs for you to offer your customers at point of sale.  The true 
beauty of these programs is that there is no up-front cost to you. 

13.16.1 Program Coverage 
Programs are offered by type of merchandise:  jewelry and watches.  These vary by provider, however.  
See your contract with your provider for details. Note that The Edge offers associated plans based on the 
item’s category.  See the section entitled Care Plan Category Options.  For more about working with 
categories, see the section in The Edge User Guide entitled Categories 
(http://docs.edgeuser.com/NetHelp/Documents/categories.htm). 

13.16.2 Licensing 
Here’s how to get started: 
 
1. Contact The Edge Customer Service team at service@ajsllc.com.  
2. You’ll be referred to a care plan provider who can license you for one of The Edge’s care plans. 
3. Your Edge license will be updated to show your enrollment and the programs you wish to offer your 

customers.  Care plans are tied to the store license, but there is a flag at the account level.  
4. After you have set up your account with the care plan partner, The Edge Customer Service team will 

update your license and send it to you.  Install your license and reboot The Edge. 
 
It is through the license information that your care plan provider will bill you for the cost of the plans. 

13.16.2.1 Partner Contact Information 
Your care plan provider will provide you with access to a portal where you can view activity and make 
claims for repair reimbursement. 

13.16.3 Setting Care Plan Updates – Initial Setup 
Some providers offer terms to be kept in your system.  To download pricing rows and terms as well as 
care plan repair SKUs, use the Care Plan Updates feature.  This is usually only needed when you first 
start with a care plan.  To do so: 
 
1. Go to Administrative ► Care Plan Administration ► Care Plan Check for Updates. 
2. The Edge will contact your care plan provider and update your plan files. 
 

 
 
3. You’re up to date. 

http://docs.edgeuser.com/NetHelp/Documents/categories.htm
mailto:service@ajsllc.com
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13.16.4 Care Plan Pricing Customization 
Once you have the plans and initial pricing downloaded, you can edit them to suit your needs.  To do so: 
 
1. Go to Administrative ► Care Plan Administration ► Care Plan Pricing.  The Care Plan 

Pricing window will appear. 
 

 
 
Fields and option in the Care Plan Pricing window include: 
 

Term The length of coverage on the plan. 
Warranty Type The category of coverage.  Options include: 

Watch 
Jewelry No Center Stone 
Jewelry with Center Stone 

Begin Range The lower end of the item retail price range within this plan. 

Ending Range The upper end of the item retail price range within this plan. 

Retail Price The suggested amount you should charge for the plan. 

Cost The cost to you from your care plan provider for the coverage.  
Keep this in mind if you change the pricing; you’ll want to make 
sure you cover this cost. 

2. If desired, edit the Retail Price of each plan. 
3. Select OK.  The prices will be saved. 
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13.16.5 Uploading Care Plan Transactions 
Transactions are collected in The Edge and then sent to you care plan provider on a daily basis.  If you 
must perform a manual upload: 
 
1. Go to Administrative ► Care Plan Administration ► Care Plan Upload Data. 
2. The transactions will be uploaded and recorded by your care plan provider. 
 

 
 
This data may take up to 48 hours to show up on your care plan provider’s records and be reflected in 
bills.   

13.16.6 Printing Care Plan Terms 
Some providers offer plan terms to be kept in your system. When you update your license, terms are 
stored as PDF files in your shared data folder, for example, 
C:\ProgramData\AJSLLC\edge\CarePlanTerms.  Open them and print as needed. 
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 Care Plan Repair SKUs 
Care plan repair SKUs will be downloaded into The Edge when you do Care Plan Update.  See the 
section entitled Getting Care Plan Updates.  These will be needed to ensure repairs done on covered 
items are uploaded to your care plan provider correctly.  After that, to see the list of SKUs for care plan 
repairs, go to Administrative ► Care Plan Administration ► Repair SKUs. 
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 Retagging Items 
If an item requires a new tag, either because of an item ID change or data conversion, use the Retag 
function.  To retag an item: 
 
1. Select Administrative ► Retag.  The Re-tag Items window will appear. 

 

 
 

2. Select the field in which to enter the appropriate type of item number. 
3. Enter the new item number or scan the old tag. 
4. To see the tag before you print it, select Preview. 
5. Select Print. 
 

 

If you wish to convert a number or all of your tags to a new format, contact The 
Edge Support Team for assistance. 
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 Reprice Items 
The Reprice Items section allows you to reprice a selection of items based on specific criteria.  It is very 
flexible in its use and selection criteria, and also generates a pricing preview.  This preview is useful in 
examining price changes before committing to them.   To reprice an item: 
 
1. Select Administrative ► Reprice.  The Reprice Items window will appear. 

 

 
 
The repricing function includes two tabs:  Criteria and Factors.  Options in the Criteria tab 
include: 
 
Item Filter Presents a standard item filter to aid in narrowing down include 

inventory. 
Change Cost No change – Cost is not changed. 

Cost x Factor – Multiplies cost by the factor specified on the factors tab. 
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Change Re-Cost For more about re-costing, see the section entitled Re-Costing Multiple 
Items. 
No change – Re-cost is not changed. 
Cost x Factor – Recalculates re-cost by the multiplying cost by the factor 
specified on the Factors tab. 
Re-Cost x Factor – Recalculates re-cost by multiplying re-cost by the 
factor specified on the Factors tab. 
Apply to sold Items – Indicates that sold items should be included in the 
re-costing. 

Change Retail No change – Retail is not changed. 
Cost x Markup - Recalculates retail price based on the cost multiplied by 
the markup defined on the category Pricing tab. 
Auto-Reprice Items Only – Indicates that only items that have the Auto 
option enabled should be affected. 
Cost x Markup x Factor – Recalculates retail price based on the cost 
multiplied by the markup multiplied by an additional factor specified on 
the Factors tab. 
Cost x Factor – Recalculates retail price based on the cost multiplied by a 
factor specified on the Factors tab. 
Re-Cost x Markup – Recalculates retail price based on the item re-cost 
multiplied by the markup defined on the category Pricing tab. 
Auto Price Items Only – Indicates that only items that have the Auto 
option enabled should be affected. 
Re-cost x Markup x Factor – Recalculates retail price based on the re-
cost multiplied by the markup multiplied by an additional factor specified 
on the Factors tab. 
Re-cost x Factor – Recalculates retail price based on the re-cost multiplied 
by a factor specified on the Factors tab. 
OldRetail x Factor – Recalculates retail price based on the old retail price 
multiplied by a factor specified on the Factors tab 

Change Lowest 
Price 

No change –Lowest price is not changed 
Cost x Markup - Recalculates lowest price based on the cost multiplied 
by the minimum markup defined on the category Pricing tab 
Auto Price Items Only – Indicates that only items that have the Auto 
option enabled should be affected. 
Cost x Markup x Factor – Recalculates lowest price based on the cost 
multiplied by the markup multiplied by an additional factor specified on 
the Factors tab. 
Cost x Factor – Recalculates lowest price based on the cost multiplied by 
a factor specified on the Factors tab. 
Re-Cost x Markup – Recalculates lowest price based on the re-cost 
multiplied by the minimum markup defined on the category Pricing tab 
Auto Price Items Only – Indicates that only items that have the Auto 
option enabled should be affected. 
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Re-Cost x Markup x Factor – Recalculates lowest price based on the re-
cost multiplied by the markup multiplied by an additional factor specified 
on the Factors tab. 
Re-Cost x Factor – Recalculates lowest price based on the re-cost 
multiplied by a factor specified on the Factors tab. 
Retail x Factor – Recalculates lowest price based on the retail price 
multiplied by a factor specified on the Factors tab 
OldLowest x Factor – Recalculates lowest price based on the old lowest 
price multiplied by a factor specified on the Factors tab 
Proportional to Retail – Recalculates lowest price in such a way as to 
keep it proportionally equal to a new retail. 

Change Current 
Price 

No Change – Current price is not changed. 
Retail x Age Markdown – Calculates current price based on the retail 
price multiplied by the markdown defined on the category Pricing tab. 
Retail x Factor – Recalculates current price based on the retail price 
multiplied by a factor specified on the Factors tab. 
OldCurrent x Factor – Recalculates current price based on the old current 
price multiplied by a factor specified on the Factors tab. 
Proportional to Retail – Recalculates current price in such a way as to 
keep it proportionally equal to a new retail. 

 
2. Select the Factors tab. 
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Options in the Factors tab include: 
  
Older Than Allows you to specify inventory age. 
Factor Specifies a multiplier to use for repricing and re-costing inventory.  It only 

works in conjunction with repricing and re-costing options that utilize a factor. 
 
3. Specify your criteria by using the radio buttons to select what price change is to occur.  

Additionally, use the item filter to define which items this repricing will apply to. 
4. Use the Factors tab, if necessary, to include a factor and an age range to apply that factor to. 
5. Select OK to run the repricing.  You will be presented with a list of items matching your repricing 

criteria.  This list will show the old pricing information as well as the new pricing information for 
you to review.  If it is satisfactory, select OK to finalize these price changes. 

 

 

Be sure to review the changes carefully.  Repricing cannot be undone. 
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13.19.1 Re-Costing Multiple Items 
The Re-Cost Item feature allows you to change the replacement cost of an inventory item without 
affecting the actual cost paid.   This way, a retailer can consider what the cost of an inventory item 
would be if they purchased it again.  Some reports have been optimized so you can choose to print either 
cost or re-cost.   A retailer can recalculate certain business decisions based on a new value of the 
inventory, e.g., commissions or inventory stock reports.   
 
To re-cost items, do so from the Administrative menu: 
 
1. Select Administrative ► Reprice.  The Reprice Items window will appear with the Criteria tab 

open. 
2. From the Criteria tab, use the Item filter identify the items to re-cost.  This could include 

narrowing to items that have been re-costed previously or not at all. 
3. From the Change Re-Cost area, select Re-Cost x Factor, which recalculates the cost by 

multiplying the original cost for a factor to be specified on the Factors tab.  
4. Select the Factors tab.  Options for specifying cost ranges will appear. 

The left column allows you to select a date for items older than which to re-cost.  The right column 
allows you to enter an amount by which to change the cost. 
For example, if you select a date 30 days in the past from Older Than and then enter 1.2 under 
Factor, items older than 30 days will have a cost increased by 20 percent.  That is, The Edge will 
multiply the existing cost by the current amount plus/minus the change. 

5. Select OK.  You will be presented with a list of all items matching the criteria.  This list will show 
the old information as well as the new information for you to review.  If it is satisfactory, select 
Check All to finalize these changes.  Alternatively, select those which you wish to change. 

 

 

Be sure to review the changes carefully.  Recosting cannot be undone.  As a backup, it 
may be prudent to use Print List for future reference. 

 

 

• When dealing with bulk items, the re-cost is associated with the master SKU 
record by default. 

• When running the Commission report, look for the field Calculate Commission, 
which allows you to use this amount to determine commission, as opposed to cost 
or sale line.  

• This has no bearing on your QuickBooks accounts or financial records. 
 

 

A specific Re-Cost report is available to show cost and re-cost along with the 
difference. 
The inventory item find function now offers re-cost-related filters as well.  A number 
of inventory-related reports allow you to choose between inventory cost vs. inventory 
re-cost. 
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 Start a Sale 
The Edge makes it easy to categorically reduce the price of items for a special event.  This feature can be 
used for fine-item pricing and bulk UPC item pricing.  To start a sale: 
 
1. Select Administrative ► Start a Sale.  The Start a Sale window will appear. 

 

 
 
Fields and options in the Start a Sale window include: 
 
Item Filter Presents a standard item filter to aid in narrowing down results. 
Discount The percentage discount to apply 
Sign Type The type of sign to generate for items put on sale 
Sale Starts/Ends The dates this sale will run (optional). 
Skip items already 
on sale 

If running multiple sales, items already on sale will not be affected by this 
new sale. 

New Tags Defines whether to generate new inventory tags for items put on sale. 

2. Complete the fields as desired and select OK.  The results window will appear. 
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3. Select items to include on the sale and select OK. 
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 End a Sale 
Though you can set the end date of a sale in Start a Sale, you can end sale pricing here as well.  This 
can be useful to end sale pricing for items that are to be marked back up outside of the dates marked in 
the Start a Sale function. Like Start a Sale, this feature can be used for fine-item pricing and bulk UPC 
item pricing.  To do so: 
 
1. Select Administrative ► End a Sale.  The End a Sale window will appear. 

 

 
 
Fields and options in the End Sale Pricing window include: 
 
Organize by Indicates how ending prices should be selected.  The items selected here 

will appear as columns to be selected from below. 
Sign Type Because sales often have a sign made for their particular event, the sign 

type may contain the appropriate association. 
Start Date Allows you to select items by sale start date. 
End Date Allows you to select items by sale end date. 
Category Allows you to select items by category. 
Location Allows you to select items by location. 

 
2. Select the items for which the sale price is to end and select OK.  A confirmation window will 

appear. 
3. Select OK. 
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 Configuration Options 
The Edge Configuration window contains settings that allow you to make hardware selections and 
make file location and data selections. 
 
To access The Edge Configuration, select Administrative ► Configuration.  The Edge Configuration 
window will appear.  Alternatively, you can access The Edge Configuration through Windows Start 
► All Programs ► Abbott Jewelry Systems ► Administrative ► Configuration. 
 
For any of the sections that appear, select the plus sign to expand the options or the minus sign to 
collapse the listing.  Notice that at the bottom of The Edge Configuration window, there is a 
description of the selected item along with applicable suggestions.  Double-click on the data field to the 
right to either change the value or obtain a drop-down list of settings. 
 

 

13.22.1 Barcode Scanner Settings 

Barcode Scanner 
Type 

Allows you to select a different scanner from the one prescribed in the setup 
instructions.  Most scanners should use SX/ETX. 

13.22.2 Database Settings 

Mode Specifies whether to start The Edge in Production or Test mode.  If you have not 
selected a mode, you may be prompted to select a database at login.   
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Production 
Settings 

Contains a number of options to specify the database and other file locations.  If 
you expand the Production Settings entry, several options appear. 
 

 
 
• [Database Type] Database Path:  The database path as specified in the 

Production Database Settings window. 
• Database Type:  The type of database as indicated by the settings. 
• MemorizedReportPDFPath:  The folder to which memorized report PDFs 

should be saved. 
• Photopath:  The photo database path as specified in the Production 

Database Settings window. 
• Shared Data folder:  The path to shared data for synchronization purposes. 
• SQL Database Name:  If MSSQL, the database name. 
• SQL Password:  If MSSQL, the server password. 
• SQL Server Name:  If MSSQL, the server name. 
• SQL User Name:  If MSSQL, the user name. 
 
Use the browse icon on the right to access the dialog that allows edits to these 
fields. 
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Test Settings Contains the path to the test database.  See above for details. 
 
File Locations specifies where The Edge should retrieve and store information.  DatabasePath is used 
to direct The Edge to use a particular database.  PhotoPath is used to direct The Edge to use a particular 
image folder. 
 
The server computer should have local paths for these locations (e.g., C:\Program Files 
(x86)\AJSLLC\EDGE\Edge.mdb) while the workstations should have network paths (e.g., 
\\[servername]\edge\edge.mdb). 

13.22.3 Device Settings 
Device Settings contains settings for configuring a cash drawer to work with the software in an 
integrated fashion.   
 
Cash Drawer Port Used for drawers connected via a serial cable and references the serial port 

(e.g., com1) used. 

Cash Drawer Program 
Location 

The location of the program to open the cash drawer.  For example:  
c:\program files\cashdrawer\open.exe.   

Consumer Display If you provide a monitor for the consumer to see the transaction, use this 
field to select it from the list. 

Phone Dialer Program 
Location 

The location of the program to dial the phone.  If you have a fax/modem 
device configured for Windows on your machine, leave this blank, and 
The Edge will use that by default.  If you have your own dialer program, 
then use this field to specify that.  For example, it might read 
c:\program files\MyPhoneSystem\DialThisNumber.exe.   
This program must accept the phone number as the first argument on the 
command line. 

13.22.4 Edge Tech Support Only  
These options are to be configured by The Edge Support Team only.  Do not change them unless 
directed to do so by an Edge representative. 

13.22.5 Headquarters Store ID 
This option specifies headquarters location for a multi-store environment.  Do not change this unless 
directed to do so by The Edge Support Team. 

13.22.6 ID Scanner 

ID Scanner Folder Location This is to indicate the folder to which scans are saved.  For example:  
c:\temp\idscan. 
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ID Scanner Program 
Location 

The location of the scanner program executable.  For example:  
c:\program files\idscan\idscan.exe. 

13.22.7 Misc 

Program Data Folder Path The location of the program data folder. 

13.22.8 Plug-Ins 

Credit Card Processor 
Plug-Ins 

The plug-in for credit card processing, e.g., c:\program files 
(x86)\ajsllc\edge\AcmeCreditCards.dll. 

13.22.9 Postcards 

Name or IP Address of the 
Postcard Server 

The name or path to the Postcard Server.  Leave this blank unless told 
to do otherwise by The Edge Support Team. 

13.22.10 RFID 

RFID Config File Path The location of the RFID configuration file.  Use the standard 
Windows Open File window to find the file.   

RFID Maintains 
Connection 

Whether the RFID device maintains a connection while scanning. 

RFID Server Type The type of server for the RFID device. 

13.22.11 Station ID 
Each workstation in the store must have a station number so the system can report transactions.  
Likewise, each store has a store ID.  You must set a unique station number for each station. 
 
Station Number The unique identifier of the workstation as determined at installation. 
Store Number The unique identifier of the store as determined at server installation. 
Store Number Host The store number of the store that houses the server.  Use -1 unless 

otherwise directed. 

13.22.12 TagPrinter 1 Settings 
The tag printers print to very small paper.  Therefore, The Edge allows you to adjust printer settings to 
ensure proper printing on the tag. 
 
Center Adjustment Allows you to adjust the center space between ends of the dumbbell tag.   
Left Edge Adjustment Allows you to adjust the left edge of the label.  Bigger is more to the 

right. 
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Number of Retries to 
Open Port 

The number of times to retry opening the printer port before showing an 
error. 

Port Number The tag printer port, e.g., LPT1. 
Special Strings to Begin 
Batch Print 

Special strings to send before a batch of tags.  Not supported by all tag 
printer models.  Might override other settings. 

Special Strings to End 
Batch Print 

Special strings to send at the end of a printer batch.  Not supported by all 
tag printer models. 

Special Strings to Send 
on Individual Tag Print 

Special strings to send before each tag.  Not supported by all tag printer 
models. 

Tag DPI The dots-per-inch capability of tag printer 1.   
Tag Printer Burn 
Settings 

This allows you to adjust the burn setting.  Higher is darker.  Not all 
printer types allow this. 

Tag Printer Make & 
Model 

The make and model of the tag printer, e.g., Eltron_2742. 

Tag Sensor Mode The method by which the tag printer senses the start of the label. 
Tag Stop Position Millimeters to advance the tag printer after printing, to be pulled back 

before the next tag begins.  Applies to Zip Tape only. 
Top Edge Adjustment Allows you to adjust the space to the top. 

13.22.13 TagPrinter 2 Settings and 3 Settings 
In the event you have more than one tag printer set up on your system, settings are made as described 
above. 

13.22.14 Video Surveillance 
These settings control the use of third-party video surveillance software/hardware with The Edge. 
Video Surveillance Port 
Number 

The port number of the video surveillance server. 

Video Surveillance 
Server Name or IP 
Address 

The server name or IP address of the video surveillance server. 

Video Surveillance 
Server Type 

The type of video surveillance server. 

13.22.15 Vis Server 

Name or IP Address of 
the Vis Server 

The name or IP address of the Vis Server.  Leave this blank unless 
otherwise directed by Edge Tech Support. 
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 System Options 
While Configuration handles hardware and file location settings, System Options is where transaction 
settings, default values, and data settings are handled. 
 

 
 

Note that the bottom of the System Options window contains a description of the selected option and 
suggestions for settings. 

13.23.1 Appointment Options 

How to Notify Associates 
of a New Appointment 

When creating a new appointment, this will be the method for notifying 
the assigned associate of the task.  Select from Text or Email. 

Number of Next-Up 
Records Listed 

Number of records to be listed for appointments to be worked.  It is 
sorted by End Date. 

Send Daily Email of 
Upcoming Appointments 

Whether to send an email on a daily basis to each associate to inform 
them of the day's appointments.     

13.23.2 Appraisal Options 

Appraisal Cancel Fee – 
Percentage 

How much should still be charged in the event someone cancels an 
appraisal request, as a percentage of appraisal fee. 
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Appraisal Claim Check Whether a claim check should be issued for appraisal items. 
Appraisal Claim Check 
Fine Print 

The fine print that should appear on the appraisal claim check. 

Appraisal Cost for New 
Appraisals 

When intaking a new appraisal this is the default cost filled in. 

Appraisal Fine Print The fine print to appear on the bottom of the finished appraisal form. 
Appraisal Pick Up Only 
when Marked Done 

Allow only complete appraisals to be picked up as opposed to allowing 
unfinished items to be picked up. 

Appraisal Print Declared 
Value on Customer’s 
Receipt 

Whether the estimated value of the item before appraisals will be printed 
on the customer’s receipt. 

Appraisal Print 
Envelope 

Whether to automatically generate an item envelope. 

Appraisal Print One 
Item Per Envelope 

Whether each item in an appraisal request should be assigned its own 
envelope or all a customer’s items can be grouped. 

Appraisal Reserve 
Location on Preprinted 
Form 

If you are printing an appraisal on a pre-printed form, this specifies the 
amount of space, in inches, to reserve at the top of the form. 

Appraisal Taxable by 
Default 

Whether appraisals are taxable by default. 

Appraisal Template 
Default File 

The location of the appraisal template file, e.g., 
\\[servername]\data\appr.htm.  Leave this field blank to use 
the AJS built-in template.  We recommend you speak with The Edge 
Support Team before changing this option.   

Appraisal Template 
Folder Location 

The location of the appraisal template file, e.g., 
\\[servername]\data. 

Appraisal Title The title of the appraisal document, e.g., “Jewelry Appraisal.” 
Appraisal Use 
Preprinted Forms 

Whether to print appraisals on pre-printed forms.  If True, The Edge 
will not print your store name and address. 

Appraisal Value Title The label the appraised value, e.g., “Replacement Value.”  
Pre-Appraisal Title The title of the appraisal document for pre-appraised items, e.g., 

“Certificate of Sale.” 

13.23.3 Barcode Options 

Dual Barcodes Set to True if you have barcodes from an older system that are 8 digits 
long, and overlap Edge barcodes. 

13.23.4 Build/Assemble Options 
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Default Build/Assemble 
Lead Time 

The default number of days a build or assembly will take to complete. 

Require Assemble Work 
In Progress ETA 

Require that an ETA be entered for assemble jobs that are a work-in-
progress. 

Require Assemble Work 
In Progress Who 

Require that the job Who field be completed for assemble jobs that are a 
work-in-progress. 

Require Build Work In 
Progress ETA 

Require that an ETA be entered for build jobs that are a work-in-progress. 

Require Build Work In 
Progress Who 

Require that the job Who field be completed for build jobs that are a 
work-in-progress. 

Require Task SKU for 
Assemble 

Whether to require that all tasks have a SKU in assembling items. 

Require Task SKU for 
Build 

Whether to require that all tasks have a SKU in building items. 

13.23.5 Care Program 

Can Discount Care 
Plans 

Whether care plan fees can be discounted at POS.  Options are: 
Requires Override:  Requires an override to allow the discount. 
Permission Check Only:  The Edge will check to see if the 
associate has permission to do this. 
No Discounting:  No discounting will be allowed by anyone. 
No Permission Checks:  Allows complete discounting without any 
checks. 

Care Plan Max Return 
Period 

The number of days that can pass before a care plan can no longer be 
returned. Check with your care plan provider for this information. 

Care Plan POS 
Reminder 

Text to appear in a reminder to your associates to ask the customer about 
a care plan.  The default is Did you talk to the customer 
about our Jewelry Care Program? 
If you don’t wish to have a reminder pop up, then leave this field blank. 

13.23.6 Commission Options 

Commission Penalized 
for Below Cost 

Whether to penalize commission if an item is sold below cost. 

13.23.7 Consignment Options 

Consignor Store Credit Whether to create a store credit in the consignor’s account when the 
consigned item sells. 

13.23.8 Conversion Options 
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Enable Old Sales Name Enables finding converted cash customer sales by name.  This does not 
work for all conversions. 

13.23.9 Credit Card Options 

Account Number 
Required (Last 4 Digits) 

Require the last four digits of a credit card number when processing 
offline. 

Address Verification 
System Copy from 
Customer 

Set to True if you want to initialize the Address Verification System 
data from the customer record. 

Authorization Code 
Required 

Whether the authorization code is required when performing an offline 
entry of the credit card. 

Authorization Code 
Visible 

Whether the authorization code is visible when performing an offline 
entry of a credit card. 

Batch Error Additional 
Emails 

If there is an error in batch settlement, an error message will go to 
whoever is listed on The Edge license.  This field allows you to list 
additional recipients.  Use a new line for each recipient email address. 

Customer Name 
Compare 

Set to True if you want to compare the name on the credit card to what 
is on the magnetic strip when swiping. 

Customer Name 
Required 

Set to True if you want to require manual entry of the cardholder name 
when offline. 

Customer Name Visible Set to True if you want the Cardholder Name fields to appear on the 
tender window when offline. 

Customer on File 
Required 

Set to True if you require a customer to be in our database before you 
will accept a credit card. 

Expiration Date 
Required 

Set to True if you want to require manual entry of the expiration date 
when offline. 

Expiration Date Visible Set to True if you want the expiration date field to be visible when 
offline. 

Signature Text The text that appears under the signature line to indicate agreement to 
the terms of sale. 

When is Address 
Verification System 
Required 

Select the option for when customer’s billing address is required for 
address verification:  Unknown, AlwaysOptional, 
RequiredForCNP, AlwaysRequired. 

When is the CVV Code 
Required 

Select the option for when the CVV code is required:  Unknown, 
AlwaysOptional, RequiredForCNP, AlwaysRequired. 

13.23.10 Custom Job Options 
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Auto Fill Custom Job 
ETA 

Prefill the ETA field for customer jobs to be this number of days, by 
default, after the take-in.  To disable this feature, enter -1. 

Custom Job Claim 
Check Fine Print 

The fine print to appear on the bottom of the custom job claim check. 

Custom Job Envelope for 
“Estimate Only” Jobs 

Whether to print an envelope for an estimate-only custom job. 

Custom Job is “Estimate 
Only” on Job Detail 
Sheet Fine Print 

The fine print to appear on the job sheet if the custom job is only an 
estimate. 

Custom Job Is “Estimate 
Only” Receipt Fine Print 

The fine print to appear on receipts if the customer job is only an 
estimate. 

Custom Job Require 
Photo on Intake 

Whether a photo is required at intake. 

Custom Job Tax With 
Custom Job Item 

Whether to print job taxes with the customer job line, as opposed to the 
receipt subtotal. 

Custom Jobs on Reports How custom jobs should appear on the sales tax and activity reports. 
Enable Custom Jobs Whether to enable custom job features.   
Place Cursor in 
Description Field on 
Start 

When adding a task to a custom job, make sure the cursor stats in the 
description field instead of the SKU field. 

Print Claim Check on 
Customer Section of 
Custom Job Envelope 

Whether to print the claim check on the customer side of the custom job 
envelope.  If Print JLRC on Customer Section of Custom Job 
Envelope is set to true, it will not print. 

Print JLRC on Customer 
Section of Custom Job 
Envelope 

The JLRC is the jeweler's commission, i.e., what you pay the goldsmith.  
This setting determines whether to print the JLRC slip on the customer 
side of the custom job envelope.  If set to True, it overrides the claim 
check. 

Require a Task SKU for 
Custom Job 

Whether to require that each task have a SKU in custom jobs. 

Tax Custom Job “Other” Whether “other” custom job charges are taxable by default. 
Tax Custom Job Labor Whether custom job labor is taxable by default. 
Tax Custom Job Parts Whether custom job parts are taxable by default. 
Use Time of Day for 
Custom Job ETA 

Whether to record the time of day for the ETA. 

13.23.11 Customer Options 

Balances to Primary on 
Split 

When splitting linked customer accounts (Spouse/Partner), whether all 
balances go to primary or are split between the two. 
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Convert Customer Name 
and Address on Receipts 
to Mixed Case 

Whether to convert the customer name and address to mixed case on 
receipts. 

Custom Field Names Labels for custom fields. 
Customer Duplicate 
Check 

What action to take with regard to check for duplicate customers before 
adding a new one.  Options are: 
Check All Relevant Fields 
Check on Phone and Email Only 
Disable Only. 

Enable Customer 
Activity Tab Green Dot 

Allows you to activate or deactivate the green dot indicating activity in 
the Customer Activity tab.  The feature does demand database activity, 
so it might not be desired. 

Guess Gender if Not 
Specified 

Whether to try to guess the gender when not specified on a customer 
record. 

Include Spouse/Partner 
Column on Customer 
List Views 

Whether or not to include extra column for spouse information on 
customer list windows. 

Include Spouse/Partner 
Name 

Whether to include the spouse/partner’s name throughout The Edge. 

Lock Customer Notes 
After Save 

Whether to prevent customer notes from being edited after saving. 

Phone Number Format Template that controls how phone numbers are formatted.  Use ‘x’ in 
place of numbers, e.g. (xxx)xxx-xxxx, xxx.xxx.xxxx, xxx-xxx-xxxx.   
 
Note this option can potentially conflict with the Validate That Phone 
Numbers Have 10 Digits option if your phone number template 
contains less than 10 digits. 

Show Dial and Email 
buttons on contacts 
screen 

Show Dial and Email buttons on contacts screen next to the Edit 
controls. 

Title Case Names Whether to automatically set title case (capitalization) on names, 
addresses, and titles throughout the program. 

Use Comma After City 
and Before State in 
Mailings and on Reports 

Whether a comma should appear after the city and before the state in 
mailings and reports. 

Use Period After Title in 
Customer’s Name in 
Mailings and on Reports 

Whether a period should appear after the title of part of a customer name 
on mailings and reports. 

Validate That Phone 
Numbers Have 10 Digits 

Validate that phone numbers have 10 digits in them. This is important if 
you will be using texting/SMS features. 
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13.23.12 Department Defaults 

Default Appraisal 
Department 

The appraisal department to which to default. 

Default Custom 
Department 

The custom work department to which to default. 

Default Inventory 
Department 

The inventory department to which to default. 

Default Misc. Item 
Department 

The miscellaneous department to which to default. 

Default Repair 
Department 

The repair department to which to default. 

Default Trade 
Department 

The trade department to which to default. 

 
 
 

13.23.13 General Options 

Ask “Are You Sure?” on 
Cancel 

Whether to prompt “Are you sure?” when canceling an edit window 
where changes have been made, but not saved. 

Enable ETA Is 
Estimated on Receipts 

ETA will always print as estimated. 

Enable Export Raw 
Report Data 

Enables the ability to export raw data from the report viewer. 

Enable Spell Checker Enable spell-checking capability in all text fields. 
Form Defaults Require 
Permission 

Setting a form’s defaults require permission. 

Logo File Location The location of the logo file for areas such as Receipts and Appraisals. It 
is best to keep the file in the configured photo folder.  It can be .bmp, 
.jpg, .gif, or any other standard Windows image format.  Because the logo 
will appear in a 2.25” x 2” rectangle, your logo file may be shrunk to fit 
in that space.  Logo resolution should be the same as that for your receipt 
printing, usually 300 pixels per inch. 

Maximum Number of 
Days Back for Sale/Sold 
Dates Searched Without 
Permission 

The maximum number of days back an associate can conduct searches on 
sales dates without permission.  Enter a value of 0 to always search 
without permission. 

Print Non-Stock Job 
Envelopes to Report 
Printer 

Print other (non-stock) job envelopes to the report printer. 
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Report Criteria Cover 
Page Default Setting 

Set this to True to enable the Report Criteria Cover Page checkbox on 
the report query form by default.  Set this to False to disable the 
Report Criteria Cover Page checkbox on the report query form; this 
will generate criteria headers on the top of the first report page. 

Require Notes on 
Override 

Whether to require an explanatory note when an override is made. 

Show Background 
Texture 

Whether to show background texture on the windows.  Turn this to False 
for remote access. 

Show Lines on Rapid 
Reorder Report 

Set this to True to enable vertical column separators for the last 3 
columns of the Rapid Reorder report.   

Where to Place Help 
Button 

Where on the form/window to place the Help button. 

 

13.23.14 Gift Certificate Options 

Enable Gift Certificate 
Button at POS 

Set this to True to enable the Gift Certificates button in the Point of 
Sale window.  Set to False if you do not use gift certificates. 

Gift Certificate Border 
Options 

What type of border should be printed on gift certificates. 

Gift Certificate Font 
Used at POS 

In what font the gift certificate will print out. 

Gift Certificate Form 
Used at POS 

The type of form on which gift certificates should be printed. 

Gift Certificate Print 
Envelope 

Whether to print a gift certificate envelope insert. 

Number of Days a Gift 
Certificate Expires 

How many days for which the gift certificate is valid. 

13.23.15 Inventory Options 

Allow User to Assemble 
Items 

Whether to allow the user to assemble item in inventory. 

Allow User to Build 
Items 

Whether to allow the user to build item in inventory. 

Allow Zero Costs Whether to allow the cost of an item to be entered as zero. 
Enable Master Vendor 
IDs 

Whether to enable The Edge Master Vendor ID field. 

Inventory Change Sold 
Item 

Controls whether you need a manager override or just permission to 
make changes to sold items.  Set to Override to require a manager 
override or Permission to only require the ability to edit items. 



The Edge User Guide v. 20.0.0.114 

14 January 2020 USR-2020-017 757 
© 2020 Abbott Jewelry Systems, Inc. 

Inventory Item 
Description Auto Suggest 

Controls whether a new description is automatically suggested when an 
item is edited and saved.  Set to True to suggest a new description 
automatically or False to not suggest any changes (description can 
always be manually changed).   

Inventory Protect 
Changes 

Controls whether permission is required to save changes to existing 
items.  Set to True to require permission or False not to require it. 

Prompt Reprint 
Assembled/Built Item 
Envelope With a Status 
of Work In Progress 

Prompt to reprint a built or assembled item envelope on save while it is a 
work in progress. 

Protect Inventory 
Reports 

Whether permission is required to run inventory reports. 

Save and New Maintains 
Stock Type 

If enabled, when selecting Save & New from an item record to create a 
new item record, the stock type will be carried over to the new item. 

Trade Category The default category for traded-in items.  Use 0 to disable and allow 
them to remain uncategorized.  For accounting purposes, we recommend 
a default. 

Trade Vendor The vendor to which traded-in goods will be attributed by default. 
Trades Reduce Sales Tax 
Due 

Whether a trade-in reduces the sales tax due. 

Validate Retail Price 
Greater Than Cost 

Whether to validate that the retail price of an item is greater than cost. 

Vendor Style Number 
Minimum Length on 
Searches 

The minimum length for a vendor style code in the use of searching for 
like items. 

13.23.16 Layaway Options 

Layaway Cancellation 
Fee – Percentage  

The fee for a canceled layaway order in percentage of purchase price. 

Layaway Claim Check 
Fine Print 

The fine print to appear on the layaway claim check. 

Layaway Minimum 
Deposit – Percentage  

The minimum percentage of purchase price to collect for a deposit. 

Layaway One Item Per 
Envelope 

Whether each layaway item requires its own envelope or if all of a 
customer’s items can be grouped together. 

Layaway Pay 
Commission on Layaway 
Creation 

Whether commission should be paid when layaway is initiated or on 
pickup. 
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Layaway Print Claim 
Check on Customer 
Section of Envelope 

Whether to print a claim check for the item on the customer section of 
the layaway envelope. 

Layaway Print Envelope Whether to print a layaway envelope insert. 
Layaway Sales Tax is 
Collected When 
Layaway is Created 

Whether tax should be collected when the layaway is first created. 

13.23.17 Memo Out/On Approval Options 

Memo Cancellation Fee 
– Percentage 

The percentage charged on the cancellation of a memo out. 
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13.23.18 News Feed Options 

RSS Feeds Any RSS news feeds, one per line.  Edit this ONLY at the direction of an 
Edge Support representative. 

13.23.19 Notifications Options 

Notification Field 
Displayed on Special 
Order Intake 

Set to True if you want the Notifications field to be visible on special 
order intake.  When used, notifications are sent to the customer when 
the item is entered into inventory.  For more notification control, you 
may wish to do this manually on a case-by-case basis, in which case 
this value would be False. 

Require Notifications on 
Appraisals 

Set this to True if you want the Notifications field to be required on 
all appraisals. 

Require Notifications on 
Custom Job 

Set this to True if you want the Notifications field to be required on 
all custom jobs. 

Require Notifications on 
Repairs 

Set this to True if you want the Notifications field to be required on 
all repairs. 

Require Notifications on 
Special Orders 

Set this to True if you want the Notifications field to be required on 
special orders. 

13.23.20 Physical Inventory Options 

Display “Are You Sure?” 
on Partial Scan Bulk 
Change 

Turns on a prompt to confirm the changing of bulk quantities during a 
physical inventory partial scan. 

Require Physical 
Location For Inventory 

Whether location is required on an inventory record for physical 
inventory. 

Show Case List Makes the Location list visible on the bottom of the Physical Inventory 
window. 

13.23.21 Podium Options 

Podium Contact Method Contains options for sending texts and emails via Podium.  Options are: 
Only Send Correct Phone Email:  Without offering options 
at POS, Podium will automatically request a review provided correctly 
formatted information is provided. 
Open Phone Email Selector Every Time:  Offers the 
prompt at POS with every customer transaction asking for verification of 
data and whether to send text or email. 
Open Phone Email Selector When Defaults Not 
Correct:  If a phone number or email address is not available or in 
the correct format, the selector window will appear for further action. 
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Podium Retry Period To ensure that your customers are not sent too many requests, this option 
allows you to select how many days should pass between requests.  
Podium sets the minimum at 60 days, but you can use this setting to 
increase the number of days. 

Podium Send Always If True then Podium will always send a request for any transaction.  If 
False, then Podium will only send requests on appraisal pickup, 
customer job pickup, layaway pickup, memo pickup, repair pickup, gift 
cert sale, tender card sale, item sale, special order pickup, and trade in.  
It will not send requests for interim transactions such as repair intake.  
The default is False. 

Use Podium for SMS If True then text messages (SMS) for notifications will use the Podium 
platform.  Marketing messages are never sent through Podium. 

13.23.22 POS Options 

Ask “Are You Sure?” 
When Cancelling an 
Order 

Whether to include an Are You Sure prompt for canceling an order. 

Cash Drawer Button Controls the behavior of the cash drawer button. 
Cash Drawer Options Defines when to open the cash drawer. 
Customer Add Screen Select which customer add window to use in the Point of Sale window: 

Fast 
Full. 

Display a Menu on 
Service Scan 

Whether to enable scanned service action menu at POS.  True enables 
a menu that will provide possible actions (payment / pick up / cancel) 
for this envelope when scanned.  False will act immediately on the 
scanned envelope bringing it up for pick up if available, otherwise 
payment.   

Enable Adding New 
Customers at POS 

Whether to enable the New Customer button in the Point of Sale 
window. 

Fast Customer Find 
Preferred Contacts Only 

When using the fast customer find at POS, whether to return only 
preferred contact methods.  True returns only preferred contact 
methods; False returns all matching contact methods. The Edge 
default is True.   

Fast Customer Find 
Return Options 

When searching using the fast customer find at POS, the results that will 
be returned.  Options include: 
Individual:  Returns only matching individual records 
Couple:  Returns matching records from either individual in the 
couple. 
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Fast Customer Find 
Starting Field 

When searching using the fast customer find at POS, what should be the 
default starting field, i.e., cursor placement.  Options include: 
Last name 
First name 
Phone 
Email. 

Flash Sale Line Buttons Flash buttons on the sale line when indicated by certain pop-ups, flags, 
or other indicators. 

Giveaway Threshold 
Amount – Percentage 

If a giveaway exceeds this percentage of the other merchandise on the 
sale, an override is required. 

Inventory Item Pop-Up 
at POS 

Pop-up notes for inventory items when placed on a sale line. 

Item Tax Override Whether to enable the checkbox to allow an entire sale to be taxed as if 
it were a single item.  This is useful in some states for “trade up” sales.  
This item is always set to True for stores located in Tennessee. 

No Address on File Defines the text to display at point of sale if the customer has no address 
on file. 

No Email Address on 
File 

Defines the text to display at point of sale if the customer has no email 
on file. 

No Mailing Address Defines the text to display at point of sale if the customer has one or 
more addresses on file, but none specified for as a mailing address. 

No Phone Number on 
File 

Defines the text to display at point of sale if the customer has no phone 
number on file. 

No Preferred Email 
Address 

Defines the text to display at point of sale if the customer has no 
preferred Email address selected. 

No Preferred Phone Defines the text to display at point of sale if the customer has no 
preferred phone number on file. 

Occasion Days If an occasion is within this many days, it will appear at point of sale. 
Pay in Full Without Pick 
Up Options 

Level of security needed to allow a job to be paid in full without picking 
it up.   
No Check:  Anyone can pay in full without picking up. 
Prompt:  Prompt when an attempt is made to pay in full without 
picking up. 
Override:  An override is necessary when an attempt is made to pay 
in full without picking up. 

Refund Limit Requires 
Override 

Any refund, other than credit memo, great than this amount requires an 
override.  Use -1 to disable. 

Require Address when 
Entering New Customer 

Whether to require a customer address when a customer is added at 
point of sale. 
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Require Email when 
Entering New Customer 

Whether to require that an email address be entered with a new 
customer record at POS. An override can allow the customer to decline. 

Require Permission to 
Allow Tax Changes at 
POS 

Level of security needed to change the change whether a sale is taxable. 
No Permission Required: Anyone can change tax.    
Requires Permission: Associate must have permission, but will 
not otherwise be prompted. 
Requires Override: Associate must have permission & will be 
prompted with an override window if trying to change taxable status. 

Require Permission to 
Sell Item from Another 
Store 

Whether to require permission when selling an item located in another 
store.  Options are: 
Do Not Require 
Ask Are You Sure? 
Require Override. 

Require Permission to 
Sell to Cash Customer 

Require a permission check to make sales to the cash customer. 

Require Phone Number 
when Entering New 
Customer. 

Whether to require that a phone number be entered with a new customer 
record at POS. An override can allow the customer to decline. 

Require Why In for 
Every Sale 

Whether the WhyIn field is required. 

Require Why In for New 
Customers 

Whether the WhyIn field is required for new customers. 

Restocking Fee for 
Returned Merchandise – 
Percentage  

How much as a percentage of purchase price, if any, to charge for a 
restocking fee in a return transaction. 

Returned Items when on 
a Sale with a Giveaway 
Item Options 

Level of security needed to validate a return that has a giveaway as part 
of the sale. 
No Check:  Anyone can perform this action. 
Prompt:  Prompt when an attempt is made to perform this action. 
Override:  An override is necessary when an attempt is made to 
perform this action. 

Sell or Use Out of Stock 
Bulk Options 

Controls what to do when a user attempts to sell or use an out-of-stock 
bulk item.  There are three options:    Ignore it, Ask “Are you sure?” and 
require an override. 

Show Collection Pop-Up If an item that is part of a collection, this option will enable a pop-up at 
point of sale to prompt the associate to suggest other items in the 
collection to the customer. 

Show Customer Activity 
Summary at POS 

Whether to show an activity summary at point of sale. 

Show Customer Email at 
POS 

Whether to show customer email at point of sale. 
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Show Customer Phone 
Number at POS 

Whether to show customer phone number at point of sale. 

Show Number of Items 
to be Picked Up or Make 
Payments at POS 

Whether to show the number of transactions available for 
pickup/payment next to the corresponding button. 

Show Only Selected 
Customer’s Services 

For linked customer accounts (spouse/partner), whether to show 
layaways, special orders, repairs, memos, and custom jobs on the 
Payment & Pickup buttons/screens for just the selected customer or for 
both the customer & their spouse. 

Tax Refunded on 
Returns With No Receipt 
or Sale Record 

Whether taxes are to be refunded on a return of an item with no receipt 
or sale record. 

Update Sold Item SKUs 
from Other Stores 

If enabled, if an item recorded as being in one store is sold in another, 
The Edge will update the item number to reflect the selling store. 

Use Fast Customer Find 
at POS 

When searching for customer as POS, this will bring up an abbreviated 
Customer Find window. 

Use Small Task Lines for 
Repairs and Custom 
Jobs 

Use small task line for repairs and custom jobs on intake at point of sale. 

Why In Allow Typing Set to True to allow users to type in the why-in reason.  Otherwise they 
can pick from the list. 

Why In is Optional if 
Sale Includes a 
Cancellation 

Whether the WhyIn field is optional if the sale contains an order 
cancellation. 

Why In is Optional 
Payment if Sale Includes 
a Payment on Account 

Whether the WhyIn field is optional if the sale contains a payment on 
account. 

Why In is Optional if 
Sale Includes a Pickup 

Whether the WhyIn field is optional if the sale contains a pickup. 

Why In is Optional if 
Sale Includes an 
Adjustment to Repair or 
Custom Job 

Responding to the WhyIn field is optional if the sale contains an 
adjustment to a repair or custom job. 

Why In is Optional if 
Sale Includes a Return 

Whether the WhyIn field is optional if the sale contains a return. 

Why In is Optional if 
Sale Includes an Intake 

Whether the WhyIn field is optional if the sale contains an intake. 
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13.23.23 Postcard Options 

Delete Temporary 
Postcard Job Files After 
Upload 

Whether to delete postcard job files after a successful upload. 

 

13.23.24 Pricing Options 

Auto-Pricing Default 
Value 

Specifies the default value of the Auto-Price option on the Item 
window. 

Enable Auto-Pricing Whether the auto-pricing features in Automatic Markup and 
Automatic Markdown should be enabled. 

Enable Auto-Pricing for 
Item Edit 

Whether auto-pricing occurs when you edit an item. 

Round All Pricing to the 
Dollar 

Rounds all pricing calculations to the nearest dollar. 

Use Replacement Cost 
for Auto Markup 

Whether to use Re-Cost for AutoMarkup. 

 

13.23.25 Purchase Order Options 

Open Previous Non-
Submitted Purchase 
Orders 

When starting a new purchase order for a specified vendor, any non-
submitted purchase orders will be opened for additional items. 

Purchase Order BCC 
Email Address 

Email address(es) to use by default in the BCC email field in Purchase 
Order Settings.  If there is more than one, separate them by semi-colons 
(;).   

Purchase Order Email 
Address 

The email address of the store when sending an email on a purchase 
order. 

Purchase Order Most 
Recent Item Cost 

If set to True, The Edge will use the most recent cost for the vendor 
style in the purchase order. 

Save Most Recent 
Purchase Order Settings 

If set to True, The Edge will save settings in Purchase Order Settings 
for future purchase orders. 

Show Images by Default 
on Purchase Orders 

If set to True, item images will be shown on the Purchase Order 
window. 

Show Images by Default 
on Receive Invoice 

If set to True, item images will be shown in the Receive Invoice 
window. 

13.23.26 Receipt Options 
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If you obtain pre-printed forms on your own, you must do a test proof with The Edge 
and send it to us to be verified.  This will ensure your pre-printed forms will fit our 
receipt layout.  It may help to work with an Edge-approved vendor who will 
guarantee compatibility. 

 
Ask Before Printing 
Receipt 

Whether to offer a prompt or preview of a receipt before printing.  True 
results in a prompt at point of sale with Yes, No, and Preview options. 

Ask to Print Gift Receipt Whether to remind the associate to offer the customer a gift receipt. 
Description Length Limit Because repair and appraisal descriptions can get quite long, this option 

allows you to limit the length of long description that will appear on the 
receipt.   

Description Maximum 
Height 

The maximum height of the printed description in inches.  Repair and 
appraisal descriptions can get very long. 

Donation Disclaimer If desired, enter the text for a disclaimer printed with a donated item 
description. 

Enable Emailing of 
Receipts 

Enable receipt emailing. 

Giveaway Disclaimer If desired, enter the text for a disclaimer printed with a giveaway item 
description.  

Number of Receipt 
Copies 

Number of copies of the receipt to print. 

Number of Repair 
Photos to Print 

The number of photos to print on the repair receipt; the limit is eight. 

Omit “Receipt” from 
Receipts  

Whether the receipt should have the word “Receipt” on the top or not. 

Preprinted Receipt 
Paper 

Indicates whether receipts are preprinted with artwork or forms. 

Print Associate’s Last 
Name 

Whether the sales associate’s last name should appear on the receipt. 

Print Barcodes Whether barcodes containing such information as transaction IDs, item 
IDs, or customer IDs should be included. 

Print Notifications on 
Envelopes 

Whether to print notifications on envelopes. 

Print Store Name on 
Preprinted Receipts 

If receipt paper is preprinted, then print store name on store copy. 

Print Tear Guide Whether a dashed line indicating where the receipt should be torn off 
should appear. 
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Receipt Disclaimer Disclaimers (e.g., warranty limitations, etc.) that should be included on 
the receipt.  This can be used for marketing or other messages as well.  
To enter such text, select the … button in the Disclaimer field.  A text 
editor will appear in which to enter the message.  Select OK to save it.  
 

 

To enter a blank line, type [blank] (including the 
brackets) for each line.  You can add additional lines 
before preprinted items to push text up or after 
preprinted items to push text down. 

 

Receipt Preview  Whether the receipt should appear in print preview before being printed. 
Repair Price Breakdown Whether to breakdown repair prices between parts/labor/other on the 

receipt. 
Repair/Custom Job Tax 
With Line Item 

Whether to print repair taxes with the repair, not with the receipt 
subtotal. 

Reserve Height for 
Preprinted Name and 
Address 

Height of the preprinted name and address. 

Show Balances on 
Receipts 

Whether the customer’s balances should appear on the receipt. 

Show Customer’s 
Address and Phone 
Number on Receipt  

Whether the customer’s address and phone number should appear on the 
receipt. 

Show Customer's Email 
Address on Receipt 

Whether to print a customer's email address on printed receipts. 

Show Discount 
Percentage Threshold 

If discount exceeds this amount, the discount will be printed on the 
receipt.   

Show Discounts on Each 
Line 

Whether the discounts on each item should appear on the receipt. 

Show Expired Rewards 
on Receipts 

Set to True to show expired rewards card balances on receipts with the 
expiration date. 

Show Photos Whether to print item images on the receipt. 
Show Store Credit 
Balance on Receipts 

Whether to show the store credit balance, if any, on each receipt. 

Special Order Tax with 
Special Order Item 

Print special order tax with the order, not with the receipt subtotal. 

Where to Print Anti-
Piracy ID 

Where to print anti-piracy ID for preprinted paper.  We insist that your 
name and store number be used on all pre-printed forms.  To 
accommodate a variety of designs, we give you a choice as to where this 
information will appear.  
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13.23.27 Repair Options 

Enable Repairs Whether to enable the repair job features. 
Enforce See Cost on Jobs Requires permission see costs and adjust cost on repairs. 
Job Envelope Due Date 
Adjustment 

Number of days to subtract from actual due date when printing repair 
due date on repair envelope. 

Match Partial Repair 
Task SKU 

If the user types in a task SKU that matches one SKU exactly, but is also 
a partial match for others, whether to list all results or just the matching 
one. 

Maximum Height in 
Inches for JLRC Task 
Description 

The maximum height, in inches, of the task description.  This also 
applies to custom jobs. 

Move Services 
Permission Check Only 
Once 

If set to True, the system will only require you to login when the Move 
Envelope screen is first opened and will not time out.  It remains logged 
in until you close out of this screen. 

Number of Days to Auto-
Fill Repair ETA 

Prefill the ETA field for repairs to be this number of days after take-in.  
To disable this feature, enter -1. 

Preprinted Envelope for 
Repairs/Custom Jobs 

Whether the envelope has a preprinted image for repairs and custom 
jobs. 

Print Balance Due on 
Repair/Job Envelope 

Whether to print the balance due on the repair/job envelope. 

Print JRLC on Customer 
Section of Envelope 

Whether to print JLRC slip on the customer side of the repair envelope.  
This overrides the claim check. 

Print Repair Envelope 
for “Estimate Only” 
Repairs 

Whether to print an envelope for an “estimate only” repair job. 

Print Repair Information 
on Each Page of 
Envelope When Multiple 
Pages 

When printing a multi-page repair envelope, whether to repeat the repair 
information at the top of each page. 

Repair “Other” Taxable 
by Default 

Whether to include applicable tax on other charges of a repair. 

Repair Claim Check Whether to generate a claim check for the repair. 
Repair Claim Check Fine 
Print 

The fine print to appear on the bottom of the repair claim check. 

Repair Envelope Print 
Customer Name and 
Phone Number 

Whether the envelope should include the customer’s name and phone 
number. 
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Repair Express Service 
Labor Charge – 
Percentage 

Percentage to increase labor cost for express service.  For example, enter 
25 to pay your goldsmith 25 percent more for express service. 

Repair Express Service 
Markup – Percentage 

The percentage markup, if any, on a rush order. 

Repair Job Sheet Fine 
Print for when Repair is 
an “Estimate Only” 

If the repair is only an estimate, the fine print to appear on the job sheet. 

Repair Labor Taxable by 
Default 

Whether to include applicable tax on the labor of a repair. 

Repair One Item Per 
Envelope 

Whether only one item to be repaired can be included in an envelope or 
all of the customer’s repairs can be grouped together. 

Repair Parts Taxable by 
Default 

Whether to include applicable tax on the parts of a repair. 

Repair Price Printed on 
Envelope 

Whether to include the price of the repair on the envelope. 

Repair Print Declared 
Value on Customer’s 
Receipt 

Whether to include the declared value of the item on the envelope. 

Repair Print Envelope Whether a repair envelope should be generated. 
Repair Print Store 
Address on Repair 
Envelope 

Whether the envelope should include the address of the store where the 
repair was initiated. 

Repair Receipt Fine 
Print for when Repair is 
an “Estimate Only” 

If the repair is only an estimate, the fine print to appear on the receipt. 

Repair Require Cost 
When Marking Task 
Done 

Whether cost is required in order to mark a repair as done. 

Repair Require Declared 
Value at Repair Intake 

Whether a declared value must be included in the record. 

Repair Require Part 
Status when Marking a 
Task Done or Cancelled 

When marking a task done or cancelled, require all parts be either 
received or cancelled. 

Repair Require Who on 
Done 

The Who field is required to list the task as Done. 

Repairs Displayed on 
Reports 

Indicates how repairs should appear on sales tax and activity reports. 

Repair Pickup Only 
when Marked Done 

Allow only completed repair items to be picked up. 
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Repairs With Negative 
Values Requires 
Override 

If a task value is negative on a repair, an override will be required. 

Require “Condition” at 
Repair Intake 

Whether condition of the item is to be required at intake. 

Require Declared Value 
for Customer Owned 
Parts 

Whether it is require to include declared value of customer-owned parts 
that are used on repairs and customer jobs. 

Require ETA at Repair 
Intake 

Whether to require ETA at repair take-in. 

Require ID & Password 
on Repair Intake 

Whether repair intake transactions require an ID. 

Require Photo at Repair 
Intake/Edit 

Whether a photo is required at intake or edit. 

Require Reason Code 
from Repair Adjustment 
List 

Whether to require a reason code when adjusting a repair or custom job. 

Require Repair Deposit 
when Declared Value is 
Below this Dollar 
Amount 

Items to be repaired that have a declared value lower than this amount 
will require the user to enter a deposit amount, which could be $0.   

Require a Task SKU for 
Repairs 

Whether to require that each task have a SKU for repairs. 

Silently Mark All Tasks 
Done 

When scanning a job done, silently mark all tasks done without asking 
(also applies to custom job). 

Start Cursor in Repair 
Task Description Instead 
of SKU 

When adding a task to a repair, make the cursor start in the Description 
field instead of the SKU field. 

Use Time of Day for 
Repair ETA 

Record the time of day for ETA. 

13.23.28 Service Options 

See Cost on Job Details 
Email 

Level of security needed to view Cost on the Job Details email: 
Warn:  Warn before sending email with Cost displayed. 
Do Not Warn:  Do not warn before sending email with cost displayed. 
Override:  Override is necessary to send cost on email. 

13.23.29 Special Options 
This is a collection of keywords that we may define for special purposes.  Do not enter anything here 
unless directed to do so by The Edge Support Team. 
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13.23.30 Special Order Options 

Special Order 
Cancellation Fee – 
Percentage 

The amount, if any, in percentage of purchase price, should be charged if 
a special order is canceled. 

Special Order Claim 
Check Fine Print 

The fine print to appear on the special order claim check. 

Special Order Enable 
Sales Tax by Default on 
Special Order Intake 

The default value of the sales tax checkbox at special order intake. 

Special Order Minimum 
Deposit – Percentage  

The amount, if any, in percentage of purchase price, should be required 
for a deposit. 

Special Order One Item 
Per Envelope 

Whether only one special order item can be included in an envelope. 

Special Order Print 
Claim Check on 
Customer Section of 
Envelope 

Whether to print claim check on customer section of the special order 
envelope.   

Special Order Print 
Envelope 

Whether a special order envelope should be generated. 

Special Order Start Date The date after which special order will be available for purchase orders. 
Special Order Store 
Address Prints on 
Envelope 

Whether to print the store address on the special order envelope. 

Special Order Suggest 
Description Contains 
Equal Signs 

When doing a special order intake, whether the suggested item 
description generated by The Edge from the item details shows a listing 
using details labels, equal signs, and values.  

Special Order Vendor ID 
Required 

Whether the vendor information must be included in the record. 

13.23.31 Statement Options 

Generate Statement for 
Customers With Activity 
but a Negative Ending 
Balance 

Whether to generate a statement for a customer who did have activity 
in the period, but now has a negative balance.  Make sure you comply 
with any legal requirements in your jurisdiction. 

Generate Statement for 
Customers With Activity 
but a Zero Ending 
Balance 

Whether to generate a statement for a customer who did have activity 
in the period, but now has a zero balance.  Make sure you comply with 
any legal requirements in your jurisdiction. 
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Statement “From 
Address” Location 
Adjustment 

When statements are printed, the amount, in 1/1440ths of an inch, the 
“from address” value should be moved up, down, in overall width, and 
in overall height. 

Statement “To Address” 
Location Adjustment 

When statements are printed, the amount, in 1/1440ths of an inch, the 
“to address” value should be moved up, down, in overall width, and in 
overall height. 

Statement Closing Date The day of the month for statement closing date (1-31).  Will 
automatically use the last day of February if 29, 30, or 31 is selected. 

Statement Due Date Days 
After Statement End 
Date 

Due date calculated by adding this number of days to the statement end 
date. 

Statement Wording For 
Dates Outside the 
Current Period 

Wording used in override message and in statement footer when the 
dates do not conform to the posting dates.  The default text is "The 
dates used to print this Statement do not conform to the current closing 
/ print dates." 

Statement Wording 
Interest 

Wording for interest and average balance.  Ensure that your wording 
meets legal requirements. 

Statement Wording 
Minimum Amount Due 

Wording for minimum payment and due date.  Ensure that your 
wording meets legal requirements.  This field is limited to 110 
characters. 

Statement Wording 
When House Account 
Balances Have Been 
Estimated 

Used primarily when upgrading to v. 6.1 and initially using the Aging 
function, indicates the wording to be used on statements that have been 
generated using an estimated balance. 

Statement Wording 
When Running Without 
Closing 

Wording used in the override message and in the statement footer when 
the statement has been printed before closing the current period. 

Statement Wording 
When Store Charge 
Account Balance 
Thresholds Are Set 

If using account balance thresholds to waive interest if a customer pays 
a specified amount of balance, this is the message that displays on the 
statement informing the customer how much must be paid in order to 
avoid the finance charge. 

13.23.32 Store Charge Options 

Everybody Can Charge Set this to True to allow all customers to use a store charge or house 
account.  Set this to False to check if the customer is set up for a store 
charge or house account before allowing it at point of sale. 

Store Charge Account 
Balance Threshold 
Dollar Amount 

Works in conjunction with Store Charge Account Balance Threshold 
Percentage.  Allows you to waive the monthly finance charge if a 
payment was made.  Payment must meet threshold percentage or dollar 
amount entered here, whichever is greater.  This does NOT work unless 
you also set Store Charge Account Balance Threshold Percentage. 
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Store Charge Account 
Balance Threshold 
Interest Waived Message 

If set to True, the statement will show a line item showing the interest 
being waived. 

Store Charge Account 
Balance Threshold 
Percentage 

Allows you to credit the last monthly finance charge if a payment on the 
store charge account balance is at least this percentage of the full 
balance. 

Store Charge Interest 
Rate – Percentage 

The interest rate to be charged on outstanding store charge balances as a 
percentage.     

Store Charge Minimum 
Fee – Dollar Amount 

Store charge minimum fee (finance charge) as a dollar amount.  Note 
this only applies to store charge balances. 

Store Charge Minimum 
Payment Due – Dollar 
Amount 

The minimum payment expected on outstanding store charge balances, 
expressed as a flat dollar amount. 

 

If both Store Charge Minimum Payment Due – 
Percentage and Store Charge Minimum Payment Due – 
Dollar Amount are specified, then the greater of the two 
calculations will be used. If the minimum payment 
calculation returns an amount higher than the 
outstanding balance, then the outstanding balance 
amount will be used as the minimum payment amount. 

 

Store Charge Minimum 
Payment Due – 
Percentage 

The minimum payment expected on outstanding store charge balances, 
expressed as a percentage of the outstanding balance. 

Waive Interest if Balance 
is Zero Anytime During 
Period 

Whether to charge interest on a store charge (house account) if the 
balance was zero at any time during the billing period. 

Waive Interest if  
Ending Balance was Zero 

Whether to charge interest if the balance was zero at the end of the 
billing cycle. 

Waive Interest if  
Starting Balance was 
Zero 

Whether to charge interest if the balance was zero at the beginning of the 
billing cycle.  Also known as a grace period. 

 

13.23.33 Store Options 

Store Number Sets the store number within the system for identification purposes. 

13.23.34 Task Options 

Add Task Screen When adding a task, choose whether to use the Add Task Form or Add 
Task Wizard.  Additional options allow you to use the Form with a link 
to the Wizard and vice-versa. 
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Add Tasks on Start 
Date to Daily Email 

Set this to True to have tasks appear on associate’s daily email on the 
task’s Start Date, otherwise it will show on the task’s Due Date. 

Send Daily Email of 
Tasks 

Set this to True to send each associate a daily email of tasks due or 
starting today.  If the Edge is running, the daily email is sent once each 
morning, otherwise it will send the next time the software is started. 

New Task Default 
Notify 

The default notification method used when creating a new task.  Choose 
between email, SMS (text), both, or neither. 

Task Lead Time Task Due Date will default to this number of days in the future, e.g. 
enter 1 to always default due date to tomorrow. 

13.23.35 Tender/Rewards Cards Options 

Earned Rewards 
Reduced on Return 
Receipt Wording 

How to word returned deduction from rewards earnings on the receipt.   

Enable Rewards Cards Whether to enable rewards cards. 
Enable Tender Cards Whether to enable tender cards. 
House Card Wording 
POS Button 

A general phrase that describes either a tender card or rewards card.  
Used only on the tender buttons on the Point of Sale window. 

Referral Card Wording How you refer to the card you give to a customer to in turn give to 
another. 

Referral Wording What you call the credit you give a customer for referring someone. 
Rewards Cap Earned 
Per Item 

Caps how much can be earned in rewards per sale item.  Set this to -1 
if you do not want a cap. 

Rewards Cap Per Sale The total amount that a sale can earn in a single rewards transaction.  
For example, if a sale is supposed to earn $350 in rewards, but a cap of 
$250 is set, then the sale will earn $250.  If set to -1, the cap will be 
ignored. 

Rewards Card 
Maximum Initial Bonus 

Maximum initial bonus that can be given without an override. 

Rewards Card Prefixes Prefixes that identify rewards cards. 
Rewards Card Wording How you refer to your Rewards or Loyalty cards. 
Rewards Earned 
Wording 

How to word reward earnings on a receipt.  It might be best for sales 
tax purposes to word it as some kind of future discount.  For example, 
“This purchase has earned you ___ in future rewards discounts” where 
the blank is replaced by some dollar amount. 

Rewards Redemption 
Receipt Wording 

How to word reward card redemption on the receipt.  It might be best 
for sales tax purposes to word it as some kind of discount. 

Rewards Use Vendor 
Filters 

Allows for items that pay out rewards to be filtered by vendor. 
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Tender Card Prefixes Prefixes that identify tender cards. 
Tender Card Wording How you refer to your tender/give/refund cards. 
Use Category Filters 
With Rewards 

Allows for items that pay out rewards to be filtered by category. 

 

13.23.36 Time Card Options 

Show Elapsed Time as 
Hours and Minutes 

Whether to show time as hours and minutes or just hours with decimals.  
Values are true or false.  For example, True would indicate you wish 
to show hours and minutes, e.g., 3 hours and 30 minutes.  False 
indicates the time should be shown in decimal hours, e.g., 3.5 hours.   

13.23.37 Wish List Options 

Wish List Commission 
Split 

How to split the commission on items sold from a wish list.  0 means all 
commission goes to the associate who enters the item on the wish list.  
100 means that all commission goes to the associate(s) who sell(s) the 
item.  Enter a number between 0 and 100. 

Wish List Deletion 
Options 

Level of security required to delete a wish list entry. 
Any:  Anyone can delete a wish list entry. 
Permission:  Permission is required to delete a wish list entry. 
Override:  An override is necessary to delete a wish list entry. 

13.23.38 Wording Options 

“No Sale” Tracking 
Wording 

How you wish to label the No Sale Tracking button. 

Credit Memo Wording What you wish to call a credit when issued in lieu of a cash refund. 
Discount Wording How you refer to a customer credit in lieu of a cash refund. 
Giveaway Wording How giveaways should be worded in the Point of Sale window and on 

receipts. 
House Account Wording What you wish to call the use of a house account or store charge. 
No Image Available 
Wording 

Wording displayed on an image when the image is not available.  If this 
value is left blank, nothing will show where the image would appear.  
This affects reports only. 

Shipping & Handling What you wish to call shipping and handling charges on a receipt. 
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 Select Photo Device 
In Select Photo Device, you select the twain compliant device to use as your default camera.  To select a 
photo device: 
 
1. Select Administrative ► Select Photo Device.  The Select Source window will appear. 

 

 
 
There will usually be only one device from which to select.  If you have more than one device 
installed, however, all device options will appear. 
 

2. Select the desired device. 
3. Select Select. 
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 Credit Cards 
The Edge Integrated Payment Processing system allows you to process credit and debit card payments 
right at your Edge workstation, using magnetic strip cards, EMV cards (chip on card), NFC wireless 
payment methods such as Apple Pay and tap-and-go cards, and manual key. This saves time, improves 
customer service and eliminates errors associated with keying dollar amounts into two different devices.  
 
This solution consists of several components.  There is the merchant services provider, the 
“middleware,” the terminal devices, and The Edge integrated payments feature.  
 
Merchant Services Provider 
 
A merchant services provider (or “processor”) establishes your merchant account and provides for credit 
and debit authorizations. Merchant services providers fall into three categories: Edge Certified Partners; 
Jewelry Industry Group Members; and Bring Your Own (BYO).  We recommend Edge Certified 
partners for a number of reasons.   
 
We have special relationships with several national merchant processors.  We urge you to consider using 
them because we work closely and often with each of them and can therefore provide you with the most 
satisfying integration experience, especially when it comes to setup and troubleshooting.  
 
In most cases, Edge Certified Partners will cover the cost of the middleware, The Edge integrated 
payments feature, and one or more EMV devices (exact number of devices depends on your transaction 
history).  Please contact us to ask about the Edge Certified Partner most appropriate for you. 
 
Middleware 
 
The middleware is third-party software that provides a consistent interface to a variety of different 
processing platforms and plays the biggest part in compliance with PCI (payment card industry) 
regulations.  The exact middleware installed in your store will depend on your choice of merchant 
service provider.  
 
EMV/Terminal Device 
 
You will need an EMV capable device.  This device consists of a pin pad, display, EMV slot, magnetic 
strip slot and NFC capability for Apple Pay and other wireless payment methods.  Some EMV devices 
connect directly to your workstation via USB, others connect to your local area network via an Ethernet 
cable. 
 
The Edge Integrated Payments Feature 
  
Because payment processing requirements are subject to change, we provide the Edge integrated 
payments feature on an annual subscription basis. 
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Other Requirements 
 
• Windows 7 or higher is required. 
• Authorizations are obtained over the internet; you must have reliable internet service in the store.   
• If your EMV device is USB-connected, your workstation must have an open USB port (USB 

version 2.0 or higher). 
• If your EMV device is Ethernet-connected, you may need additional cables and/or Ethernet 

switches. 
 
Contact The Edge Customer Service Team so we can help select the best solution for you.   

13.25.1 Credit Card Types 
In this section, we will discuss adding card types to your system.  To accept credit cards as payment, see 
the section entitled Tender Options.   To set up a credit card in The Edge: 
 
1. Select Administrative ► Set Up Card Types. The Credit Card Setup window will appear with a 

list of currently recorded cards. 
 

 
 

Fields and options in the Credit Card Setup window include: 
 

Enabled Whether the card is enabled in The Edge. 
Internal Key The unique name for the credit card.  It can be the same as The Edge 

name or the QuickBooks name, but must be unique. 
Edge Name The name for the card as it appears on The Edge Point of Sale 

window. 
QuickBooks Name The name used for mapping to QuickBooks. 

 

 

If integrated with QuickBooks, there must be a 
payment method that matches the QuickBooks 
name exactly (with case sensitivity). 

 

Move Up/Move Down Used to reorder the list. 
New Row Used to create a new credit card record. 

mailto:service@ajsllc.com
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2. Select New Row.  A blank row will appear at the bottom of the list.   
3. Complete the fields as required. 
4. Select OK/Save & Close. 
 
To edit an entry: 
 
1. Select the field to edit. 
2. Make changes as required. 
3. Select OK/Save & Close. 

13.25.2 Credit Card Settlement 
To receive payments from credit card transactions, settlement is required.  Credit card settlement varies 
greatly based on the type of integration your credit card system has within The Edge and your processing 
company.  Contact your credit card processing company for instructions on settlements.  If there is an 
error in batch reconciliation, an error message will go to whoever is listed on The Edge license.  System 
Options may allow additional recipients.   
 
If you’re working with one of our integrated partners, The Edge support can also provide guidance. 
 
For TSYS, each PAX S300 card reader is independent of the others and each has its own batch.  If you 
must void a transaction, it must be done at the same workstation/device.  If you want to manually 
process a batch settlement, you must do so at the workstation where the transaction originally took place.  
There is no need to do a batch settlement at all as these devices will automatically settle at 11:30 to 
12:00 midnight local time.  To manually settle the batch: 
 
1. Go to Administrative ►Credit Cards ► Daily Settlement.  Unsettled amounts will appear. 
2. Verify that the dollar amount in the batch matches activity for the period to be settled. 
3. Select Close the Batch.  You'll be prompted to confirm. 
4. Do so.  Credit card transactions since the last settlement will be settled. 

13.25.3 Credit Card FAQs 
Question:  Where do I batch out at the end of the day?  
Answer: 
To receive payments from credit card transactions, settlement is required.  Most credit card processors 
set up clients to automatically settle batches at a specific time of day.  In addition, most processors 
support manual settlement.  Please contact your processor to see how your account is setup.  Note that 
processors may charge a fee for multiple daily settlement.  See the section entitled Credit Card 
Settlement for instructions on manual batch settlement. 
 
Question:  I have a new credit card device I need to add to my existing credit card setup.  What do 
I do? 
Answer:  
Contact your credit card processor to set up a time for configuration of the new system. 
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Question:  I’m replacing my server; will we be able to process credit cards? 
Answer: 
During the time of replacement, you will not have access to credit cards; you should contact your credit 
card processor for a temporary solution.  Once your new server is in place and the processor software is 
reinstalled and configured, you can continue to process credit cards. 

13.25.4 Credit Card Troubleshooting 

 

Contact information for your processor is available from the Credit Card window. 

 
Problem:  Cannot Connect to Credit Card Server 
Cause(s)/Solution(s): 

• NETePay is not open.  Open NETePay. 
• A card reader is not connected to the workstation.  Check card reader connection. 
• Firewall issue.  Check firewall settings to ensure they permit reader transactions. 
• Internet access is down.  Troubleshoot the Internet connection. 
• IP Address is not static.  Check server name or server IP address to make sure it is static.  If 

necessary, contact your Internet Service Provider and request a static IP. 

Problem:  Maximum Number of Lanes Already Reached 
Cause(s)/Solution(s): 

• Maximum number of licensed lanes has been reached.  Call The Edge sales for additional lanes. 

Problem:  Declined Card 
Cause(s)/Solution(s): 

• For VX805, use date YY/MM not MM/YY. 
• Card declined by card issuer.  Try another card. 

Problem:  Card Swipe Does Not Respond 
Cause(s)/Solution(s): 

• Not selecting OK in The Edge Credit Card Tender window before beginning the swipe, insertion, 
or tap.  Select OK before processing the card; this tells The Edge to start interacting with the 
terminal device. 

• The terminal device may not be properly connected.  Check the connection. 

Problem:  There Was an Error on a Transaction Causing “AP Dupe” 
Cause(s)/Solution(s): 
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• Brief network issue that caused the transaction to authorize successfully with card processing 
company but not communicated back to The Edge:  Look at batch totals to determine what was 
approved on card processor side and verify against sale causing error.  Enter the transaction into The 
Edge using the Offline tab. 

Problem:  Main Workstation Crashed 
Cause(s)/Solution(s): 

• System crash:  If it’s a total system crash, call The Edge.  If it is only credit cards that are crashed, 
call your processor for emergency support.  You may need to do both.   

Problem:  Internet is Down 
Cause(s)/Solution(s): 

• Internet is down:  Call voice authorizations into card processor and enter transactions into The Edge 
using the Offline tab. 

Problem:  Batches Don’t Match 
Cause(s)/Solution(s): 

• When closing the batch, the batch totals between the processor’s server and The Edge records don’t 
match.  Call The Edge Technical Support. 

Problem:  Merchant ID Does Not Match License 
Cause(s)/Solution(s): 

• Merchant ID in The Edge Credit Card Setup doesn’t match that in your Edge license.  Check the 
license file and update it if necessary.  It may be necessary to contact the processor to verify an 
accurate MID. 

• Internet service is down:  Reestablish connection. 
• NETePay is not running:  Restart NETePay. 

Problem:  Track 2 Error 
Cause(s)/Solution(s): 

• The card may have been processed through the terminal device too quickly or too slowly.  Swipe, 
insert, or tap again. 

Problem:  Component with SLSID Failure 
Cause(s)/Solution(s): 

• The active control (DSIPDCX) that talks to NETePay was not installed.  Call The Edge Technical 
Support to have DSIPDCX reinstalled and retested.  
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Problem:  ComPort Not Found in XML Document 
Cause(s)/Solution(s): 

• The user is not logged in the account that was set up in for credit cards:  Log out and log into the 
account they were set up under (usually the ADMIN account) and call the processor to have them 
set up under the other user account.  

Problem:  Error:  Unable to find an entry point when trying to process (TSYS) 
Cause(s)/Solution(s): 

• This error is because of a Windows incompatibility. The computer receiving this error was a 
Windows XP, which is not supported on the TSYS platform.  Upgrade the operating system to at 
least Windows 10. 

Problem:  Error: EMV pad reset failed, transaction not complete, failed on com port access 
(VX805) 
Cause(s)/Solution(s): 

• A Windows update has caused the VX805 driver to drop.  Reinstall the VX805 driver. 

Problem:  A transaction showing at the processor, but sale is not in The Edge 
Cause(s)/Solution(s): 

• The merchant should ring the sale “Offline” in The Edge to record the sale but not process the 
payment a secondary time. 

• For VX805, commonly the driver must be reinstalled or the station workstation is looking at the 
wrong com port for the device. Com9 is the default.  Re-install the driver. 

Problem:  A sale exists in The Edge, but is not showing with the processor 

• Contact processor to be certain they are unaware of the funds. 
• Void the sale and reenter ensuring the merchant does not choose “Process Offline.”  

Problem:  Socket errors 

1. Reboot NETePay.  (Go to NETePay and click File>Exit, then double click to restart.)    
2. Browse to the server computer over the network (or computer that has NETePay) be sure you can 

access it without needing network credentials.     
3. Make sure The Edge and NETePay connection is through FW and AV.    
4. Reboot the computer. 

Problem:  Can’t process Amex    

• Likely needs an update of the CC software (NETePay and DSI possibly). 
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• Must be on release version DSIEMV Version 5.06.10 or higher.  
• Not licensed for CC processor, could that be an old license is installed; re-send and install newer 

license.     

Problem:  No connection to any server    

• Again, make sure NETePay is up and running; if it is, reboot it.    
• Access to the path needs permission to the folder location.  The store needs to reach out to the CC 

processor.    

Problem:  PAX Troubleshooting 

• If manually processing with a PAX, you must PRESS OK in The Edge and immediately start 
entering the card # directly on the device. You will time out if more than 60 seconds passes  

• For any access denied error, make sure they have full permissions to The Edge folder and are signed 
in as an admin.  

Problem:  Not Licensed for Plugin 

• License file is incorrect OR the wrong DLL has been selected 

Problem:  Connect Error 

• Edge workstation is failing to communicate with the IP address of the PAX device.  If 
persistent, Processor will set the merchant up for Static IP. 

• DHCP support was added to the Edge in 17.1. 

13.25.5 General Tips for Smooth Processing 

• The processor server name should be device name rather than a static IP.  If you use an IP address, 
make sure it is the correct server and make sure it is static. 

• If something is wrong with connection between The Edge and the processor, the first step should be 
to check your Internet connection, then ping the server. 

• The NETePay folder must have read/write permission for everyone.  Processing permissions in The 
Edge will protect against unauthorized activity. 

• NETePay should have firewall access. 
• When looking for NETePay for the purposes of restarting it, look for the NETePay icon.   
• To restart NETePay, minimizing the window is not sufficient.  Open the application window and 

select File ► Exit. 
• If you use multiple Windows logins to ring up credit card transactions, provide them to your 

processor. 
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 Email Settings 
In an effort to save paper, customers can opt to receive receipts by email.  This option is known as Green 
Receipts.  This document outlines the steps required to get you started with Green Receipts.  

13.26.1 Green Receipt System Options 
For green receipts to work, it must be configured in System Options.  To do so: 
 
1. Select Administrative ► System Options and scroll down to Receipt Options. 
2. Set Enable Emailing of Receipts to True. 
3. Select OK. 

13.26.2 Configuring Email Settings for Email Receipts and Job Details Sheets 
To send email receipts and job details sheets, The Edge must be configured to use the email settings 
associated with your store email account.   The fields marked with an asterisk below are specific to your 
email account.  You should contact your email vendor or ISP (Internet service provider) and ask them 
specifically for this information. 
 

 

Some web-based email applications such as Yahoo mail, Hotmail, AOL mail may not 
work well from within The Edge. 

 

If you complete the email settings for Customer Marketing first, you can copy those 
settings to this area. 

 
The Edge email server must be configured to send messages.  To do so: 
 
1. Select Administrative ► Email Settings ► Receipts/Job Details.  The Email Receipt/Job 

Details Settings window will appear. 
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Fields and options to complete in the Email Receipt/Job Details Settings window include: 
 
From Name The name that you want to appear as the sender of the receipt.  This 

will probably be your store name.  This also serves as the “reply to” 
email address. 

From Email The email address from which the receipt is being sent.  This will 
be your store email account. 

SMTP Server* The outbound server as provided by your email provider.  It will 
probably be an SMTP account. 

Port #* The port number with which your email interacts. 
Server Requires SSL* Whether the outgoing server requires a secure socket layer. 
Server Requires 
Authentication* 

Whether the outgoing server requires authentication. 

User ID* The email account’s user ID. 
Password* The password for the email account. 
Logo File/Browse Optionally you can supply a logo file (image) containing your 

store’s logo.  If you do, the image will appear at the top of the 
email receipt 
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Copy Values from 
Customer Marketing 
Email Settings 

Allows you to copy the settings you used in setting up customer 
marketing emails as discussed in the section entitled Configuring 
Email Settings for Customer Marketing. 

Test Connection Sends a ping though the system to make sure settings are correct. 
Clear Settings Allows you to clear email settings, which will effectively disable 

automated emails. 
 
2. Complete these fields with user and server settings (SMTP) provided by your email provider. 
3. Select Test Connection to have a test email sent to you to verify set up is correct. 
4. Select OK. 

13.26.3 Configuring Email Settings for Customer Marketing 
You can use different email settings for different purposes.  To configure email settings for customer 
mailings that are different from those of receipts or notifications, select Administrative ► Email 
Settings ► Customer Marketing.  Complete the fields as described in the section entitled Configuring 
Email Settings for Email Receipts and Job Details Sheets.   

13.26.4 Configuring Email Settings for Notifications 
You can use different email settings for different purposes. To configure email settings for customer 
mailings that are different from those of receipts or notifications, select Administrative ► Email 
Settings ► Notifications.  Complete the fields as described in the section entitled Configuring Email 
Settings for Email Receipts and Job Details Sheets.   

13.26.5 Configuring Email Settings for Internal Notifications 
You can use different email settings for different purposes. To configure email settings for internal 
communications that are different from those of receipts or notifications, select Administrative ► 
Email Settings ► Internal.  Complete the fields as described in the section entitled Configuring Email 
Settings for Email Receipts and Job Details Sheets.   
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 Log Off 
Allows one user to log off the system, thereby removing his or her permissions, so the next user will 
only be permitted his or her own access.   
 
When a user logs in, they have 5 minutes of idle time before they are automatically logged off.  The 
clock in the lower left corner counts down this time.  With each keystroke, the clock is reset to 5 
minutes.   
 
To abort the remaining time, use Log Off.  For example, if you logged on and then must take a phone 
call and leave the workstation, use Log Off to ensure that no one performs tasks under your ID. 
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14 User Resources 
You have questions?  We have answers!  You're always welcome to call for support, but to get the 
most from The Edge, take a look at the variety of user resources available from Abbott Jewelry 
Systems. 
 
Associate and Management Training 
 
With knowledge comes the ability to unleash the full potential of The Edge and your business. Take 
advantage of the variety of regional training classes, classroom work at our Shelton, Connecticut, 
headquarters, or the numerous webinars that you can take from anywhere.  Visit 
www.theedgeforjewelers.com/calendar. 
 
To find out how you can get free, unlimited training, contact service@ajsllc.com. 
 
Help at Your Fingertips 
 
The most convenient and all-encompassing reference tool is The Edge's On-Line Help System, which is 
built right into The Edge interface and available on-line.  From there, you can browse a topic, search the 
index, or do a full key-word search.  When working in The Edge, many screens contain a yellow Help 
button built right in; it will automatically open to the topic for that screen.  
 
EdgeUser.com 

 
At EdgeUser.com, you'll see:  
• New user videos (good for a brush up, too!) 
• Specific feature videos 
• Tip sheets on getting the most from new and even not-so-new features 
• An extra link to The Edge User Guide in PDF (which is also installed on your desktop) 
• We also have a Downloads area where you can get the most recent Vendor Catalogs, ZIP Code files, 

and of course, the latest version of The Edge. 
 
Specifically available on EdgeUser.com, following is a list of tip sheets and videos available to help you 
work with specific features of The Edge.   
 
 
 
  

http://www.theedgeforjewelers.com/calendar
mailto:service@ajsllc.com
http://docs.edgeuser.com/NetHelp/index.html#!Documents/introduction.htm
http://edgeuser.com/documents.aspx
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15 Glossary 
 

Acronym Term Definition 
AIMS aged inventory 

management 
system 

A process designed to take a proactive approach to aging 
inventory.  The goal of AIMS is the reduction and elimination of 
old inventory.  This is accomplished by using a tiered system of 
assigning spiff and price markdowns to items dynamically as 
they age. 

 bulk master record An inventory record that serves as the item record for all bulk 
items of that style number.   

 bulk quantity 
record 

Bulk quantity records are a subset of bulk master records, but are 
based on shipments.  For example, if you receive 10 of a 
particular bulk item, a bulk quantity record is created. 

 bulk instance 
record 

Bulk instance records are created when a bulk item is sold or 
otherwise used individually.  Creation of an instance record 
depletes the quantity record for that item. 

 bulk pricing 
methods 

• General Merchandise, UPC/SKU:  Appropriate when an 
item is carried in quantity and carries the same cost and price 
each, e.g., charms, batteries, and bead lines. 

• Buy and Sell Item by Unit of Measure, IUOM:  Appropriate 
when an item is carried in quantity that includes a physical 
count and a measure and sold per measure, e.g., melee 
diamond parcels. 

• Buy and Sell by Measure Only, UOM:  Appropriate when an 
item is carried in measure and sold per measure, e.g., gold 
stock. 

• Mixed Retail Pricing, PRE:  Appropriate when an item 
represents a group of like-items of differing costs and prices 
but consistent markup, e.g., watchbands.  

COGS cost of goods sold The direct costs attributable to the production of the goods sold 
by a company. This amount includes the cost of the materials 
used in creating the good along with the direct labor costs used to 
produce the good. It excludes indirect expenses such as 
distribution costs and sales force costs.  

 consignment Items owned by a customer that reside at and are to be sold by 
the store, at which time the customer will receive payment.  Also 
see memo items. 

GROI gross return on 
investment 

An inventory profitability evaluation ratio that analyzes a firm's 
ability to turn inventory into cash above the cost of the inventory. 
It is calculated by dividing the gross margin by the average 
inventory cost and is used often in the retail industry.  
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 customer account 
types 

CH:  House Account 
Reward Card:  Reward Card 
L:  Layaway 
R:  Repair 
CR:  Store Credit. 

 inventory types A:  Assembled 
P:  Take-Off 
U:  Custom 
S:  Stock 
M:  Memo 
C:  Consignment 
O:  Special Order 
T:  Trade-In 
B:  Built 
E:  Template 
V:  Virtual Model 
I:  Internet Model approved 
J:  Internet Model Browse not yet approved 
F:  Faux Model 
L:  Live Model 

 item statuses I:  In stock 
L:  On Layaway 
S:  Sold 
A:   Memo Out 
V:   Returned to Vendor 
M:  Missing 
D:  Disassembled 
U:  Consumed here (i.e. as a part) 
    Consumed gone (no status letter, determined by sold or in 
stock) 
X:  Scrapped 
G:  Giveaway 
N:  Donation 
W:  Work in Progress 
C:   Cancelled 
E:  Template. 
 
Purchase Order Statuses: 
Q:  Queued 
E:  Entered 
B:  Backordered 
O:  On Order 
C:  Cancelled. 
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IUOM item unit of 
measure 

Bulk item pricing method; see bulk pricing methods above. 

 levels In concert with Rapid Reorder, a designation of the minimum 
number of an item to be kept in stock at all times. 

 memo item Items owned by a vendor that reside at and are to be sold by the 
store, at which time the vendor will receive payment.   Also see 
consignment. 

PRE  Bulk pricing method; see bulk pricing above 
 purchase order 

statuses 
• New             P/O line added, not saved or ordered. 
• Entered       P/O line added and saved, but not ordered. 
• Ordered      P/O line entered and ordered. 
• Received      Full quantity for this P/O line received to 

inventory 
• Canceled      Order has been canceled 
• Back Order   Items ordered but unavailable for shipping. 

 reprice/re-cost The repricing feature allows you to change the price of an item or 
several items.  Re-cost allows you to change and track 
replacement cost of an item. 

RFID radio frequency 
identification 

A technology that allows reading of tags by radio frequency.   
The tag contains a chip which the wand can interact with.  They 
do not require line-of-sight with text or a barcode.   

 server A computer that may or may not serve as a workstation, but in 
any case, houses the databases. 

 special order status • Need More Info 
• Need to Order 
• Waiting on Vendor 
• All Here 
• Part Here 
• Complete or Canceled. 

TROI true return on 
investment 

The return on investment taking account how long the item has 
been in inventory. 

UOM unit of measure Bulk pricing method; see bulk pricing above 
UPC/SKU universal product 

code/stock keeping 
unit 

Bulk pricing method; see bulk pricing above 

WIP work in progress A build or assembly that has been initiated but has never added a 
SKU and does not have a completed task. 

 work station A computer running The Edge that does not house the databases. 
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activity reports .............................................. 463 
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activity tab, customer record ........................ 230 
add customer ................................................ 323 
add item manually, receive invoice ................ 88 
add permission................................................ 18 
add task, item assembly ................................ 118 
adding a category ........................................... 31 
adding a new customer ................................. 246 
adding a purchase order ................................ 141 
adding a stone ................................................. 66 
adding a vendor .............................................. 46 
adding an item ................................................ 59 
address, customer ................................. 220, 221 
addressee, results tab .................................... 202 
adjust a repair cost ........................................ 365 
adjusting balances ........................................ 225 
adjustment reason, repair .............................. 367 
adjustments report ........................................ 569 
adjustments, rewards balance ....................... 708 
administrative menu ..................................... 620 
advertising report .......................................... 542 
aging house accounts .................................... 274 
aging, undoing .............................................. 278 
AIMS ............................................ 168, 176, 788 
allocate special order ...................................... 85 
allocate, item .................................................. 63 
allocating items .............................................. 83 
already finished, custom job ......................... 371 
already finished, repair ................................. 355 
alternate items .............................................. 413 
amount due report ......................................... 564 

amount spent tab, customer find .................. 209 
appointment notifications ............................ 574 
appointments ........................................ 329, 571 
appointments tab, customer record .............. 238 
appointments, at POS .................................. 417 
appointments, creating ................................. 571 
appointments, next ....................................... 580 
appointments, queued .................................. 580 
appraisal tab, customer find ......................... 212 
appraisal, print ............................................. 335 
appraisals, find ............................................. 445 
appraisals, intake ......................................... 352 
ask before printing ....................................... 424 
ask if gift receipt .......................................... 424 
assemble from previous ............................... 120 
assemble from scratch ................................. 113 
assemble from template ............................... 119 
assemble item supervisor menu ................... 113 
assemble items ............................................. 112 
assembled tab, item record ............................ 80 
assembly template........................................ 119 
assembly, cancelling .................................... 123 
associate ....................................................... 320 
associate commissions ................................. 544 
associate, changing ...................................... 316 
associate, ID ................................................ 320 
associates ..................................................... 621 
associates, commission ................................ 623 
associates, security....................................... 625 
asterisks, item list view ............................ 70, 99 
attendance report.......................................... 548 
automatic markdown ................................... 169 
automatic markdown, category ...................... 34 
automatic markup, category........................... 33 
automatic markup, vendor ............................. 49 
back from vendor ......................................... 103 
backdating.................................................... 380 
backup database ........................................... 615 
balance adjustments, rewards ...................... 708 
balances report ............................................. 528 
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balances, adjusting ....................................... 225 
balances, rewards ......................................... 532 
barcode scanner ............................................ 744 
barcode, item .................................................. 62 
billing statements ......................................... 281 
bonus poster ................................................. 500 
bonus poster ................................................. 177 
bonus, rewards ............................................. 695 
breakdown report ......................................... 568 
build from previous ...................................... 122 
build from scratch ........................................ 121 
build from template ...................................... 122 
build, cancelling ........................................... 123 
bulk instance record ............................... 59, 788 
bulk inventory merge ................................... 106 
bulk inventory, item ....................................... 57 
bulk item supervisor menu ................... 103, 105 
bulk master ..................................................... 59 
bulk master record ....................................... 788 
bulk pricing methods.................................... 788 
bulk quantity record ............................... 59, 788 
buy and sell, item ........................................... 71 
buy period .................................................... 179 
buying plan .................................................. 171 
buying tools.......................................... 168, 171 
by acquisition report .................................... 524 
by why in report ........................................... 526 
by ZIP report ................................................ 522 
calculate commission ................................... 740 
calculating interest ....................................... 284 
calculations .................................................... 11 
call before starting ............................... 351, 372 
camera ...................................................... 18, 20 
cancel ............................................................... 9 
cancel assembly ........................................... 123 
cancel build .................................................. 123 
canceling an order ........................................ 341 
cancelling a credit card sale ......................... 398 
capitalization .................................................. 11 
care plan pricing ........................................... 732 
care plan pricing on tags ................................ 39 
care plan repair SKU report ......................... 570 
care plan repair SKUs .................................. 734 
care plan report ............................................ 561 
care plan updates .......................................... 731 
care plan, repair intake ................................. 368 

care plans ...................................................... 389 
care program ................................................ 734 
care programs ............................................... 731 
cash .............................................................. 394 
cash customer ............................................... 328 
catalog files, vendor ....................................... 52 
categories, listing............................................ 30 
category adjustment, vendor .......................... 49 
category setup ........................................ 30, 544 
category, changing ....................................... 101 
category, item ................................................. 61 
category, new ................................................. 31 
cell calculations .............................................. 11 
change category ............................................ 101 
change pricing .............................................. 102 
changing a customer ..................................... 316 
changing a sale ............................................. 316 
changing an associate ................................... 316 
changing sales tax rate ................................. 627 
changing why-in ........................................... 316 
checks ........................................................... 395 
clienteling ..................................................... 298 
clienteling purchase history .......................... 299 
clock, punch ................................................. 594 
close period .................................................. 279 
close period, undoing ................................... 280 
COGS ........................................................... 788 
COGS sales .................................................. 179 
collections ...................................... 91, 125, 385 
color code, wish list ...................................... 229 
color codes, purchase orders .................. 87, 143 
columns, lists .................................................. 14 
commission .................................................. 623 
commission adjustment, category .................. 32 
commission adjustment, vendor ..................... 49 
commission on sale ...................................... 232 
commission report ........................................ 544 
compacting the database............................... 615 
conducting a sale .......................................... 320 
configuration ................................................ 744 
configuration, RFID ..................................... 165 
configuring email settings ............................ 710 
configuring email settings, customer marketing

 ................................................................. 785 
configuring email settings, notifications ...... 785 
configuring email settings, receipts .............. 783 
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consignment ......................................... 110, 788 
consumed ........................................................ 80 
consumed, item build ................................... 122 
contact information .......................................... 3 
contact method, appointments ...................... 573 
contact methods .................................... 220, 329 
contact tab, vendor ......................................... 46 
context-sensitive help ................................... 618 
conversion report .......................................... 505 
copy details ..................................................... 88 
copy from ....................................................... 36 
cost history report ......................................... 557 
cost of goods sold ......................................... 788 
cost, item ........................................................ 64 
cover page, report ......................................... 458 
create a take-off, item disassembly .............. 123 
creating appointments................................... 571 
creating lists ................................................. 638 
credit card FAQs .......................................... 778 
credit card settlement.................................... 778 
credit card settlement errors ......................... 778 
credit card troubleshooting ........................... 779 
credit card types ........................................... 777 
credit card, cancelling sale ........................... 398 
credit card, void sale ..................................... 398 
credit cards ........................................... 395, 776 
credit manager, vendor ................................... 47 
credit memo, accepting as payment .............. 404 
criteria page .................................................. 459 
custom job .................................................... 370 
custom job, parts .......................................... 375 
custom task detail, custom job ..................... 374 
customer account types ................................ 789 
customer add ................................................ 323 
customer address .................................. 220, 221 
customer contact methods ............................ 329 
customer criteria, mailing ............................. 263 
customer data, exporting .............................. 269 
customer database ........................................ 198 
customer edit ................................................ 328 
customer edit, spouse/partner records .......... 223 
customer email ..................................... 221, 222 
customer emails, sending ............................. 271 
customer find ................................................ 321 
customer IDs .................................................. 24 
customer information ................................... 323 

customer mailing ......................................... 263 
customer marketing email settings .............. 785 
customer mismatch ...................................... 400 
customer phone .................................... 220, 221 
customer postcards ...................................... 249 
customer record, duplicate ................... 246, 324 
customer report ............................................ 517 
customer returned items ............................... 558 
customer statements ..................................... 274 
customer supervisor menu ........................... 242 
customer supervisor menu ........................... 242 
customer, changing ...................................... 316 
customer, disable ......................................... 242 
customer, editing ......................................... 218 
customer, find .............................................. 198 
customer, item ............................................... 64 
customer/group mailing lists........................ 267 
customers, adding ........................................ 246 
daily activity ................................................ 463 
daily activity by department report .............. 477 
data ................................................................ 14 
database mode ............................................. 744 
database, backup .......................................... 615 
database, compacting ................................... 615 
database, customer ....................................... 198 
date change .................................................. 380 
date selection ................................................. 12 
dates ............................................................... 13 
dates tab, customer find ............................... 206 
dates, rolling .................................................. 13 
declared value, custom job .......................... 372 
declared value, repairs ................................. 355 
delete line..................................................... 335 
delete wish list entry .................................... 414 
deleted items report ..................................... 556 
departments .................................................... 42 
deposit, custom job ...................................... 372 
description template ................................. 40, 66 
description, item ............................................ 66 
details ............................................................. 35 
details sheet, job .......................................... 451 
details tab, category record ............................ 34 
details, item .................................................... 95 
diamond ......................................................... 68 
disable customer .......................................... 242 
disassemble item .......................................... 123 
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disassembled tab, item record ........................ 80 
disassembling ............................................... 124 
discontinued style ........................................ 130 
do not exceed ....................................... 351, 372 
donate ........................................................... 336 
donations ...................................................... 384 
donations report ........................................... 503 
done.............................................................. 418 
drop-down menus ........................................ 636 
drop-down values ........................................... 67 
due at pickup, custom job ............................ 372 
due date detailed report ................................ 565 
duplicate customer record .................... 246, 324 
each individually, results tab ........................ 202 
earning rewards credits ................................ 403 
Edge Community ............................................. 4 
edgeuser.com ................................................... 4 
edit bulk quantities, item .............................. 103 
edit customer ................................................ 328 
edit labor, item assembly ............................. 123 
edit sale ........................................................ 313 
edit task when scanned................................. 451 
editing a customer record ............................. 218 
editing a purchase order ............................... 147 
editing assembled items ............................... 123 
editing built items ........................................ 123 
editing lists ................................................... 636 
editing special orders ................................... 435 
editor, image .................................................. 19 
editor, photo ................................................... 19 
email administration..................................... 711 
email configuration ...................................... 710 
email headers and footers ............................. 712 
email job details ........................................... 432 
email receipt ................................................. 418 
email receipts ............................................... 783 
email settings ............................................... 783 
email subjects and greetings ........................ 714 
email support................................................ 619 
email, customer .................................... 221, 222 
emailing wish lists ............................... 302, 308 
emails, customer, sending ............................ 271 
entering wish lists items ............................... 407 
envelopes ............................................... 27, 420 
errors, credit card settlement ........................ 778 
estimate only, custom job ............................ 371 

estimate only, repairs ................................... 356 
estimated statement ...................................... 274 
estimated statements, finding ....................... 278 
ETA ................................................................ 13 
ETA, custom job .......................................... 372 
ETA, repair ................................................... 363 
Excel export ................................................. 460 
exceptions reports......................................... 555 
exclude empty .............................................. 457 
exclude from rewards ..................................... 64 
expiration dates .............................................. 13 
exporting customer data ............................... 269 
exporting reports .......................................... 460 
express service, custom job .......................... 371 
express service, repair .................................. 356 
FAQs, credit card ......................................... 778 
fast customer add.......................................... 323 
fast sellers ..................................................... 172 
fee calculations ............................................. 284 
field values ............................................. 67, 636 
file menu ...................................................... 614 
filtering by date .............................................. 12 
filtering reports ............................................... 16 
filters .............................................................. 11 
finance charge calculations .......................... 284 
find customer ........................................ 198, 321 
find gift certificates ...................................... 288 
find item, RFID ............................................ 110 
find sale supervisor menu ............................. 315 
finding a vendor ............................................. 49 
finding a wish list item ................................. 412 
finding an item ............................................... 90 
finding items, item assembly ........................ 122 
finding jobs by notification .......................... 716 
finding rewards............................................. 705 
finding statements ........................................ 279 
finding wish lists .................................. 301, 414 
first N records, printing signage ................... 155 
fixup bulk quantities ..................................... 106 
fixup status ................................................... 103 
format, list ...................................................... 10 
frequently-used SKU .................................... 651 
G/L report, QuickBooks ............................... 682 
general ledger report, QuickBooks ............... 682 
general tab, category record ........................... 32 
general tab, custom job ................................ 371 
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general tab, customer find ............................ 198 
general tab, item find ...................................... 90 
general tab, item record .................................. 61 
general tab, repair ......................................... 649 
general tab, repair task details ...................... 358 
general tab, rewards ...................................... 695 
general tab, task details, custom job ............. 374 
gift card report .............................................. 539 
gift certificate recipient ................................ 344 
gift certificate, editing .................................. 289 
gift certificate, selling ................................... 343 
gift certificates .............................................. 288 
gift certificates, as payment .......................... 399 
gift receipt .................................................... 418 
gift receipt options ........................................ 423 
gift receipts ................................................... 421 
giveaway ...................................................... 336 
giveaway report ............................................ 502 
giveaway report (management) .................... 559 
giveaways ..................................................... 382 
green receipt ................................................. 418 
green receipts................................................ 783 
GROI .................................................... 509, 788 
gross return on investment ........................... 788 
group by ....................................................... 457 
group mailing lists ........................................ 265 
group pane .................................................... 460 
headers and footers, email ............................ 712 
headquarters ID ............................................ 746 
help ............................................................... 618 
history tab, item record ................................... 82 
history, item .................................................. 100 
history, postcard ........................................... 255 
history, repair ....................................... 365, 380 
house account aging report ........................... 530 
house accounts.............................................. 274 
house accounts, aging ................................... 274 
ID scanner .................................................... 326 
ID the associate ............................................ 320 
identify yourself ............................................. 17 
IDs, customer ................................................. 24 
IDs, item ......................................................... 24 
IDs, transaction............................................... 24 
image ........................................................ 18, 20 
image editor .................................................... 19 
image properties ....................................... 19, 20 

image, custom job ........................................ 372 
image, repairs .............................................. 355 
importing repair SKUs ................................. 654 
in stock and sold report ................................ 485 
in stock by category report .......................... 485 
in stock by location report ........................... 487 
in stock by vendor report ............................. 486 
in stock, item assembly ................................ 115 
in-case signage ............................................... 34 
initial amount, rewards ................................ 694 
instance record, bulk .............................. 59, 788 
intake, repair ................................................ 649 
interest ......................................................... 279 
interest calculations ..................................... 284 
interim ......................................................... 179 
inventory ........................................................ 29 
inventory buying tools ......................... 168, 171 
inventory levels ........................................... 128 
inventory reports .......................................... 481 
inventory tab, rewards ................................. 695 
inventory type ................................................ 93 
inventory types ............................................ 789 
inventory, item ............................................... 63 
inventory, QuickBooks ................................ 672 
invoice, item .................................................. 62 
invoice, receive by ......................................... 87 
invoice, receive item ...................................... 85 
item allocation ............................................... 83 
item assembly .............................................. 112 
item assembly from previous ....................... 120 
item assembly from scratch ......................... 113 
item assembly from template ....................... 119 
item assembly supervisor menu ................... 120 
item building from previous ........................ 122 
item building from scratch ........................... 121 
item building from template ........................ 122 
item category, changing ............................... 102 
item collections ............................................ 125 
item description template ......................... 40, 66 
item details..................................................... 95 
item details lists ........................................... 638 
item details tab, item find .............................. 94 
item disassembly.......................................... 123 
item donation ............................................... 384 
item edit, item assembly .............................. 123 
item edit, item build ..................................... 123 
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item entry ....................................................... 64 
item history ............................................ 82, 100 
item IDs ......................................................... 24 
item information, repairs .............................. 355 
item labor, item assembly ............................ 117 
item levels .................................................... 495 
item list view supervisor menu ...................... 99 
item list view, asterisks ............................ 70, 99 
item lists ....................................................... 636 
item location ........................................ 131, 656 
item order from list view ................................ 99 
item parts ..................................................... 113 
item per row, stones tab ................................. 97 
item pop-up .................................................... 75 
item pop-ups ................................................ 336 
item setup ....................................................... 56 
item status ...................................... 93, 103, 789 
item supervisor menu ..... 51, 102, 103, 112, 130 
item tags ......................................................... 70 
item unit of measure..................................... 790 
item, adding ................................................... 59 
item, finding ................................................... 90 
item, move ................................................... 131 
item, order ...................................................... 99 
items quantities tab, item record .................... 71 
items, photographing.................................... 133 
items, re-cost ................................................ 736 
items, repricing ............................................ 736 
items, selling ........................................ 334, 336 
items, ship .................................................... 328 
IUOM ........................................................... 790 
jade ................................................................. 70 
Jewelers Mutual ........................................... 424 
jewelry care program ................................... 734 
jewelry care programs .................................. 731 
JMIC ............................................................ 424 
job details ..................................................... 451 
job details, email .......................................... 450 
job details, emailing ..................................... 432 
job record supervisor menu .......................... 453 
job tracking .......................................... 450, 451 
jobs, find by notification ...................... 452, 453 
labor, editing, item assembly ....................... 123 
labor, item assembly .................................... 117 
layaways ...................................................... 403 
layaways report ............................................ 534 

level fields .................................................... 130 
levels .............................................. 65, 495, 790 
levels, inventory ........................................... 128 
liability report ............................................... 567 
links, in reports ............................................. 460 
list format ....................................................... 10 
listing categories............................................. 30 
lists ......................................................... 14, 636 
lists, columns in .............................................. 14 
lists, creating ................................................ 638 
lists, customer mailing ................................. 267 
lists, editing .................................................. 636 
lists, system .................................................. 639 
load defaults ................................................... 10 
load program defaults ..................................... 10 
load settings .................................................... 10 
location, item .................................. 63, 131, 656 
location, physical inventory ......................... 132 
locations supervisor menu ............................ 660 
mail merge .................................................... 271 
mailing lists, group ....................................... 265 
mailing, customer ......................................... 263 
main screen ...................................................... 6 
make a payment............................................ 339 
make database permanent............................. 744 
make default image .................................. 19, 20 
making a sale ................................................ 320 
manage reports ............................................. 727 
management reports ..................................... 542 
managing a style ........................................... 130 
manual sale ................................................... 334 
mapping QuickBooks accounts .................... 664 
mark as done ................................................ 120 
mark as work in progress ............................. 120 
mark as work in stock .................................. 120 
mark missing ................................................ 102 
markdown ..................................................... 169 
markdown percentage, category ..................... 34 
markup, category ............................................ 33 
master record bulk ........................................ 788 
master record, bulk ......................................... 59 
matching special order inventory ................. 437 
max item discount, rewards .......................... 696 
measure, sell by, item ..................................... 71 
memo item .................................................... 790 
memo items .................................................. 110 
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memo items, return ......................................... 51 
memo out ...................................................... 335 
memorize report ............................................. 10 
memorized reports ................................ 461, 727 
menu bar ....................................................... 614 
menus ............................................................... 6 
merchandise tab, customer find .................... 203 
merchant services ......................................... 397 
merge fields .................................................. 271 
merge, bulk inventory................................... 106 
merge, vendor ................................................. 50 
messages, text ............................................... 716 
minimum cost, category ................................. 33 
minimum days, markdown, category ............. 34 
minimum markup, category ........................... 33 
minimum price, rewards ............................... 696 
misc charge ................................................... 342 
misc sale lines............................................... 647 
misc tab, QuickBooks................................... 678 
miscellaneous sales activity report ............... 466 
miscellaneous sales report ............................ 547 
mismatch, customer ...................................... 400 
missing item ................................................. 102 
mixed retail, item ............................................ 71 
mode, database ............................................. 744 
Montage ........................................................ 731 
more button .......................................... 334, 335 
most recent settings ........................................ 10 
move item ..................................................... 131 
move task, custom job .................................. 374 
move task, repairs ......................................... 358 
multi-store, postcards ................................... 256 
my brand ......................................................... 47 
narrowing query results .................................. 11 
navigation ......................................................... 6 
need override .................................................. 17 
net COGS ..................................................... 179 
new category .................................................. 31 
new item, item disassembly .......................... 124 
new repair part recommendation tab, repair . 652 
news feed ...................................................... 598 
next appointments ........................................ 580 
no name ........................................................ 328 
no sale........................................................... 380 
notes ............................................................. 328 
notes tab, customer record ............................ 234 

notes tab, item record ..................................... 74 
notes, customer ............................................ 328 
notification email settings ............................ 785 
notification find ................................... 452, 453 
notifications ......................................... 311, 710 
notifications report ....................................... 537 
notifications, appointment ........................... 574 
notifications, find ......................................... 716 
notify, custom job ........................................ 372 
notify, repairs ............................................... 356 
numbering ...................................................... 24 
occasions report ........................................... 538 
OCR scanner ................................................ 326 
OK/save & close .............................................. 9 
on account report ......................................... 529 
on-line help .................................................. 618 
opals ............................................................... 70 
open drawer ................................................. 381 
open to buy report ........................................ 178 
options tab, customer record ........................ 237 
options tab, item find ..................................... 98 
order items ..................................................... 99 
order postcards ............................................. 249 
ordered items ................................................. 86 
ordered, item assembly ................................ 115 
ordering reports ........................................... 492 
organize by start date, printing signage ....... 155 
other keys, customer find ............................. 208 
other tender detail report .............................. 475 
outbound email settings ............................... 710 
output options .............................................. 461 
override .......................................................... 17 
overview report by period ............................ 549 
park .............................................................. 381 
part details, item assembly ........................... 116 
parts tab, custom job details......................... 377 
parts tab, repair details ................................. 361 
parts tab, repairs ........................................... 364 
parts, as part of repair tasks ......................... 360 
parts, as part of tasks .................................... 379 
parts, item .................................................... 113 
parts, repair tasks ......................................... 363 
parts, tasks, custom job ................................ 375 
payment options ........................................... 394 
payment, special order ................................. 352 
payments using rewards card ............... 340, 401 
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payments, cash ............................................. 394 
payments, check ........................................... 395 
payments, credit card ................................... 395 
payments, credit memo ................................ 404 
payments, gift certificate .............................. 399 
payments, layaway ....................................... 403 
payments, store charge ................................. 405 
payments, tender card .................................. 402 
PDF report ................................................... 460 
pdf, report .................................................... 461 
pearls .............................................................. 70 
percentiles report .......................................... 519 
performance reports ..................................... 506 
permission, add .............................................. 18 
permissions .................................................... 16 
phone, customer ................................... 220, 221 
photo ........................................................ 18, 20 
photo device ................................................. 775 
photo editor .................................................... 19 
photo, item ............................................. 66, 115 
photographing an item ................................. 133 
pick a standard message ............................... 344 
pick up ......................................................... 340 
pickup special order ..................................... 352 
placed field, special orders ........................... 436 
Podium ................................................. 424, 759 
point of sale .................................................. 320 
pop-up, item ........................................... 75, 335 
popups tab, customer record ........................ 235 
pop-ups tab, item record ................................ 75 
pop-ups, item ............................................... 336 
POS, working with appointments at ............ 417 
postcard account .......................................... 249 
postcard history ............................................ 255 
postcard presets ............................................ 254 
postcard tab, customer find .......................... 215 
postcards ...................................................... 249 
postcards, scheduling ................................... 251 
posting fees .................................................. 279 
posting to QuickBooks ................................. 681 
PRE .............................................................. 790 
pre-appraise tab, item record .......................... 80 
presets .............................................................. 9 
presets, postcard ........................................... 254 
preview receipt ............................................. 424 
previous, item from ...................................... 113 

price estimate, repairs ................................... 363 
price is estimated, custom job .............. 351, 372 
price method, item .......................................... 64 
price, item assembly ..................................... 114 
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